
تولید کننده چندرسانه ای سه بعدی تولید کننده چندرسانه ای سه بعدی 
)جلد دوم()جلد دوم(

) ) Cinema 4D – PremiereCinema 4D – Premiere((

رشتۀ تولیدکننده چند رسانه ای
گروه برق و رایانه
شاخۀ کاردانش

پایۀ دوازدهم دورۀ دوم متوسطه

ــــلْ فَرجََهُــــمْ  ــــدٍ وَ عَجِّ ــــدٍ وَ آلِ مُحَمَّ الَلّٰهُــــمَّ صَـــــلِّ عَلــــیٰ مُحَمَّ

httpswww.roshd.ir312270


وزارت آموزش و پرورش
سازمان پژوهش و برنامه ریزی آموزشی

کلیه حقوق مادی و معنوی این کتاب متعلق به سازمان پژوهش و برنامه ریزی آموزشی 
به صورت چاپی  اجزای آن  و  از کتاب  استفاده  و هرگونه  پرورش است  و  آموزش  وزارت 
ترجمه،  تبدیل،  تلخیص،  اقتباس،  نمایش،  مجازی،  پایگاه های  در  ارائه  و  الکترونیکی  و 
عکس برداری، نقاشی، تهیه فیلم و تکثیر به هر شکل و نوع بدون کسب مجوز از این سازمان 

ممنوع است و متخلفان تحت پیگرد قانونی قرار می گیرند.

ISBN  978 - 964 - 05 - 3547-9          978 - 964 - 05 - 3547 - 9 شابک

تولیدکننده چندرسانه ای سه بعدی )جلددوم( ـ 312270                                       نام کتاب:	
سازمان پژوهش و برنامه ریزی آموزشی                                     پدیدآورنده:	

دفتر تألیف کتاب های درسی فنی و حرفه ای و کاردانش            مدیریت برنامه ریزی درسی و تألیف:	
مجتبی انصاری پور، حسن جعفریه، لیلا سعید و بیتا رهنمای زربیجاری ) اعضای شورای برنامه ریزی(    شناسه افزوده برنامه ریزی وتألیف:	

رامین مولاناپور )مؤلف( ـ آزاده حق روستا )برنامه ریزی و هماهنگی تألیف( 	
ادارة کلّ نظارت بر نشر و توزیع مواد آموزشی               مدیریت آماده سازی هنری:	

جواد صفری  )مدیر هنری( ـ شهرزاد قنبری و مریم نصرتی  )صفحه آرا(                شناسه افزوده آماده سازی:	
تهران: خیابان ایرانشهر شمالی ـ ساختمان شمارة 4 آموزش و پرورش )شهید موسوی(                               نشانی سازمان:	

 ـ88831161    ،  دورنگار  : 88309266  ، کد پستی  : 1584747359  تلفن  : 9  	
www.irtextbook.ir و www.chap.sch.ir :وب سایت                                                  

شرکت چاپ و   نشر کتاب های  درسی ایران : تهران ـ کیلومتر 17 جادة مخصوص کرج   ـ خیابان61 )داروپخش(                                                  ناشر:	
 ـ44985161، دورنگار  : 44985160، صندوق پستی  : 139ـ 37515                                                   تلفن : 5   

شرکت چاپ  و  نشر کتاب های درسی ایران »سهامی خاص«                                         چاپخانه:	
چاپ اول 1402                سال انتشار و نوبت چاپ:	



اگر یک ملتی نخواهد آسیب ببیند باید این ملت اوّلاً با هم متحد باشد، و ثانیاً 
در هر کاری که اشتغال دارد آن را خوب انجام بدهد. امروز کشور محتاج به 
کار است. باید کار کنیم تا خودکفا باشیم. بلکه ان شاءالله صادرات هم داشته 
باشیم. شما برادرها الان عبادتتان این است که کار بکنید؛ این عبادت است.
هُ« سَ سِرُّ امام خمین ى»قُدِّ



فهرست

	1 فصل 1: آشنایی با محیط کاربری	
	3 	Cinema 4D اصول نصب نرم‌افزار 
	4  نحوهٔ استفاده از رابط کاربر	
5  تنظیمات محیط کار	
6  پرسش‌های تشریحی	
6  پرسش‌های چندگزینه‌ای	

	7 	Viewport فصل 2: انتخاب و حرکت اشیا در
	9  نوار عنوان	
	16 	Cinema 4D انواع انتخاب در محیط 
	18 	Object Axis مفهوم 
24 	Connect انواع فرمان 
26  پرسش‌های تشریحی	
26  پرسش‌های چندگزینه‌ای	
26  پروژهٔ عملی	

27 فصل 3: انواع مدل‌سازی	
	29 	Parametric Primitives مدل‌سازی با 
	31 	Subdivision surface گوشه‌ها و  
	32  مدل‌سازی به‌وسیلهٔ ابزارهای رسم چندضلعی و رسم نقاط	
	35 	Spline انواع مدل‌سازی با منحنی‌های 
	35 	NURBS انواع مدل‌سازی با ابزارهای مختلف 
43 	Text 3D انواع مدل‌سازی متون با 
45  پرسش‌های تشریحی	
45  پرسش‌های چندگزینه‌ای	
45  پروژهٔ عملی	

	47 فصل 4: سبک‌های مدل‌سازی	
	48  مدل‌سازی آرایه‌ای	
	49 	Symmetry مدل‌سازی 
49 	Boolean مفهوم بولی یا 
50  پرسش‌های تشریحی	
51  پرسش‌های چندگزینه‌ای	
51  پروژهٔ عملی	



53 فصل 5: آشنایی با Deformerها	
57  پرسش‌های تشریحی	
57  پرسش‌های چندگزینه‌ای	
58  پروژهٔ عملی	

59 فصل 6: متحرک‌سازی و کنترل انیمیشن	
60 	Keyframes شیوهٔ انیمیشن‌سازی با 
71  پرسش‌های تشریحی	
71  پرسش‌های چندگزینه‌ای	
72  پروژهٔ عملی	

73 	Expressions فصل 7: نحوۀ انیمیشن‌سازی با
80  پرسش‌های تشریحی	
80  پرسش‌های چندگزینه‌ای	
80  پروژهٔ عملی	

81 فصل 8: نورپردازی	
89  پرسش‌های تشریحی	
89  پرسش‌های چندگزینه‌ای	
89  پروژهٔ عملی	

91 فصل 9: جنسیت‌سازی	
92  مفهوم مَتریال‌ )بافت(	
97 	Bodypaint 3D آشنایی با مفهوم 
99  پرسش‌های تشریحی	
99  پرسش‌های چندگزینه‌ای	
99  پروژهٔ عملی	

101 فصل 10: ابزار Brush و ساخت مو	
111  پرسش‌های تشریحی	
111  پرسش‌های چندگزینه‌ای	
111  پروژهٔ عملی	

113 فصل 11: دوربین‌ها	
114  مقدمات کار با دوربین	



116   پرسش‌های تشریحی	

116   پرسش‌های چندگزینه‌ای	

116   پروژهٔ عملی	

117 فصل 12: متحرک‌سازی کاراکتر و ایجاد داینامیک	
118 	Character Mesh مفهوم ساخت  

128   پرسش‌های تشریحی	

129   پرسش‌های چندگزینه‌ای	

129   پروژهٔ عملی	

131 فصل 13: ساخت پوست و لباس برای کاراکتر	
132 	Claud Bonet نحوهٔ ایجاد پوست روی کاراکتر توسط  

150   پرسش‌های تشریحی	

150   پرسش‌های چندگزینه‌ای	

150   پروژهٔ عملی	

151 فصل 14: خروجی گرفتن )رندر(	
152   انواع رندر	

155   مفهوم رندر پیش‌نمایش انیمیشن	

159   پرسش‌های تشریحی	

159   پرسش‌های چندگزینه‌ای	

159   پروژهٔ عملی	

161 فصل 15: مفاهیم و تعاریف تدوین	
162   مفهوم تدوین در امر فیلم‌سازی	

164   مراحل تدوین فیلم	

168   مفهوم تداوم و زمان در تدوین	

168   ویژگی تدوین خطی، معایب تدوین خطی	

170   ویژگی تدوین غیرخطی، مزایای تدوین غیرخطی	

170   پرسش‌های تشریحی	

171   پرسش‌های چهار گزینه‌ای	

173 فصل 16: فرمت‌های تصویری	
174 	SECAM و PAL ،NTSC انواع استانداردهای تصویری  

176 استانداردهای جدید جهانی	  



177 تعریف رزولوشن تصویر	  

177 مفهوم جنبه‌های مختلف نسبت ظاهری تصویر 16:9، 4:3 و مشابه آن	  

178 مفهوم کدک زمانی	  

180 مفهوم کدک‌ها	  

180 پرسش‌های تشریحی	  

181 پرسش‌های چهار گزینه‌ای	  

181 پروژه عملی	  

183 فصل Pemiere :17 و نحوه کار با آن	
185 	Premiere نحوه نصب نرم‌افزار  

185 	Premiere Pro فضای کار  

187 	Timeline مفهوم پنجره  

189 	Program و Source معرفی نمایشگرهای  

190 ساخت سکانس	  

196 معرفی منوی اصلی نرم‌افزار	  

197 مفهوم تغییر ظاهری محیط کار	  

202 پرسش‌های تشریحی	  

202 پرسش‌های چهار گزینه‌ای	  

205 فصل 18: انتقال و ذخیره ویدیوی دیجیتال	
207 	Adobe Bridge  

208 انتقال از کارت‌خوان	  

209 ویرایش مستقیم از طریق کارت	  

211 دانلود کردن کلیپ‌ها	  

211 وارد کردن رسانه	  

212 افزودن کلیپ‌های موسیقی و صدا	  

213 پرسش‌های تشریحی	  

213 پرسش‌های چندگزینه‌ای	  

215 فصل 19: مفاهیم جلوه و گذار و کاربردهای آنها	
219 تنظیم گذار‌های پیش‌فرض	  

219 اعمال گذار‌های پیش‌فرض	  

220 کنترل گذار‌ها	  

221 استفاده از دستگیره‌های کلیپ	  



222 تکنیک‌های پیشرفتهٔ گذار	  

222 برنامه‌ریزی برای استفاده از گذار‌ها	  

223 تغییر و حذف گذار‌ها	  

224 استفاده از پلاگین‌های گذار	  

224 	Effects تنظیم گذارها در پنل کنترل‌های  

224 پرسش‌های تشریحی	  

225 پرسش‌های چهار گزینه‌ای	  

227 فصل 20: فریم‌های کلیدی	
229 استفاده از فریم‌های کلیدی در عمل	  

231 پرسش‌های تشریحی	  

231 پرسش‌های چندگزینه‌ای	  

233 فصل 21: مفهوم عنوان و کاربردهای آن	
235 	Text استفاده از ابزار  

235 	Essential Graphics پیمایش پنل  

235   آشنایی با قالب‌ها	

236 	Text to Speech ویژگی  

238    متحرک سازی متن و قرار دادن آن روی مسیر دلخواه	

244   پرسش‌های تشریحی	

244 پرسش‌های چندگزینه‌ای	  

	245 فصل 22:‌ حرکت دادن یک کلیپ	
	246 استفاده از کلیدها	  

	247 نحوه پخش وارونه کلیپ‌ها	  

	247 کاربرد شیارهای صوتی و انواع آن	  

	253 	)Compositing Clips( نحوه ترکیب کردن کلیپ‌ها  

254 لایه‌بندی کلیپ‌ها	  

	255 تکنیک‌های ترکیب کردن و کاربرد آنها	  

	255 تنظیم ماتی برای نمایش محتوای زیرین	  

	256 	Blend و Opacity استفاده از وضعیت‌های  

	257 برقراری توازن صحیح بین کلیپ‌ها	  

	264 جلوهٔ Transform و لایه‌های تنظیم	  



	264 ادغام کلیپ‌ها در یک مجموعه	  

	265 آشنایی با کانال‌های آلفا	  

267 ایجاد ماسک در تصویر	  

267 پرسش‌های تشریحی	  

268 پرسش‌های چندگزینه‌ای	  

	269 فصل 23: گرفتن خروجی و انواع فرمت‌های خروجی	
	271 	Export آشنایی با پنل  

	273 آشنایی با تنظیمات پیش‌ساخته	  

	274 آشنایی با انشعاب‌های فایل‌های مرسوم ویدیویی	  

	275 نگاهی به بخش Summary بیندازید	  

	276 تنظیمات سرعت بیت	  

	276 تأیید کادرهای انتخاب مناسب	  

277 تفاوت بین ظرف فایل و برنامهٔ پخش فایل	  

278 تنظیم نام خروجی برای تحویل	  

279 پرسش‌های تشریحی	  

279 پرسش‌های چندگزینه‌ای	  



مقدمه

                                                    علمی که در کار جلوه کند بهترین نوع دانش است.
                                                                                                     حضرت علی )ع(

تولیدکننده چندرسانه ای سه بعدی در حوزۀ مشاغل فناوری اطلاعات است. از شایستگی های این شغل 
می توان طراحی و تولید انیمیشن ها و تصاویر و فضاهای سه بعدی، کار با جلوه های ویژه، رندرسازی و 
نورپردازی ویدیوهای چندرسانه ای، تولید خروجی از پروژه، تولید پروژه، راهبری و طرح کسب و کار 
سیستم های  تحلیلگر  مشاغل  کلیه  با  شغل  این  برد.  نام  را  سه بعدی  چندرسانه ای  تولیدکننده  برای 
چندرسانه ای و تولید محتوا، طراحان و تولیدکنندگان چندرسانه ای و تولید محتوا، طراحی و توسعه 

سیستم های تحت وب، آموزش و کسب و کار در ارتباط است. 
جلد دوم کتاب به آموزش دو نرم افزار Maxon Cinema 4D و Adobe Premiere Pro اختصاص 
توسط  که  است  سه بعدی  رندر  و  انیمیشن  مدل سازی،  حرفه ای  نرم افزار  یک   Cinema 4D دارد. 
بر جدول  ویدیو مبتنی  ویرایش  نرم افزار  Adobe Premiere Pro یک  است.  یافته  توسعه   Maxon

زمانی و غیرخطی )NLE( است که توسط شرکت Adobe توسعه یافته و به منزله بخشی از برنامه 
Adobe Creative Cloud منتشر شده است. Adobe Premiere Pro برای اولین بار در سال ٢٠٠٣ 

عرضه و جانشین Adobe Premiere شد. این برنامه برای ویرایش حرفه ای ویدیو طراحی شده است. 
مؤلف   



فصل 1
آشنایی با محیط کاربری



2

اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می‌رود:
  با محیط کاربری Cinema 4D آشنا باشد.

  بتواند نرم‌افزار Cinema 4D را نصب کند.

  بتواند از رابط کاربر استفاده کند.

  بتواند تنظیمات محیط کار را انجام دهد.

زمینۀ موشن  در  نرم‌افزاری حیرت‌انگیز  نامیده می‌شود،  نیز   C4D اختصار  به  Cinema 4D که  نرم‌افزار 
 MAXON گرافیک بوده و برنامۀ مدل‌سازی، انیمیشن‌سازی و پردازش سه‌بعدی است که توسط شرکت
ارائه شده است. این برنامه قابلیت ساخت مدل از صفر تا صد و قابلیت‌های Tracking را دارا بوده و در 
قبیل  از  برنامه‌های مدل‌سازی سه‌بعدی  رایج  ویژگی‌های  تمام  است.   After Effects با  کامل  هماهنگی 
نیز  برنامه  این  نورپردازی، متریال‌سازی و غیره را در  مدل‌سازی چندلایه‌ای و چندضلعی، متحرک‌سازی، 
خواهید یافت. این نرم‌افزار نه تنها برای افزودن جلوه‌های بصری به فیلم‌ها توصیه می‌شود، بلکه در معماری 
انیمیشن جان ببخشید.  یا  قالب عکس  به مفاهیم و تصورات ذهنی خود در  تا  به شما کمک می‌کند  نیز 
 Cinema 4D ،فرقی نمی‌کند که در زمینۀ چاپ، تبلیغات، طراحی، تصویرسازی یا فیلم فعالیت داشته باشید
هنگام  بپوشانید.  عمل  جامۀ  را  خود  ایده‌های  تا  می‌دهد  قرار  شما  اختیار  در  را  موردنیاز  ابزارهای  تمام 
انیمیشن‌سازی کاراکتر )ماژول MOCCA( و یا زمانی که می‌خواهید از ظاهری کارتونی برای رندر استفاده 
کنید )ماژول Sketch and Toon(، ساختار ماژولی Cinema 4D به کمک شما خواهد آمد. استفاده از 
این نرم‌افزار در بازی‌های رایانه ای نیز بسیار مرسوم است، زیرا دارای جعبه ابزار کاملی برای طراحی محیط 
و شخصیت‌ها، بافت‌های پر از جزئیات و تصاویر متحرک پیچیده است. ضمناً این نرم‌افزار نقشی‌ اساسی در 
تصویرسازی پزشکی داشته و انتخابی عالی برای تصویرسازی‌های فنی به شمار می‌آید. این برنامه به گونه‌ای 
طراحی شده که عملکرد آسان آن حتی برای افراد مبتدی نیز به‌سادگی قابل‌درک است. در یک کلام به 
کمک این برنامه می‌توانید به ایده‌های خود حیات ببخشید و از نتیجۀ کار با این برنامه حیرت‌زده خواهید 

شد. 



فصل اول: آشنایی با محیط کاربری

3

   Cinema 4D اصول نصب نرم‌افزار

برای نصب نرم‌افزار Cinema 4D کافی است به آدرس www.soft98.ir مراجعه کنید و با جست‌وجوی نام 
نرم‌افزار، مراحل نصب را طبق توضیحات داده شده، طی کنید.

Cinema 4D شکل 1ـ1ـ رابط کاربر

ــ پس از نصب برنامۀ Cinema 4D برای استفاده از آن می‌توانید به یکی از روش‌های زیر عمل کنید: 
ــ روی آیکن Cinema 4D روی دسک‌تاپ دابل کلیک کنید. 

ــ روی فایل صحنۀ Cinema 4D دابل کلیک کنید. 
ــ در منوی Start روی گزینۀ Cinema 4D کلیک کنید. 

ــ فایل c4D. را از Windows Explorer به آیکن برنامه بکشید. 
ــ برنامه را از طریق Command Prompt اجرا کنید. 

ــ Cinema 4D Lite را از طریق After Effects اجرا کنید. 
ــ به این ترتیب رابط کاربر پیش‌فرض برنامه به صورت شکل فوق نمایش داده می‌شود. 
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 نحوۀ استفاده از رابط کاربر   

زمانی که برای اولین بار Cinema 4D را باز می‌کنید، وارد رابط کاربر می‌شوید. همان‌طور که در شکل زیر 
مشاهده می‌شود، عناصر مختلف رابط کاربر شماره‌گذاری شده‌اند و در مورد آنها بیشتر شرح داده خواهد شد 

)شکل٢ـ١(. 

Cinema 4D شکل ٢ـ١ـ عناصر مختلف رابط کاربر

در جدول ١ـ١ به اختصار در مورد هر یک از عناصر رابط کاربر، شرح داده شده است.
 

Cinema 4D ١  ـ عناصر مختلف رابط کاربر    جدول ١

توضیحنامشماره
منویی حاوی فرمان‌ها و کارکردهای Cinema 4Dنوار منو1

2Standard در زیر نوار منو قرار گرفته و حاوی ابزارها، فرمان‌ها و کارکردهای مخصوص به خود است.پالت

3Tools این پالت حاوی فرمان‌ها و ابزارهایی است که بیشتر از همه مورد استفاده قرار می‌گیرند.پالت

4Command مجموعه‌ای از ابزارها و فرمان‌ها را در اختیار شما قرار می‌دهند.گروه‌های

با استفاده از این دکمه‌ها می‌توانید در صحنه پیمایش کنید.دکمه‌های پیمایش5

6Layout از گزینه‌های ارائه‌شده در این فهرست کشویی می‌توانید برای انتقال بین طرح‌بندی‌های فهرست کشویی
مختلف استفاده کنید.

7Object Manager.مدیریت تمام اشیای موجود در صحنه را برعهده دارد Manager این



فصل اول: آشنایی با محیط کاربری

5

8Attribute Manager.خصوصیات و تنظیمات مربوط به هریک از اشیای انتخاب‌شده را نمایش می‌دهد

9Coordinate Manager حاوی فیلدهایی است که با استفاده از آنها می‌توانید اشیای موجود در صحنه را به دقت
مدل‌سازی و ویرایش کنید.

10Material Manager.حاوی تمام متریال‌های قابل‌دسترس در صحنه است

11Animation این نوار ابزار حاوی کنترل‌هایی برای ضبط و پخش انیمیشن است.نوار ابزار

12Editor ها قابل‌دسترس بوده و از آن می‌توانید برای تنظیم وظایف منوی نمایViewport این منو در تمام
مختلف مربوط به Viewportها استفاده کنید. 

13View است.پنل Viewport این پنل متشکل از چهار

تنظیمات محیط کار  

پالت   ،Viewport پنجرۀ  عنوان،  نـوار  نظیر  مختلفی  مـؤلفـه‌هـای  از  متشکل   Cinema 4D کـاربر  رابط 
Commands، پالت Modes، منوی اصلی و غیره است. 

Viewport مهم‌ترین بخش نرم‌افزار، یعنی بخشی‌ از فضای کـار است که می‌توانید صحنۀ سه‌بعدی را در آن 
ایجاد کنید. 

با  ترتیب  به  و  بوده   Z و   Y  ،X محورهای  بیانگر  که  دارند  وجود  این چارچوب مشبک‌مانند، خطوطی  در 
رنگ‌های قرمز، سبز و آبی نمایش داده می‌شوند. 

رابط کاربر Cinema 4D تا حد زیادی قابل‌پیکربندی است. می‌توانید هر یک از بخش‌ها را جابه‌جا کرده و 
در جاهای دیگری مستقر کنید. زمانی که یکی از پنجره‌ها را جابه‌جا می‌کنید، اندازۀ سایر پنجره‌ها به‌طور 
خودکار تغییر می‌کند. حتی می‌توانید پنجره‌ها را به صورت برگه نمایش دهید تا فضای کمتری را اشغال کنند. 

Cinema 4D شکل ٣ـ١ـ فضای کار
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پرسش‌های تشریحی  

1 سه نوار منو در رابط کاربری Cinema 4D را نام ببرید.
2 نام سه محور در View port را نام ببرید.

3 چند فضای کاری در Cinema 4D وجود دارد؟ آنها را نام ببرید.
4 چهار مورد از کنترلرهای زیر مجموعۀ نوار Animation را نام ببرید و کاربرد دو مورد را ذکر کنید.

5 کاربرد Auto switch mode را توضیح دهید.

 پرسش‌های چندگزینه‌ای  

Viewport 1 پیش‌فرض در Cinema 4D کدام است؟ 
Perspective )د 	Back )ج 	Right )ب 	Top )الف

2 فایل‌های Cinema 4D با چه پسوندی ذخیره می‌شوند؟
Psd )د 	ai )ج 	.c4d  )ب 	prproj )الف

3 کدام یک از گزینه‌های زیر در پالت Tools وجود دارد؟
Workplane )د 	Edge )ج 	Model )ب 	Bend )الف

4 کدام یک جزو داده‌های نمایش داده شده در Structure manager نیست؟
      Polygons )د 	Weight vertices )ج 	Array )ب 	Points )الف

5 کلید‌های میانبر Scale ،Rotate و Move به ترتیب از چپ به راست کدام موارد هستند؟
R.E.T )د 	E,T,R )ج 	T,E,R )ب 	R,T,E )الف



فصل 2

 Viewport  انتخاب و حرکت اشیا در
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می‌رود:
  بتواند اشیا را در ‌Viewport انتخاب کند و حرکت دهد.

  نوار عنوان، منوها و پالت‌ها را بشناسد.

  انواع انتخاب در محیط Cinema 4D را بشناسد.

  مفهوم Object Axis را بشناسد.

  انواع فرمان Connect را بشناسد.

زمانی که Cinema 4D را باز می‌کنید، به صورت پیش‌فرض در نمای Perspective Viewport قرار دارید. 
در این نما، اشیا از دید دوربین نمایش داده می‌شوند. البته می‌توانید از Viewportهای دیگر موجود در فضای 
کار مانند Bottom ،Right ،Top و Front نیز استفاده کنید. برای انتقال به نمای چهاربخشی‌ Viewportها، 
باید مکان‌نمای ماوس را در Perspective Viewport قرار داده و سپس یک بار دکمۀ میانی ماوس را فشار 
دهید. هر کدام از نماها را که می‌خواهید بزرگ‌تر نمایش دهید، باید مکان ‌نمای ماوس را در آن نما قرار داده 

و سپس دکمۀ میانی ماوس را یک بار فشار دهید. 



 Viewport فصل دوم : انتخاب و حرکت اشیا در
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نوار عنوان   

نوار عنوان در بالای رابط کاربر قرار گرفته، نام و نگارش نرم‌افزار و نیز نام فایل بازشده را نشان می‌دهد. فایل 
Cinema 4D با پسوند نام فایل c4d. ذخیره می‌شود. 

منوی اصلی   

منوی اصلی درست در زیر نوار عنوان قرار گرفته و با کمک گزینه‌های ارائه‌شده در آن می‌توانید به ابزارها، 
کارکردها یا فرمان‌های Cinema 4D دسترسی یابید. این منو شامل ابزارهای مختلف، گزینه‌هایی برای تغییر 

Viewport، گزینه‌های مربوط به رندر و آیکن‌هایی برای ایجاد اشیا است. 

   Command پالت 

این پالت در زیر منوی اصلی قرار گرفته است. ابزارهایی را که بیشتر مورد استفاده قرار می‌گیرند، در این پالت 
می‌یابید. ابزارهای موجود در این پالت عبارت‌اند از: 

به صورت  استفاده کنید.  لغو آخرین عمل صورت‌گرفته در صحنه  برای  Undo می‌توانید  ابزار  از   :Undo    ـ
پیش‌فرض، کاربر می‌تواند تا حداکثر سی تغییر اخیر را لغو کند. 

ــ Redo: با استفاده از این ابزار می‌توانید آخرین عمل صورت‌گرفته توسط ابزار Undo را برگردانید. 
ــ  Live Selection: با استفاده از این ابزار می‌توانید اشیا و نیز اجزای سازنده اشیا )نقاط، لبه‌ها و چندضلعی‌ها( 

را انتخاب کنید. 
ــ Move: از این ابزار می‌توانید برای جابه‌جایی اشیا در Viewport استفاده کنید به شرطی که محورها قفل 

نباشند. 
ــ Scale: از این ابزار می‌توانید برای تغییر مقیاس شی‌ء در Viewport استفاده کنید. 

ــ Rotate: از این ابزار می‌توانید برای چرخش شی‌ء در Viewport استفاده کنید. 
ــ Active Tool: این ابزار، آیکن آخرین ابزار مورداستفاده را نمایش می‌دهد. 

 World و   Object بین سیستم‌های مختصات  ابزار می‌توانید  این  از  استفاده  با   :Coordinate System
جابه‌جا شده و از آنها برای حرکت دادن، تغییر مقیاس یا چرخش شی‌ء استفاده کنید. 

ــ Render View: از این ابزار برای رندر نمای فعال جاری استفاده می‌شود. 
ــ Cube: از این ابزار می‌توانید برای ترسیم مکعب در Viewport استفاده کنید. 

 ،BـSpline  ،Bezier ابزارهای  جایگزین  می‌شود  شناخته  نیز   Spline Pen نام  با  که  ابزار  این   :Pen     ـ
Linear و Akima Spline در نگارش‌های قبلی شده و مجهز به کارکردهای جدیدی است که به کمک آن 

می‌توانید منحنی‌های موج‌داری را در Viewport ترسیم کنید. 
ــ Array: از این ابزار می‌توانید برای ایجاد آرایه‌ای از اشیا به شکل فنری یا موج‌دار استفاده کنید. 

ــ Bend: با استفاده از این ابزار می‌توانید شی‌ء انتخاب‌شده را در جهت مشخصی خم کنید. 
ــ Camera: با استفاده از این ابزار می‌توانید شی‌ء دوربین را به صحنه اضافه کنید. 
ــ Light: با استفاده از این ابزار می‌توانید اشیای نورپردازی را به صحنه اضافه کنید. 
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  Tools پالت

پالت Tools در منتهی‌الیه سمت چپ رابط کاربر قرار گرفته و شامل ابزارهای مختلفی است که عبارت‌اند از: 
ــ Make Editable: از این ابزار می‌توانید برای تبدیل اشیای مقدماتی به اشیای چندضلعی استفاده کنید. 

ــ Model: از این ابزار می‌توانید برای فعال کردن وضعیت Model استفاده کنید. 
ــ Texture: با استفاده از این ابزار می‌توانید بافت فعال را ویرایش کنید. 

ابزارهای  از  استفاده  با  و  به صورت دستی  را  کار  می‌توانید سطح  ابزار  این  از  استفاده  با   :Workplane    ـ
Rotate ،Move و Scale اصلاح کنید. 

ــ Points: از این ابزار می‌توانید برای نمایش شی‌ء در وضعیت Points استفاده کنید. 
ــ Edges: از این ابزار برای نمایش شی‌ء در وضعیت Edge استفاده می‌شود. 

ــ Polygons: از این ابزار می‌توانید برای نمایش شی‌ء در وضعیت Polygon استفاده کنید. 

   Animation نوار ابزار

نوارابزار Animation در زیر بخش Viewport قرار گرفته است. این نوارابزار شامل تمام کنتر‌ل‌های مربوط 
به انیمیشن‌سازی است که می‌توانید برای کنترل انیمیشن در صحنه مورد استفاده قرار دهید. این کنترل‌ها 

عبارت‌اند از: 
ــ Timeline Ruler: خط‌کش Timeline در بالای نوار ابزار Animation قرار گرفته و با حرکت دادن 

لغزندۀ زمان می‌توانید فریم موردنظر خود را در Viewport مشاهده کنید. 
ــ Start frame: از این گزینه می‌توانید برای تنظیم اولین فریم انیمیشن که در خط‌کش Timeline نمایش 

داده می‌شود استفاده کنید. 
 Timeline انیمیشن که در خط‌کش  فریم  تنظیم آخرین  برای  این گزینه می‌توانید  از   :End Frame ــ 

نمایش داده می‌شود استفاده کنید. 
ــ Go to Start: با استفاده از این دکمه می‌توانید لغزندۀ زمان را جابه‌جا کرده به اولین فریم انیمیشن در 

خط‌کش Timeline منتقل شوید. 
ــ Go to Previous Key: با استفاده از این دکمه می‌توانید لغزندۀ زمان را جابه‌جا کرده هر بار یک فریم 

کلیدی از فریم کلیدی جاری در خط‌کش Timeline به عقب بروید. 
ــ Go to Previous Frame: با استفاده از این دکمه می‌توانید لغزندۀ زمان را عقب کشیده و یک فریم از 

فریم جاری در خط‌کش Timeline به عقب بروید. 
ــ Play Forwards: از این دکمه می‌توانید برای پخش انیمیشن رو به جلو استفاده کنید. 

ــ Go to Next Frame: از این دکمه می‌توانید برای جابه‌جا کردن لغزندۀ زمان به فریم بعدی در خط‌کش 
Timeline استفاده کنید. 

از این دکمه می‌توانید برای جابه‌جا کردن لغزندۀ زمان به فریم کلیدی بعدی در   :Go to Next Key ــ
خط‌کش Timeline استفاده کنید. 

ــ Go to End: با استفاده از این دکمه می‌توانید لغزندۀ زمان را به آخرین فریم انتقال دهید. 
ـ      Record Active Objects: از این دکمه برای ایجاد کلیدی برای شی‌ء انتخاب‌شده در فریم جاری انیمیشن 

استفاده می‌شود. 
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ــ Autokeying: از این دکمه می‌توانید برای تنظیم خودکار کلیدها در خط‌کش Timeline برای تغییرات 
اعمال‌شده در انیمیشن استفاده کنید. 

ــ  Keyframe Selection: با انتخاب این ابزار منویی کشویی نمایش داده می‌شود که با استفاده از ابزارهای 
ارائه‌شده در آن می‌توانید ضبط کلید را به شی‌ء خاصی محدود کنید. 

ــ Position: از این دکمه می‌توانید برای ضبط مکان شی‌ء در فریم جاری استفاده کنید. 
ــ Scale: از این دکمه می‌توانید برای ضبط مقیاس شی‌ء در فریم جاری استفاده کنید. 

ــ Rotation: از این دکمه می‌توانید برای ضبط چرخش شی‌ء در فریم جاری استفاده کنید. 
ــ Parameter: با استفاده از این دکمه می‌توانید مطمئن شوید فقط پارامترهای انتخابی در حین ضبط 

فریم‌های کلیدی اعمال خواهند شد. 

 Material Manager 

همان‌قدر که باید در مدل‌سازی تبحر داشته باشید، استفاده از مَتریال خوب نیز اهمیت دارد. با استفاده از 
Material Manager می‌توانید هر نوع مَتریالی را به دقت بازسازی کنید. Material Manager در گوشۀ 
سمت چپ پایینی رابط کاربر قرار گرفته است. با استفاده از این بخش می‌توانید مَتریال‌های موردنظر خود 
را ایجاد کرده و آنها را در اشیای صحنه اعمال کنید. نمونه تصاویر هر یک از مَتریال‌های ایجاد‌شده در این 
نمونه  می‌کنید،  انتخاب   Object Manager در  را  شیئی  که  هنگامی  می‌شوند.  داده  نمایش   Manager
تصاویر مَتریال‌های اعمال‌شده در آن شی‌ء در این‌جا متمایز می‌شوند. برای اعمال مَتریال در شی‌ء موردنظر 
خود باید نمونه تصویری آن مَتریال را از Material Manager کشیده و در شی‌ء )اشیای( موردنظر خود در 

Attribute Manager یا نمای Editor رها کنید )شکل ١ـ٢(. 

شکل 1ـ2ـ انواع متریال

   Object Manager      

بالایی  راست  در گوشۀ سمت   Object Manager
شامل  بخش  این  است.  گرفته  قرار  کاربر  رابط 
است.  صحنه  در  استفاده  مورد  اشیای  از  فهرستی 
نام  برای اشیا مشخص کرده،  را  می‌توانید تگ‌هایی 
آنها را تغییر داده، سلسله ‌مراتب و قابلیت مشاهدۀ 
آنها را تنظیم کرده و با استفاده از برگه‌های موجود 
به لایه‌های مختلف اشیا دسترسی یابید )شکل ٢ـ٢(.

Object Manager شکل 2ـ2ـ
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 Attribute Manager   

انتخاب‌شده در صحنه را نمایش می‌دهد. ضمناً می‌توانید  ابزار یا شی‌ء  Attribute Manager خصوصیات 
برای  را  انیمیشن  کلیدهای  می‌توانید  به‌علاوه،  کنید.  ویرایش  این‌جا  در  را  متریال‌ها  و  اشیا  خصوصیات 
خصوصیاتی که در کنار نام آنها دایره‌ای نمایش داده شده است تنظیم کنید. به صورت پیش‌فرض، تنظیمات 
شی‌ء انتخاب‌شده در این‌جا نمایش داده می‌شود. اگر غالب اوقات از اشیای خاصی استفاده می‌کنید، می‌توانید 
یک کپی از Attribute Manager تهیه کرده و آن را به همان شی‌ء قفل کنید )شکل ٣ـ٢(. برای ایجاد کپی 
جدید، روی آیکن + در گوشۀ سمت راست بالایی نوار عنوان کلیک کنید. برای قفل کردن Manager، روی 

آیکن قفل در نوار عنوان آن کلیک کنید. 

Attribute Manager شکل 3ـ2ـ

ضمناً در سمت چپ Attribute Manager، پالت Coordinate Manager قرار گرفته است که با استفاده 
از آن می‌توانید اشیا را به صورت عددی ویرایش کنید. در این‌جا فیلدهایی برای ویرایش مقادیر مربوط به 
مکان، مقیاس و میزان چرخش ارائه می‌شوند. می‌توانید از آن به‌عنوان مرجع هنگام تغییر مقیاس اشیا در 
نمای Editor نیز کمک بگیرید. مقادیر نمایش داده شده مربوط به همان ابزاری هستند که در حال حاضر 
فعال است. برای مثال اگر از ابزار Move استفاده می‌کنید، مقادیر مربوط به مکان، اندازه و چرخش عنصر 

انتخاب‌شده را در این فیلدها خواهید دید. 

 Layer Manager 

هنگام کار با صحنه‌های پیچیده‌تر، می‌توانید از Layer Manager برای مدیریت اشیا در لایه‌ها استفاده کنید. 
برای باز کردن این پنجره، باید برگۀ Layers را از Attribute Manager انتخاب کنید. به این ترتیب تمام 
لایه‌های ایجادشده نمایش داده خواهد شد. می‌توانید برای هر یک از لایه‌ها از رنگی سفارشی‌ استفاده کنید 

که در این صورت در Object Manager نیز از همان رنگ استفاده خواهد شد. 
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 Content Browser 

تصاویر،  است که می‌توانید صحنه‌ها،  و جایی  بوده   Cinema 4D از  کلیدی  Content Browser بخشی‌ 
داخل   Content Browser دهید.  قرار  استفاده  مورد  و  یافته  را  آماده  پیش‌ساختۀ  تنظیمات  و  متریال‌ها 
Object Manager در رابط کاربر Cinema 4D ادغام شده و از طریق آن قابل‌دسترس است )شکل ٤ـ٢(.

Content Browser شکل 4ـ2ـ

  )Tweak پیش‌فرض، خودکار و( Modes کار با منوی

در منوی Modeling Modes در Cinema 4D سه گزینه وجود دارد که بیشتر مورد استفاده قرار می‌گیرند: 
ــ Default Mode: یکی از وضعیت‌های مدل‌سازی است که از همان نگارش‌های اولیۀ برنامه مورد استفاده 
قرار می‌گرفته است. در این وضعیت، می‌توانید عناصر اشیا )مانند نقاط، لبه‌ها یا چندضلعی‌ها بسته به این که 

چه ابزاری انتخاب شده باشد( یا خود اشیا را انتخاب کنید. 
ــ Auto Switch Mode: این وضعیت برای استفاده از ابزار Live Selection طراحی شده است. اشاره‌گر 
ماوس را روی عناصر انتخاب‌شدۀ اشیا )مانند نقاط، لبه‌ها یا چندضلعی‌ها( حرکت دهید. زمانی که اشاره‌گر 

ماوس را روی عنصری حرکت می‌دهید، آن عنصر به رنگ زرد متمایز می‌شود. 

Extrude و Move شکل 5ـ2ـ استفاده از ابزارهای

که  این  به  بسته  و  خودکار  به‌طور  می‌کنید،  کلیک  که  زمانی 
عنصری که به رنگ زرد متمایز شده است نقطه، لبه یا چندضلعی 
است، به همان وضعیت مربوطه منتقل می‌شود. اگر می‌خواهید 
عناصر دیگری را نیز انتخاب کنید، دکمه‌های ماوس را همچنان 

نگه دارید. 
این  از  پیداست،  نامش  از  که  همان‌طور   :Tweak Mode   ـ
وضعیت می‌توانید برای اصلاح سریع مدل‌های چندضلعی استفاده 
 Extrude و Move کنید. از این وضعیت می‌توانید با ابزارهای

استفاده کنید. 
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 Tweak برای استفاده از وضعیت       
 .Bevel یا Extrude ،Move پشتیبانی کند، مانند ابزار Tweak 1  ابزاری را انتخاب کنید که از وضعیت

2  اشاره‌گر ماوس را روی عناصر شیء انتخاب‌شده )نقاط، لبه‌ها یا چندضلعی‌ها( حرکت دهید. زمانی که 
اشاره‌گر روی یکی از عناصر قرار می‌گیرد، آن عنصر به رنگ زرد متمایز می‌شود. 

3  اشاره‌گر ماوس را روی عنصری قرار دهید که می‌خواهید مورد اصلاح قرار دهید. زمانی که آن عنصر به 
رنگ زرد متمایز شد، ماوس را بکشید تا ابزار مربوطه روی عنصر عمل کند. 

می‌توانید هر یک از انواع عناصر شیء )نقطه، لبه یا چندضلعی( را مورد اصلاح قرار دهید و فرقی نمی‌کند در 
کدام وضعیت باشید. نیازی به مشخص کردن کادر انتخاب نیست، بنابراین از وضعیت Tweak می‌توانید برای 
اصلاح هریک از عناصر به صورت مجزا استفاده کنید. اما توجه داشته باشید برخی از ابزارهای مدل‌سازی در 

وضعیت Tweak کار نمی‌کنند. 

   Structure کار با منوی

در  می‌گیرد.  قرار  استفاده  مورد  داده  محاسبۀ  برای  که  است  نوعی صفحه‌گسترده   Structure Manager
تبدیل  فرایند  باشند. طی  قابل‌ویرایش  داده می‌شود که  نمایش  اشیای چندضلعی  به  مربوط  دادۀ  آن فقط 
شی‌ء ساده به شی‌ء چندضلعی، داده‌های مربوط به نقاط، چندضلعی‌ها و مختصات آنها به صورت ردیف‌ها 
 Object به همراه Structure Manager .نمایش داده می‌شوند Structure Manager و ستون‌هایی در

Manager و Content Browser در رابط کاربر Cinema 4D ادغام شده‌ است. 

Structure Manager شکل 6ـ2ـ
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داده‌های نمایش داده‌شده در Structure Manager به این شرح هستند: 
 Points  ــ

Polygons  ــ
 UVW Coordinates  ــ

 Bezier Spline Tangents  ــ
 Weight Vertices  ــ

 Normal Vector Coordinates  ــ

ایجاد و مرتب‌سازی فرمان‌ها  

اگر می‌خواهید سرعت کار خود را در برنامه افزایش دهید، بهتر است از کلیدهای میانبر صفحه‌کلید مربوط به 
هر یک از ابزارها استفاده کنید. در این بخش قصد داریم شما را با کلیدهای میانبر صفحه‌کلید آشنا کنیم که 

باعث صرفه‌جویی در زمان انجام کار می‌شوند. 

Cinema 4D کلیدهای میانبر مورد استفاده در

کلید میانبرابزار

UndoCtrl + Z

RedoCtrl + Y

MoveE

ScaleT

RotateR

X-Axis/HeadingX

Y-Axis/PitchY

Z-Axis/BankZ

Coordinate SystemW

Render ViewCtrl + R

Render to Picture ViewerShift + R

Edit Render SettingsCtrl + B

Make EditableC

Undo ViewCtrl + Shift + Z

Redo ViewCtrl + Shift + Y
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   Cinema 4D  انواع انتخاب در محیط

)نقاط،  آنها/مؤلفه‌ها  زیرمجموعه‌های  یا  اشیا  بتوانید  باید  برنامه‌های کاربردی سه‌بعدی،  برای مدل‌سازی در 
لبه‌ها و چندضلعی‌ها( را انتخاب کنید. Cinema 4D ابزارها و فرمان‌های متعددی برای انتخاب ارائه می‌دهد. 

در ادامه به بررسی این ابزارها و فرمان‌ها می‌پردازیم که از طریق منوی Select قابل‌دسترس هستند. 
نوع  می‌دهند  اجازه  شما  به   Selection Filter زیرمنوی  در  موجود  گزینه‌های   :Selection Filter ــ 
اشیایی را انتخاب کنید که می‌خواهید در Viewport قابل‌انتخاب باشند. به صورت پیش‌فرض، تمام اشیا در 
Viewport قابل‌انتخاب هستند. این گزینه‌ها در مورد صحنه‌هایی مفید واقع می‌شوند که از عناصر زیادی در 
آنها استفاده شده است. برای مثال اگر روی نورپردازی صحنه‌ای کار می‌کنید، می‌توانید کاری کنید که فقط 

نور قابل‌انتخاب باشد و سایر عناصر را غیرفعال کنید. 
برای این منظور باید ابتدا گزینۀ Selection Filter > None را از منوی Select انتخاب کرده و سپس گزینۀ 

Selection Filter > Light را از منوی Select انتخاب کنید. 
 Loop عناصری هستند که به صورت حلقه به هم متصل هستند. ابزار Loop منظور از :Loop Selection  ــ

Selection به شما اجازه می‌دهد تا این عناصر را به سرعت انتخاب کنید. 

Loop Selection شکل 7ـ2ـ استفاده از ابزار

ــ Ring Selection: کارکرد این ابزار بسیار شبیه به ابزار Loop Selection است. البته این ابزار می‌تواند 
عناصر را در محدودۀ وسیع‌تری انتخاب کند. 

ــ Outline Selection: در وضعیت Polygons، این ابزار می‌تواند لبه‌هایی را انتخاب کند که محدودۀ دور 
انتخاب خطوط دور لبه‌ها، اشاره‌گر ماوس را روی چندضلعی حرکت  چندضلعی را مشخص می‌کنند. برای 
دهید. زمانی که رنگ خطوط دور لبه‌ها تغییر کرد، روی لبه‌ها کلیک کنید تا انتخاب شوند. به این ترتیب 
وضعیت Edges نیز فعال می‌شود. این ابزار در وضعیت Edges نیز کار می‌کند و می‌توانید سایر قسمت‌های 

چندضلعی را نیز انتخاب کنید. 

Edges شکل 8ـ2ـ فعال کردن وضعیت
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می‌توانید   Edges وضعیت  در   :Fill Selection ــ 
با استفاده از این ابزار از محدودۀ انتخاب لبۀ موجود 
برای  کنید.  انتخاب  را  چندضلعی  انتخاب  محدودۀ 
استفاده  انتخاب  در محدودۀ  زمینه  رنگ  از  که  این 
لبه  انتخاب  محدودۀ  روی  را  ماوس  اشاره‌گر  کنید، 
کرد،  تغییر  چندضلعی  رنگ  که  زمانی  دهید.  قرار 
کلیک کنید تا انتخاب شود. به این ترتیب وضعیت 

Polygons نیز فعال می‌شود. 

ــ Path Selection: این ابزار به شما اجازه می‌دهد 
از  و  تعاملی  صورت  به  را  چندضلعی  نقاط  یا  لبه‌ها 
طریق رنگ‌آمیزی روی لبه‌ها یا نقاط انتخاب کنید. 
یا   Edges وضعیت  در  می‌توانید  فقط  ابزار  این  از 
خود  موردنظر  عناصر  روی  کنید.  استفاده   Points
مشخص  انتخاب  محدودۀ  تا  بکشید  و  کرده  کلیک 

شود. 

یا  لبه‌ها  نقاط،  تمام  فرمان  این   :Select All     ـ
انتخاب  را  جاری  انتخاب‌شدۀ  شی‌ء  چندضلعی‌های 

می‌کند. 
یا  لبه‌ها  نقاط،  تمام  فرمان  این   :Deselect All ــ 
از حالت  انتخاب‌شدۀ جاری را  چندضلعی‌های شی‌ء 

انتخاب خارج می‌کند. 
معکوس  برای  می‌توانید  فرمان  این  از   :Invert ــ 

کردن محدودۀ انتخاب جاری استفاده کنید. 
فرمان  این  از  استفاده  با   :Select Connected ــ 
می‌توانید تمام نقاط، لبه‌ها یا چندضلعی‌های متصل 

به عنصر انتخاب‌شده را انتخاب کنید. 

Polygons شکل 9ـ2ـ فعال کردن وضعیت

شکل 10ـ2ـ مشخص کردن محدوده انتخاب

شکل 11ـ2ـ انتخاب عناصر لبه
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ــ Grow Selection: با استفاده از این فرمان می‌توانید به محدودۀ انتخاب‌شدۀ قبلی اضافه کنید. 

ــ Shrink Selection: با استفاده از این فرمان می‌توانید بخشی‌ از محدودۀ انتخاب‌شدۀ قبلی را لغو کنید. 

Grow Selection شکل 12ـ2ـ استفاده از فرمان

Shrink Selection شکل 13ـ2ـ استفاده از ابزار

ــ  Hide Selected: عناصر انتخاب‌شدۀ جاری را پنهان می‌کند. 
ــ  Hide Unselected: تمام عناصر انتخاب‌نشده را پنهان می‌کند. 

ــ  Unhide All: تمام عناصر پنهان را مجدداً قابل‌مشاهده می‌سازد. 
ــ Invert Visibility: به کمک این فرمان می‌توانید تمام عناصر پنهان را قابل‌مشاهده و تمام عناصر قابل‌مشاهده 

را پنهان کنید.

   Object Axis مفهوم

ابزار Object Axis می‌توانید برای تنظیم نقاط برای حرکت یا چرخش در Inverse Kinematics یا  از 
استفاده   Lathe NURBS ایجاد شیء  یا   Duplicate عملکرد  از  استفاده  با  ایجاد شده  اشیای  تراز  برای 
کنید. این ابزار به شما امکان می‌دهد تا محورهای شیء انتخاب‌شده را اصلاح کنید بدون این که بر نقاط یا 
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چندضلعی‌های آن شیء تأثیری بگذارید. دلایل استفاده از این ابزار ممکن است یکی از این موارد باشد: 
ــ کمک به پیمایش ساده‌تر شیء انتخاب شده )دوربین حول مبدأ سیستم مختصات شیء انتخاب شده حرکت 

می‌کند(.
ــ  تعریف نقطۀ مرکزی چرخش برای شیء IK )اشیای IK حول مبدأ سیستم مختصات آنها می‌چرخند(.

ــ  تعریف نقطۀ مرکزی برای تهیه تصویر آینه‌ای شیء )فرمان Mirror تصویر آینه‌ای نقاط را بر اساس مکان 
مبدأ سیستم مختصات شیء ایجاد کند(.

مکان جاری محورهای شیء انتخاب‌شده در Coordinate Manager نمایش داده می‌شود که در آن می‌توانید 
تمام مقادیر را به صورت جداگانه تغییر دهید. زمانی که محورهای مختصات شیئی دارای سلسله‌مراتب را 
چرخانده یا حرکت می‌دهید، تمام محورهای اشیای فرزند نیز تغییر می‌کنند. اگر این اشیای فرزند حاوی 
فریم انیمیشن باشند، خطا در انیمیشن رخ می‌دهد، زیرا محورهای سیستم والد نیز تغییر خواهد کرد. به 
همین دلیل است که قبل از ایجاد انیمیشن، مهم است ابتدا محورها را تعریف کرده باشید. البته تغییر مقیاس 
محورهای شیء کمی متفاوت است. اینجا فقط محورها نیستند که تغییر اندازه می‌دهند، بلکه اندازۀ نقاط 
تغییر مقیاس است.  انیمیشن  ایجاد  برای  تنها روش  این  تغییر می‌کند.  نیز  انتخاب شده  بافت‌های شیء  و 

و  نقاط  فقط  مدل،  مقیاس  تغییر  در  در عوض، 
بافت‌ها تغییر می‌کنند و در اندازۀ محورها تغییری 

ایجاد نمی‌شود. 
برای درک بهتر مطلب بهتر است کار را با ایجاد 
مکعب  سیزده  کنید.  شروع   Primitive اشیای 
)فرمان  اصلی  منوی  از  استفاده  با  را  کره  یک  و 
 Objects > Primitive > Cube > Sphere
 Add Cube Object یا آیکن  انتخاب کنید(  را 
ایجاد کنید. ممکن است فکر کنید با پروژۀ عظیمی 
سروکار دارید، اما این طور نیست. با مرتب کردن 
ایجاد  را  کوچکی  شکل  است  قرار  مکعب‌ها  این 
کنیم. با ایجاد مکعب‌ها با چیدمانی شبیه به این 

در Object Manager روبه‌رو خواهید شد. 

Object Manager شکل 14ـ2ـ چیدمان مکعب در
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منحصربه‌فردی  نام  از  کار،  شدن  ساده‌تر  برای 
)روی  کنید  استفاده  مکعب‌ها  از  یک  هر  برای 
نام شی‌ء مربوطه در Object Manager دابل 
نام  و  شود  باز  داده  درج  فیلد  تا  کنید  کلیک 
این  از  می‌توانید  کنید(.  وارد  را  خود  موردنظر 

نام‌ها استفاده کنید )شکل١٥ـ٢(. 

مشاهده   Editor پنجرۀ  در  که  همان‌طور 
است.  قابل‌مشاهده  مکعب  یک  فقط  می‌شود، 
و  است  یکی  مکعب‌ها  تمام  مختصات  چون 
هم‌اندازه هستند و کره هم در وسط قرار گرفته 
است. البته که می‌خواهیم این وضعیت را تغییر 
دهیم، اما اول بهتر است کمی با پیمایش پنجرۀ 
راست  سمت  گوشۀ  به  شویم.  آشنا   Editor
نماد  چهار  کنید.  نگاه   Editor پنجرۀ  بالایی 
کوچک در این‌جا مشاهده می‌شود که به کمک 
این پنجره  آنها می‌توانید زاویۀ دید خود را در 

تغییر دهید. 

شکل 15ـ2ـ نام‌گذاری مکعب‌ها

شکل 16ـ2ـ چهار نماد کوچک در گوشه سمت راست 
Editor بالای پنجره

امکان  شما  به  است  دوسر  فلش  شکل  به  که  دوم  نماد  کنید.  جابه‌جا  را  نما  می‌توانید  اول  نماد  کمک  به 
می‌دهد نما را بزرگ‌نمایی یا کوچک‌نمایی کنید. سومین نماد که دو فلش منحنی و نقطه‌ای در وسط دارد 
به شما امکان می‌دهد صحنه را بچرخانید. با انتخاب نماد مستطیل شکل در سمت راست می‌توانید به نمای 
چهاربخشی‌ رفته و زاویۀ دید بهتری از صحنه داشته باشید. هر یک از این نماهای چهاربخشی‌ دارای نماد 
مستطیل شکل مربوط به خود هستند که با کلیک روی آنها می‌توانید فقط همان نما را مورد استفاده قرار 



 Viewport فصل دوم : انتخاب و حرکت اشیا در

21

دهید. کمی بزرگ‌نمایی کرده و گزینۀ Head را در Object Manager انتخاب کنید. به این ترتیب محور 
سبز رنگ مکعب نمایش داده می‌شود. 

شکل 17ـ2ـ محور سبز رنگ مکعب

با کلیک روی هر یک از فلش‌های محور می‌توانید آن را در جهت مربوط به خود بکشید. برخلاف زمانی 
که روی خود شی‌ء کلیک کرده و آن را می‌کشید، این‌جا دیگر نمی‌توانید شی‌ء را در هر جهتی بکشید. در 
نمای سه‌بعدی معمولاً نمی‌توانید ببینید شی‌ء در کدام جهت کشیده می‌شود. برای این که مطمئن شوید 
شی‌ء فقط در یک جهت کشیده می‌شود، می‌توانید محور موردنظر خود را از طریق پالت Command قفل 
کنید. به این ترتیب شی‌ء دیگر در راستای آن محور قفل‌شده حرکت نخواهد کرد. البته در این‌جا اشیا قفل 
نشده‌اند. شی‌ء Body را انتخاب کرده و روی گزینه Scale در بالا کلیک کنید. فلش‌های انتهای محورها 
تبدیل به مکعب‌های کوچکی می‌شوند که با کشیدن آنها می‌توانید مقیاس شی‌ء را در راستای همان محور 
رنگ  نارنجی  دستگیره‌های  نشده‌اند(  تبدیل  چندضلعی  به  که  )اشیایی  ابتدایی  اشیای  در  دهید.  تغییر 

کوچکی نمایش داده می‌شوند. 

شکل 18ـ2ـ دستگیره‌های نارنجی



22

به کمک این دستگیره‌ها می‌توانید شی‌ء پارامتری را در امتداد محور خاصی بیرون کشیده یا به داخل هل 
دهید. حالا اطلاعات موردنیاز برای مرتب کردن اشیا را به صورت شکل 19ـ2 در اختیار دارید. 

شکل 19ـ2ـ مرتب‌سازی اشیا

شکل 20ـ2ـ نمای روبه‌رو

نماهای  به وضعیت  تمایل می‌توانید  در صورت 
چهاربخشی‌ بروید )روی نماد مستطیل در سمت 
تا  کنید(.  کلیک   Editor پنجرۀ  بالایی  راست 
این‌ مرحله از کار، در نمای روبه‌رو شکلی شبیه 

شکل ٢٠ـ٢ خواهید داشت. 

درست است که مکعب‌ها را مرتب کرده‌اید، اما 
هنوز هیچ شباهتی به کاراکتر انسانی ندارد. روی 
Object Manager کلیک کرده و  Body در 
 Y دستگیرۀ نارنجی رنگ را در محور سبز رنگ
انتخاب کنید. این دستگیره را بکشید تا با لبۀ 

مکعب‌های بازو تراز شود. 

شکل 21ـ2ـ شبیه‌تر کردن مکعب‌ها به کاراکتر انسان
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رنگ،  نـارنجـی  دستگیره‌هـای  از  استفاده  بـا 
مکعب‌های تشکیل‌دهندۀ بازو را انتخاب کرده و 
اندازه و مکان آنها را بر اساس شکل 22ـ2 تنظیم 

کنید. 

شکل 22ـ2ـ تنظیم اندازه و مکان مکعب‌ها

اگر می‌خواهید تمام مکعب‌های مربوط به بازو را یک‌باره تغییر مقیاس دهید به این روش عمل کنید: در حالی 
که کلید Shift را نگه داشته‌اید، اشیای موردنظر خود را انتخاب کرده و کلید C را در صفحه‌کلید فشار دهید 
تا اشیا به چندضلعی تبدیل شوند. حالا می‌توانید با استفاده از عمل Scale اندازۀ آنها را در محورهای X و 
Y تغییر دهید. همان‌طور که مشاهده می‌کنید از دستگیره‌های نارنجی دیگر خبری نیست. دست‌ها و پاها را 

به صورت شکل 23ـ2 تغییر دهید. 

شکل 23ـ2ـ تغییر دادن دست‌ها و پاها

حالا اشیای مربوط به پای سمت راست را انتخاب کنید. زمانی که در Object Manager با رنگ سفید متمایز 
 Null را در صفحه‌کلید فشار دهید تا با هم گروه‌بندی شده و همگی فرزند شی‌ء Alt + G شدند، کلیدهای
شوند. اگر به Object Manager نگاه کنید، شی‌ء Null را مشاهده می‌کنید که به تازگی ایجاد شده‌ است. 
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با کلیک روی آیکن + سلسله‌مراتب و اشیای انتخابی را مشاهده می‌کنید. زمانی که شی‌ء Null را انتخاب 
می‌کنید، محور شی‌ء Null به‌عنوان محور هر سه شی‌ء پا عمل می‌کند. اگر این محور را بچرخانید، تمام 
فرزندان شی‌ء Null خواهند چرخید. شی‌ء Null را جابه‌جا کرده و بچرخانید تا به صورت شکل 24ـ2 درآید. 

Null شکل 24ـ2ـ جابه‌جا کردن و چرخاندن شیء

پس از انتخاب عمل Rotate می‌توانید حلقه‌های چرخش محور کره را انتخاب کرده و شی‌ء را بچرخانید. 
سعی کنید با استفاده از اعمال مختلف مکان شی‌ء را به دلخواه تغییر دهید. در صورت لزوم می‌توانید اشیا را 

به صورت شی‌ء Null گروه‌بندی کرده و آنها را به صورت هم‌زمان مورد ویرایش قرار دهید. 

  Connect انواع فرمان

از طریق فرمان‌های مختلفی می‌توانید اشیا را به هم متصل کنید. 

 Connect Objects فرمان 
با استفاده از این فرمان می‌توانید از چندین شی‌ء یک شی‌ء واحد را ایجاد کنید. زمانی که اشیای چندضلعی 
را به هم متصل می‌کنید که مَتریال‌ها و تگ‌های انتخاب را در آنها اعمال کرده‌اید، Cinema 4D اطمینان 
بافت‌های متصل‌شده نیز به صورت  می‌یابد که تگ‌های انتخاب به صورت صحیح متصل شده باشند. ضمناً 
دقیق بازیابی می‌شوند. اشیای اولیه به همان شکل دست‌نخورده باقی می‌مانند و اگر در صحنه دیگر به آنها 

نیاز ندارید می‌توانید آنها را حذف کنید. 
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زمانی که از این فرمان استفاده می‌کنید، دادۀ انیمیشن در شی‌ء جدید کپی نمی‌شود. اشیای اولیه و دادۀ 
انیمیشن به صورت دست‌نخورده باقی می‌مانند. 

هشدار

  Connect Objects + Delete فرمان 

روش کار این فرمان شبیه به فرمان Connect Objects است، اما اشیای اولیه را نیز حذف می‌کند. 

                Bake as Alembic فرمان 

این فرمان اشیای Alembic را از اشیای انتخاب‌شدۀ جاری )بدون در نظر گرفتن شی‌ء فرزند( ایجاد می‌کند. 
 Alembic این فرمان برای سرعت بخشیدن به انیمیشن‌های پیچیده بسیار مفید واقع می‌شود. انیمیشن‌های
را در   Alembic فایل‌های   Cinema 4D فرمان،  این  اجرای  با  زیادی پخش کنید.  با سرعت  را می‌توانید 
پوشه‌ای با نام alembic قرار می‌دهد. اگر صحنه را هنوز ذخیره نکرده‌اید، می‌توانید این پوشه را شخصاً ایجاد 

کنید. 

 Bake as Alembic + Delete فرمان 

روش کار این فرمان شبیه به فرمان Bake as Alembic است، اما اشیای انتخاب‌شده را نیز حذف می‌کند. 
توجه داشته باشید که انیمیشن اولیه نیز حذف خواهد شد. 

 Polygon Groups to Objects فرمان   

متصل  به هم  که  کنید  ایجاد  از سطوحی  را  مجزایی  اشیای چندضلعی  می‌توانید  فرمان  این  از  استفاده  با 
نشده‌اند. 

اگر انواع مختلفی از Splineها را به هم متصل کنید، نتیجۀ نهایی یک Bezier Spline خواهد بود. هنگام 
استفاده از این فرمان، نه تنها شی‌ء متصل‌شده فضای کمتری را در Object Manager اشغال می‌کند، بلکه 

با وجود این که همان تعداد چندضعلی را دارد اما سریع‌تر رندر می‌شود. 
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پرسش‌های تشریحی  

1  سه مورد از ابزارها و روش‌های انتخاب را نام ببرید.
٢  کاربرد ابزار Object Axis چیست؟

٣  دلایل استفاده از Object Axis را نام ببرید.
٤  چگونه می‌توان یک شیء را تنها در یک جهت حرکت داد؟
٥  یکی از فرمان‌های Connect  را نام ببرید و توضیح دهید.

پرسش‌های چندگزینه‌ای   

1 کدام دستور برای خارج شدن از حالت انتخاب نقاط، لبه‌ها یا اضلاع است؟
undo )د 	redo )ج 	deselect all )ب 	invert )الف

٢ کدام میانبر برای ایجاد گروه یا Null object است؟
Alt+G )د 	Shift+G )ج 	Alt+J )ب 	Shift+T )الف

٣ چگونه یک دسته شیء را به چندضلعی‌های قابل‌ویرایش تبدیل کنیم؟        
الف( آنها را در یک null object  قرار دهیم.
ب( آنها را انتخاب کرده و دکمۀ C را بزنیم.

ج( آنها را زیرمجموعۀ یک شیء دیگر قرار دهیم. 
د( آنها را انتخاب و دکمۀ L را بزنیم.

٤ دوربین حول چه چیزی در سیستم می‌چرخد؟
ب( حول اضلاع انتخاب‌شده در شیء 		 Null object   الف( حول

 Axisد( حول شیء انتخاب‌شده ج( حول نقاط انتخاب‌شده در شیء	

٥ در کدام پنجره ابزارهای بزرگ‌نمایی یا کوچک‌نمایی قرار دارد؟
	Tools )ب 		 Editor )الف

Attribute Manager )د 		 Object Manager )ج

پروژۀ عملی    

قرار دهید  بلند  به دور یک ساختمان  را  آنها  از  زیادی  تعداد  و  بسازید  آدم  از مکعب‌ها یک  استفاده  با 
به‌طوری که با هم برخورد نکنند و در فواصل و اندازه‌های مختلفی باشند.



فصل 3

انواع مدل سازی 
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می‌رود:
  با انواع مدل‌سازی آشنا باشد.

  بتواند با Parametric Primitives مدل‌سازی کند.

  گوشه‌ها و subdivision surface را بشناسد.

  بتواند به‌وسیلۀ ابزارهای رسم چندضلعی و رسم نقاط مدل‌سازی کند.

  انواع مدل‌سازی با منحنی‌های Spline را بشناسد.

  با ابزارهای مختلف NURBS انواع مدل‌سازی را انجام دهد.

  انواع مدل‌سازی متون را با Text 3D انجام دهد.

Cinema 4D ابزارهای متعددی ارائه می‌دهد که به کمک آنها می‌توانید مدل‌سازی را ساده‌تر انجام داده و 
گردش کار را بهبود ببخشید. 

یکی از کارکردهای مفید برای پیمایش سریع »General Popup« نام دارد که برای فعال کردن آن می‌توانید 
کلید V را در صفحه‌کلید فشار دهید. 

به این ترتیب منوهایی نمایش داده می‌شوند که با قرار دادن مکان‌نمای ماوس روی هر کدام، زیرمنوهای 
درمی‌آیند.  نمایش  به  مربوطه 

General Popup شکل 1ـ3ـ فعال کردن
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   Spline و اشیای Primitive اشیای

اشیای Primitive و اشیای Spline در Cinema 4D هر دو پارامتری هستند، یعنی از نقاط یا چندضلعی‌ها 
تشکیل نشده‌اند، بلکه با استفاده از پارامترها و فرمول‌های ریاضی ساخته شده‌اند. برای ویرایش این اشیا، ابتدا 
باید آنها را به نقطه یا چندضلعی تبدیل کنید. برای این منظور می‌توانید کلید C را در صفحه‌کلید فشار داده، 
روی آیکن Make Editable در پالت Tools کلیک کرده یا گزینۀ Conversion > Make Editable را 

از منوی Mesh انتخاب کنید. 

  Parametric Primitives مدل‌سازی با

Cinema 4D مجهز به مجموعه‌ای از اشکال سه‌بعدی است که می‌توانید از آنها به‌عنوان نقطۀ شروع مدل‌سازی 
سه‌بعدی استفاده کنید. این اشکال Primitives نام دارند و گاهی با نام اشیای Parametric نیز شناخته 
می‌شوند. یعنی اشکالی که در ساخت آنها از فرمول‌های ریاضی و مقادیر منحصربه‌فرد استفاده شده است. با 
ویرایش و ترکیب این اشکال می‌توانید مدل‌های ساده‌ای را بسازید. در این تمرین می‌خواهیم با ترکیب دو 

شکل Primitive یعنی مکعب و استوانه یک چهارپایه بسازیم. 
1  در پالت Command آیکنی مشاهده می‌شود که به شکل مکعبی آبی رنگ است. روی این آیکن کلیک 
کرده و نگه دارید تا منویی شامل اشکال Primitive نمایش داده شود. گزینه‌هایی که بیشتر از بقیه مورد 

استفاده قرار می‌گیرند Cylinder ،Cube و Sphere هستند. 

Cinema 4D شکل 2ـ3ـ اشکال پایه در

2 در منوی Primitives گزینۀ Cylinder را انتخاب کنید. این شی‌ء بلافاصله در صحنه ایجاد شده، به‌طور 
خودکار در Object Manager انتخاب شده و خصوصیات آن در Attribute Manager بارگذاری می‌شوند. 
پیش‌فرض  دید. شی‌ء  خواهید  را  استوانه  به شی‌ء  مربوط  پارامتری  تمام خصوصیات   Object برگۀ  در   3
استوانه واقعاً دراز است، اما ما قرار است از آن به‌عنوان نشیمنگاه چهارپایۀ خود استفاده کنیم، پس باید خیلی 

کوتاه‌تر باشد. مقدار پارامتر Height را به مقدار 15 تغییر دهید تا اندازۀ آن کوتاه‌تر شود. 
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4 به برگۀ Caps در Attribute Manager رفته، کادر انتخاب Fillet را در حالت تأیید قرار داده و مقدار 
Radius را با ٣/٥ تنظیم کنید. به این ترتیب لبه‌های استوانه نرم‌تر شده و ظاهر زیباتری پیدا می‌کند. در 

Object Manager روی نام استوانه کلیک کرده و عبارت Seat را تایپ کنید. 
حالا که نشیمنگاه چهارپایه را ساختید وقت آن است که به سراغ پایه‌ها برویم. دوباره به آیکن Primitives در 
پالت Command رفته و یک‌بار روی آن کلیک کنید تا مکعب که شکل پیش‌فرض است ایجاد شود. مکعب 
پیش‌فرض بیش از اندازه بزرگ است. با نگاهی به Attribute Manager خواهید دید که ابعاد هر یک از 
اضلاع آن 200 است. می‌توانید ابعاد مکعب را در هر یک از محور‌های Y ،X و Z تغییر دهید. حتی می‌توانید 
منشوری مستطیل شکل با ابعاد دلخواه ایجاد کنید. مقدار Size X و Size Z را از 200 به 10 تغییر دهید. 
حالا یک پایۀ بلند و باریک برای چهارپایۀ خود دارید. کادر انتخاب Fillet را در حالت تأیید قرار داده و مقدار 
 Object Manager را تا 1 کاهش دهید تا لبه‌ها کمی نرم‌تر شوند. روی نام این شی‌ء در Fillet Radius

دابل کلیک کرده و نام آن را leg بگذارید. 
طریق  از  و  کرده  کپی   Object Manager طریق  از  را  آن  می‌توانید   Primitive شی‌ء  ایجاد  محض  به 
Attribute Manager جابه‌جا کنید. در حالی که شی‌ء Leg در Object Manager متمایز شده است، کلید 
Ctrl یا Command را نگه داشته و کمی بکشید. زمانی که دکمۀ ماوس را رها می‌کنید یک کپی از پایه‌ 
خواهید داشت. زمانی که علامت + در کنار مکان‌نمای ماوس مشاهده شد یعنی شی‌ء کپی شده است. این کار 

را دو بار دیگر نیز تکرار کنید تا در Object Manager در مجموع چهار پایه داشته باشید. 
البته هنوز به نظر می‌رسد که یک پایه دارید، زیرا تمام پایه‌ها دارای مختصات یکسانی بوده و روی هم قرار 
گرفته‌اند. هر یک از این چهار پایه را در Object Manager انتخاب کرده و با استفاده از ابزار Move آنها 
را در مکان Y جابه‌جا کنید. کلید Shift را نگه داشته و پایه‌ها را به مقدار 100 واحد پایین بیاورید. به این 

ترتیب به نظر می‌رسد از انتهای نشیمنگاه چهارپایه خارج شده‌اند. 
5 روی منوی Cameras کلیک کرده و از نمای Perspective به نمای Bottom بروید تا بتوانید محل 
قرارگیری پایه‌ها را دقیقاً ببینید. هر چهار پایه در وسط قرار گرفته‌اند اما می‌خواهیم در اطراف نشیمنگاه قرار 

گیرند تا چهارپایه برای نشستن وضعیت با ثباتی داشته باشد. 
تمام پایه‌ها را از حالت انتخاب خارج کرده و سپس فقط یکی را در Object Manager انتخاب کنید. سپس 
در حالی که ابزار Move را انتخاب کرده و کلید Shift را نگه داشته‌اید، با استفاده از دستگیرۀ قرمز رنگ 
پایه را در جهت محور X به اندازۀ 40- جابه‌جا کنید. پایه دیگری را انتخاب کرده و این بار برعکس عمل 
کنید. آن را با مقدار 40 در خلاف جهت محور X قرار دهید. این کار را با دو پایۀ دیگر نیز تکرار کرده و این 
بار آنها را با مقدار 40 و 40- در محور Y جابه‌جا کنید. به این ترتیب چهار پایه به صورت یکنواخت در زیر 

نشیمنگاه چهارپایه قرار می‌گیرند. 
٦ به نمای Perspective بروید. مشاهده می‌شود که چهارپایه اکنون دارای چهار پایه است اما باید زاویۀ قرار 
گرفتن پایه‌ها را کمی تغییر دهیم تا طبیعی‌تر به نظر برسد. برای این منظور باید هر یک از پایه‌ها را کمی 
بچرخانید. به سراغ اولین پایه بروید که از مقدار 40- در محور X آن استفاده کرده بودیم و گزینۀ R.B آن 
را با مقدار 5 تنظیم کنید. برای پایه‌ای که از مقدار 40  در محور X استفاده کرده‌ بودیم باید از 5ـ درجه 
برای گزینۀ R.B آن استفاده کنیم. همین کار را برای دو پایۀ دیگر نیز انجام دهید تا نتیجۀ نهایی به صورت 

شکل 3ـ3 دیده شود. 
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  Subdivision surface گوشه‌ها و

برای ایجاد شی‌ء Subdivision surface باید از پالت Command کناری استفاده کرده و زیرمجموعه‌ای 
از شی‌ء Subdivision surface را در مکعب ایجاد کنید. به این ترتیب می‌توانید شی‌ء چندضلعی را تغییر 
دهید بدون این که نیازی باشد در مش اولیه تغییری ایجاد کنید. مکعب را در Object Manager انتخاب 
کرده و با نگه داشتن کلید Alt روی نماد Subdivision surface کلیک کنید. به این ترتیب مکعب به فرزند 
شی‌ء Subdivision surface تبدیل می‌شود. سپس با استفاده از ابزار loop cut یک ضلع جدید نزدیک به 

سطح بالای مکعب ایجاد کنید. مکعب شما در حال حاضر به این صورت دیده می‌شود. 

شکل 3ـ3ـ چهار پایه
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مدل‌سازی به‌وسیلۀ ابزارهای رسم چندضلعی و رسم نقاط   

Subdivision surface را در پنجرۀ Object Manager انتخاب 
کنید.  تبدیل   editable شیء  یک  به   C دکمۀ  دادن  فشار  با  و 
سطح‌های بالای مکعب را انتخاب و محور آبی رنگ Z را در پنجرۀ 
به شکل حفرۀ  تا  بکشید  پایین  به سمت  را  آن  و  Editor گرفته 
 Subdivision یک  درون  را  دیده شود. حالا شیء  بزرگی  نسبتاً 

surface دیگر بیندازید.

شکل 4ـ3ـ مکعبی که Subdivision surface بر آن اعمال شده است

شکل 5ـ3ـ ایجاد حفره

شیء را با استفاده از scale در جهت محور Y کمی کوچک تر کنید تا حالت کروی‌تری به خود بگیرد.

شکل 6ـ3ـ مراقب گزینه Only Select Visible Elements باشید
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Ctrl را در  Object Manager کلیک کرده و در حالی که کلید  Subdivision surface در  روی شی‌ء 
صفحه‌کلید فشار داده‌اید آن را کمی به سمت پایین بکشید. به این ترتیب این نیم‌کره تکثیر می‌شود. در حال 

حاضر همان شی‌ء در Object Manager دو بار دیده می‌شود. 

حالا هر دو شی‌ء Subdivision surface را انتخاب 
کرده و ابزار Rotate را انتخاب کنید. می‌توانید زاویۀ 
 Rotation Rings چرخش هر دو شی‌ء را با استفاده از
تنظیم کنید. حلقۀ محور Z آبی رنگ را به زاویۀ 150 

درجه بکشید. 

  Subdivision surface شی‌ء  برای  را  مرحله  این 
دیگر هم تکرار کنید اما زاویۀ آن را با مقدار 50    درجه 

تنظیم کنید. 

Cube شکل 7ـ3ـ تکثیر شیء

Z شکل 8ـ3ـ کشیدن 150 درجه‌ای محور

شکل 9ـ3ـ چرخاندن 50 درجه‌ای شیء
Subdivision surface 
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با استفاده از ابزار Move دو نیم‌کره را به صورت شکل 10ـ3 در کنار هم قرار دهید. 

حالا باید از کارکردهای قفل محورها استفاده کرده و از یکی 
از سیستم‌های مختصات World یا Object استفاده کنید. 
حالا کرۀ دیگری را ترسیم کرده و آن را طوری قرار دهید که 

هر دو نیم‌کره را مانند شکل ١١ـ٣ در بربگیرد. 

با استفاده از ابزار Scale اندازۀ کره را طوری تغییر دهید که 
داخل دو نیم‌کره به‌خوبی جای گیرد. 

شکل 10ـ3ـ قرار دادن دو نیم کره کنار هم

شکل 11ـ3ـ اضافه کردن کره‌ای دیگر

شکل 12ـ3ـ تغییر مقیاس کره و جای دادن 
آن در دو نیم کره دیگر
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آفرین! اولین شی‌ء مدل‌سازی‌شدۀ خود را با موفقیت ساختید. 
 Subdivision شی‌ء Subdivision می‌توانید با افزایش مقدار
surface، ظاهر نرم‌تری به مدل خود ببخشید. کافیست شی‌ء 
Subdivision surface موردنظر خود را که می‌خواهید نرم‌تر 
شود انتخاب کرده و مقدار Subdivision Editor را در منوی 
Object در Attribute Manager با مقدار بالاتری تنظیم 
کنید. البته هنوز این مدل کامل نشده است و در مراحل بعدی 
کار می‌توانید با افزودن بافت به آن ظاهر بهتری به مدل خود 

ببخشید. 
شکل 13ـ3ـ شکل کامل‌شده

   Spline انواع مدل‌سازی با منحنی‌های

باریکی که آنقدر  بار در کشتی‌سازی مورد استفاده قرار گرفت. تخته‌های چوبی  اولین   »Spline« اصطلاح
کشسانی داشتند که بتوانند در ساخت بدنۀ کشتی مورد استفاده قرار گیرند Spline نامیده می‌شدند. در 
دنیای سه‌بعدی Spline به »منحنی‌های نقطه محور« اطلاق می‌شود. منظور از Spline چندین نقطۀ تعریف 
شده است که شکل منحنی را به خود می‌گیرند. ابزارهای زیادی وجود دارند که به کمک آنها می‌توانید این 
منحنی‌ها را ترسیم کرده یا از اشکال آماده استفاده کنید. می‌توانید از Spline به‌عنوان مسیری استفاده کنید 
که دوربین روی آن به حرکت درمی‌آید. ضمناً می‌توانید از Splineها در مدل‌سازی استفاده کنید. به عبارت 
ساده‌تر، می‌توانید Spline ها را به صورت وایرفریم روی یک ردیف قرار داده و با استفاده از »Loft « روی آنها 

پوست بکشید. 

   NURBS انواع مدل‌سازی با ابزارهای مختلف

 ،Bezier  ،Sweep جمله  از  هستند  قابل‌دسترس   Cinema 4D در  مختلفی   Generator ابزارهای 
Extrude ،Lathe ،Subdivision surface و Loft. در ادامه قصد داریم شما را با این ابزارها بیشتر آشنا 

کنیم: 
مرحلۀ اول: Sweep ابزاری است که از دو شی‌ء استفاده می‌کند، یک Spline و یک شی‌ء Spline مانند 
دایره یا یک n ضلعی. ابزار Sweep این دو شی‌ء را ترکیب کرده و در ترکیب حاصله از شی‌ء Spline برای 

تعریف پهنا و شکل کلی و از Spline دیگر برای تعریف درازا و منحنی استفاده می‌کند. 
Cinema 4D را باز کنید! 
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طوری  را  دوربین  جلویی،   Viewport در  حالا  دوم:  مرحلۀ 
تغییر دهید که محورهای سبز و قرمز به صورت شکل 15ـ3 
را  شی‌ء   Z محور  طریق  از  که  می‌رسد  به نظر  شوند.  دیده 
می‌بینیم. به این ترتیب می‌توانید مکان دقیق اشیای ایجاد‌شده 

را مشخص کنید. 

Cinema 4D شکل 14ـ3ـ محیط

شکل 15ـ3ـ مشخص کردن مکان دقیق اشیا

مرحلۀ سوم: یکی از Splineهای مکعبی را از پالت Spline کشیده و شکلی شبیه به تصویر 16ـ3 را ترسیم 
کنید. 

پالت  از  مکعبی  Splineهای  از  یکی  کشیدن  16ـ3ـ  شکل 
Spline
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مرحلۀ چهارم: اگر از شکل ترسیم‌شده راضی نیستید، لازم نیست کل Spline را حذف کنید، بلکه می‌توانید 
از ابزار Live Selection استفاده کرده نقاط را انتخاب کرده و آنها را جابه‌جا کرده و شکل Spline را به 

دلخواه تغییر دهید. 
Generators را از پالت Sweep و ابزار Spline را از پالت Circle گزینۀ ،Spline بلافاصله پس از ایجاد

انتخاب کنید. 

شکل 17ـ3ـ انتخاب ابزارهای مناسب

شی‌ء  که  می‌کنید  مشاهده  اکنون  ششم:  مرحلۀ 
را  دایره  که  انگار  اصل  در  است!  شده  شما ضخیم‌تر 
با فشار از داخل Spline یا شی‌ء جدید رد کرده‌اید. 
و  کرده  کلیک  دایره  شی‌ء  روی  باید  ویرایش،  برای 
است(   T آن  میانبر  )کلید   Scale ابزار  از  استفاده  با 
دایره  مقیاس  که  زمانی  دهید.  کاهش  را  آن  مقیاس 
را کاهش می‌دهید با شکلی مانند شکل 19ـ3 مواجه 

خواهید شد. 

Sweep NURBS به داخل شیء Spline و Circle شکل 18ـ3ـ کشیدن دو شیء

مرحلۀ پنجم: اکنون در Object Manager هم شی‌ء Circle و هم شی‌ء Spline را انتخاب کرده و آنها را 
به داخل شی‌ء Sweep Nurbs بکشید. 

شکل 19ـ3ـ کاهش مقیاس دایره
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مرحلۀ هفتم: اصول استفاده از ابزار Sweep  همین است! می‌توانید اشیایی از این دست را با هر شکل و 
فرمی که مایلید ایجاد کنید، از تندیس‌های پر زرق و برق گرفته تا سیم‌ها و کابل‌ها و حتی قرنیزهای چوبی! 

این ابزار واقعاً مفید است و حقیقتاً می‌تواند گردش کار را تسریع کند. 
حالا نوبت به استفاده از ابزار Subdivision surface می‌رسد. این ابزار برای ایجاد اشکال ارگانیک بی‌نهایت 
مفید واقع می‌شود و با استفاده از آن می‌توانید در زمان مدل‌سازی واقعاً صرفه‌جویی کنید. در اصل، برای 
تغییر شکل شی‌ء، مقدار چندضلعی‌ها دو برابر شده و ساختار کلی نرم‌تر می‌شود تا لبه‌ها شکل نرم‌تری به 

خود بگیرند. 
 Object انتخاب کرده و در  را   Subdivision surface ابزار  اگر  با ترسیم یک مکعب شروع کنید.  را  کار 
Manager مکعب را به شی‌ء Subdivision surface بکشید، خواهید دید که به جای مکعب یک کره به 
 Attribute شما تحویل داده می‌شود. و این چیزی نیست که می‌خواهید. حالا اگر مکعب را انتخاب کرده، به
Manager رفته و تعداد بخش‌ها را افزایش دهید، شی‌ء در کل کمی بیشتر شبیه به مکعب خواهد شد، اما 

هنوز هم گوشه‌های آن گرد است. 

Attribute Manager شکل 20ـ3ـ

تنظیمات  اعمال  با  هشتم:  مرحلۀ 
فوق، مکعبی که حاصل می‌شود شبیه 

به شکل 21ـ3 است: 

شکل 21ـ3ـ مکعب حاصله
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مرحلۀ نهم: حالا روی ابزار Live Selection کلیک کنید تا مکعب قابل‌ویرایش شود )می‌توانید از کلید 
میانبر C استفاده کنید(. به این ترتیب با انتخاب ابزار Polygon می‌توانید چندضلعی‌هایی را انتخاب کنید. 

در این‌جا ما تمام چندضلعی‌هایی را انتخاب کرده‌ایم که در این وجه از مکعب استفاده شده‌اند. 

شکل 22ـ3ـ ویرایش مکعب )یک جدول انداخته شود و دو شکل کنار هم نمایش داده شوند(

Extrude شکل 23ـ3ـ استفاده از فرمان

مرحلۀ دهم: اکنون اگر فرمان Structure > Extrude را انتخاب کرده )یا از کلید میانبر D استفاده کنید(، 
در Viewport کلیک چپ کرده و بکشید، می‌توانید چندضلعی‌ها را به سمت داخل هل داده یا آنها را به 

بیرون بکشید، اما هنوز هم گوشه‌ها منحنی شکل هستند. 



40

مرحلۀ یازدهم: تنظیمات دیگری نیز وجود دارند که می‌توانید از طریق Attribute Manager مربوط به 
خود شی‌ء Subdivision surface اعمال کنید. می‌توانید از تقسیمات بیشتری استفاده کنید تا لبه‌ها حتی 

نرم‌تر شوند.

شکل 24ـ3ـ نرم‌تر کردن لبه‌ها

شکل 25ـ3ـ سخت‌تر کردن لبه‌ها

 Polygon مرحلۀ دوازدهم: حالا اگر نخواهید کل مکعب به این شکل منحنی شکل باشد چطور؟ اگر از ابزار
استفاده کرده، برخی چندضلعی‌های بالایی را انتخاب کرده، کلید فاصله را نگه داشته و ماوس را به چپ و 
راست بکشید، می‌توانید همان بخش از لبه را نرم‌تر کنید. این خصوصیت زمانی مفید واقع می‌شود که بخواهید 

فقط برخی لبه‌های اشکال ارگانیک سخت‌تر باشند. 
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مرحلۀ سیزدهم: حالا باید به سراغ Lathe Nurbs برویم. 
ابزار Lathe Nurbs ابزاری بسیار مفید است که برای ایجاد 
لیوان، بشقاب و کاسه بسیار  اشیای مدور/ استوانه‌ای مانند 

کاربرد دارد. 
قبلی  بخش‌های  )در  کنید  شروع   Cycloid ابزار  با  را  کار 
به  کرده‌ایم(.  استفاده  آن  از   Sweep ابزار  به  مربوط 
Viewport جلویی رفته، طرحی شبیه به شکل 26ـ3 ایجاد 
کنید که شبیه به نیمۀ کاسه است و در چشم به هم زدنی 

آن را به لیوانی تبدیل خواهیم کرد! 

مرحلۀ چهاردهم: حالا که Spline اولیه را ترسیم کردید، 
به پالت  Generator رفته و ابزار Lathe را انتخاب کنید. 
شکلی  بکشید،   Lathe به شی‌ء  را   Spline اگر شی‌ء  حالا 

شبیه به شکل 27ـ3 خواهید داشت: 

اما  ساده  درآمد،  آب  از  جالبی  لیوان  پانزدهم:  مرحلۀ 
به دردبخور! اگر از شکل حاصل خوشتان نیامد )مثلًا به نظر 
 Scale ابزار  از  استفاده  با  من کمی کوتاه است(، می‌توانید 
قرمز، شی‌ء  و  سبز  محورهای  و  است(   T آن  میانبر  )کلید 
Spline را تغییر مقیاس یا تغییر شکل دهید. ما در این‌جا 

آن را کمی بلندتر کرده‌ایم: 

شکل 26ـ3ـ شروع به ایجاد شکل لیوان

شکل 27ـ3ـ شکلی شبیه لیوان

شکل 28ـ3ـ بلندتر کردن لیوان
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شی‌ء   Attributes پنل  به  اگر  شانزدهم:  مرحلۀ 
در  زیادی  گزینه‌های  دید  خواهید  بروید،   Lathe
دسترس هستند. با تغییر مقدار Rotation خواهید دید 
که یک لیوان کامل ایجاد نکرده‌اید، بلکه فقط بخشی‌ 
از آن را ایجاد کرده‌اید )برای ایجاد اشیای نیم‌دایره‌ای 
بسیار مفید است(. با تغییر مقدار Subdivision متوجه 
می‌شوید مش متراکم‌تر شده و لیوان مدورتر می‌شود 
)این ویژگی برای رندرهای کلوزآپ بسیار مفید است، 
اولیه  شکل  در  زیادی   Spline نقاط  از  اگر  به‌ویژه 
استفاده نشده باشد(. ضمناً از این تنظیمات می‌توانید 
استفاده  تغییر حرکت Lathe در حین چرخش  برای 
کنید. تنظیمات مختلف را امتحان کرده و با طرز کار هر 

کدام بیشتر آشنا شوید. 

مرحلۀ هفدهم: اکنون نوبت به Loft رسیده است که 
سطحی را بین دو شی‌ء متصل به هم ایجاد می‌کند، 
به‌ویژه زمانی که قرار است شی‌ء اولیه به شی‌ء دیگری 
تبدیل شود! برای آشنایی با طرز کار این ویژگی، دو 
Spline به شکل ستاره را از پالت Spline کشیده و 

ابزار Loft را از پالت Generator انتخاب کنید. 

شکل 29ـ3ـ امتحان تنظیمات مختلف

شکل 30ـ3ـ استفاده از ابزار  Loft روی شکل ستاره
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مرحلۀ هجدهم: حالا باید مقادیر Position/Rotation/Scale یکی از ستاره‌ها را تغییر دهید تا دیگر دو 
ستاره روی هم قرار نگرفته باشند. سپس هر دو ستاره را به داخل شی‌ء  Loft بکشید و خواهید دید که سطح 

Solid سه‌بعدی بین آنها ایجاد خواهد شد! 

شکل 31ـ3ـ ایجاد سطح Solid سه‌بعدی

  Text 3D انواع مدل‌سازی متون با

تایپوگرافی سه‌بعدی یکی از تخصص‌هایی است که هر طراح سه‌بعدی باید در آن مهارت داشته باشد. تقریباً 
نیز   Cinema 4D می‌کنند.  استفاده  خود  طراحی‌های  در  نوعی  به  متن  از  گرافیک  موشن  طراحان  تمام 
گزینه‌های متعددی در اختیار شما قرار می‌دهد که با استفاده از آنها می‌توانید از متن‌های سه‌بعدی زیبایی در 
طراحی‌های خود استفاده کنید. برای استفاده از متن در Cinema 4D می‌توانید از این روش‌ها کمک بگیرید: 

 Text ــ ایجاد شی‌ء
 Extrude ــ ایجاد شی‌ء

 Extrude در شی‌ء Text ــ رها کردن شی‌ء
 Type ــ استفاده از تنظیمات

 Extrusion ــ استفاده از تنظیمات
بهتر است وارد جزئیات کار شویم: 
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                                      Text مرحلۀ اول: ایجاد شی‌ء 

ساده‌ترین روش ایجاد متن سه‌بعدی در Cinema 4D استفاده از شی‌ء Text به همراه شی‌ء Extrude است. 
به منوی Create رفته، گزینۀ Spline و سپس گزینۀ Text را انتخاب کنید. در کادر متن نمایش داده شده 

متن موردنظر خود را تایپ کرده و برای رفتن به سطر جدید از کلید Return استفاده کنید. 

                             Extrude مرحلۀ دوم: ایجاد شی‌ء 

برای ایجاد شی‌ء Extrude باید به منوی Generators در کنار رابط کاربر بروید. روی دکمه کلیک کرده و 
نگه دارید و سپس گزینۀ Extrude را انتخاب کنید. 

 مرحلۀ سوم: شی‌ء Text را در شی‌ء Extrude رها کنید 

باید شی‌ء Text را در شی‌ء Extrude رها کنید تا به‌عنوان فرزند آن عمل کند. ایدۀ اصلی این است که تمام 
تنظیمات Type را در شی‌ء Text و تمام تنظیمات سه‌بعدی را در شی‌ء Extrude اعمال کنید. 

 مرحلۀ چهارم: متن را سفارشی‌ کنید                           

نوبت به بخش جالب ماجرا می‌رسد. می‌توانید از شیوه‌های مختلف در متن استفاده کنید:
  انتخاب فونت: پس از انتخاب Type می‌توانید از منوی کشویی نمایش داده شده فونت موردنظر خود را 

انتخاب کنید. Cinema 4D حتی پیش‌نمایش فونت انتخابی را نیز برای شما نمایش می‌دهد. 
  تنظیم پارامترهای متن: می‌توانید اندازۀ کلی متن و فاصله‌گذاری‌های افقی و عمودی را در ارتباط با کل 

بلوک متن تنظیم کنید. 

           Extrusion مرحلۀ پنجم: تنظیم پارامترهای 

کنید.  استفاده   Extrude شی‌ء  در  سه‌بعدی  تنظیمات  از  می‌توانید   ،Text شی‌ء  تنظیمات  اعمال  از  پس 
می‌توانید   Z مقدار  از  استفاده  با  کنید.  انتخاب  را   Extrude Object > Object > Movement فرمان 
عمق Extrusion را تنظیم کنید. از مقادیر منفی می‌توانید برای هل دادن متن به عقب و از مقادیر مثبت 
می‌توانید برای کشیدن متن به جلو استفاده کنید. با استفاده از کنترل‌های Subdivision می‌توانید نرمی 

متن را کنترل کنید. 

می‌توانید چندین شی‌ء Text را در زیر شی‌ء Extrude مورد استفاده قرار دهید تا از تنظیمات سه‌بعدی 
یکسانی در تمام آنها استفاده شود. برای این منظور باید تمام اشیای Text را به‌عنوان فرزندان شی‌ء 

Extrude مشخص کنید. فرمان Extrude Object > Object > Hierarchical را انتخاب کنید. 

نکته
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پرسش‌های تشریحی  

1 چند ویژگی اشیای Primitives را نام ببرید.
2 چگونه یک شیء را در Subdivision surface قرار دهیم؟

3 منظور از Spline چیست؟ یک کاربرد آن را نام ببرید.
4 ابزار Sweep چه کاربردی دارد؟ چطور می‌توان از آن استفاده کرد؟

5 مراحل استفاده از Text را به ترتیب نام ببرید.

پرسش‌های چندگزینه‌ای  

1 کدام یک از گزینه‌های زیر پارامتری هستند؟
ب( Generator ها 		 primitive الف( اشیای

د( گزینه‌های الف و ج 		 Spline )ج

2 اصطلاح Spline اولین بار در کجا مورد استفاده قرار گرفت؟ 
ب( هواپیماسازی 		 الف( کشتی‌سازی
د( در نرم افزارها 		 ج( خودروسازی

3 ابزار Sweep نیاز به چند زیرمجموعه دارد؟
Object و یک Spline ب( دو 	Object و یک  Spline الف( یک

primitives د( دو شیء 		 Spline ج( دو

Spline 4 در کنار کدام گزینه می‌تواند یک لیوان با حجم کره‌ای تشکیل دهد؟
Subdivision surface )ب 		 Sweep )الف

Loft )د 		  Lathe )ج

5 کاربرد Loft چیست؟
ب( نرم کردن اشیا 	Spline الف( چرخاندن 360 درجۀ

Spline د( ایجاد سطح بین دو ج( ساخت یک مسیر لوله مانند                            	

پروژۀ عملی  

با استفاده از ابزارهایی که در این فصل آموختید،  یک شیشه مربا و یک پردۀ دارای چین و چروک بسازید.



سبک های مدل سازی



فصل 4
سبک های مدل سازی
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می‌رود:
  با مدل‌سازی آرایه‌ای آشنا باشد.

  مدل‌سازی Symmetry را انجام دهد.

  با مفهوم بولی یا Boolean آشنا باشد.

مدل‌سازی آرایه‌ای  

شکل 1ـ4ـ مدل‌سازی آرایه‌ای

منظور از آرایه، فهرست یا حتی ترتیبی از عناصر است. با استفاده از ابزار Array می‌توانید نقاط یا چندضلعی‌های 
انتخاب‌شده از یک شیء )از این به بعد با نام عناصر به آنها اشاره می‌کنیم( را کپی کرده و آنها را به صورت 
کم و بیش یکنواخت در جهات Y ،X و Z توزیع کنید. می‌توانید اندازه و میزان چرخش هریک از این عناصر 

را حول محورهای مختصاتشان تغییر دهید. 
به کمک گزینه‌های این ابزار می‌توانید مجموعه‌ای از عناصر را به صورت کاملًا یکنواخت کپی کرده یا آنها را 
انتخابی کپی  اتفاقی در سطح پراکنده کنید. آرایه‌ها همیشه در امتداد محورهای مختصات شیء  به صورت 
می‌شوند. اگر سطوح به هم متصل باشند، به صورت یکپارچه کپی می‌شوند. اگر هیچ عنصری انتخاب نشده 
باشد یا اگر در وضعیت نقطه یا چندضلعی نباشید، تمام سطوح و نقاط شیء انتخابی کپی می‌شوند. اگر فقط 
نقاط را انتخاب کرده باشید، فقط نقاط کپی می‌شوند نه سطوح متصل به آنها. برای ایجاد سطوح برای این 

نقاط، باید از ابزار Bridge یا Create Polygon استفاده کنید. 
 Functions در منوی Duplicate یک دسته از علف را درنظر بگیرید. به‌سادگی می‌توانید با استفاده از ابزار
این دستۀ علف را تکثیر کرده و سپس با استفاده از کارکرد Randomize کپی‌هایی از آن را به صورت تصادفی 



فصل چهارم : سبک های مدل سازی

49

توزیع کنید. اشکال این روش این است که اشیای مجزایی به تعداد زیاد حاصل می‌شود. اما با استفاده از ابزار 
Array شما فقط سطوح )یا نقاط( را کپی می‌کنید نه خود شیء کامل را؛ به این ترتیب با استفاده از یک 

دستۀ علف می‌توانید به‌سادگی چمنزاری را ایجاد کنید. 

  Symmetry مدل‌سازی

اگر می‌خواهید مدلی را بسازید که در طبیعت به صورت قرینه )یا تقریباً قرینه( وجود دارد مانند صورت انسان، 
فقط کافی است نصف آن مدل را ساخته و به کمک کارکرد Add Symmetry Object قرینه و نیمۀ دیگر 
آن را به‌راحتی ایجاد کنید. فقط بخشی‌ که این کارکرد را در آن اعمال می‌کنید دارای نقاط خواهد بود. هر 
تغییری که در این نقاط اعمال کنید، توسط این کارکرد در نیمۀ دیگر نیز اعمال خواهد شد. این شی‌ء فقط با 

اشکال هندسی قابل‌استفاده است و از آن نمی‌توانید در نورها، دوربین و نظایر اینها استفاده کنید. 
به محض این که مدل‌سازی یک نیمه را انجام دادید، باید شیء Symmetry را قابل‌ویرایش کنید تا نیمۀ 
ایجاد شده تبدیل به چندضلعی شود. سپس می‌توانید هریک از نیمه‌ها را به صورت مستقل اصلاح کنید تا 

مدل حالت طبیعی‌تر پیدا کند. 
 Functions > Make Editable برای درک بهتر، کار را با شیئی ساده آغاز کنید: یک کره رسم کرده، با انتخاب فرمان
آن را به چندضلعی تبدیل کرده و ابزار Points را انتخاب کنید. ابزار Rectangle Selection را انتخاب کرده، در نمای 
Front، نقاط نیمۀ سمت راست شیء Sphere را انتخاب کرده و آنها را حذف کنید. شیء Symmetry را ایجاد کرده 

و در Object Manager، کره را به‌عنوان فرزند شیء Symmetry نسبت دهید. 
نیمۀ سمت راست کره ایجاد شده و شکل کره بار دیگر تکمیل می‌شود. توجه داشته باشید که فقط نیمۀ سمت 
چپ دارای نقاط است. اکنون می‌توانید برخی نقاط سمت چپ را با استفاده از ابزار Magnet ویرایش کنید. 

مشاهده می‌کنید که در نیمۀ دیگر نیز تغییرات اعمال می‌شوند. 

  Boolean مفهوم بولی یا

با  الگوی داده‌ای است که تنها دارای دو مقدار True و False است. این دو مقدار   ،Boolean یا  Boole
مقدار 1 برای True و 0 برای False شناخته می‌شود. اگرچه می‌توانید از مقادیر Boole در ارزیابی‌های 
شمارشگری نیز استفاده کنید، ولی به یاد داشته باشید که این الگوی داده‌ای فقط می‌تواند مقادیر 1 و 0 را 

در خود جای دهد.
تا این‌جا تمام روش‌هایی که آموختید برای تولید یا ایجاد سطح یا شکل هندسی جدید در مدل‌ها بود. اما 
اگر بخواهید برعکس عمل کنید چطور؟ اگر بخواهید قسمتی از مدل را از آن کسر کرده، مثلًا حفره، سوراخ 
یا  Boole می‌توانید بخش‌ها  از شی‌ء  استفاده  با   Cinema 4D ایجاد کنید چطور؟ در  یا دندانه‌ای در آن 
قسمت‌هایی از مدل سه‌بعدی خود را حذف کنید. به کمک این ویژگی می‌توانید شکل خاصی را به‌راحتی از 
سطح موجود برش دهید که در غیر این صورت کار دشواری خواهد بود. در چنین مواردی باید شکلی که قرار 

است برش داده شود را به‌عنوان شی‌ء Boole مشخص کرده و آن را از روی شی‌ء دیگر برش دهید. 
شیء Boole را در زیرمنوی Objects > Modeling خواهید یافت. به این ترتیب می‌توانید کارکردهای آنی 
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Boolean را روی اشیای Primitives یا چندضلعی‌ها اجرا کنید. یعنی پس از این که دو شیء موردنظر خود 
 Viewport تنظیم کردید، بلافاصله می‌توانید نتیجۀ کار را در Boole را )مثلًا دو کره( به‌عنوان فرزند شیء

مشاهده کنید. وضعیت Boolean پیش‌فرض، A Subtract B است. 

شیء Boole نیز براساس سلسله مراتب عمل می‌کند؛ یعنی با استفاده از فرمان A Subtract B می‌توانید 
نه تنها یک حفره بلکه دو یا چند حفره در شیء موردنظر خود ایجاد کنید. هریک از این اشیا باید به صورت 
تعداد  است  بهتر  آورید  به‌دست  بهتری  نتیجۀ  که  این  برای  گیرند.  قرار  اول  شیء  زیر  در  سلسله‌مراتبی 

Subdivisionها را در اشیا افزایش دهید. 
 .A Without Bو A Intersect B،A  Subtract B،A Union B.قابل‌دسترس است Boolean چهار وضعیت

پرسش‌های تشریحی   

1 ابزار array چه استفاده و کاربردی دارد؟
٢ یک روش برای ساخت چمن‌زار با استفاده از یک دسته علف را توضیح دهید.

٣ مدل‌سازی symmetry مناسب چه مدل‌هایی است؟
٤ برای ایجاد یک حفره در شیء، بهتر است از چه سبکی استفاده کنیم؟

٥ روش کار Boolean را توضیح دهید.

شکل 2ـ4ـ چهار وضعیت Boolean قابل‌دسترس

 A Intersect B
حجم قسمت متقاطع 
نشان داده می‌شود.

 A Subtract B
شیء B از شیء A کسر 

می‌شود.

 A Union B
شیء A با شیء B ادغام 

می‌شود.

 A Without B
شبیه A Subtract B است 
با این تفاوت که حفره ای 
تو خالی در شیء A ایجاد 

می شود.
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پرسش‌های چندگزینه‌ای   

1 ابزار array در چه محورهایی عمل می‌کند؟
Y )ب 	X )الف

د( همۀ موارد 	 Z )ج

2 برای مدل‌سازی Symmetry باید چه مقدار از مدل را بسازیم؟
ب( مدل را کامل باید بسازیم الف( یک چهارم از مدل	

د( یک سوم از مدل ج( به صورت نصفه 	

3 از مدل‌سازی Symmetry در کدام گزینه می‌توان استفاده کرد؟
ب( نورها الف( Primitive ها	

د( Deformer ها ج( دوربین‌ها	

4 دو مقدار True و False در Boolean به ترتیب از چپ به راست چه اعدادی را نشان می‌دهند؟
ب( 1 و 2 الف(  2 و 0 	
د( 1 و 0 ج( 0 و2	

5 در Boolean کدام یک از وضعیت‌های زیر معنای ادغام دو شیء است؟
A union B )ب 	 A subtract B  )الف

A without B )د 	 A intersect B  )ج

پروژۀ عملی   

با استفاده از سبک‌ها و روش‌های یادگرفته شده در این فصل یک عنکبوت و یک پنیر امنتال یا سوئیسی را 
مدل‌سازی کنید.





فصل 5

آشنایی با Deformer ها   
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می‌رود:
  با deformer ها آشنا باشد.

  با فرمان Bend آشنا باشد.

  با شیوۀ Melt آشنا باشد.

   با شیوۀ Explosion آشنا باشد.

  با شیوۀ Twist آشنا باشد.

Deformer، هندسۀ سایر اشیا را تغییر می‌دهد. می‌توانید از Deformerها در اشیای Primitive، اشیای 
NURBS، اشیای چندضلعی و Splineها استفاده کنید. 

Deformer بر شی‌ء والد و سلسله مراتب مربوط به آن تأثیر می‌گذارد. البته اگر این جلوه را در سطح بالای 
سلسله مراتب Object Manager قرار دهید تأثیری نخواهد داشت، زیرا هیچ والدی ندارد. 

می‌توانید از چندین شیوۀ Deformer روی یک شی‌ء استفاده کنید. ترتیب اولویت در Object Manager از 
بالا به پایین است. ترتیب ارزش‌گذاری اهمیت دارد، زیرا اگر اول Twist اعمال شود بعد Bend تأثیر متفاوتی 

دارد تا اول Bend بعد Twist. در ادامه در مورد برخی از Deformerها شرح خواهیم داد. 

   Bend فرمان

این Deformer شی‌ء را خم می‌کند. با کشیدن دستگیرۀ نارنجی رنگ سطح بالایی Deformer می‌توانید 
جلوه‌ را به صورت تعاملی در Viewport تغییر دهید. 

آن  در   Bend که جلوۀ  همان مکعب 
اعمال شده است

مکعبی با ابعاد 5 × 5 × 5

Bend شکل 1ـ5 ـ اعمال جلوه
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تنظیمات Attribute Manager برای این شیوه مطابق شکل 2ـ5 است.

Bend شکل 2ـ5 ـ تنظیمات شیوه

  Melt شیوۀ

Melt Deformer کادر محصورکننده ندارد. شی‌ء تحت تأثیر به صورت شعاعی از مرکز جلوه شروع به ذوب 
 Viewport در  را  ذوب شدن شی‌ء  وضعیت  می‌توانید  رنگ  نارنجی  دستگیرۀ  از  استفاده  با  می‌کند.  شدن 
به صورت تعاملی کنترل کنید. شی‌ء مذکور در سطح Y و از مبدأ جلوه شروع به ذوب شدن می‌کند. به همین 
 XZ در زیر شی‌ء قرار داده می‌شود. بخش‌هایی از شی‌ء اولیه که در زیر سطح Melt Deformer ًدلیل معمولا

قرار می‌گیرد به صورت ناقص اعمال می‌شوند. 

MeltDeformer در آن  همان مکعب که جلوۀ 
اعمال شده است

مکعبی با ابعاد 5 × 5 × 5

MeltDeformer شکل 3ـ5 ـ استفاده از شیوه
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تنظیمات Attribute Manager برای شیوه MeltDeformer مطابق شکل 4ـ5 است.

Melt شکل 4ـ5 ـ تنظیمات شیوه

   Explosion شیوۀ

با استفاده از این Deformer می‌توانید به سرعت جلوه‌های واقعی انفجار را ایجاد کنید. این جلوه، خوشه‌هایی 
را از شی‌ء منتشر می‌کند که کنترل زیادی روی آنها خواهید داشت. برای متحرک‌سازی انفجار، باید پارامتر 

Time را متحرک کنید. 
تنظیمات Attribute Manager برای این شیوه مطابق شکل 5ـ5 است.

Explosion شکل 5ـ5 ـ تنظیمات شیوه

   Twist شیوۀ

بالایی  سطح  در  رنگ  نارنجی  دستگیرۀ  کشیدن  با  می‌چرخاند.   Y محور  حول  را  شیء   Deformer این 
Deformer می‌توانید این جلوه را به صورت تعاملی در Viewport کنترل کنید. این جلوه براساس پارامترهای 



فصل پنجم : آشنایی با Deformer ها 

57

 Segment تنظیم شده عمل می‌کند، بنابراین اگر می‌خواهید چرخش به نرمی صورت گیرد، باید تعداد بیشتری
یا Subdivision در امتداد محور چرخش مشخص کنید. 

تنظیمات Attribute Manager برای این شیوه مطابق شکل 6ـ5 است.

Twist شکل 6ـ5 ـ استفاده از شیوه

پرسش‌های تشریحی   

1 از Deformer ها در چه اشیایی می‌توان استفاده کرد؟
2 دو نوع Deformer را نام ببرید و عملکرد آنها را توضیح دهید.

3 در کدام حالت ‌Deformerها تأثیرگذار نیستند؟
4 یک Deformer را نام ببرید که اشیا را ذوب می‌کند.

5 چگونه تأثیر دو Deformer را روی یک شیء تغییر دهیم؟

پرسش‌های چندگزینه‌ای  

1 کدام یک از ‌Deformerهای زیر باعث خمیدگی شی‌ء می‌شود؟
Explode )ب 	Melt )الف

Twist )د 	 Bend )ج

‌Deformer 2ها در کدام مورد تغییر ایجاد می‌کنند؟
ب( موقعیت مکانی اشیا الف( اضلاع اشیا	

د( نقاط اشیا ج( هندسۀ اشیا	
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‌Deformer 3ها در Object Manager بر کدام اشیا تأثیر می‌گذارند؟
ب( شی‌ء فرزند الف( شی‌ء والد	

د( همۀ موارد ج( هم گروه‌هایشان	

4 کدام گزینه باعث ذوب شدن اشیا می‌شود؟
Melt )ب 	Twist )الف
Bend )د 	Explode )ج

5  کدام یک از ‌Deformerهای زیر به صورت شعاعی از مرکز تأثیر می‌گذارند؟
Bend )ب 	Explode )الف

Melt )د 	Twist )ج

پروژۀ عملی  

با استفاده از ‌deformerها یک لوبیای قرمز و یک شیپور بسازید.



فصل 6

متحرک سازی و کنترل انیمیشن 
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می‌رود:
  با شیوۀ انیمیشن‌سازی با Keyframes آشنا باشد.

  با ساخت فریم‌های کلیدی با استفاده از Attribute Manager آشنا باشد.

  با نحوۀ انیمیشن‌سازی دوربین‌ها توسط یک Object آشنا باشد.

  با ساخت مسیر انیمیشن با استفاده از Align to Spline Tag آشنا باشد.

  با کنترل انیمیشن‌ها با Curve ManagerـF آشنا باشد.

  با ساخت حرکات انیمیشن با Pose Mixer )ابزار Morph( آشنا باشد.

  با کنترل انیمیشن‌ها در Timeline آشنا باشد.

   Keyframes شیوۀ انیمیشن‌سازی با

زمانی که ضبط را با استفاده از فریم‌های کلیدی انجام می‌دهید، Cinema 4D براساس تنظیمات مشخص‌شده 
از سوی شما، ترک‌ها، سکانس‌ها و کلیدها را در Timeline ایجاد می‌کند. برای هر شیئی که درحال حاضر 
در Object Manager انتخاب شده باشد، مشروط بر این که شیء پارامتری باشد، می‌توانید مکان، مقیاس، 
چرخش، پارامترها و مکان نقاط )PLA( را ضبط کنید. با استفاده از شیء Selection می‌توانید مشخص 

کنید کدام شیء باید ضبط شود. 
گزینۀ Active Elements به صورت پیش‌فرض برای شیء Selection انتخاب شده است که به صورت زیر 
عمل می‌کند. در نوار ابزار Animation، آیکن‌های مربوط به خصوصیاتی را فعال کنید که قرار است آنها را 
ضبط کنید. در نوار ابزار Animation، روی دکمۀ Record کلیک کنید. به این ترتیب ترک‌ها، سکانس‌ها 
انتخاب شده در  و کلیدهـا بـرای فـریم جاری )کـه در لغزندۀ زمـان انیمیشن نشان داده مـی‌شود( شیء 

Object Manager ضبط می‌شوند. 
فرض کنید می‌خواهیم مکان مکعبی را از نقطۀ A )فریم صفر( به نقطۀ B )فریم 30( متحرک کنیم. 

ــ در نوارابزار Animation، مطمئن شوید لغزندۀ زمان در فریم صفر قرار گرفته است. 
ــ در Viewport، مطمئن شوید گزینۀ Position Keys فعال باشد. 

ــ روی دکمۀ Record کلیک کنید تا کلیدهایی در مختصات Y ،X و Z در فریم صفر ایجاد شود. اگر ترک 
و سکانس Position درحال حاضر برای مکعب وجود نداشته باشند، ایجاد می‌شوند. 

ــ در نوار ابزار Animation، لغزندۀ زمان را به فریم سی‌ام بکشید. در Viewport، مکعب را به نقطه‌ای بکشید 
که می‌خواهید در فریم سی‌ام در آن قرار گیرد. روی دکمۀ Record کلیک کنید. 
ــ برای پخش انیمیشن، در نوار ابزار Animation روی دکمۀ Play کلیک کنید. 

ــ تمام شد. مکان مکعب از فریم صفر تا فریم سی‌ام به صورت پیوسته تغییر می‌کند. مسیر زرد رنگی که در 
Viewport می‌بینید مسیری است که مکعب طی کرده است. 
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سکانس مکعب در Timeline در شکل 2ـ6  نشان داده شده است.

شکل 1ـ6ـ مسیر حرکت مکعب

   Attribute Manager ساخت فریم‌های کلیدی با استفاده از

می‌توانید کلیدها را مستقیماً در Attribute Manager ضبط کنید. برای مثال برای متحرک کردن مکان 
مکعب به این ترتیب عمل کنید: 

ــ در Object Manager، مکعب را انتخاب کنید. 
ــ در نوارابزار Animation مطمئن شوید که لغزندۀ زمان در فریم صفر قرار گرفته است. 

 )Windows کلیک راست )در P روی یکی از سه حرف ،Attribute Manager در Coordinate ــ در صفحۀ
کرده یا کلید Command را فشار داده و کلیک کنید )در مکینتاش( تا منوی زمینه‌ برای پارامترهای مکان 
باز شود. فرمان Animation > Add Keyframe را انتخاب کنید تا کلیدهایی برای مختصات Y ،X و Z در 
فریم صفر ایجاد شود. اگر ترک‌های مکان هنوز وجود ندارند، درحال حاضر برای این کلیدها ایجاد می‌شوند. 

Timeline شکل 2ـ6ـ سکانس مکعب در
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 P ــ لغزندۀ زمان را به فریم سی‌ام ببرید. مکعب را به مکان دیگری انتقال داده و بار دیگر روی یکی از حروف
کلیک راست )در Windows( کرده یا کلید Command را فشار داده و کلیک کنید )در مکینتاش(. از منوی 

زمینه‌ای که نمایان می‌شود، فرمان Animation > Add Keyframe را انتخاب کنید. 
ــ برای پخش انیمیشن، در نوار ابزار Animation روی دکمۀ Play کلیک کنید. 

تمام شد. مکعب از فریم صفر تا سی به حرکت درمی‌آید. با استفاده از این روش، می‌توانید تقریباً تمام پارامترها 
را متحرک کنید. ضمناً می‌توانید از این روش برای تنظیمات رندر استفاده کرده و فریم‌های کلیدی را برای 
جلوه‌ها ایجاد کنید. حتی می‌توانید برای ضبط پارامترها در Attribute Manager، کلید Ctrl را نگه داشته 

و روی دایره‌هایی که در کنار پارامترها هستند کلیک کنید تا ضبط شوند. 

   Object نحوۀ انیمیشن‌سازی دوربین‌ها توسط یک

می‌توانید صحنه را به جای دوربین از طریق شیء مشاهده کنید. در Object Manager شیئی را انتخاب 
کنید که می‌خواهید از آن به‌عنوان دوربین در Viewport استفاده کنید. در Viewport موردنظر خود، فرمان 

Cameras > Link Active Object را انتخاب کنید. 
گاهی مشاهدۀ صحنه از طریق برخی اشیای خاص بسیار مفید واقع می‌شود. برای مثال زمانی که مو را با 
استفاده از ویژگی Shave و Haircut برای پلاگین Cinema 4D ایجاد می‌کنید، باید مطمئن شوید مخروط 
سایۀ منبع نور فقط مو را می‌پوشاند )در غیر این صورت جزئیات موجود در سایه را از دست می‌دهید(. در 
چنین مواردی باید مطمئن شوید از نور به‌عنوان دوربین استفاده کرده باشید. به این ترتیب می‌توانید اندازۀ 

مخروط سایه را به دقت تعیین کنید. 

شکل 3ـ6ـ اضافه کردن فریم‌های کلیدی
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هنگام استفاده از شیء به‌عنوان دوربین Viewport، محور Z شیء است که جهت نمایش را تعیین می‌کند. 

   Align to Spline Tag ساخت مسیر انیمیشن با استفاده از

از  Cinema 4D است. متحرک‌سازی بدون استفاده  از قابلیت‌های مهم نرم‌افزار  حرکت دادن اجسام یکی 
تگ‌ها و تنها با استفاده از فریم‌های کلیدی، کاری دشوار و بسیار وقت‌گیر است. اما استفاده از تگ‌ها این 
امکان را به ما می‌دهد که به‌راحتی اجسام را متحرک کرده و انیمیشن‌های مطلوبی را بسازیم. تگ‌های مختلفی 
آنها، تگ‌های  به کار می‌روند و پرکاربردترین   Cinema 4D برای متحرک کردن اجسام در  وجود دارد که 
انیمیشن‌سازی هستند. در بین این تگ‌ها، مهم‌ترین آنها تگ Align to Spline است. در این تگ، مسیری را 
که با استفاده از Spline Tool ایجاد شده است به Cinema 4D معرفی می‌کنیم تا جسم را روی آن حرکت 

دهد. در اینجا از شیء ساده‌ای استفاده می‌کنیم. 

شکل 4ـ6ـ تعیین اندازه مخروط سایه

Spline Tool شکل 5ـ6ـ استفاده از
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حالا مسیری را با استفاده از Spline Tool ایجاد کرده و آن را در راستای موردنظر خود قرار می‌دهیم.

Spline Tool شکل 6ـ6ـ ایجاد مسیر با استفاده از

انتخاب  را   Align to Spline تگ  باید  و سپس  درآید  انتخاب  حالت  در  تا  کنید  کلیک  روی شیء  ابتدا 
Tags گزینۀ  از منوی  این است که  از دو روش استفاده کنید. روش اول  این منظور می‌توانید  کنید. برای 

Animation Tags و سپس گزینۀ Align to Spline را انتخاب کنید.

شکل 7ـ6ـ انتخاب تگ Align to Spline با استفاده از نوار منو
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روش دوم این است که روی شیء کلیک راست کرده و از منوی بازشو گزینۀ Animation Tags و سپس 
گزینۀ Align to Spline را انتخاب کنید. 

شکل 8ـ6ـ انتخاب تگ Align to Spline با استفاده از منوی زمینه

شکل 9ـ6ـ تعیین مسیر حرکت انیمیشن

شکل 10ـ6ـ تعیین راستای حرکت شیء

پس از ایجاد تگ، در قسمت پایین پنجره، گزینه‌هایی در اختیار شما قرار می‌گیرد که مربوط به این تگ است. 
ابتدا باید مسیری را که قرار است انیمیشن روی آن حرکت کند در این بخش مشخص کنید. مسیر را انتخاب 

کرده و آن را به کادر Spline Path بکشید. 

بلافاصله شیء روی مسیر قرار می‌گیرد. گزینۀ بعدی Tangential است که با استفاده از آن می‌توانید راستای 
حرکت شیء را مشخص کنید. 
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گزینۀ بعدی Position است که محل قرارگیری شیء را روی مسیر نشان می‌دهد و با مقادیر صفر تا صد 
درصد مشخص شده است. 

شکل 11ـ6ـ تعیین محل قرارگیری شیء

 Auto Key برای این که تنظیم کنید شیء در کل مسیر حرکت کند، ابتدا به فریم صفر رفته، روی دکمۀ
کلیک کنید تا یک فریم کلیدی ایجاد شود. سپس به فریم نود رفته و مقدار Position را با مقدار صد درصد 

تنظیم کنید تا شیء در کل مسیر حرکت کند. 

  F-Curve Manager کنترل انیمیشن‌ها با

F-Curves همان مختصر‌شدۀ Function Curves است که به کنترل میان‌گذاری بین کلیدها اشاره دارد. 
از آن‌جایی که واحد اندازه‌گیری در اینجا مطرح نیست، می‌توانید از این ویژگی برای هر پارامتری استفاده 
کنید که قابل‌میان‌گذاری باشد. از F-Curves نمی‌توانید در مورد پارامترهایی مانند سایه استفاده کنید که 

قابل‌میان‌گذاری نیستند. 

روشی که پارامترهای بین دو کلید میان‌گذاری 
در  دارد.  انیمیشن  بر  زیادی  تأثیر  می‌شوند 
 F-Curve دو  13ـ6  و  12ـ6  شکل‌های 
مکان‌های  در  آنها  کلیدهای  که  می‌بینید  را 
این  از  باشد  قرار  اگر  گرفته‌اند.  قرار  یکسانی 
استفاده  شیء  مکان  کنترل  برای  منحنی‌ها 
شود، حرکت شیء در هر دو منحنی از مکان 
یکسانی شروع و در مکان یکسانی نیز خاتمه 
می‌یابد. تفاوت این دو منحنی در اتفاقی است 
که برای شیء بین دو نقطۀ شروع و پایان رخ 

می‌دهد. 

شکل 12ـ6ـ درون‌یابی خطی

راست  سمت  کلید  در  که   Ease In Interpolation 13ـ6ـ  شکل 
اعمال شده است
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فرض کنید این دو F-Curve حرکت اتومبیلی را کنترل می‌کنند که قرار است در فریم نود پشت چراغ قرمز 
متوقف شود. در شکل اول، اتومبیل با سرعت یکنواختی )که با خط راست نشان داده شده است( حرکت کرده 
و ناگهان پشت چراغ قرمز متوقف می‌شود. هیچ مرحلۀ کاهش سرعتی وجود ندارد، بنابراین این حرکت کاملًا 
نود نزدیک‌تر می‌شود، صاف‌تر می‌شود. یعنی  به فریم  غیرواقعی است. در عوض، منحنی شکل دوم هرچه 
این که راننده درحال ترمز  اتومبیل هرچه به چراغ نزدیک‌تر می‌شود، کمتر می‌شود، درست مانند  سرعت 

گرفتن است، این حرکت واقعی‌تر است. 
F-Curve روشی ساده برای افزایش یا کاهش تدریجی سرعت در اختیار شما قرار داده، کمک می‌کند تا 
حرکتی واقعی‌تر را پایه‌ریزی کنید. به‌علاوه روشی گرافیکی برای کنترل انیمیشن‌های خود در اختیار خواهید 

داشت. 

البته بیشتر مواقع، ترجیح می‌دهید F-Curve را با استفاده از F-Curve Manager ویرایش کنید تا بتوانید 
دقت بیشتری را در ویرایش اعمال کنید. به‌علاوه، F-Curve Manager فرمان‌هایی را نمایش می‌دهد که در 
 F-Curve را باز می‌کنید، فهرست F-Curve Manager قابل‌دسترس نیستند. ضمناً زمانی که Timeline

)در سمت چپ( به صورت پیش‌فرض نمایش داده می‌شود. 

Timeline در F-Curve شکل 14ـ6ـ ویرایش

 F-Curve خودکار  به‌طور   Cinema 4D
می‌کند  ایجاد  متحرکی  پارامتر  هر  برای  را 
به  دسترسی  برای  باشد.  قابل‌میان‌گذاری  که 
 ،Timeline برای ترک موردنظر در F-Curve
باید روی نماد + در کنار نام ترک کلیک کنید. 
به این ترتیب می‌توانید F-Curve را مستقیماً 

در Timeline ویرایش کنید. 

F-Curve Manager شکل 15ـ6ـ
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  )Morph ابزار( Pose Mixer ساخت حرکات انیمیشن با

اگر ماژول اختیاری Mocca را نصب کرده باشید، با استفاده از ابزار PoseMixer می‌توانید ژست‌های مختلف را 
وارد کنید. در این صورت باید کادر انتخاب Import Poses /PLA را در حالت تأیید قرار داده باشید.

زمان آن رسیده که با ابزار Morph آشنا شویم. این ابزار بسیار شبیه به PoseMixer است، با این تفاوت که 
ایجاد ژست‌های مختلف در آن ساده‌تر است. هنگام استفاده از ابزار Morph نیازی نیست مش اولیه را کپی 
کنید. برای ذخیره‌سازی تمام ژست‌ها فقط به یک تگ نیاز دارید )تگ Morph(. ضمناً حجم فایل‌ها نسبت 

به زمانی که از PoseMixer استفاده می‌کنید بسیار کمتر است. 
نکته‌ای اصلی هنگام ایجاد ژست‌ها در صورت بسیار ساده است: تگ Morph را به مش اضافه کرده، مقصدهای 
Morph را ایجاد کرده و با جابه‌جا کردن نقاط، احساسات مختلف را در ژست موردنظر خود تصویرسازی 
کنید. کاربرد ابزار Morph فقط به ایجاد ژست‌های صورت محدود نمی‌شود و می‌توانید حرکات عضلات را 
نیز شبیه‌سازی کنید. فرض کنید ژست‌های صورت را طراحی کرده و ناگهان دریافتید که باید صورت را از نو 
مدل‌سازی کنید. مشکلی نیست! به کمک ابزار Knife می‌توانید جزئیات کاملًا جدیدی را اضافه کنید، بدون 

این که حتی لازم باشد ژست‌های موجود را از نو اضافه کنید.
قبل از این که بتوانید از کارکرد Morph استفاده کنید، ابتدا باید تگ Morph را اضافه کنید. برای ایجاد 
 Character کلیک راست کرده و گزینۀ Object Manager باید روی مش موردنظر خود در Morph تگ
Tags/Morph را انتخاب کنید. توجه داشته باشید که Base Morph و Morph Target از قبل و به صورت 

خودکار در Attribute Manager نسبت داده شده‌اند. 

Morph شکل 17ـ6ـ اضافه کردن تگ

Base Morph نقطۀ شروع است و نمی‌توانید آن را حذف کنید. Morph Target همان ژست نهایی است 
که قرار است آن را مدل‌سازی کنید. برخلاف Base Morph، می‌توانید Morph Target را به دلخواه ایجاد 

و یا حذف کنید. 
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  Timeline کنترل انیمیشن‌ها در

تقریباً  اجازه می‌دهد  به شما   Cinema 4D
تمام خصوصیات یک شی‌ء را متحرک کنید. 
یعنی می‌توانید هر یک از خصوصیات موجود 
 Y مختصات  از   Attribute Manager در 
شی‌ء گرفته تا رنگ نور را متحرک کنید. به 
این ترتیب می‌توانید به‌سادگی جلوه‌های ویژۀ 

جذابی در صحنه‌های خود ایجاد کنید. 
انیمیشن  با  کار  اولیۀ  اصول  با  که  این  برای 
آشنا شوید بهتر است کار را با صحنۀ جدید 
 Floor شی‌ء  یک  کنیم.  شروع  )خالی( 
را   Objects > Scene > Floor )فرمان 
)فرمان  مخروط  شی‌ء  یک  و  کنید(  انتخاب 
را   Objects > Primitives > Cone
را  مخروط  کنید.  ایجاد  را  کنید(  انتخاب 
کمی در امتداد محور Y به بالا ببرید تا روی 

سطح کف قرار گیرد. 

با استفاده از کادر Attribute Manager آنها را تغییر دهید.  مخروط خصوصیات زیادی دارد که می‌توانید 
مطمئن شوید صحنه در فریم صفر قـرار گـرفته است. کلید Ctrl را نگه داشته و روی دایرۀ سیاه رنگ مقابل 

Top Radius کلیک کنید تا رنگ آن قرمز شود. 

شکل 18ـ6ـ ایجاد مخروط

شکل 19ـ6ـ تنظیم خصوصیات مخروط



70

به این ترتیب به Cinema 4D اعلام می‌کنیم که خصوصیت Top Radius مخروط در ابتدای انیمیشن باید 
در فریم صفر باشد. دایرۀ قرمز رنگ در کنار خصوصیت نشان می‌دهد که در این نقطه از زمان انیمیشن یک 
کلید ایجاد شده است. اگر بار دیگر کلید Ctrl را نگه داشته و روی این دایره کلیک کنید، کلید حذف خواهد 

شد. 

شکل 20ـ6ـ صحنه اجرای مخروط 

این  در  مقابل خصوصیت  دایرۀ  بروید.  پنجاهم  فریم  به 
فریم توخالی است. یعنی این خصوصیت در نقطه‌ای از 
Timeline متحرک شده است اما در این نقطه کلیدی 

برای آن تنظیم نشده است. 
مقدار خصوصیت Top Radius را با 200 تنظیم کرده 
در  را  کنید. صحنه  ایجاد  نقطه  این  در  دیگری  کلید  و 
Editor اجرا کرده و ببینید که چگونه مخروط و مقدار 

آن در Attribute Manager تغییر می‌کند. 

مقدار خصوصیت Top Radius در فریم 50 باید 200 باشد. Cinema 4D تمام مقادیر بین این دو زمان 
را »   میان‌گذاری « می‌کند. 

حالا به فریم صفر برگشته و کلیدی را برای خصوصیت  Rotation Segments تنظیم کنید. به فریم 90 
رفته، تعداد بخش‌ها را با 3 تنظیم کرده و کلید دیگری را ایجاد کنید. انیمیشن را پخش کنید. 

شکل 21ـ6ـ تنظیم تعداد بخش‌ها
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این بار دو خصوصیت مخروط متحرک می‌شوند: تغییرات یکی بین فریم صفر و پنجاه و تغییرات دیگری بین 
فریم صفر تا نود است. Timeline را باز کرده )فرمان Window > Timeline را انتخاب کنید( یا به چیدمان 
Animation بروید )فرمان Window > Layout > Animation را انتخاب کنید(. در Timeline می‌توانید 

مخروط، خصوصیات متحرک شده و کلیدهای تنظیم‌شده را ببینید. 

پرسش‌های تشریحی  

١ مراحل انیمیت جا‌به‌جایی یک مکعب از چپ به راست را توضیح دهید.
٢ چگونه می‌توان از یک شیء به عنوان دوربینی برای دیدن در Viewport استفاده کرد؟

٣ دو روش برای متحرک‌سازی اجسام نام ببرید.
٤ نحوۀ استفاده از Align to spline tag را با ذکر مثال توضیح دهید.

٥ یکی از کاربردهای F-curve را نام ببرید.

پرسش‌های چندگزینه‌ای  

١ از F-curve در کدام گزینه نمی‌توان استفاده کرد؟
ب( نورهای متحرک 		 primitive الف( اشیای متحرک

د( دوربین‌های متحرک 		 ج(  سایه‌های متحرک

2 کدام یک از گزینه‌های زیر برای استفاده از Align to spline tag لازم است؟
Spline ب( یک شیء و یک 		 Spline و یک deformer الف( یک

Spline د( دو 		 primitive ج( دو شیء

3 برای کدام یک از گزینه‌های زیر می‌توان Key frame ایجاد کرد؟
ب( مقیاس 		  الف( مکان

د( هر سه گزینه 		  ج( چرخش

Timeline شکل 22ـ6ـ مشاهده موارد تنظیم‌شده در
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4 فریم‌های کلیدی در کدام بخش ایجاد می‌شوند و قابل‌کنترل هستند؟
Tools )ب 	Timeline )الف

Attribute Mananger )د 	Object Manager )ج

5 تگ‌ها به ما اجازۀ انجام چه کاری را می‌دهند؟
ب( حذف اشیا الف( تغییر اندازۀ اشیا	

د( هیچ کدام ج(  متحرک‌سازی اشیا  	

پروژۀ عملی   

یک ماشین را در طی مسیری از چپ به راست انیمیت کنید که چرخ‌هایش هم هنگام حرکت بچرخد. ماشین 
در ابتدا سرعتش زیاد و در انتهای حرکت سرعتش کم شود و سپس بایستد.



فصل 7

Expressions نحوۀ انیمیشن سازی با
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می‌رود:
  با نحوۀ انیمیشن‌سازی با Expression ها آشنا باشد.

  با گره‌ها آشنا باشد.

  با پورت‌ها آشنا باشد.

  با Wireها آشنا باشد.

  با Xgroup آشنا باشد.

به کمک Cinema 4D و در ویراستار Xpresso می‌توانید با برقراری لینک بین دو شی‌ء کاری کنید که 
با خم  مثلًا  بزنید.  پیوند  را درهم  اشیا  رفتارهای  ترتیب می‌توانید  این  به  برقرار کنند.  تعامل  با هم  بتوانند 
شدن آرنج، ماهیچه‌های بازو خودبه‌خود برآمده شوند یا مدلی بسازید که هرچند ثانیه یک بار پلک بزند یا 
 Expression حتی با فشار دادن کلید برق، چراغی روشن شود. به‌سادگی می‌توانید این رفتارها را که به آنها

می‌گویند، از طریق ویراستار Xpresso ایجاد کنید. 
برای ایجاد Expression جدید و باز کردن Xpresso Editor، در Object Manager شیئی را انتخاب 
کرده و فرمان File > Cinema 4D > Xpresso را انتخاب کنید. برای بستن یا باز کردن مجدد این ویراستار 

فقط باید روی تگ Xpresso Expression دابل کلیک کنید. 

گره‌ها   

گره‌ها قطعات سازندۀ Expressionها هستند. گره‌ها می‌توانند وظایف مختلفی را برعهده بگیرند، از گزارش 
شمارۀ فریم جاری انیمیشن گرفته تا تنظیم مکانی خاص برای شیء. برای ساخت Expression، باید ابتدا 
گره‌های موردنیاز را ایجاد کرده و آنها را به هم مرتبط سازید. برای این منظور باید خطوطی را که اصطلاحاً 
Wire نام دارند، بین پورت‌های ورودی و خروجی گره‌ها ترسیم کنید. به این ترتیب گره‌ها می‌توانند مقادیر 

خود را از طریق این پورت‌ها و وایرها با هم مبادله کنند.
در این شکل دو گره‌ مشاهده می‌کنید: 

یکی برای مکعب و دیگری برای استوانه. دایره‌های قرمز و آبی که هر دو با برچسب Rotation مشخص شده‌اند 
پورت‌ها هستند. پورت‌های قرمز رنگ خروجی بوده و مقادیر را به XGroup ها یا سایر گره‌ها می‌فرستند. پورت‌های 

شکل 1ـ7ـ گره‌ها

آبی رنگ ورودی بوده و مقادیر را از سایر گره‌ها یا 
XGroup ها دریافت می‌کنند. در این مثال، مقدار 
چرخش مکعب به استوانه منتقل می‌شود. به این 
 Viewport در  سمتی  همان  به  استوانه  ترتیب 
حرکت خواهد کرد که مکعب درحال حرکت است. 
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پورت‌ها 

 XGroup پورت‌ها، ورودی‌ها و خروجی‌های هر گره‌ یا
موردنظر  پورت  باید  پورت،  افزودن  برای  هستند. 
منوی  یا  رنگ(  آبی  )کادر   Inputs منوی  از  را  خود 
این  در  کنید.  انتخاب  رنگ(  قرمز  )کادر   Outputs
رنگ  به  شده‌اند  اضافه  قبلًا  که  پورت‌هایی  منوها، 

خاکستری نمایش داده می‌شوند. 

شکل 2ـ7ـ پورت‌ها

پورت‌های قرمز رنگ، پورت‌های خروجی هستند و مقادیر را به سایر گره‌ها یا Xgroupها ارسال می‌کنند. 
پورت‌های آبی رنگ، پورت‌های ورودی بوده و مقادیر را از سایر گره‌ها یا Xgroupها دریافت می‌کنند. برای 
اتصال پورت به پورت ورودی، دایرۀ پورت را کشیده و در محل موردنظر رها کنید. سیم )Wire( نمایان شده 

و پورت‌ها را به هم متصل می‌کند. 

 Wire   ها  

پورت‌های  ابتدا  باید  انتقال دهند،  یکدیگر  بین  را  مقادیر  بتوانند  تا  Xgroupها  و  گره‌ها  فعال کردن  برای 
موردنیاز را ایجاد کرده و آنها را با استفاده از Wire به هم متصل کنید. برای ایجاد Wire بین دو پورت، باید 

دایرۀ یکی از پورت‌ها را کشیده و آن را در پورت دیگر رها کنید. 

شکل 3ـ7ـ نحوه اتصال پورت‌ها
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هر پورت خروجی را می‌توانید به چندین پورت ورودی متصل کنید. به این ترتیب می‌توانید یک مقدار را به 
چندین گره‌ یا Xgroup ارسال کنید. برای اتصال پورت خروجی به پورت ورودی همان گره‌، باید گره‌ را کپی 
کرده )کلید Ctrl را نگه داشته و بکشید تا یک کپی ایجاد شود( و پورت خروجی اولین گره‌ را به پورت ورودی 

گره‌ دوم متصل کنید. 

 Xgroup   

از  را در خود جای می‌دهند.  آنها  اتصالات  و  Xgroup ها  Xgroup ها، ظرف‌هایی هستند که گره‌ها، سایر 
Xgroup ها می‌توانید برای سازمان‌دهی بهتر کارهای خود استفاده کنید. به این ترتیب پیمایش، اصلاح و 
کار با Expression ها ساده‌تر می‌شود. Xgroupها علاوه بر این که به‌عنوان ظرف عمل می‌کنند، می‌توانند 
آنها را در  Xgroup ها را ذخیره کرده و  نیز متصل شوند. می‌توانید  ‌XGroup های دیگر  به سایر گره‌ها و 

پروژه‌های دیگر مجدداً بارگذاری کنید. 

شکل 4ـ7ـ سیم‌ها

Xgroup شکل 5ـ7ـ
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 Attribute موردنظر خود را انتخاب کنید تا تنظیمات آن در Xgroup ها، بایدExpression هنگام ایجاد
Manager بارگذاری شود و بتوانید آنها را ویرایش کنید. برای انتخاب Xgroup باید روی نوار عنوان آن 
کلیک کنید. اگر می‌خواهید چندین Xgroup را انتخاب کنید، باید کادر انتخابی را روی تمام آنها ترسیم 
کرده یا ابتدا یک Xgroup را انتخاب کرده و سپس کلید Shift را نگه داشته و روی سایر Xgroup ها کلیک 

کنید تا انتخاب شوند. 

شکل 6ـ7ـ تنظیم شعاع استوانه‌ها

اکنون سه استوانه با شعاع‌های مختلف در صحنه داریم. هدف ما این است که جلوۀ تلسکوپی را ایجاد کنیم. 
برای این منظور باید کوچک‌ترین استوانه را به سمت بالا حرکت دهیم درحالی که استوانۀ متوسط در مرکز 

قرار گرفته و با استوانۀ کوچک حرکت می‌کند. 
 Object در  استوانه‌ها  از  یکی  روی  که  است  این  روش  سریع‌ترین  کنید.  اعمال  XPresso جدید  تگ  یک 
Manager کلیک راست کنید. فرمان Cinema 4D Tags > XPresso را انتخاب کنید. فرقی نمی‌کند تگ 
را در کدام شیء اعمال کنید. ویراستار XPresso باز می‌شود. هر سه شیء موجود در Object Manager را 
به سطح خالی ویراستار XPresso بکشید. اشیا تبدیل به کادرهای کوچکی می‌شوند که اصطلاحاً گره‌ نامیده 

می‌شوند. 

در ادامه قصد داریم نوعی بازوی تلسکوپی بسازیم. 
صحنۀ جدیدی را باز کنید. سه استوانه ایجاد کنید )فرمان 
انتخاب  را   Objects > Primitives > Cylinder
 ،»Cylinder-small« کنید(. نام آنها را به ترتیب
 »Cylinder-big« و   »Cylinder-medium«
شعاع   Attribute Manager در  بگذارید. 
شعاع  و   45 مقدار  با  را   Cylinder-medium

Cylinder-small را با مقدار 40 تنظیم کنید. 

XPresso Editor شکل 7ـ7ـ
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یا  اشیا  نشان‌دهندۀ  و  بوده   XPresso سازندۀ  قالب‌های  گره‌ها 
کارکردها هستند. هر گره دارای پورت‌های ورودی و خروجی است 
که به آن اجازه می‌دهد اطلاعات خود را با سایر گره‌ها تبادل کند. 
در  رنگ  آبی  کوچک  کادر  روی  باید  گره  ورودی  مشاهدۀ  برای 
گوشۀ سمت چپ بالای گره کلیک کنید. برای مشاهدۀ خروجی 
گره باید روی کادر قرمز رنگ کلیک کنید. به خروجی‌های گره‌های 
استوانه‌ها نگاه کنید. برخی از آنها برای شما آشنا هستند )آنها را 

در Attribute Manager دیده‌اید(. 
بهتر است ببینیم دقیقاً می‌خواهید چه اتفاقی بیفتد. می‌خواهیم 
استوانۀ کوچک را به سمت بالا بکشیم، یعنی مختصات Y آن را 
تغییر دهیم. این حرکت بر مختصات Y استوانۀ متوسط هم تأثیر 
می‌گذارد که باید دقیقاً در میانۀ استوانه‌های بزرگ و کوچک قرار 

گیرد. 
فرمان  و  کرده  کلیک   Cylinder-big رنگ  قرمز  کادر  روی 
کنید.  انتخاب  را   Coordinates > Position > Position Y

همین کار را برای Cylinder-small نیز انجام دهید. 
Y شکل 8 ـ7ـ تنظیم مکان

هر دو استوانه درحال حاضر می‌توانند از مختصات Y مربوط به خود عبور کنند. حالا نیاز به گره‌ خاصی داریم 
که بتواند مقدار میانگین این دو نقطه را محاسبه کند. 

به برگۀ X-Pool رفته و گره ‌Mix Operator را از System Operator به سطح دو گره‌ دیگر بکشید. در 
Attribute Manager مقدار Mixing Factor مربوط به گره Mix را به 50% تغییر دهید. 

Mixing Factor شکل 9ـ7ـ تنظیم مقدار
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با  را   Cylinder-small در   »Position Y« خروجی 
Cylinder- مرتبط کنید. خروجی Mix ورودی اول گره

big را با ورودی دوم گره Mix مرتبط کنید. 

هر دو مختصات Y اکنون به گره Mix انتقال یافته و 
میانگین مقادیر آنها به ترتیب محاسبه می‌شود. به این 
ترتیب مختصات Y برای استوانۀ وسطی تعیین می‌شود. 
روی کادر آبی رنگ گره Cylinder-Medium کلیک 
کنید تا ورودی برای مختصات Y باز شود )یا می‌توانید 
 Coordinates > Position > Position Y فرمان 
با ورودی گره  انتخاب کنید(. خروجی گره Mix را  را 

Cylinder-Medium مرتبط کنید. 

استوانۀ  شد.  خواهید  شگفت‌زده  کار  نتیجۀ  از  حالا 
کوچک را در امتداد محور سبز رنگ Y حرکت دهید. 

استوانۀ وسطی به‌طور خودکار با آن تراز می‌شود. 

شکل 10ـ7ـ تنظیمات اتصالات مناسب

Mix شکل 11ـ7ـ تنظیم خروجی گره

شکل 12ـ7ـ حرکت استوانه ای
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پرسش‌های تشریحی    

1 چند رفتار را که با Expression انجام می‌شود مثال بزنید.
2 گره‌ها را در Expression توضیح دهید. چه نقش و کاربردی دارند؟

3 تفاوت پورت‌های آبی با قرمز رنگ و کاربرد آنها را بنویسید.
4 پورت‌ها چه هستند و چگونه ایجاد می‌شوند؟

‌X group 5ها را تعریف کنید.

پرسش‌های چندگزینه‌ای  

1  ......... قطعات سازندۀ ‌Expressionها هستند؟
X group )ب الف( پورت‌ها	
د( هیچ کدام ج(  گره‌ها	

2  برای مرتبط ساختن گره‌ها به هم دیگر چه اقدامی باید انجام گیرد؟
ب( رسم خطوط wire بین پورت‌های ورودی و خروجی الف( ایجاد X-group اضافی	

د( ایجاد یک Expression جدید ج(  ایجاد یک پورت اضافی	

3 پورت‌های آبی چه پورت‌هایی هستند؟
ب( ورودی الف( خروجی	

د( فعال نشده ج(  قبلًا اضافه شده	

٤ وظیفۀ پورت‌های قرمز چیست؟
ب( دریافت مقادیر از سایر گره‌ها 		 الف( ارسال مقادیر به گره‌ها

د( وصل کردن دو پورت قرمز به یکدیگر ج(  وصل کردن دو پورت آبی به یکدیگر	

٥  هر پورت خروجی را می‌توان به چند پورت ورودی وصل کرد؟
ب( محدودیت ندارد الف( دو پورت	

د( ده پورت ج( هجده پورت	

پروژۀ عملی   

یک Expression بسازید که با کوچک شدن اندازۀ مکعب، حجم کره در محور Y حرکت کند.



فصل 8

نورپردازی
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می‌رود:
  با مفاهیم نورپردازی آشنا باشد.

  با منبع نور Omni آشنا باشد.

  با نورهای نقطه‌ای کار کند.

  با نورهای Parallel آشنا باشد.

  با نورهای نقطه‌ای Parallel آشنا باشد.

  نور Area را بشناسد.

  با ویژگی Ambient Occlusion آشنا باشد.

  با Sky Preset آشنا باشد.

  بتواند آسمان جذابی ایجاد کند.

در این بخش شما را بـا انـواع مختلف نـورهـای قـابل ‌رؤیت آشنا می‌کنیم کـه می‌توانید بـا استفاده از گـزینۀ 
Visible Light در صفحۀ General انتخاب کنید. 

انواع مختلف نورهای قابل رؤیت  

  Omni  

منبع نور Omni مانند حباب لامپ واقعی عمل کرده، پرتوهای نور را در تمام جهات منتشر می‌کند. اگر منبع 
نور Omni را در صحنه قرار دهید، کل صحنه به صورت یکنواخت روشن می‌شود. 

شکل 1ـ8 ـ روشن شدن کل صحنه
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 Spot & Square Spot  

نورهای نقطه‌ای پرتوهای خود را فقط در یک جهت منتشر می‌کنند که به صورت پیش‌فرض در امتداد محور 
Z است. به محض ایجاد این منابع نور، می‌توانید آنها را حرکت داده و بچرخانید تا تک‌تک اشیا و بخش‌های 

مختلف صحنه را با آن روشن کنید. منبع نور نقطه‌ای می‌تواند نور را به صورت دایره یا مربع بتاباند. 

شکل 2ـ8 ـ استفاده از منبع نور نقطه‌ای

 Parallel   

را در فاصلۀ دور  نوری  Parallel منبع  نورهای  قابل‌رؤیت رندر کرد.  نور  به صورت  را نمی‌توان  نور  نوع  این 
شبیه‌سازی می‌کنند. البته این منبع نور دارای مبدأ بوده و شبیه به دیوار بزرگی از نور است. ظاهر این نورها 
به گونه‌ای است که انگار نور از سطحی بزرگ به صورت پرتوهای موازی در یک جهت منتشر می‌شود. اجسامی 

که در پشت منبع نور قرار داشته باشند، روشن نمی‌شوند. 

شکل 3ـ8 ـ استفاده از نور موازی
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  Parallel Spot (round/square)  
نورهای نقطه‌ای Parallel مانند نورهای نقطه‌ای معمولی هستند با این تفاوت که مخروط نور ندارند و فاصله 
در آنها معنایی ندارد. در عوض، پرتوهای نور در امتداد استوانه یا میله‌هایی تابیده می‌شوند. منبع نور از این 
لحاظ اهمیت دارد که مشخص می‌کند کدام اشیای موجود در صحنه تحت تأثیر این نور قرار می‌گیرند. شعاع 

نور نقطه‌ای را می‌توانید با استفاده از دستگیره‌های موجود تنظیم کنید. 

شکل 4ـ8 ـ استفاده از نورهای نقطه‌ای موازی

  Area  

این نور را نیز مانند نور Parallel نمی‌توان به صورت منبع نور قابل‌رؤیت رندر کرد. پرتوهای نور Area از 
تمام نقاط روی سطح و در تمام جهات به سمت بیرون می‌تابند. صفحه‌نمایش مستطیل شکل رایانه نمونه‌ای 
از این نوع نور است. نور حاصل و جلوۀ آینه‌ای آن کمی متفاوت از نور Omni است. پرتوهای آینه‌ای تا حدی 
زاویه‌دار بوده و روشنایی سطح شدت بیشتری دارد. هرچه منبع نور به شیء نزدیک‌تر باشد، وضوح آن بیشتر 

خواهد شد. 

Area شکل 5ـ 8 ـ استفاده از نور
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 Ambient Occlusion  

معمولاً درجه روشنایی هر سطحی از روی زاویه‌ای تعیین می‌شود که اشعۀ نور به آن تابیده می‌شود. هرچه 
زاویۀ این اشعه و تانژانت آن با سطح بزرگ‌تر باشد، سطح با نور بیشتر روشن می‌شود. البته زمانی که ویژگی 
زاویه  این  دیگر  یعنی  نادیده گرفته می‌شود،  فیزیک  قانون  این  فعال می‌کنید،  را   Ambient Occlusion
اهمیتی نخواهد داشت. تمام قسمت‌های سطح با شدت یکسانی روشن خواهد شد. به این ترتیب تصویر کاملًا 

تخت خواهد شد. فقط از رنگ مَتریال برای محاسبات نورپردازی استفاده خواهد شد. 
اگر هم Ambient Occlusion و هم Falloff برای منبع نور فعال باشند، می‌توانید بخش‌های خاصی از 

صحنه را به همان صورتی روشن کنید که آنها را با استفاده از Negative Lighting تاریک‌تر کرده بودید. 
Ambient Occlusion (AO) در حقیقت نوعی تکنیک سایه‌زنی است و کاربرد آن به زمانی برمی‌گردد که 
هنوز استفاده از Global Illumination مرسوم نبوده است. امروزه رایانه ها بسیار قوی‌تر از زمانی هستند 
که از Ambient Occlusion استفاده می‌شد و درحال حاضر استفاده از Global Illumination بیشتر 
رایج است. البته هنوز هم Ambient Occlusion در موارد خاصی برای دستیابی به جلوه‌های خاصی مورد 

استفاده قرار می‌گیرد که عبارت‌اند از: 
  ایجاد کنتراست/تاری اضافی در مناطق مسدودشده برای ایجاد خلاقیت‌های هنری ـ زمانی که GI موفق 

به ایجاد این وضعیت نشده و نور زیادی در این مناطق نفوذ کرده است.
  برای ایجاد جلوه‌های غیرعادی مانند گرد و غبار یا کثیفی که با ادغام بافت‌های مختلف در مناطق مسدودشده 

صورت می‌گیرد. 
برای تنظیم خصوصیات Global Illumination و Ambient Occlusion به این شرح عمل کنید: 

ابزار Edit Render Settings را از پالت Command انتخاب کنید. پنجرۀ Render Settings نمایش داده 
 Global را انتخاب کنید. از منوی بازشوی نمایش داده شده گزینۀ Effect می‌شود. در این پنجره، دکمۀ

Illumination را انتخاب کنید. 
دکمۀ Effect را انتخاب کنید. منوی بازشویی نمایش داده می‌شود که در آن گزینۀ Ambient Occlusion را 
 ،Ctrl + R را ببندید. سپس با استفاده از کلیدهای Render Settings انتخاب کنید. پس از اعمال تنظیمات پنجرۀ

خروجی را در فریم نمایش داده شده رندر کنید. 

   Sky Preset آشنایی با

در هر پروژه‌ای، نورپردازی مهم‌ترین نقش را ایفا می‌کند تا عناصر واقعی و قابل‌باور به نظر برسند. اگرچه بافت 
و مَتریال در مدل‌سازی اهمیت زیادی دارند، اما برای نورپردازی اهمیت ویژه‌ای قائل شوید، زیرا بدون نور 
مدل‌ها اصلًا دیده نمی‌شوند. برای این که با تأثیرات نورپردازی بیشتر آشنا شوید، در این تمرین قصد داریم 
از مدلی به شکل قوطی اسپری رنگ استفاده کنیم. این مدل برای آشنایی با تکنیک‌های نورپردازی عالی 
است، چون هم ساده است و رندر کردن آن به زمان زیادی نیاز ندارد و همچنین از مَتریال‌های مختلفی در آن 
استفاده شده مانند نوک پلاستیکی و بدنۀ فلزی، می‌توانید تأثیرات مختلف نورپردازی را در آن بهتر ببینید. 
برای دستیابی به جلوه‌های واقعی نورپردازی باید بدانید از چه تنظیماتی برای رندر استفاده کنید تا بتوانید از 

جلوه‌های واقعی سایه و روشن‌ها بهره بگیرید. 
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Cinema 4D  در  Physical Sky بـا استفاده از ویـژگـی
می‌توانید از این تکنیک نورپردازی به سرعت بهره بگیرید، 
اما به خاطر داشته باشید این تکنیک در صحنه‌های فضای 

باز بهتر عمل می‌کند. 

ویژگی Physical Sky در زمانی کوتاه نتیجۀ فوق‌العاده‌ای 
بسته  ندارد.  هم  زیادی  تنظیمات  به  نیاز  و  می‌آورد  به بار 
به نوع صحنه ممکن است لازم باشد از شیء floor استفاده 
کنید. نیازی به تنظیم پس‌زمینه نیست، بنابراین با انتخاب 
فرمان Create > Environment > Floor از این شیء 
فضا شناور  در  رنگ  اسپری  نرسد  به نظر  تا  استفاده کنید 

است. 

حالا که شیء floor هم وارد عمل شده، می‌توانید مستقیماً 
در Viewport روی آیکن Render View کلیک کرده و 
این صحنه  رندر کنید. چون درحال حاضر هیچ نوری در 

اعمال نشده است، کیفیت رندر پایین است. 

Floor شکل 6ـ8 ـ استفاده از فرمان

Floor شکل 7ـ8 ـ استفاده از فرمان

Physical Sky شکل 8ـ8 ـ استفاده از ویژگی
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حالا باید از ویژگی Physical Sky استفاده کنیم. فرمان 
مشاهده  کنید.  انتخاب  را   Create > Physical Sky
جهت‌یابی  و  شده  روشن‌تر  به‌تدریج  صحنه  که  می‌کنید 
درست در مرکز دیده می‌شود. اگر بار دیگر صحنه را رندر 

کنید بلافاصله متوجه افزایش کیفیت خواهید شد. 

تشکیل  نیز  سایه  اکنون  و  شده  اضافه  زیبایی  و  نرم  نور 
شده است. اگر زاویۀ دوربین را تغییر داده و بار دیگر رندر 
کنید، می‌بینید که واقعاً آسمان به صحنه اضافه شده است. 
بسته به نوع صحنۀ مورد استفاده، ممکن است این ویژگی 
مفید واقع شود یا خیر. بهتر است ببینیم چگونه می‌توانیم 

کیفیت رندر را باز هم بیشتر افزایش دهیم. 

صفحۀ تنظیمات رندر را باز کرده و در منوی Effect گزینۀ 
Global Illumination را انتخاب کنید. 

ایجاد آسمان جذاب   

و  نهاده  فراتر  را  پا  می‌توانید  می‌بینید.  را  مختلف  تنظیمات  از  فهرستی   Global Illumination برگۀ  در 
 Physical قبلًا گزینۀ  انتخاب کنید. چون  را   Cinema 4D ارائه‌شده توسط  آمادۀ  از پیش‌فرض‌های  یکی 
 Global گزینۀ  برای  را   Exterior Physical Sky مقدار  بار  این  می‌توانید  بودیم،  کرده  انتخاب  را   Sky

Illumination انتخاب کنید.

شکل 9ـ8 ـ افزایش کیفیت رندر

 Global Illumination شکل 10ـ8 ـ انتخاب گزینه
Effect از منوی

Exterior Physical Sky شکل 11ـ8 ـ انتخاب مقدار
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بیشتر طول  ثانیه  رندر کنید، چند  دیگر  بار  را یک  اگر صحنه 
شود،  محاسبه   Global Illumination باید  زیرا  می‌کشد 

می‌بینید که کیفیت رندر بی‌نهایت بهتر شده است. 

برگردید   Render Settings صفحۀ  به  دوباره  اگر  پایان،  در 
می‌توانید گزینۀ Ambient Occlusion را فعال کنید، به این 
ترتیب سایه‌ها عمق بیشتری یافته و اسپری با وضوح بیشتری 

خودنمایی می‌کند. 

 Physical Sky فقط ظرف چند دقیقه توانستید پس از اعمال
به این تغییر بزرگ دست یابید.

 Physical Sky از  که  زمانی  گفتیم،  هم  قبلًا  که  همان‌طور 
نمایان  در صحنه  نیز  استفاده می‌کنیم، یک جهت‌یاب کوچک 
می‌شود. به کمک این جهت‌یاب می‌توانید جهت تابش خورشید 
را تغییر دهید. برای این منظور باید Physical Sky را انتخاب 
کرده، کارکرد چرخش را برای آن فعال کرده و با چرخاندن این 

جهت‌یاب، جهت تابش خورشید را تغییر دهید. 
و این تغییر را زمانی می‌بینید که صحنه را بار دیگر رندر می‌کنید. 
فقط با چرخش این جهت‌یاب می‌توانید ساعات روز را به‌سادگی 

تغییر دهید. 

شکل 12ـ8 ـ تغییر زاویه دوربین 
و رندر دوباره

شکل 13ـ8 ـ افزایش کیفیت رندر

شکل 14ـ8 ـ افزایش بیشتر 
وضوح اسپری

شکل 15ـ8 ـ ایجاد تغییری بزرگ 
Physical Sky با اعمال

شکل 16ـ8 ـ تغییر دادن جهش 
تابش خورشید
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پرسش‌های تشریحی   

1  نور Omni و ویژگی‌های آن را توضیح دهید.
2  دو نوع نور را که نمی‌توان به صورت نور قابل‌رؤیت رندر کرد نام ببرید.

3  نوری را نام ببرید که شبیه‌ساز نور آسمان است.
4  دو استفاده و کاربرد نور Ambient entocclusion را نام ببرید.

5  تفاوت نور parallel را با parallel splot ذکر کنید.

 پرسش‌های چندگزینه‌ای   

1  کدام یک از گزینه‌های زیر در گروه نورهای غیرقابل رؤیت در رندر هستند؟
Parallel spot )ب 	Parallel )الف

د( گزینه‌های الف و ج 	Area  )ج

2  کدام یک را می‌توان به عنوان نور لامپ استفاده کرد؟
Omni )ب 	Area )الف

parallel )د 	Spot square spot )ج

3 کدام یک از نورهای زیر تنها در یک جهت می‌تابند؟
Spot و Spot square )ب 	Omni )الف
Ambient occlusion )د 	 Area  )ج

4  با کدام یک از نورهای زیر می‌توان نور آسمان را شبیه‌سازی کرد؟
Omni )ب 	parallel )الف

Area )د 	Physical sky )ج

5 کدام یک از نورهای زیر پرتوهای نور را در همه جهات منتشر می‌کنند؟
Omni )ب 	 Spot و Spot square )الف

د( هیچ کدام 	Parallel spot  )ج

پروژۀ عملی 

یک بطری را در صفحه قرار دهید. با استفاده از نورها یک بار محیط یک استودیو و یک بار محیط باز در هنگام 
غروب آفتاب را نورپردازی کنید.





فصل 9

جنسیت سازی
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می‌رود:
  با مفهوم جنسیت‌سازی آشنا باشد.

  مفهوم مَتریال‌ )بافت( را بشناسد.

  چگونگی استفاده از جلوۀ Caustic را بداند.

  انواع Camera Mapping را بشناسد.

  بافت Texture Axis را بشناسد.

  با شیوۀ Texture آشنا باشد.

  با مفهوم Bodypaint 3D آشنا باشد.

مفهوم مَتریال‌ )بافت(   

شیء مدل‌سازی شده تا زمانی که از بافت مناسبی در آن استفاده نشده باشد تأثیر چندانی نخواهد داشت. 
به کمک بافت است که می‌توانید از رنگ، سایه و روشن، ساختار و سایر خصوصیات سطح در شیء استفاده 
بافتی که در کانال Bump مورد استفاده قرار می‌دهید، سطحی ناهموار و برآمده در  کنید. به‌عنوان مثال 
شیء ایجاد می‌کند بدون این که در ساختار هندسی آن تغییری ایجاد کند. از این جلوه می‌توانید برای ایجاد 
چین و چروک، زخم‌ها یا جلوۀ پوست پرتغالی استفاده کنید. کانال‌های جابه‌جایی نیز به همین روش عمل 
 Luminance می‌کنند، با این تفاوت که عملًا ساختار هندسی شیء را نیز تغییر می‌دهند. با استفاده از کانال
می‌توانید این خصوصیت را در سطح شیء اعمال کرده، جلوه‌ای نیمه‌شفاف یا براق به شیء دهید که برای 
ایجاد جلوه‌هایی نظیر پوست صورت انسان یا موم شمع مناسب است. به‌طور خلاصه، بافت‌ها به همان اندازۀ 
شکل ظاهری شیء اهمیت دارند، زیرا به کمک آنها می‌توانید رنگ‌بندی، ساختار سطح و طرح‌های مختلف 

را در شیء اعمال کنید. 

ابتدا بهتر است با کانال‌های مَتریال بیشتر آشنا شوید: 
Color : به کمک این کانال می‌توانید رنگ مَتریال‌ها یا رنگ مبنای بافت را تنظیم کنید. 

Diffusion : به کمک این کانال می‌توانید از بافتی غیرعادی استفاده کنید، مثلًا می‌توانید از ظاهری کثیف 
یا خاک‌آلود در شیء استفاده کنید.

 Global محاسبات  در  که  می‌دهد  قرار  تأثیر  تحت  را  روشنایی  خصوصیت  مَتریال  این   :  Luminance
Illumination نیز مورد استفاده قرار می‌گیرند. 

Transparency : این‌جابجایی است که شفافیت مَتریال را مشخص می‌کنید. 
Environment : بافتی مورد استفاده قرار می‌گیرد که محیط را شبیه‌سازی می‌کند. 

Fog : این کانال به شما امکان می‌دهد خصوصیت مه را در مَتریال اعمال کنید. 
Bump : با استفاده از سایه و روشن در بافت عناصر، سطحی ناهموار یا تصور عمق را به وجود می‌آورد. 
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Normal : از این کانال برای بافت‌های مرسوم استفاده می‌شود. 
Alpha : شفافیت بافت از روی مناطق تیره و روشن بافت سنجیده می‌شود. سیاه برابر با شفافیت 100% و 

سفید برابر با مات است. 
Displacement : با استفاده از مقادیر تیره و روشن شکل شیء را تغییر می‌دهد )آن را با Bump اشتباه 

نگیرید که سطح ناهموار ایجاد می‌کند(. 

 Caustic چگونگی جلوۀ

آیا تا به حال به انعکاس نور در کف استخر دقت کرده‌اید؟ این پدیده Caustic نام دارد نور از مادۀ شفافی عبور 
کرده، در محل ورود شکسته و خارج می‌شود.

صحنه‌‌ای جدید )خالی( ایجاد کنید. شیء Floor را ایجاد کنید 
)فرمان Objects > Scene > Floor را انتخاب کنید(. یک شیء 
منشوری ایجاد کرده )فرمان Objects > Scene > Platonic را 
انتخاب کنید(، مختصات Y آن را در Attribute Manager به 

140 تغییر دهید. 

کنید.  ایجاد   Material Manager در  را  جدیدی  مَتریال 
فعال   Attribute Manager در  را   Transparency کانال 
کرده و به منوی Transparency بروید. رنگ را به آبی تغییر 
مَتریال  و  داده  تغییر   ١/٤ به  را   Refraction گزینۀ  دهید. 
 Object در Platonic به شیء Material Manager از را 

Manager بکشید. 

از شیء عبور  نور  به همان شکل رها کنید،  را  اگر تنظیمات 
ایجاد  نقطه‌ای  نور  یک  نمی‌افتد.  اتفاق  نور  شکست  و  کرده 

Caustic شکل 1ـ9ـ پدیده

Material Editor شکل 2ـ9ـ
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کنید )فرمان Objects > Scene > Spot Light را انتخاب کنید(. آن را در 
محلی با این مختصات قرار دهید: Y = 300 ،X = 270 وZ = -100 . با استفاده 
از Attribute Manager زوایا را به صورت H = 70 و  P = - 25 تنظیم کنید. 
به این ترتیب نور پس از تابیدن به شیء به کف منتقل می‌شود. صحنه را 

رندر کنید. 
شکل 3ـ9ـ رندر صحنه نور

بخشی از نور روی شیء و بخشی دیگر روی زمین منعکس می‌شود، اما هنوز هیچ جلوه‌ای از بازتاب نور در 
 Attribute در Caustic جایی دیده نمی‌شود ابتدا باید جلوه را فعال کنید. ابتدا نور را فعال کرده و به صفحۀ

Manager بروید. کادر انتخاب Surface Caustic را در حالت تأیید قرار دهید. 

Surface Caustics شکل 4ـ9ـ تأیید کادر انتخاب

انتخاب کنید( و گزینۀ  را   Render > Render Settings باز کرده )فرمان  را   Render Settings منوی 
Caustic را از منوی Effects انتخاب کنید. 

Render Settings شکل 5ـ9ـ کادر محاوره‌ای
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صحنه را رندر کنید. جلوۀ Caustic به وضوح در کف زمین مشخص 
است. 

شکل 6ـ9ـ صحنه رندرشده
 Camera Mapping انواع

به خاطر داشته باشید Camera Mapping محدودیت‌هایی دارد. برای مثال نمی‌توانید به صورت 360 درجه 
دور یک ساختمان بچرخید. 

Camera Mapping شکل 7ـ9ـ استفاده از

هنگام استفاده از Camera Mapping، بافت از دوربین روی شیء منتقل می‌شود. فرض کنید می‌خواهید از 
عکسی استفاده کرده و کاری کنید تا با مدل‌ها تعامل برقرار کند. برای مثال، شاید بخواهید آدمکی سه‌بعدی 
در پشت اشیای موجود در عکس راه برود! Camera Mapping کمک می‌کند تا این ترفند را به کار بگیرید. 
مَتریال جدید   Luminance را در کانال  باید عکس  ایجاد کنید. سپس  را   Background باید شیء  ابتدا 
بارگذاری کنید. مَتریال را در شیء Background و با استفاده از Camera Mapping اعمال کنید. برای 
این منظور باید دوربینی داشته باشید تا مَتریال را در شیء منعکس کند. به این دوربین در Viewport سوئیچ 

کنید )در Viewport فرمان Cameras > Scene Cameras را انتخاب کنید(. 
حالا باید )مدل( هر شیئی را در تصویر واقعی بازسازی کنید که قرار است آدمک سه‌بعدی )یا هر شیء دیگری( 
از پشت آن حرکت کند. فرض کنید می‌خواهید آدمک سه‌بعدی از پشت صندوقچه‌ای که در عکس قرار دارد 
حرکت کند. باید صندوقچه را به صورت سه‌بعدی بسازید و این کار بسیار ساده است فقط باید صفحه‌نمایشی 
برای بافت صندوقچه ایجاد کنید. حالا باید بافت پس‌زمینه را در اشیای بازسازی‌شده )مثلًا صندوقچه( و با 

استفاده از Camera Mapping منعکس کنید. حالا آدمک می‌تواند در پشت صندوقچه حرکت کند! 
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 Texture Axis   

این ابزار به شما امکان می‌دهد محورهای بافت و بافت فعال را ویرایش کنید. به محض این که ابزار را انتخاب 
می‌کنید، بافت شیء و طرح آن نمایان می‌شود. برای جابه‌جایی، چرخش و تغییر مقیاس طرح به روش‌های 

مرسوم استفاده کنید )با کشیدن درحالی که ابزار Scale ،Move یا Rotate انتخاب شده است(. 
تفاوت بین Texture و Texture Axis در شکل‌های 8ـ9 و 9ـ9 مشاهده می‌شود. در هر دو مورد حرکت 
در امتداد محور X صورت می‌گیرد. در شکل8 ـ9 جابه‌جایی با استفاده از ابزار Texture و در شکل 9ـ9 

جابه‌جایی با استفاده از ابزار Texture Axis صورت گرفته است. 

شکل 8ـ9ـ Texture جابه‌جایی با استفاده از ابزار

Texture Text شکل 9ـ9ـ جابه‌جایی با استفاده از ابزار

 Texture شیوۀ  
به کمک این شیوه می‌توانید بافت فعال را ویرایش کنید. به محض انتخاب این ابزار، بافت شیء نشان داده 

شده و خطوط مشبک نمایان می‌شوند. خصوصیات نگاشت نیز مورد استفاده قرار می‌گیرند. 
خطوط مشبک براساس نوع تابش نور مشخص می‌شوند، به‌عنوان مثال برای نگاشت کروی از خطوط مشبک 
کروی استفاده می‌شود. فقط نگاشت UVW از این قاعده مستثنی است. در این حالت خطوط مشبک در کل 

Viewport نمایش داده می‌شود. 
ابزارهای Scale ،Move و  از  با استفاده  محورهای بافت شیء را می‌توانید در امتداد سطح حرکت داده و 

Rotate بچرخانید. 
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به کمک دکمه‌های چپ و راست ماوس و کشیدن می‌توانید بافت را در امتداد محور X و با استفاده از کشیدن 
به بالا و پایین می‌توانید آن را در امتداد محور Y حرکت دهید. کارکرد Scale بر همین اساس عمل می‌کند، 

اما به این ترتیب دیگر بافت حرکت نمی‌کند، بلکه اندازۀ آن تغییر می‌کند. 
داده‌های X و Yـ بسته به مکان و ابعاد بافت در Coordinate Managerـ همیشه به صورت درصد نمایش 
داده می‌شود، چون اندازۀ واقعی اهمیتی ندارد. اندازۀ 100% در هر دو مختصات به این معناست که بافت هر 

دو سطح را به‌طور کامل پوشانده است. 

   Bodypaint 3D آشنایی با مفهوم

Bodypaint 3D روشی کاملًا جدید برای کار با بافت‌ها است. با استفاده از این ماژول می‌توانید روی مدل‌ها 
به همان صورتی که هستند رنگ‌آمیزی کنید: به صورت سه‌بعدی. به‌علاوه، Bodypaint 3D به شما امکان 
RayBrush حتی  به کمک  کنید.  رنگ‌آمیزی  بافت  مختلف  کانال  در چندین  به صورت هم‌زمان  می‌دهد 
می‌توانید مستقیماً روی خود تصویر رندرشده رنگ‌آمیزی کنید. Projection Painting ابزاری است که به 

کمک آن می‌توانید روی اشیای پیچیده رنگ‌آمیزی کنید بدون این که باعث تغییر شکل شود. 
با استفاده از ابزارهای UV می‌توانید با آسودگی خاطر مش UV را هر چقدر هم که پیچیده باشد ترسیم 
کنید. به عبارت ساده‌تر، مش UV یکی از انواع مش چندضلعی است که به کمک آن می‌توانید بافت را روی 
پایان رسیده و  به  بعدی  به صورت دو  بافت‌ها  از  استفاده  قرار دهید. روزگار  استفاده  شیء چندضلعی مورد 
از بافت‌ها تمرکز کنید: خلاقیت. هر کاری که در  بالاخره زمانی رسیده که می‌توانید روی اهمیت استفاده 
فضای دو بعدی بافت‌ها انجام می‌دادید و بسیار زمان‌بر بود، با استفاده از Bodypaint 3D قابل‌انجام است و 

می‌توانید پروژه‌های خود را سریع‌تر تحویل دهید. بهتر است با رابط کاربر بیشتر آشنا شویم. 

Bodypaint 3D شکل 10ـ9ـ رابط کاربر
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 )»BP 3D Paint«( طرح‌بندی بعدی .»BP UV Edit« :در این تصویر یکی از دو طرح‌بندی استاندارد را مشاهده می‌کنید
به همین روش تنظیم می‌شود، فقط فاقد پنجرۀ ویراستار meshـUV است و به این ترتیب فضای بیشتری 

برای رنگ‌آمیزی در اختیار دارید. 

 Editor Window (RayBrush Window) 1
که در آن می‌توانید شیء در حال رنگ‌آمیزی را ببینید. در صورت لزوم می‌توانید پنجره را چرخانده، آن را 
حرکت داده و بزرگ‌نمایی کنید. وضعیت RayBrush به شما امکان می‌دهد مستقیماً روی شیء در نگارش 
رندرشده رنگ‌آمیزی را انجام دهید. به این ترتیب می‌توانید مقدار رنگ اعمال‌شده را کنترل کرده و به محض 

اعمال رنگ جدید روی شیء تأثیر آن را ببینید. 

 Texture Window (UVـmesh Editor Window) 2
همان جایی است که مش UV را ویرایش می‌کنید. به‌سادگی می‌توانید مش UV را بازیابی کنید. اگر از 
ابزارهای UV Manager استفاده می‌کنید، می‌توانید کاربرد بافت‌ها را مشاهده کنید. در این پنجره حتی 

می‌توانید جزئیات مراحل کار رنگ‌آمیزی را دنبال کنید. 

UV Manager 3
 به شما امکان می‌دهد مش UV را با استفاده از الگوریتم بازیابی کنید. این پنجره چندضلعی‌های چندلایه‌ای 
را شناسایی کرده و از مش‌ UV در تمام نقاط سطح آن‌ و حتی در صورت لزوم در نقاط دیگر تعیین‌شده 

استفاده می‌کند. سایر مراحل را می‌توانید به صورت دستی اعمال کنید. 

Active Tool 4 پنجرۀ
 UV ابزارهای  نیز  و  هرکدام  به  مربوط  خصوصیات  و  قلم‌موها  مختلف  انواع  که  دارد  مختلفی  برگه‌های   

Manager را نمایش می‌دهد. 

Texture Layers و Material Manager 5
 مطمئناً لازم نیست در مورد Object Manager توضیح زیادی بدهیم. درست مانند همین Manager در 
برنامۀ اصلی Cinema 4D است و به شما امکان می‌دهد شیئی را که می‌خواهید ویرایش کنید انتخاب کرده 

یا مکان آن را در سلسله‌مراتب تغییر دهید. 
Texture Layers همان Material Manager خود برنامۀ Cinema 4D است که کارکردهای بیشتری 
را ارائه می‌دهد. این‌جا، جایی است که بافت‌ها و لایه‌های مربوط به هرکدام را خواهید یافت. در صورت لزوم 
می‌توانید چندین لایه را به صورت هم‌زمان رنگ‌آمیزی کنید )مانند کانال‌های Color و Bump(. برای این 

منظور فقط باید بافت‌های موردنظر و لایه‌های مربوط به هر کدام را انتخاب کنید. 

Command 6 پالت
این پالت حاوی Projection Painting ،Paint Wizard و ابزارهای متعدد دیگری است )که احتمالاً قبلًا 
 BodyPaint 3D هم در برنامه‌های رنگ‌آمیزی دو بعدی مورد استفاده قرار می‌دادید(. با استفاده از ویزارد
دیگر لازم نیست بافت و مش UV آن را به صورت دستی ایجاد کنید. ضمناً این ویزارد اندازۀ بافت و کانال‌ها 
را نیز محاسبه می‌کند. بلافاصله می‌توانید رنگ‌آمیزی را شروع کنید و نیاز به انجام این محاسبات وقت‌گیر 

ندارید. 
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پرسش‌های تشریحی   

1     تأثیر کانال Bump را روی شی‌ء توضیح دهید.
2  از کانال Bump برای ایجاد چه کارهایی می‌توان استفاده کرد؟ دو مورد را نام ببرید.

3  کاربرد کانال Diffusion  در متریال چیست؟
4  از Texture axis چه استفاده‌ای می‌شود؟

5  کانال Displacement در متریال چه کاربردی دارد؟

پرسش‌های چندگزینه‌ای     

1  با استفاده از سایه روشن در بافت عناصر، سطحی ناهموار یا تصور عمق را به‌وجود می‌آورد.
این جمله کاربرد کدام یک از گزینه‌های زیر را توضیح می‌دهد؟

Fog )د 	 Bump  )ج 	Color )ب 	Transparency )الف

2  کدام یک جلوه‌ای نیمه‌شفاف یا شفاف را به شی‌ء می‌دهد؟
Transparency )د 	Alpha  )ج 	Fog )ب 	Normal )الف

3  کدام ابزار به شما امکان ویرایش بافت‌ها را می‌دهد؟
د( هیچ کدام 	Bump ج(  کانال 	Texture axis )ب 	Bodypaint  )الف

4  کدام ابزار به ما امکان رنگ آمیزی روی تصویر رندر شده را می‌دهد؟
Ray Brush )د 	Camera mapping )ج 	Bodypaint )ب 	Texture axis )الف

5 در کدام پنجره می‌توان مش را ویرایش کرد؟
UV mananger )ب 		 Texture window )الف

Material manager )د 	                          Editor window  )ج

پروژۀ عملی  

با استفاده از یک شیء primitive یک جلوۀ Caustic بسازید. یک کاراکتر را انتخاب کنید. به آن متریال 
پوست را بدهید و به دلخواه روی بدن آن رنگ‌آمیزی کنید.





فصل 10

ابزار Brush و ساخت مو   
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می‌رود:
  با ابزار Brush و ساخت مو آشنا باشد.

  شیوه‌های رسم RayBrush Render View را بداند.

  مفهوم چندکاناله و لایه‌ها را بشناسد.

  چگونگی استفاده از Hair Module را بداند.

  نحوۀ افزودن مو به کاراکتر را بداند.

کنار  )در   Type کشویی  فهرست  از  استفاده  با  می‌دهد.  ارائه  قلم‌موها  بر  کاملی  کنترل   BodyPaint 3D
 .Bitmap یا Generic :می‌توانید نوع قلم‌مو را انتخاب کنید )Brush Preview

Generic  

برای تنظیم نوک قلم‌موی Generic Brush می‌توانید از گزینه‌ها و لغزنده‌های زیر استفاده کنید: 
 Size                          Profile                         Shape  

 Squeeze                           Spacing                      Hardness  

 Rotation  

  Bitmap  

می‌توانید از هر نقش بیتی موجود در پوشۀ Library یا Pattern در BodyPaint 3D به‌عنوان نوک قلم‌مو 
استفاده کنید، اما نکات زیر را به خاطر داشته باشید: 

BodyPaint 3D از نقش‌بیتی‌های موجود در پوشۀ Pattern به صورت تصاویر سیاه و سفید استفاده می‌کند. 
و  سیاه  به صورت  را  آنها   BodyPaint 3D اما  کنید،  استفاده   RGB رنگ  با  نقش‌بیتی‌هایی  از  می‌توانید 
سفید مورد استفاده قرار می‌دهد. بخش‌های سیاه رنگ نشان‌دهندۀ مناطق شفاف و بخش‌های سفید رنگ 

نشان‌دهندۀ مناطق مات هستند. 

   RayBrush Render View شیوه‌های رسم

انتخاب این فرمان می‌توانید رندر RayBrush )یعنی پیش‌رندر( را در نمای فعال اعمال کنید. این کار  با 
چند ثانیه طول می‌کشد و به محض تکمیل شدن وارد وضعیت Raybrush شده و می‌توانید در نمای فعال 

رنگ‌آمیزی را انجام دهید. 
به محض این که شیء را حرکت داده، آن را تغییر مقیاس داده یا هر تغییری را در نما یا شیء ایجاد کنید، 

این وضعیت غیرفعال خواهد شد. 
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مفهوم چندکاناله و لایه‌ها   

هر بافتی در ابتدا فقط یک لایه دارد: لایۀ Background. لایۀ Background را مانند بوم نقاشی در نظر 
بگیرید، درست مانند بوم واقعی، می‌توانید روی لایۀ Background نقاشی کنید و درست مانند بوم واقعی 
اگر اشتباهی صورت گیرد در مراحل بعدی کار، حذف آن سخت خواهد بود. راه‌حل این مشکل استفاده از 
لایه‌ها است. لایه‌ها مانند برگه‌های شفافی هستند که روی لایۀ Background قرار گرفته‌اند. روی هریک از 
این لایه‌ها می‌توانید رنگ‌آمیزی کنید و در بخش‌هایی که رنگ‌آمیزی صورت نگرفته باشد لایۀ زیرین دیده 
می‌شود. زمانی که هریک از جلوه‌ها را روی لایه‌ای جدا از پس‌زمینه اعمال می‌کنید، آن جلوه مستقل عمل 

کرده و در صورت لزوم با حذف لایه می‌توانید آن جلوه را نیز حذف کنید. 
یا  انتخاب، جابه‌جا  از لایۀ پس‌زمینه و لایه‌های دیگر  به صورت مستقل  را  از لایه‌ها  می‌توانید هریک  ضمناً 
رنگ‌آمیزی کنید. به‌علاوه هر لایه دارای تنظیمات Blending Mode و Strength مخصوص به خود است 
و به این ترتیب ایجاد و تنظیم جلوه‌ها بسیار ساده‌تر خواهد شد. بیشتر فرمان‌های منوی Layer فقط بر لایۀ 
فعال تأثیر می‌گذارند )یعنی همان لایه‌ای که در Material Manager کادر قرمز کمرنگی در کنار آن دیده 
می‌شود(. با استفاده از آیکن‌هایی که به شکل چشم هستند می‌توانید لایه‌ها را پنهان کنید. با هر بار کلیک 
کردن روی آیکن چشم می‌توانید لایه را پنهان کرده یا آن را مجدداً نمایش دهید. توجه داشته باشید که اگر 

لایه‌ای پنهان شده باشد دیگر نمی‌توانید روی آن رنگ‌آمیزی کنید. 

   Hair Module چگونگی استفاده از

انواع مختلف مو و خز  ایجاد  ابزاری قدرتمند برای   HAIR
است. حتی پر، علف‌های متحرک، … و موارد بسیار دیگری 

را نیز می‌توانید با استفاده از این ابزار ایجاد کنید. 
 HAIR ابزار  از  استفاده  با  نتایج  اولین  به  دستیابی  اگرچه 
نسبتاً ساده است، این ماژول آنقدر جامع و کامل است که 

می‌تواند تمام نیازهای شما را برآورده سازد. 
برای دسترسی به این ماژول می‌توانید از منوی اصلی استفاده 

کنید که در بالای رابط کاربر استاندارد قرار دارد. 

شکل 1ـ10ـ انتخاب Hair از منوی اصلی
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روش کار ماژول Hair به این صورت است که از راهنماهایی 
استفاده می‌کند که به‌عنوان مکان‌یاب برای موهای رندر شده 

عمل می‌کنند. 

تعداد این راهنماها که در نمای ویراستار نمایش داده می‌شود 
کمتر از تعداد واقعی موهایی است که در نهایت رندر خواهند 
شد. البته می‌توانید تعداد راهنماهای نمایش داده‌شده را نیز 
راهنماها  این‌  میان  در  افتاده  قلم  از  موهای  دهید.  افزایش 
در حین رندر »میان‌گذاری« می‌شوند. به‌طور طبیعی نیاز به 
ابزارهایی برای آرایش مو دارید تا شکل و شمایل بهتری به 
 ،Comb ،Brush موها بدهید. در میان این ابزارها می‌توانیم از

Scissors و غیره نام ببریم. 

کاملًا  مو  حرکت  کنید  کاری  می‌توانید  ماژول  این  کمک  به 
واقعی به نظر برسد. حتی می‌توانید برخی Modifireها مانند 
باد را با شیء مو همراه کرده و کاری کنید حرکت مو کاملًا 

طبیعی به نظر برسد. 

نحوۀ افزودن مو به کاراکتر 

تمرین  این  انجام  برای  که  بیابید  را  مویی  بدون  کاراکتر 
مناسب باشد. تنها با چند کلیک سادۀ ماوس می‌توانیم این 
آماده  زمستان  برای  تا  بپوشانیم  خز  با  را  مو  بدون  کاراکتر 
شود. کاراکتری با ساختاری ساده را انتخاب کنید تا انجام کار 

ساده‌تر شود. 

Hair شکل 2ـ10ـ روش کار ماژول

شکل 3ـ10ـ ابزارهای آرایش مو

شکل 4ـ10ـ کاراکتری بدون مو
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مو را می‌توانید در کل شیء یا فقط در بخش‌های چندضلعی 
مختلف  بخش‌های  در  می‌توانید  حتی  کنید.  اعمال  انتخابی 
 Object به  کنید.  استفاده  خز  یا  مو  مختلف  انواع  از  بدن 
کنید.  انتخاب  را   Bear-mesh شیء  و  رفته   Manager
مطمئن شوید ابزار Polygon در پالت Tool در سمت چپ 
رابط کاربر انتخاب شده باشد. چندضلعی‌هایی که قرار است 
مو در آنها اعمال شود باید از قبل انتخاب شده باشند. فرمان 
Hair > Add Hair را از منوی اصلی Cinema 4D انتخاب 
کنید. راهنماهایی که قبلًا در مورد آنها صحبت کردیم از بدن 

کاراکتر منشعب می‌شوند. 

راهنماها در تمام جهات از هر سطحی به بیرون منشعب می‌شوند 
و طول آنها به صورت پیش‌فرض 100 است. حالا بهتر است کار 
را تا این مرحله رندر کرده و ببینید صحنه به چه شکلی درآمده 
است )فرمان Render > Render View را انتخاب کرده یا 

روی دکمۀ Render کلیک کنید(. 

لباس شویی خارج  از دستگاه خشک‌کن  که  است  این  مانند 
شده است. با انجام تنظیمات بعدی می‌توانید ظاهر زیباتری 

به کاراکتر خود ببخشید. 
زمانی که مو را به کاراکتر خود اضافه می‌کنید، مَتریال مربوطه 

به‌طور خودکار در Material Manager نمایان می‌شود. 

Add Hair شکل 5ـ10ـ استفاده از ابزار

Render View شکل 6ـ10ـ اعمال فرمان

Material Manager شکل 7ـ10ـ
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شیء HAIR در بالای فهرست اشیا در Object Manager دیده می‌شود. 

قبل از شروع به ویرایش مَتریال و شیء HAIR، باید کمی راهنماها را کوتاه‌تر کنید )تا در نهایت موها کوتاه‌تر 
 Object را در HAIR کمی سبک قرارگیری موها را تغییر دهید. شیء Gravity شوند( و با اعمال ویژگی
Manager انتخاب کنید. به Attribute Manager رفته و برگۀ Guides را فعال کنید. این برگه حاوی 

تنظیمات Length و Segments است. 

Object Manager در Hair شکل 8ـ10ـ شیء

Object Manager در Guide شکل 9ـ10ـ برگه

مقدار Length را به 21 و مقدار Segments را به 6 تغییر دهید. مقدار Segments نشان می‌دهد هر مویی 
که از راهنما منشعب می‌شود از چند بخش تشکیل شده است. اگر مقدار Segments را با 1 تنظیم کرده 
باشید، یعنی فقط از یک بخش تشکیل شده است و ویژگی Gravity روی آن تأثیری نخواهد داشت. در این‌جا 

از مقدار 6 استفاده می‌کنیم، یعنی مو در امتداد خود می‌تواند از پنج نقطه خم شود. 
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 Surface to Hair تنظیمات  و  رفته   Forces برگۀ  به  حالا 
استفاده   Gravity از  که  زمانی  ترتیب،  این  به  کنید.  فعال  را 
می‌کنید، هنوز هم موها شکل مش چندضلعی را حفظ می‌کنند. 
 Object در  کاراکتر  به  مربوط  شیء  روی  منظور  این  برای 
Manager کلیک کرده و تگ Collision را به آن نسبت دهید 
)کلیک راست کرده و فرمان Hair Tags > Hair Collider را 

انتخاب کنید(. 

Collision شکل 10ـ10ـ نسبت دادن تگ

اکنون اگر انیمیشن را اجرا کنید، خواهید دید که موها به سمت پایین امتداد می‌یابند. 

شکل 11ـ10ـ اجرای انیمیشن

به نمای سمت چپ در پنجرۀ Editor رفته و ابزار Cut را فعال کنید )فرمان Hair > Tools > Cut را 
انتخاب کنید(. سپس کادر انتخاب Only Visible را در Attribute Manager از حالت تأیید خارج کنید تا 
مطمئن شوید موهای بخش‌هایی که قابل رؤیت نیستند نیز کوتاه خواهند شد. حالا گزینۀ Form را با مقدار 
Circle تنظیم کرده و کار کوتاهی مو را آغاز کنید. برای کوتاه کردن مو، فقط باید روی نوک آبی رنگ موها 

کلیک کرده و بکشید. موها را کوتاه کنید تا به شکل 12ـ10 دست یابید. 

شکل 12ـ10ـ کوتاه کردن مو
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 Hair > Tools > Brush را فعال کنید )فرمان Brush حالا به نمای روبه‌رو رفته و موها را به دلخواه مرتب کنید. ابزار
را انتخاب کنید(. تنظیمات Collision را فعال کنید. به این ترتیب زمانی که از ابزار Brush استفاده می‌کنید، موها 

سیخ سیخ نمی‌شوند. همچنان باید کادر انتخاب Visible Only را از حالت تأیید خارج کرده باشید. 
هنگام مرتب کردن موها مرتب به نماهای مختلف بروید. برای استفاده از ابزار Brush فقط باید روی نوک آبی 
رنگ موها کلیک کرده و بکشید. برای ایجاد خز، باید کمی راهنماها را بیرون کشیده و نوک آنها را به سمت 

بالا خم کنید. با توجه به شکل 13ـ10، می‌توانید برای استفاده از این ابزارها ایده‌ بگیرید. 

شکل 13ـ10ـ استفاده از ابزارهای مرتب کردن موها

شکل 14ـ10ـ شکل واقعی کاراکتر

پس از این که به نتیجۀ دلخواه خود دست یافتید به نمای 
کرده  رندر  را  نما  بروید.   Editor پنجرۀ  در   Perspective
اصلی  منوی  از  را   Render > Render View )فرمان 

انتخاب کنید( تا شکل واقعی کاراکتر را بهتر ببینید. 

به نظر می‌رسد کاراکتر دارای مشکل ریزش مو است. البته دلیل آن استرس نیست، بلکه با انجام تنظیمات 
دیگری می‌توانیم این مشکل را برطرف کنیم. 

مقدار  و  کرده  انتخاب   Object Manager در  را   Hair شیء  است.  چقدر  موها  تعداد  ببینیم  باید  ابتدا 
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Count را در برگۀ Hair در Attribute Manager با مقدار 
 Fill کادر   Fill Hairs برگۀ  در  کنید.  تنظیم   100,000
Hairs را فعال کرده و مقدار آن را به 80,000 تغییر دهید. 
دوباره صحنه را رندر کنید. حالا به نتیجه‌ای شبیه به شکل 

15ـ10 می‌رسید. 

نتیجۀ  به  تا  کنیم  ویرایش  را  موها  خصوصیات  باید  هنوز 
 Material Manager در Hair مطلوب برسیم. روی مَتریال
 Material دابل کلیک کنید. به این ترتیب کادر محاوره‌ای

نمایش داده می‌شود. 

تنظیمات زیر را اعمال کنید: 
ــ Specular: گزینۀ Primary Strength را با مقدار %34 
تنظیم   %50 مقدار  با  را   Secondary Strength گزینۀ  و 

کنید. 
 0/5m را با مقدار Root گزینۀ :Thickness Channel ــ

و گزینۀ Tip را با مقدار 0/03m تنظیم کنید. 
را  مو  اندازۀ  می‌توانید  کانال  این  کردن  فعال  با   :Scale ــ 
 Scale تغییر داده و جلوۀ واقعی‌تری به آن ببخشید. مقدار
را به Variation ،%100 را به 80% و Amount را به %40 

تغییر دهید. 
به صورت شکل  نتیجه  کنید.  رندر  را  دیگر صحنه  بار  یک 

17ـ10 دیده می‌شود. 

شکل 15ـ10ـ رندر دوباره صحنه

Material شکل 16ـ10ـ کادر محاوره‌ای

شکل 17ـ10ـ رندر مجدد صحنه
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نتیجه خیلی بهتر شده، اما باید حالت نرمی و درخشندگی 
آن را کاهش داده و کمی حالت فرفری به آن اضافه کنیم. 
Scale قرار  Frizz بروید که در زیر کانال  به سراغ کانال 

دارد و گزینۀ Frizz را با مقدار 15% تنظیم کنید. 

خیلی بهتر شد، حالا می‌تواند در انظار عمومی ظاهر شود، 
اما بهتر است کمی موهایش را پرپشت‌تر کنیم. برای این 
 Clump استفاده کنیم. کانال Clump منظور باید از کانال
را انتخاب کرده و تنظیمات آن را بر اساس تصویر روبه رو 

تغییر دهید: 

صحنه را یک بار دیگر رندر کنید. نتیجۀ نهایی عالی شده 
است. 

Frizz شکل 18ـ10ـ استفاده از گزینه

Clump شکل 19ـ10ـ تنظیمات کانال

شکل 20ـ10ـ نتیجه نهایی
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پرسش‌های تشریحی   

1 رنگ‌های سیاه و سفید در Bodypaint 3d نشان‌دهندۀ چیست؟
٢ از ابزار Hair برای ساخت چه مواردی استفاده می‌شود؟ سه مورد را نام ببرید.

٣ دو نوع قلم‌مو در bodypaint را نام ببرید.
٤ روش کار ماژول Hair به چه صورت است؟

٥ چند ابزار برای آرایش مو نام ببرید.

پرسش‌های چندگزینه‌ای  

Bodypaint 1 از نقش‌بیتی‌های موجود به صورت تصاویرـــــــــ استفاده می‌کند.
ب( سفید و قرمز الف( رنگی	
د( مشکی و قرمز ج(  سیاه و سفید	

2 هر بافتی در ابتدا چند لایه دارد؟
ب( یک لایه الف( سه لایه	
د( شش لایه ج(  دو لایه	

3  در ماژول Hair راهنماها به‌طور پیش‌فرض چند سانتی‌متر هستند؟
ب( 18 سانتی‌متر الف( 20 سانتی‌متر	

د( 100 سانتی‌متر ج( 60 سانتی‌متر	

4 جملۀ زیر کارکرد کدام گزینه را توصیف می‌کند؟
ـــــــــ نشان می‌دهد هر مویی که از راهنما منشعب می‌شود از چند بخش تشکیل شده است.

Length )ب 	Segments )الف
Scale )د 	 Specular  )ج

5 کدام کانال در متریال Hair باعث فر شدن حالت مو می‌شوند؟
Thickness )ب 	 Clump  )الف

Specular )د 	 Frizz  )ج

پروژۀ عملی  

یک کاراکتر انسانی در صحنه قرار دهید و برایش موهای فرفری و نسبتاً کوتاهی را بسازید.
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می‌رود:
  کار با دوربین‌ها را بداند.

  Focal Length را بشناسد.

  دیافراگم را بشناسد.

  زاویۀ دید را بشناسد.

  بزرگ/کوچک‌نمایی را بشناسد.

  Film Offset X و Film Offset Y را بشناسد.

مقدمات کار با دوربین   

می‌توانید هر تعداد دوربینی را که مایل باشید به صحنه اضافه کنید. زمانی که دوربین جدیدی را )با انتخاب 
فرمان Objects > Scene > Camera( اضافه می‌کنید، دوربین‌ها همان مکان و نقطۀ کانونی نمای فعال را 

به خود می‌گیرند. 
 Cinema 4D  هنگام جایگذاری و تراز دوربین‌، از سیستم مختصات دوربین استفاده می‌کند. محور X و 
محور Y فاصلۀ کانونی یا سطح فیلم را تعریف می‌کنند، درحالی که محور Z جهتی را مشخص می‌کند که 

دوربین در آن قرار گرفته است. 
خصوصیات شیء Camera در Attribute Manager در شکل 1ـ11 نشان داده شده است.

Camera شکل 1ـ11ـ خصوصیات شیء
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   Projection     

البته می‌توانید از  به صورت پیش‌فرض، اشیا در Viewport در نمای Perspective نمایش داده می‌شوند. 
گزینه‌های دیگری نیز استفاده کنید. 

 Viewport 11ـ نمای اشیا در   شکل 2
)Isometric و Dimetric ،Gentleman ،Perspective :از چپ به راست(

 Focal Length  

را می‌توانید  لنز  این  کانونی  فاصلۀ  را شبیه‌سازی می‌کنند.  لنز  Cinema 4D همان سیستم  در  دوربین‌ها 
انتخاب کنید. 

هرچه فاصله کوچک‌تر باشد، زاویۀ دید افزایش یافته و تمام صحنه را دربر می‌گیرد. البته اشیا در صحنه کمی 
تغییر شکل می‌دهند. فاصله‌های کانونی بزرگ‌تر مربوط به لنزهای تله‌فوتو است که در آنها زاویۀ دید کوچک‌تر 

بوده و بخش کوچکی از صحنه را نمایش می‌دهد. 

      دیافراگم       
از لنز عبور کرده و  اندازۀ دریچۀ دیافراگم اشاره دارد که اجازه می‌دهد نور  پارامتر Aperture Width به 
روی فیلم بتابد. نسبت ابعاد Aperture Width به Focal Length است که مشخص می‌کند چه مقداری از 
صحنه از طریق دوربین دیده شود. به‌عنوان مثال، اگر هر دو اندازۀ Aperture Width و Focal Length را 

دو برابر کنید، زاویۀ دید تغییری نخواهد کرد. 

      زاویۀ دید      

اندازۀ زاویۀ دید دوربین را مشخص می‌کند. هر چه فاصلۀ کانونی بزرگ‌تر باشد، زاویۀ دید کاهش می‌یابد. 

 بزرگ/کوچک‌نمایی 

اگر گزینۀ Projection را با مقدار Perspective تنظیم کرده باشید، گزینۀ Zoom قابل‌دسترس نخواهد بود. 
این گزینه به شما امکان می‌دهد زاویۀ دید خود را تغییر دهید. در حقیقت مقیاس دید را تغییر می‌دهید. 

 Film Offset Y و Film Offset X  

فرض کنید دوربین Cinema 4D شبیه به دوربین فیلم‌برداری سنتی عمل کرده و تصاویر یکی پس از دیگری 
روی فیلم نگاتیو ضبط می‌شوند. حالا تصور کنید اطلاعات اضافی تصویر با حرکت فیلم در امتداد محور X و 

Y ضبط می‌شود. این دقیقاً همان کاری است که این پارامترها انجام می‌دهند.
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پرسش‌های تشریحی  

1 سه محور Y ،X و Z  در دوربین چگونه عمل می‌کنند؟
2 لنزهای تله‌فوتو را تعریف کنید.

3 چه چیزی در دوربین مشخص می‌کند چه مقدار از صحنه دیده شود؟
4 در چه صورت گزینۀ Zoom در دسترس نخواهد بود؟

5 کدام پارامتر به اندازۀ دریچۀ دیافراگم اشاره دارد و کار آن چیست؟

پرسش‌های چندگزینه‌ای  

1 به صورت پیش‌فرض اشیا در Viewport درکدام نما نمایش داده می‌شوند؟
Isomatric )ب 	 Perspective )الف

Gentleman )د 	Dimetric  )ج

2 در Focal Length هرچه فاصله کوچک‌تر باشد زاویۀ دید چه تغییری می‌کند؟
ب( تغییری نمی‌کند الف( بزرگ‌تر می‌شود	
د( کوچک‌تر می‌شود ج(  نصف می‌شود	

3 با تغییر هم‌زمان کدام دو پارامتر زاویۀ دید تغییری نخواهد کرد؟
Focal Length و Aperture width )ب 	Focal Length و Zoom )الف

د( گزینه‌های الف و ب 	Zoom و Aperture width )ج

4 دوربین‌ها به‌طور پیش‌فرض در چه مختصاتی ساخته می‌شوند؟
Y و X ب( روی محورهای 	 X الف( روی محور

د( مکان و نقطۀ کانونی نمای فعال ج( در محل قرارگیری شیء 	

5 در دوربین‌ها، کدام محورها فاصلۀ کانونی را تعریف می‌کنند؟
Z و X )ب 	Z و X )الف
Z و Y )د 	Y و X )ج

پروژۀ عملی  

با استفاده از دوربین‌های مختلف و متعدد، پلان‌هایی را از یک ماشین درحال حرکت ضبط کنید که در آن، 
را   isometric و   gentleman پلان‌ها سبک‌های  از  بعضی  باشد. همچنین  استفاده شده   Focal Length

داشته باشند.
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می‌رود:
  مفهوم ساخت Character Mesh را بداند.

  انواع اسکلت برای کاراکتر با Mocca Bonet را بشناسد.

  نحوۀ کار با IK (Inverse Kinematics) کاراکتر را بداند.

  مفهوم به حرکت در آوردن کاراکتر را بداند.

  بتواند با Walk Cycles کار کند.

  روش‌های ایجاد Rigid Body Dynamics را بداند.

   Character Mesh مفهوم ساخت

مدل‌سازی کاراکترها و حرکت دادن اندام‌ها و لباس‌های آنها یکی از چالش‌های انیمیشن‌های سه‌بعدی است. 
یک رویکرد این است که کاراکتر را به چندین شیء تقسیم کنید و کارکرد Inverse Kinematics را اعمال 
کنید. ایراد این روش این است که باید مش را در محل مفاصل از هم مجزا کنید و به این ترتیب سطح کاراکتر 

نیز مقطع خواهد شد. 
راه‌حل بهتری نیز وجود دارد و آن این است که از طبیعت تقلید کنید. اسکلت )یعنی سلسله مراتبی از اشیای 
استخوان( را داخل یک مش واحد در کاراکتر قرار دهید. به این ترتیب می‌توانید با حرکت دادن استخوان‌ها، 
کاراکتر را متحرک کنید. پوست )یا لایۀ خارجی( با حرکت کردن استخوان‌ها خم یا کشیده می‌شود. این 
رویکرد از مشکل مقطع شدن مفاصل جلوگیری می‌کند، چون استخوان‌ها کاملًا مستقل از خود شیء هستند 

و حتی می‌توانید از همان اسکلت بار دیگر در کاراکترهای دیگری نیز استفاده کنید. 
ماژول اختیاری Mocca کنترل ویژه‌ای روی متحرک‌سازی کاراکتر ارائه می‌دهد. ایجاد اسکلت‌ها و مش‌های 
استفاده  پیش‌ساخته  تنظیمات  از  می‌توانید  است.  ساده‌ای  بسیار  کار   Mocca توسط  سفارشی  و  پیچیده 
کنید و با ترکیب‌ آنها به سرعت انیمیشن‌های جذابی را ایجاد کنید. سیستم جدید IK با ارائۀ دینامیک‌ها و 

محدودیت‌های ویژۀ تعبیه‌شده، حرکات جالبی را فراهم می‌کند. 
می‌توانید از استخوان‌ها در تمام انواع اشیا از جمله اشیای پارامتری، اشیای NURBS، اشیای چندضلعی و 

Spline ها استفاده کنید. حتی می‌توانید از استخوان‌ها در اشیای Deformer نیز استفاده کنید. 

       Mocca Bonet انواع اسکلت برای کاراکتر با

Cinema 4Dمعمولاً متفاوت از سلسله‌مراتب موردنیاز برای اسکلت در FBX سلسله‌مراتب اسکلت به فرمت فایل
است. اگر اشیای تحت تأثیر توسط اسکلت در حالت استراحت باشند، فقط یک اسکلت برای آنها طراحی شده و این 
اسکلت در بالاترین سطح سلسله‌مراتبی شیء قرار می‌گیرد. از سوی دیگر، اگر قرار است از اسکلت در حالات 
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مختلف شیء استفاده شود، باید یک کپی از اسکلت را به‌عنوان فرزند شیء تنظیم کنید. اسکلت‌هایی که با 
هندسۀ شیء مرتبط نباشند حذف می‌شوند. استخوان‌ها را می‌توانید با استفاده از رئوس نگاشت‌شده در مش 

کنترل کنید. 
در صورت لزوم می‌توانید با ایجاد اشیای Null برای گره‌های اولیۀ اسکلت، انیمیشن مطلوب‌تری را ایجاد کنید. 
به محل    Cinema 4Dاستخوان در نیز متفاوت هستند.  استخوان‌ها  Cinema 4D  در ساختار  و   FBX
اتصال دو گره‌ اسکلتی به فرمت FBX اشاره دارد. نام عناصر را نمی‌توانید وارد کنید. به‌عنوان یک قانون کلی، 
استخوان Cinema 4D از دو گره‌ به فرمت FBX ایجاد می‌شود که نام و خصوصیات مربوط به وزن خود را 
از گره‌ اول می‌گیرند. اگر FBX Node دوم در زنجیره دارای وزن باشد، استخوان با طول صفر ایجاد و با والد 

خود تراز می‌شود. 
به  قرار دهید.  تأیید  را درحالت   Use Absolute Weights انتخاب  باید کادر  نتیجه،  بهترین  برای کسب 
این ترتیب می‌توانید دادۀ مربوط به وزن استخوان‌ها را نیز بدون اتلاف وارد یا صادر کنید و تغییر شکل در 

MOTIONBUILDER و Cinema 4D یکسان خواهد بود. 
تبدیل  وزن  بدون  و  ارجاع  بدون   Null استخوان‌های  به  نباشند،   Rest یا   Link وضعیت  در  که  گره‌هایی 

می‌شوند. 
اگر ماژول Mocca را نصب کرده باشید، دادۀ مربوط به وزن به جای این که برای نگاشت رئوس و تگ‌های 
Restriction ایجاد شود برای ابزار Cloud Bonet ایجاد می‌شود. اگر نیاز به نگاشت‌های رئوس دارید، باید 

با استفاده از تنظیمات مربوطه در کادر Preferences آن را فعال کنید. 

نحوۀ IK (Inverse Kinematics) کاراکتر    

انیمیشن  در  که  هستند  اصطلاحاتی  Inverse Kinematics (IK)ـ  و   Forward Kinematics (FK)
سه‌بعدی به کار برده می‌شوندـ دو روش مختلف برای ساخت انیمیشن در اختیار شما قرار می‌دهند. منظور از 
FK چرخاندن هریک از استخوان‌های موجود در سلسله‌مراتب از بالا به پایین است. این روش مزایایی برای 

بخش‌هایی از انیمیشن دارد اما ممکن است معایبی هم برای بخش‌های دیگر انیمیشن داشته باشد. 
به سختی می‌توانید مقدار چرخش را مشخص کنید تا به‌عنوان مثال قسمت بالای بازو را آنقدر بچرخانید که 
بخش پایینی بازو و سپس مچ دست در همان وضعیتی قرار گیرد که می‌خواهید. یا فرض کنید که مچ دست 
در مکان موردنظر قرار گرفته است اما حالا بخش بالایی بازو بیش ازحد بالا آمده است. حالا بخش پایینی بازو 
را می‌چرخانید، اما با این کار فرزندان این بخش در سلسله‌مراتب نیز می‌چرخند و از مکان خود خارج می‌شوند. 

حالا باید فرزندان را بچرخانید تا دوباره در مکان مطلوب خود قرار گیرند. 
حالا تصور کنید چه خوب می‌شد اگر می‌توانستید فقط دست را می‌گرفتید و آن را به هر صورتی که مایل 
بودید می‌چرخاندید؟ اینجاست که IK به کار می‌آید. به جای این که هریک از مفاصل موجود در زنجیره را 
یک به یک بچرخانید، می‌توانید Effector را نزدیک دست متصل کنید و در یک مرحله حرکت کل زنجیرۀ 
IK را کنترل کنید. این کار بسیار ساده است. مفاصل را انتخاب کنید، ابزار IK Chain را فعال کنید و تمام. 
IK متحرک کنید! دیگر لازم نیست به خود زحمت داده و مقصد‌ها و  از  با استفاده  بازو را  حالا می‌توانید 

محدوده‌ها را مشخص کنید.
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این ابزار به شما امکان می‌دهد تا اشیای موجود در سلسله‌مراتب را به صورت تعاملی حرکت دهید. برای مثال 
می‌توانید دست را گرفته و آن را به مکان موردنظر خود حرکت دهید و بازو نیز متعاقباً حرکت را دنبال می‌کند. 
ابزار IK نه تنها برای ساخت انیمیشن مفید واقع می‌شود، بلکه برای ژست دادن به کاراکتر نیز ایده‌آل است. 
ابتدا باید اشیا را در سلسه‌مراتبی تنظیم کنید و تگ‌های Kinematics را به آنها نسبت دهید. اگر یکی از 
اشیای انتهای سلسله‌مراتب را انتخاب کنید و ماوس را حرکت دهید،Cinema 4D فاصلۀ بین مفاصل را به 
صورت خودکار محاسبه می‌کند و حرکت را به صورت یکنواخت اعمال می‌کند. به این ترتیب حرکت در کل 

زنجیره )به‌عنوان مثال بازویی که دارای چندین مفصل است( به صورت ثابت و یکنواخت اعمال می‌شود. 

شکل 1ـ12ـ ایجاد حرکتی ثابت و یکنواخت

 ،Figure را بهتر بیاموزید. برای ایجاد شیء IK کمک می‌کند تا کار با ابزار Cinema 4D در Figure شیء
 Functions > Make Editable را انتخاب کنید. سپس فرمان Objects > Primitive > Figure فرمان
را انتخاب کنید. به این ترتیب شکل آدمک به چندضلعی‌هایی با اندام‌های مجزا، سلسله‌مراتب و تمام تگ‌های 
موردنیاز برای شروع کار تبدیل می‌شود. برای استفاده از ابزار IK، باید ابزار IK و ابزار Move را انتخاب کنید، 

روی بخشی از بدن مثلًا روی دست کلیک کنید و در Viewport بکشید. 
تگ  از  استفاده  زمان  در  تا  کنید  مشخص  را  چرخش  زاویۀ  محدودۀ  می‌توانید   ،IK زنجیرۀ  تنظیم  هنگام 
Kinematics اندام‌ها بیش از حد نچرخند. ضمناً با استفاده از تگ Anchor می‌توانید اشیا را به هم متصل 

کنید. در این صورت دیگر با ابزار Inverse Kinematics نمی‌توانید آنها را حرکت دهید. 
ابزار IK همیشه در شیء انتخاب‌شده اعمال می‌شود. زنجیرۀ IK از مبدأ شیء بیرون کشیده می‌شود یا اگر 

شیء دارای اشیای فرزند باشد، از مبدأ فرزند اول خارج می‌شود. 

مفهوم به حرکت در آوردن کاراکتر 

در قسمت Animate می‌توانیم کاراکتر را به حرکت درآوریم. بخش Animate قابلیت‌هایی را در اختیار ما 
قرار می‌دهد که برای به حرکت درآوردن کاراکتر به کمک ما می‌آیند. 
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انتخاب می‌کنید، این تابع روی  از این قابلیت‌ها، قابلیت Add Walk است. زمانی که این کارکرد را  یکی 
کاراکتر اعمال می‌شود و دو اتفاق می‌افتد. اتفاق اول این است که شکل کاراکتر عوض می‌شود و به حالت قدم 

زدن و راه رفتن درمی‌آید. پاها جلو و عقب قرار می‌گیرند و دست‌ها رو به پایین قرار می‌گیرند. 

شکل 2ـ12ـ به حرکت درآوردن کاراکتر

شکل 3ـ12ـ افزودن قابلیت قدم زدن
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 CMotion شیء ،Objects اتفاق دوم این است که در بخش
اضافه می‌شود. این شیء قابلیت‌هایی را در اختیار ما قرار 
می‌دهد که به ما کمک می‌کنند حرکت کاراکتر را مدیریت 

کنیم.

قابلیت Stride طول قدم‌های کاراکتر را مشخص می‌کند. 
با کم یا زیاد کردن این مقدار می‌توانید طول گام را تغییر 

دهید. 

شکل 4ـ12ـ مدیریت حرکت کاراکتر

Stride شکل 5ـ12ـ تنظیم مقدار

قابلیت Time سرعت حرکت کاراکتر را تنظیم می‌کند. هرچه این مقدار بیشتر باشد، سرعت حرکت کاراکتر 
کمتر و هرچه این مقدار کمتر باشد سرعت حرکت کاراکتر بیشتر می‌شود. 

Time شکل 6ـ12ـ تنظیم مقدار

قابلیت بعدی Walk است که مدل راه رفتن کاراکتر را تنظیم می‌کند. این قابلیت سه حالت دارد: حالت 
Static که کاراکتر در حین حرکت درجا می‌زند. حالت Live که کاراکتر روی یک خط تا انتهای فریم‌ها 
حرکت می‌کند. حالت Pass که در این حالت می‌توانیم مسیری را برای کاراکتر مشخص کنیم تا روی آن 

حرکت کند. 
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Pass شکل 7ـ12ـ استفاده از حالت

برای تعریف مسیر بهتر است به نمای Top بروید تا دید بهتری روی مسیر ترسیم‌شده داشته باشید. برای 
تعریف مسیر از ابزار Spline Pen استفاده کنید. مسیر را تعریف و روی محل‌های تقاطع کلیک کنید تا مسیر 

منحنی شود. به این ترتیب حرکت روی مسیر زیباتر صورت می‌گیرد. 

شکل 8ـ12
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پس از تنظیم مسیر، به نمای Perspective برگردید. حالا باید مسیر را به کاراکتر بدهید. برای این منظور 
وارد بخش CMotion شوید و مسیری را که تعریف کرده‌اید به بخش Path بکشید. 

شکل 9ـ12ـ دادن مسیر به کاراکتر

در بخش Action قابلیت‌های متعددی ارائه می‌شود که به کمک آنها می‌توانید کاری کنید که حرکت کاراکتر 
طبیعی‌تر به نظر برسد. 

   Walk Cycles کار با

از قدم  تا بی‌نهایت تکرار می‌شوند و تصوری  انیمیشن‌ها است که  از  از Walk Cycles مجموعه‌ای  منظور 
برداشتن کاراکتر را به وجود می‌آورند. به‌عنوان انیماتور باید با ساخت این نوع انیمیشن آشنا باشید، زیرا در 

همه جا کاربرد دارد از بازی‌های ویدیویی گرفته تا تبلیغات و فیلم‌ها. 
در برخی نگارش‌های Cinema 4D سیستمی به نام CMotion وجود دارد که می‌توانید از آن برای ایجاد 
از CMotion می‌توانید کاری  با استفاده  حرکات قابل‌استفادۀ مجدد مانند Walk Cycles استفاده کنید. 

شکل 10ـ12ـ طبیعی‌تر کردن حرکت کاراکتر
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کنید کاراکتر در امتداد مسیری حرکت کند که شما مشخص کرده‌اید. برخلاف حرکاتی که در انیمیشن‌های 
سنتی صورت می‌گرفت، CMotion پارامتری است. این سیستم به شما امکان می‌دهد درصورت لزوم طول 
گام‌ها و سرعت قدم‌ برداشتن‌ها را تنظیم کنید. در چنین مواردی اگر بخواهید از روش‌های سنتی تنظیم 
فریم‌های کلیدی استفاده کنید، بسیار خسته‌کننده و زمان‌بر خواهد بود. به کمک CMotion حتی می‌توانید 

در تایپولوژی تغییراتی را اعمال کنید و حتی خود تایپولوژی را نیز متحرک کنید. 

   Rigid Body Dynamics روش‌های ایجاد

 Rigid Body نیز داریم. منظور از Collider Body می‌شود، در کنار آن یک Rigid Body وقتی صحبت از
Collider Body جسمی است که به آن ضربه وارد می‌شود و  از  جسمی است که حرکت دارد و منظور 
جسمی که حرکت دارد قرار است به آن برخورد کند. کار را با دو شیء شروع می‌کنیم که هیچ حرکتی ندارند. 

شکل 11ـ12ـ ضربه‌زدن به جسم در حال حرکت

از  برای این که بخواهیم از تگ Rigid در شیء استفاده کنیم، روی شیء دایره کلیک راست می‌کنیم و 
قسمت Simulation Tags گزینۀ Rigid Body را انتخاب می‌کنیم. 
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درحال حاضر اگر صحنه را اجرا کنید، شیئی که تگ Rigid را بر آن اعمال کرده‌اید به سمت پایین یعنی 
تحت تأثیر نیروی جاذبه حرکت می‌کند. همین تگ را در مکعب نیز اعمال کنید. می‌خواهیم وقتی اشیا به 
Plane رسیدند متوقف شوند، یعنی Plane باید نقش Collider Body داشته باشد، زیرا این دو شیء قرار 
است با آن برخورد کنند. پس روی Plane کلیک راست کنید، گزینۀ Simulation Tags و سپس گزینۀ 

Collider Body را انتخاب کنید. 

Rigid Body شکل 12ـ12ـ انتخاب گزینه

Collider Body شکل 13ـ12ـ انتخاب گزینه
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حالا اگر صحنه را اجرا کنید، می‌بینید که 
به سطح می‌رسند، متوقف  وقتی  دو جسم 
از  کدام  هر  ندارند.  حرکتی  دیگر  و  شده 
برگۀ  انتخاب می‌کنید در  را که  این تگ‌ها 
Collision سه گزینه در اختیار شما قرار 

می‌گیرد که مهم هستند. 

Collision شکل 14ـ12ـ انتخاب گزینه‌ها از برگه

گزینۀ Bounce مقدار جهشی را مشخص می‌کند که هنگام برخورد دو شیء به وجود می‌آید. هرچه مقدار 
Bounce بیشتر باشد، جسم بعد از برخورد بیشتر رو به بالا برمی‌گردد. مقدار Friction )اصطکاک( هرچه 
بیشتر باشد، جهش رو به بالا کمتر خواهد بود. حالا می‌خواهیم نقش مکعب را تغییر دهیم. ابتدا تگ مکعب 
را انتخاب و آن را حذف کنید. می‌خواهیم این بار مکعب به دایره ضربه وارد کند و دایره حرکت داشته باشد. 
دایره قرار است حرکت داشته باشد، پس باید نقش Rigid Body داشته باشد. مکعب قرار است ضربه وارد 

کند، پس باید نقش Collider Body داشته باشد. 

Collider Body و Rigid Body شکل 15ـ12ـ دایره با نقش‌های
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مکعب را انتخاب کرده و در فریم صفر یک فریم کلیدی را تنظیم کنید. حالا مکعب را به قدری حرکت دهید 
تا به دایره برخورد کند و در همان محل یک فریم کلیدی دیگر تنظیم کنید. 

شکل 16ـ12ـ برخورد دایره و مکعب

اکنون صحنه را اجرا کنید. مشاهده می‌کنید که مکعب حرکت و به دایره برخورد می‌کند و دایره به مسیر 
حرکت ادامه می‌دهد. این بار مسیر حرکت عوض شده است و دیگر فقط تحت تأثیر نیروی جاذبه به سمت 

پایین نیست. 

پرسش‌های تشریحی    

1 منظور از FK در استخوان‌بندی چیست؟
2 تفاوت FK  و IK در استخوان‌بندی چیست؟

3 سه حالت راه رفتن در Add walk را نام ببرید.
4 ابزار Walk circle چه کاربردی دارد؟

5 منظور از Rigid body و Collider body چیست؟



فصل دوازدهم : متحرک سازی کاراکتر و ایجاد داینامیک 

129

پرسش‌های چندگزینه‌ای   

IK 1 مخفف چیست؟
Forward kinematics )ب 	Invers keyframe )الف

Forward keyframe )د 	Invers kinematics )ج

2 کدام تگ اشیا را به هم متصل می‌کند؟
Kinematics )ب 	Anchor )الف
Rigid body )د 	Align to spline )ج

3  گزینۀ Stride در Cmotion چه قابلیتی دارد؟
ب( جایگاه ‌IKها را مشخص می‌کند. الف( مقدار گام‌ها را مشخص می‌کند.	

د( طول گام‌ها را مشخص می‌کند. ج( عرض گام‌ها را مشخص می‌کند.	

4 کدام یک از گزینه‌های زیر کارکرد Pass را در Walk توصیف می‌کنند؟
الف( تعیین مسیری برای کاراکتر تا روی آن حرکت کند.                                

ب( درجا زدن کاراکتر در حین حرکت
ج( کاراکتر روی یک خط تا انتهای فریم حرکت کند.                                  

د( هیچ کدام

5  برای تعریف مسیر حرکت برای کاراکتر از کدام گزینه استفاده می‌شود؟
ب( Deformer ها 	 Primitives objects )الف

Null object )د 	Spline )ج

پروژۀ عملی   

یک کاراکتر را درحال قدم زدن انیمیت کنید. سپس بایستد و ژست‌های مختلفی برای عکاسان فرضی 
بگیرد.



ساخت پوست و لباس برای کاراکتر



فصل 13
ساخت پوست و لباس برای کاراکتر
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می‌رود:
  نحوۀ ایجاد پوست روی کاراکتر توسط Claud Bonet را بداند.

  روش‌های ساخت پوست خزدار برای کاراکتر را بداند.

  مفهوم Dress-o-matic را بشناسد.

  مفهوم به حرکت درآوردن لباس کاراکتر را بداند.

 Claud Bonet نحوۀ ایجاد پوست روی کاراکتر توسط

نیاز به یک مدل از نوع مش پیوسته داریم. در اینجا از یک مدل دست استفاده کرده‌ایم که از نوع مش پیوسته 
است و دارای فرزند1 نیست. 

ابتدا  کنیم.  متصل  به‌دست  پوست  طریق  از  را  آن  و  ایجاد  اسکلت‌بندی  یک  دست  این  برای  می‌خواهیم 
Display را به حالت Hidden Line درمی‌آوریم تا اسکلت بهتر دیده شود. 

Child ـ 1

شکل 1ـ13ـ مدل‌دست از نوع مش‌پیوسته
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بعد از منوی Character گزینۀ Joint Tool را انتخاب می‌کنیم، کلید Ctrl را نگه می‌داریم و مفصل‌ها را 
یکی یکی اضافه می‌کنیم. 

شکل 2ـ13ـ دیدن بهتر اسکلت دست

شکل 3ـ13ـ اضافه کردن مفصل‌ها

از آنجا که به هنگام اضافه کردن مفصل‌ها، Character Mesh در حالت انتخاب قرار داشته است، مفصل‌ها 
از  تا  بکشید   Arm بالای  به  را  آن‌  و  کنید  انتخاب  را   Root می‌شوند.  تنظیم   Arm زیرمجموعۀ  به‌عنوان 
زیرمجموعۀ Arm خارج شود. حالا باید مفصل‌ها را IK rig کنیم تا تبدیل به زنجیره شوند. مفصل ابتدای 
 IK rig را انتخاب می‌کنیم تا Create IKI Chain گزینۀ Character زنجیره را انتخاب می‌کنیم و از منوی

ساخته شود و شیء Goal ایجاد گردد. 
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حالا شیء Goal را انتخاب می‌کنیم، آن را می‌گیریم و جابه‌جا می‌کنیم. می‌بینید که مفصل‌ها هم‌زمان باهم 
جابه‌جا می‌شوند و IK rig به‌درستی کار می‌کند. اما با حرکت دادن مفصل‌ها، دست حرکت نمی‌کند چون 

بین مفصل‌ها و دست اتصالی برقرار نیست. 

شکل 4ـ13ـ زنجیره‌ای کردن مفصل‌ها

می‌خواهیم با ایجاد پوست این اتصال را برقرار کنیم. برای ایجاد پوست، باید Character Mesh که می‌خواهیم 
پوست را برای آن ایجاد کنیم به همراه تمام مفصل‌هایی که می‌خواهیم پوست را روی آنها ایجاد کنیم انتخاب 
زیرمجموعۀ  به   Skin شیء  ترتیب  این  به  کنیم.  انتخاب  را   Bind گزینۀ   Character منوی  از  و  کنیم 

Character Mesh یعنی Arm اضافه می‌شود. 

شکل 5ـ13ـ نبود اتصال بین دست و مفصل‌ها
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حالا اگر مجدداً شیء Arm را انتخاب کنیم و آن را حرکت دهیم، دست به‌خوبی حرکت می‌کند و اتصال 
برقرار می‌شود. 

شکل 6ـ13ـ ایجاد پوست

شکل 7ـ13ـ حرکت خوب درست
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روش‌های ساخت پوست خزدار برای کاراکتر  

در بخش Objects گزینۀ Plane را انتخاب و سطحی را به صحنه اضافه کنید. 

Plane شکل 8ـ13ـ انتخاب گزینه

از منوی Deformers گزینۀ Displacer را انتخاب کنید. دقت کنید که در منوی Displays، گزینه‌های 
Shading انتخاب شده و فعال باشند. 

شکل 9ـ13ـ از فعال بودن گزینه‌های Shading مطمئن شوید
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در برگۀ Shading برای Shader خود یک Noise اعمال کنید و با کلیک روی Noise وارد تنظیمات شوید 
و تغییرات موردنظر خود را اعمال کنید. Global Scale را با مقدار 200 تنظیم کنید و کنتراست را کمی 

افزایش دهید. 

به بخش Objects برگردید و گزینۀ Height را با مقدار 3 تنظیم کنید. 

Shader شکل 10ـ13ـ انجام تنظیمات

Height شکل 11ـ13ـ تنظیم گزینه

سطح اولیه آماده شده است، حالا می‌توانیم مَتریال مدنظر خود را به آن اضافه کنیم. می‌توانید از تنظیمات 
آمادۀ Skin استفاده کنید یا مَتریال موردنظر خود را بسازید و در بخش Texture اضافه کنید. حالا در بخش 

تنظیمات گزینۀ Projection را از UV به Quebic تغییر دهید. 
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باید نور را به صحنه اضافه کنیم. یک نور را در سمت چپ و کمی بالا و نور دیگری را در سمت راست و کمی 
پایین اضافه کنید. به نمای Perspective بروید و تنظیمات نور را تغییر دهید. 

شکل 12ـ13ـ اضافه کردن متریال موردنظر

شکل 13ـ13ـ تغییر دادن تنظیمات نور
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حالا می‌توانیم مو را اضافه کنیم. از قسمت Simulate گزینۀ Hair Object و سپس گزینۀ Add Hair را 
انتخاب کنید. 

تنظیمات مربوط به مو را اعمال کنید و در بخش Hair Tool گزینۀ Brush را انتخاب کنید و به موها حالت 
دهید. 

شکل 14ـ13ـ اضافه کردن مو

شکل 15ـ13ـ حالت دادن به موها
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صحنه را رندر کنید. پوست خزدار ساخته شده است، اما هنوز ویژگی‌های مدنظر ما را ندارد. به تنظیمات 
مربوط به مَتریال Hair برگردید و در قسمت Root پوست خزدار مدنظر خود را در بخش Texture اعمال 

کنید. 

شکل 16ـ13ـ اعِمال پوست خزدار

تنظیمات این بخش را به دلخواه تغییر دهید و دوباره رندر کنید.

شکل 17ـ13ـ رندر دوباره
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 Brush را کاهش دهید تا موها کمی نرم‌تر به نظر برسند. از ابزار Frizz کار بهتر شده است اما باید مقدار
Tool استفاده کنید و با دقت و حوصله جهت و خواب موها را تنظیم کنید تا به نتیجۀ مطلوب برسید. 

  Dress-o-matic مفهوم

می‌خواهیم لباسی را که به شکل Outfit برای کاراکتر طراحی کرده بودیم روی بدن کاراکتر ثابت کنیم. 

شکل 18ـ13ـ تنظیم جهت و خواب موها

شکل 19ـ13ـ متناسب کردن لباس روی بدن کاراکتر
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از قابلیت Dress-o-matic می‌توانیم برای پوشاندن لباس روی تن کاراکتر استفاده کنیم. ابتدا باید تمام اتصالاتی 
که قسمت جلوی لباس را به قسمت پشت لباس وصل می‌کنند به صورت هم‌زمان انتخاب کنیم. ابتدا حالت 
 Only و سپس اتصالات را انتخاب کنید. البته دقت داشته باشید که قبل از این کار، کادر انتخاب Polygons

Select Visible Elements را از حالت تأیید خارج کنید تا تمام اتصالات به صورت هم‌زمان انتخاب شوند. 

Only Select Visible Elements شکل 20ـ13ـ غیرفعال کردن کادر انتخاب

 Reverse به جهت اتصالات دقت کنید. اگر جهت آنها نرمال نیست، روی آنها کلیک راست کنید و گزینۀ
Normal را انتخاب کنید تا تمام اتصالات در جهت درست قرار گیرند. 

شکل 21ـ13ـ درست کردن جهت تمام اتصالات
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حالا باید عملیات متناسب کردن لباس را شروع کنیم. ابتدا به بخش Cloths بروید و گزینۀ Tags را انتخاب 
کنید. در منوی بازشده گزینۀ Simulation Tags را انتخاب کنید و در زیرمنوی بازشده گزینۀ Cloths را 

انتخاب کنید. به این ترتیب تگ Cloths به لباس اضافه می‌شود. 

تگ Cloths قابلیت‌هایی دارد که با استفاده از آنها می‌توانید لباس را روی بدن کاراکتر ثابت کنید. یکی از 
این قابلیت‌ها، قابلیت Dresser است. ابتدا باید اتصالات انتخاب‌شده را به هم بدوزید. در بخش Dresser به 

سراغ گزینۀ Seam Polys بروید و آن را با مقدار Set تنظیم کنید. 

شکل 22ـ13ـ افزودن تگ Cloths به لباس

Seam Polys شکل 23ـ13ـ تنظیم گزینه
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به نظر می‌رسد عملیات دوخت در محل اتصالات صورت گرفته است. 

 Tags حالا می‌خواهیم لباس به‌طور کامل روی بدن کاراکتر بنشیند. بدن کاراکتر را انتخاب و مجدداً گزینۀ
را انتخاب کنید. از منوی بازشده گزینۀ Simulation Tags را انتخاب و این بار از زیرمنوی بازشده گزینۀ 
Cloths Collider را انتخاب کنید. به این ترتیب تگ Cloths Collider به بدن اضافه می‌شود و به تگ 

Cloths دستور می‌دهد لباس را روی بدن قرار دهد. 

شکل 24ـ13ـ عملیات دوخت در محل اتصالات

شکل 25ـ13ـ افزودن تگ Cloths Collider به بدن
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حالا می‌توانیم با انتخاب گزینۀ Dress-o-matic لباس را روی بدن کاراکتر قرار دهیم. با انتخاب این گزینه 
لباس به‌خوبی روی بدن کاراکتر قرار می‌گیرد. 

البته در قسمت سرشانه‌ها، عرض سرشانه کمی زیاد است.

Dress-o-matic شکل 26ـ13ـ انتخاب گزینۀ

شکل 27ـ13ـ زیاد بودن عرض سرشانه‌ها
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برای حل این مشکل به بخش Dresser بروید، در بخش Width مقدار کمتری را انتخاب کنید تا عرض 
سرشانه‌ها کمتر شود. 

شکل 28ـ13ـ کمتر کردن عرض سرشانه‌ها

گزینۀ دیگری با نام Steps وجود دارد که تعداد مراحل شبیه‌سازی را مشخص می‌کند. می‌توانیم تعداد این 
مراحل را بیشتر کنیم. هرچه تعداد این مراحل بیشتر باشد، لباس با دقت بیشتری روی بدن کاراکتر قرار 
کنید.  انتخاب  را   Dress-o-matic گزینۀ  دیگر  بار  یک  خود،  موردنظر  تنظیمات  اعمال  از  پس  می‌گیرد. 
می‌بینید این بار عرض سرشانه‌ها کمتر شده و لباس با دقت بیشتری روی بدن کاراکتر می‌نشیند. برای اعمال 
تنظیمات بیشتر می‌توانید لباس را انتخاب و از قسمت Subdivision Surface گزینۀ Cloths Surface را 

انتخاب کنید. این گزینه کمک می‌کند تا سطح لباس نرم‌تر شود و طبیعی‌تر به نظر برسد. 

شکل 29ـ13ـ نرم‌تر و طبیعی‌تر کردن سطح لباس
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مفهوم به حرکت در آوردن لباس کاراکتر  

بعد از این که لباس را ایجاد و آن را به تن کاراکتر فیت کردیم، باید کاری کنیم تا لباس به همراه کاراکتر به 
حرکت درآید. 

شکل 30ـ13ـ حرکت لباس به همراه کاراکتر

برای این منظور، در فریم صفر، بدن کاراکتر را انتخاب و قابلیت Auto Keying را فعال کنید. به این ترتیب 
فریم صفر تبدیل به یک فریم کلیدی می‌شود. حالا به فریم بیستم می‌رویم و مقداری بدن کاراکتر را رو به جلو 

حرکت می‌دهیم. به این ترتیب فریم بیست هم تبدیل به یک فریم کلیدی دیگر می‌شود. 

شکل 31ـ13ـ تنظیم فریم‌های کلیدی
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اگر صحنه را اجرا کنید، می‌بینید که بدن کاراکتر حرکت می‌کند و جابه‌جا می‌شود، اما لباس به همراه بدن 
حرکت نمی‌کند.

برای این که لباس را نیز به همراه بدن حرکت دهیم، ابتدا به فریم صفر برگردید و در فریم صفر یک بار دیگر 
قابلیت Dress-o-matic را اجرا کنید تا لباس یک بار دیگر روی بدن کاراکتر متناسب شود. برای این که 
لباس با بدن کاراکتر حرکت کند، باید یک بار دیگر تگ Cloth را در لباس اعمال کنید. برای این منظور باید 
گزینۀ Cloth را انتخاب کنید و از قسمت Tags گزینۀ Simulation Tags را انتخاب کنید و از زیرمنوی 
بازشده گزینۀ Cloths را انتخاب کنید. به این ترتیب تگ Cloth یک بار دیگر در لباس اعمال می‌شود و 

اعمال مجدد تگ Cloth در لباس باعث می‌شود تا این بار لباس به همراه کاراکتر حرکت کند. 

شکل 32ـ13ـ حرکت نکردن لباس با بدن

شکل 33ـ13ـ این بار لباس با بدن حرکت می‌کند
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اگر صحنه را یک بار دیگر اجرا کنید، این بار لباس به همراه کاراکتر حرکت می‌کند. مشکلی وجود دارد و آن 
این است که حرکت لباس و کاراکتر بسیار کند و با مکث‌های زیادی همراه است. علت این مشکل این است 
که نرم‌افزار هم‌زمان با حرکت لباس و کاراکتر به‌طور مداوم درحال اجرای قابلیت Dress-o-matic است و 
با هر بار جابه‌جایی، مجدداً لباس را روی بدن کاراکتر متناسب می‌کند. این امر باعث می‌شود حرکت کند و 

با مکث همراه شود. 

برای جلوگیری از بروز این مشکل، از قابلیت Cache در تگ Cloth استفاده کنید. در بخش Cache، کادر 
انتخاب Cache Mode را در حالت تأیید قرار دهید. 

شکل ٣4ـ13ـ حرکت کند و همراه با مکث

بدن  روی  لباس  متناسب شدن  نرم‌افزار شبیه‌سازی  تا  کنید  انتخاب  را   Calculate Cache گزینۀ  سپس 
کاراکتر را ذخیره کند و نیاز نباشد با هر جابه‌جایی یک بار دیگر Dress-o-matic را اجرا کند. 

Cache Mode شکل 35ـ13ـ استفاده از قابلیت
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اگر بار دیگر صحنه را رندر کنید، دیگر مکث صورت نمی‌گیرد. 

پرسش‌های تشریحی   

1 نحوۀ ایجاد پوست را توضیح دهید.
٢ روش ساخت پوست خزدار را توضیح دهید.

٣ نحوۀ قرار دادن لباس روی بدن کاراکتر را توضیح دهید.
٤ قابلیت Drees-O-Matric چه کاربردی دارد؟

٥ از تگ Cloth چه استفاده‌ای می‌شود؟

پرسش‌های چندگزینه‌ای 

1 کدام گزینه برای متحرک‌سازی استخوان‌ها استفاده می‌شود؟
د( هیچ کدام 	Create IK Chain  )ج 	Joint tool )ب 	Skin  )الف

٢ کدام گزینه باعث ایجاد پوست برای کاراکتر می‌شود؟
Cmotion )د 	 IK Chain  )ج 	Bind )ب 	 Joint tool )الف

٣ با کدام گزینه می‌توان بین مفاصل و کاراکتر اتصال ایجاد کرد؟
 Creat IK Chain )د 	  Joint tool  )ج 	Skin )ب 	 Bind  )الف

٤ برای ایجاد یک خز نرم از کدام گزینه برای نرمی خز استفاده می‌شود؟
د( هیچ کدام 	  Frizz  )ج 	Root )ب 	Brush tool )الف

٥ کدام تگ را برای ایجاد لباس باید استفاده کرد؟
Cloth )د 	 Collider body  )ج 	Align to spline )ب 	 Rigid body  )الف

پروژۀ عملی 

برای یک کاراکتر شلواری بسازید و کاراکتر را درحال راه رفتن انیمیت کنید و مطمئن شوید لباس هم همراه 
کاراکتر حرکت می‌کند.

Calculate Cache شکل 36ـ13ـ انتخاب گزینه

خروجی گرفتن )رندر(
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می‌رود:
  انواع رندر را بشناسد.

  تنظیمات رندر را بداند.

  بتواند تصاویر Multi-pass را ذخیره کند.

  مفهوم رندر پیش‌نمایش انیمیشن را بشناسد. 

  چگونگی رندر کارتون‌ها با Sketch & Toons را بداند.

انواع رندر   

برای رندر می‌توانید از یکی از این روش‌ها استفاده کنید: 

 Render View

 Render To Picture Viewer اگر می‌خواهید تصویر یا انیمیشن را رندر کنید، به جای استفاده از فرمان
باید در Picture Viewer رندر کنید. از این فرمان برای رندر صحنه در Viewport فعال استفاده کنید. 
Esc را  پیشرفت تدریجی رندر در نوار وضعیت نشان داده می‌شود. اگر لازم شد رندر را لغو کنید، کلید 
فشار داده یا با استفاده از ماوس کلیک کنید. برای دسترسی به گزینه‌های بیشتر برای کنترل رندر، فرمان 

Render > Render Settings را از منوی اصلی انتخاب کنید. 

 Render Active Object

این فرمان، اشیای انتخاب‌شده و فرزندان آنها را در Viewport فعال رندر می‌کند. نوار نشان‌دهندۀ وضعیت 
رندر را در گوشۀ سمت چپ پایینی صفحه‌نمایش می‌بینید. برای لغو رندر، باید کلید Esc را فشار داده یا با استفاده 
 Render > Render Settings از ماوس کلیک کنید. برای دسترسی به گزینه‌های بیشتر برای کنترل رندر، فرمان

را از منوی اصلی انتخاب کنید. 

 Render Region

با استفاده از این فرمان می‌توانید بخشی از تصویر را در Viewport رندر کنید. به محض انتخاب این فرمان، با 
ترسیم کادری در Viewport مشخص کنید کدام بخش را می‌خواهید رندر کنید. نوار نشان‌دهندۀ وضعیت رندر 
را در گوشۀ سمت چپ پایینی صفحه‌نمایش می‌بینید. برای لغو رندر، باید کلید Esc را فشار داده یا با استفاده از 
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 Render > Render Settings ماوس کلیک کنید. برای دسترسی به گزینه‌های بیشتر برای کنترل رندر، فرمان
را از منوی اصلی انتخاب کنید. 

 Render To Picture Viewer

Picture Viewer گزینه‌هایی دارد که با استفاده از آنها می‌توانید برخی کانال‌های رنگ را غیرفعال کرده یا 
اندازۀ نمایش را تغییر دهید. با استفاده از این فرمان می‌توانید صحنه را در Picture Viewer رندر کنید. 
اگر می‌خواهید تصویر یا انیمیشن را ذخیره کنید، قبل از استفاده از این کارکرد، نام فایل موردنظر خود را در 
بخش تنظیمات رندر وارد کنید. به محض شروع رندر، وضعیت رندر در نوار وضعیت نمایش داده می‌شود. در 
این نوار، مقدار زمان سپری‌شده از زمانی که رندر آغاز شده است نشان داده می‌شود. اگر درحال رندر انیمیشن 
هستید، شمارۀ فریم جاری و تعداد کل فریم‌ها نیز نشان داده می‌شود. برای لغو رندر، باید کلید Esc را فشار 
دهید. برای دسترسی به گزینه‌های بیشتر برای کنترل رندر، فرمان Render > Render Settings را از 

منوی اصلی انتخاب کنید. 

 Render HUD

با استفاده از این گزینه می‌توانید از HUD در تصویر یا انیمیشن رندرشده استفاده کنید. این ویژگی برای 
ضمیمه کردن اطلاعاتی مانند زمان فریم در رندر مفید واقع می‌شود. 

 Multi-pass Rendering

این گزینه به‌ویژه زمانی بسیار مفید واقع می‌شود که بخواهید از تنظیمات نورپردازی مختلف در رندر استفاده 
کنید. به این ترتیب رندر کردن یک فایل Multi-pass کمتر زمان می‌برد تا بخواهید تمام پروژه‌ها را جداگانه 

رندر کنید. 
Multi-pass Rendering به شما امکان می‌دهد تا مراحل پس از ویرایش را در برنامه‌های دیگری مانند 
 CINEMA دنبال کنید. با استفاده از این ویژگی می‌توانید پروژۀ Photoshop یا Adobe After Effects
4D خود را به لایه‌های مجزایی مانند سایه‌ها، انعکاس‌ها، های‌لایت‌ها یا هریک از منابع نور مجزا تفکیک کنید. 
 )B3D( BodyPaint 3D و RLA، RPF، Photoshop (PSD) می‌توانید این لایه‌ها را به یکی از فرمت‌های

ذخیره کنید. 
فرض کنید می‌خواهید فیلم پیچیده‌ای را رندر کنید که در آن از انعکاس‌های زیادی استفاده شده است. به 
کمک Multi-pass، دیگر لازم نیست صحنۀ CINEMA 4D را بارها و بارها رندر کنید. در عوض فقط باید 
درجۀ تاری لایۀ Reflections را کاهش دهید. گزینه‌های موجود در کادر Render Settings به این شرح 

هستند: 
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تنظیمات رندر 

منوی Render حاوی تمام گزینه‌هایی است که برای رندر تصویر یا انیمیشن به آنها نیاز دارید. می‌توانید از 
گزینه‌های پیش‌فرض متعددی برای رندر استفاده کنید، مثلًا رندر برای پیش‌نمایش یا رندر نهایی. به این 
ترتیب دیگر لازم نیست هربار تنظیمات را تک به تک تغییر دهید. حتی با استفاده از تنظیمات رندر می‌توانید 
از وضعیت Multi-pass rendering نیز استفاده کنید. توجه داشته باشید که کارت گرافیکی هیچ تأثیری 

در سرعت رندر ندارد. 
اگر CINEMA 4D نتواند بافتی را هنگام رندر بیابد، پیام هشداری نمایش داده می‌شود. اگر انتخاب کنید 
که رندر را به همان شکل ادامه دهید، از مَتریال بدون آن بافت استفاده می‌شود. CINEMA 4D بافت‌ها را 
در محل‌های زیر جستجو می‌کند: پوشۀ صحنه، پوشۀ Tex در صحنه، پوشۀ Tex در CINEMA 4D، پوشۀ 

Texture Paths )و زیرپوشه‌های آن( که در بخش Preferences مشخص شده است. 

  Multi-pass ذخیره‌سازی تصویر

برای مشاهدۀ هریک از لایه‌های تنظیم شده می‌توانید از منوی Channels در Picture Viewer استفاده 
کنید. کادر انتخاب Save Multi-pass Image را درحالت تأیید قرار دهید تا تصویر Multi-pass هنگام 

رندر در Picture Viewer ذخیره شود. 

شکل 1ـ14ـ تنظیمات رندر
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مفهوم رندر پیش‌نمایش انیمیشن 

حالا که صحنه را ایجاد کرده، نور را تنظیم کرده، اشیا را متحرک کرده و مَتریال‌ها را به آنها نسبت داده‌اید، 
زمان آن است که نتیجۀ کار خود را مشاهده کنید. تنها کاری که باید انجام دهید این است که این صحنۀ 
سه‌بعدی را به تصویری دو بعدی تبدیل کنید )در اصل انیمیشن مجموعه‌ای از تصاویر است و شما باید تصاویر 
را »رندر« کنید(. Cinema 4D گزینه‌های متعددی برای رندر کردن صحنۀ سه‌بعدی در اختیار شما قرار 

می‌دهد. 
کرده  رندر   Cinema 4D استاندارد  تنظیمات  از  استفاده  با  را  انیمیشن  آخر  فریم  کنید می‌خواهید  فرض 
و ببینید صحنۀ آخر واقعاً چه شکلی دیده می‌شود. این روش رندر کردن بیشتر از همه مرسوم است، زیرا 

می‌توانید دریابید آیا صحنه مسیر درستی را طی کرده است یا خیر. 
لغزندۀ زمان را به فریم صفر انتقال داده و کلیدهای Ctrl + R را در صفحه‌کلید فشار دهید. 

سه روش برای رندر کردن نمای جاری وجود دارد: 
1 با استفاده از منوی اصلی 

 Ctrl + R ٢ کلیدهای میانبر
 Editor ٣ کلیک روی آیکن پنجرۀ

از روشی‌ استفاده کنید که برای شما راحت‌تر است. 
رندر  کامل  به‌طور  را   Editor نمای  کل  نمی‌خواهید  گاهی 
هم  باز  شماست.  موردنظر  آن  از  بخشی‌  فقط  بلکه  کنید، 
را   Render > Render Region فرمان  نیست.  مشکلی 
به‌علاوه  علامت  به  تبدیل  ماوس  مکان‌نمای  کنید.  انتخاب 
می‌شود. روی بخشی‌ که می‌خواهید رندر شود کادر انتخابی 

را ترسیم کنید تا فقط همان بخش رندر شود. 
این  را رندر کنید. در  گاهی فقط می‌خواهید یک شی‌ء خاص 
صورت باید شی‌ء موردنظر خود را در Object Manager انتخاب 
کرده و سپس فرمان Render > Render Active Objects را 
انتخاب کنید. به این ترتیب فقط اشیای انتخاب‌شده رندر می‌شوند. 
بر  سریع  مروری  می‌دهد  امکان  به شما   Editor نمای  رندر 
صحنه داشته باشید، اما نمی‌توانید هیچ پردازشی‌ روی تصویر 
اعمال کنید، مثلًا نمی‌توانید آن را در درایو سخت ذخیره کنید. 
حتی با بهترین رندر هم اگر نتوانید تصاویر تولید‌شده را ذخیره 
 Cinema 4D که  البته  داشت؟  خواهد  فایده‌ای  چه  کنید 

فرمانی برای این منظور در نظر گرفته است. 
را فشار دهید.   Shift+R یا کلیدهای  انتخاب کرده  را   Render > Render to Picture Viewer فرمان 
 File > Save Picture As پنجرۀ جداگانه‌ای باز شده و صحنه در آن رندر می‌شود. درحین رندر صحنه فرمان

Render شکل 2ـ14ـ منوی
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را انتخاب کنید. پنجرۀ دیگری نمایش داده می‌شود. محل ذخیره‌سازی را مشخص کرده و روی OK کلیک کنید. 

   Sketch & Toons چگونگی رندر کارتون‌ها با

Sketch And Toons از خانوادۀ NPR است. NPR مخفف Non-Photorealistic Renderer است و 
نشان می‌دهد قرار نیست رندرها، تصاویری واقعی باشند بلکه برعکس، قرار است تصاویری ایجاد شوند که انگار 

به روش‌های تکنیک‌های سنتی انیمیشن‌سازی ایجاد شده‌اند. 
استفاده از Sketch and Toon بسیار ساده است. حتی درصورت تمایل می‌توانید از تنظیمات پیش‌فرض 
Sketch and Toon استفاده کنید تا به سرعت به نتیجۀ موردنظر دست یابید. در غیر این صورت، تنظیمات 

گسترده‌ای در اختیار شما قرار می‌گیرد که می‌توانید از آنها استفاده کنید. 
Sketch and Toon، جلوه‌ای است که مرتبط با رندر است. همان‌طور که انتظار دارید، تنظیمات آن را در 
منوی Effects در کادر Render Settings خواهید یافت. به محض این که گزینۀ Sketch and Toon را 
از منوی Enable Post Effects انتخاب کنید، مجموعۀ گسترده‌ای از تنظیمات در اختیار شما قرار می‌گیرد. 

این پارامترها به شما امکان می‌دهند شکل مقدماتی رندرهای خود را تنظیم کنید. 

 Material نیز خواهید یافت. نگاهی به CINEMA 4D را در نقاط دیگری از Sketch and Toon البته
Manager بیندازید. به محض این که ویژگی Sketch and Toon را انتخاب می‌کنید، مَتریال Sketch ایجاد 

می‌شود. این مَتریالی است که برای به تصویر کشیدن خطوط در رندر مورد استفاده قرار می‌گیرد. 

Sketch and Toon شکل 3ـ14ـ تنظیمات
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ضمناً متوجه خواهید شد که این مَتریال در Material Manager دارای تنظیمات زیادی است. این تنظیمات 
Global بوده و بر کل صحنه تأثیر می‌گذارند. 

Sketch شکل 4ـ14ـ متریال

Sketch شکل 5ـ14ـ تنظیمات متریال

این قانون کلی را به خاطر داشته باشید: خصوصیات Sketch در کادر Render Settings مشخص می‌کنند 
چه چیزی قرار است رندر شود )خطوط واضح؟ خطوط پنهان؟( و خصوصیات مَتریال طریقۀ رندر را مشخص 
می‌کنند )پهنای خطوط؟ رنگ خطوط؟(. البته لازم نیست تمام اشیا را به یک شیوه رندر کنید. می‌توانید 
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مَتریال Sketch را به دلخواه تنظیم کرده و آن را در اشیای مختلف اعمال کنید. به‌عنوان مثال می‌توانید 
طراحی مدادی را با شیء کارتونی ترکیب کنید بدون این که مشکلی پیش آید. 

در آخر این که، Sketch and Toon چهار گزینه برای Sketch shader ارائه می‌دهد که می‌توانید از آنها در 
کانال Normal مَتریال استفاده کنید، اما پیشنهاد ما این است که از آنها در کانال Luminance استفاده کنید. 
 Sketch ها به صورت مستقل عمل می‌کنند، یعنی برای استفاده از آنها نیاز نیست حتماً ویژگیShader این
and Toon را فعال کرده باشید. این Shaderها عبارت‌اند از: Art برای جلوه‌هایی مانند نقاشی رنگ و روغن یا 
 .Cross Hatching برای پردازش Hatch برای جلوه‌های پرینت و Spots ،برای شیوه‌های کارتونی Cel ،آکرولیک

Sketch and Toon هایShader شکل 6ـ14ـ

Sketch and Toon سطوح مختلفی از کنترل را در اختیار شما قرار می‌دهد. اگر تازه‌کار هستید و با دیدن 
دکمه‌ها و لغزنده‌های بی‌شمار سردرگم شده‌اید، می‌توانید سطح کنترل را در سطح Easy قرار دهید تا برخی 

کارکردها پنهان شوند. 
زمانی که طول می‌کشد تا صحنۀ Sketch and Toon رندر شود، بستگی به اندازه یا پیچیدگی صحنه دارد. 
اگر زمان رندر خیلی طولانی شده است، با استفاده از تگ‌ها اشیایی را در صحنه بیابید که می‌توانید از رندر 

حذف کنید. با پایین آوردن کیفیت Anti-aliasing نیز می‌توانید سرعت رندر را بهبود ببخشید. 
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پرسش‌های تشریحی 

Render Active Object 1 را توضیح دهید.
٢ قابلیت‌های Render Picture View را بنویسید.

٣ Multi-pass rendering چه امکاناتی را به شما می‌دهد؟
٤ NPR چیست؟

٥ سه روش برای رندر کردن نمای جاری را نام ببرید.

پرسش‌های چندگزینه‌ای 

1 در کدام گزینه از انواع رندرهای زیر می‌توان برخی از کانال‌های رنگ را غیرفعال کرد؟
Render HUD )ب 	 Picture view  )الف

د( در هر سه گزینه این امکان وجود دارد 	 Render Active Object  )ج

٢ کدام رندر برای خروجی گرفتن نورپردازی‌های مختلف مناسب است؟
Render Active Object )ب 	Render HUD )الف

Render View )د 	 Multi-pass render  )ج

٣ Multi-pass render به شما امکان می‌دهد تا مراحل پس از ویرایش را در کدام نرم‌افزارها دنبال کنید؟
After Effects و Illustrator )ب 	Illustrator و Photoshop )الف
After Effects و Photoshop )د 	Blender و Photoshop )ج

٤ رندر Sketch & Toons مناسب چه تصاویری است؟
ب( جلوه‌های ویژه الف(  رئال	

د( سه بعدی ج(  کارتون‌ها	

٥ در Multi-passrender تصاویر را با چه فرمت‌هایی می‌توان ذخیره کرد؟
RLA )ب 	RPF )الف

د( همۀ موارد 	 PSD  )ج

پروژۀ عملی 

یک کاراکتر را درحال قدم زدن در فضای باز و نور آسمان انیمیت کنید. برای کاراکتر جنسیت پوست و لباس 
بسازید. دوربین‌ها را جای‌گذاری کنید و از پلان‌های ساخته‌شده خود رندر سه‌بعدی بگیرید.
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می‌رود:
  با مفاهیم و تعاریف تدوین آشنا باشد.

  بتواند از تدوین در امر فیلم‌سازی استفاده کند.

  مراحل تدوین فیلم را بداند.

  مفهوم تداوم و زمان را در تدوین بشناسد.

  ویژگی‌ها و معایب تدوین خطی را بداند.

  ویژگی‌ها و معایب تدوین غیرخطی را بداند.

در بيشتر قرن بیستم، خلق »تصاویر متحرک«، چه فیلم و چه ویدیو، تخصصی بود که تیم‌های حرفه‌ای ماهر 
و تجهیزات گران‌قیمتی را می‌طلبید. دوربین‌های فیلم‌برداری خانگی، وسوسه‌ای ساده را برای وارد شدن به 
دنیای ویدیو در آماتورها به‌وجود می‌آورد. در حقیقت آنها می‌توانند تصاویر متحرک را ثبت کنند؛ اما این ویدیو 
کاملًا خام محسوب می‌شود )تنها با اصلاح و بازنگری از طریق ویرایش است که »طرح اوليه« ویدیو به پیامی 
آنالوگ گران و پیچیده بود و تنها عده معدودی  به یادماندنی تبدیل می‌شود(. در گذشته ویرایش ویدیوی 

غیرحرفه‌ای برای خلق ویدیوهای آنالوگ مهارت و یا منابع لازم را در دست داشتند. 
رایانه، ویدیو و فیلم را مانند همه رسانه‌ها متحول کرد و امکانات گويايي را به آنها اضافه کرد که با به‌کارگیری 
ترفندهای آنالوگ تولید آنها غیرممکن می‌بود. نتیجه آن نیز شکل‌های جدیدی از بیان بوده است؛ از جلوه‌های 
ویژه گرفته تا شبیه‌سازی‌های دیجیتالی قانع‌کننده‌ای از بازیگران. جدیدترین فیلم و ویدیوهای دیجیتال هنوز 
البته در  نیاز دارند.  از تهیه‌کنندگان چندرسانه‌ای  از بودجه بسیاری  فراتر  رایانه ای  به تخصص و منابع  هم 
ویدیو‌های دیجیتال رومیزی نيز انقلابي به وقوع پیوسته است. ریزرایانه ها، دوربین‌های دیجیتال و نرم‌افزارهای 
ویرایش ویدیو، امکان افزودن فیلم به طیف گسترده‌ای از نرم‌افزارهای چندرسانه‌ای را برای افراد و تیم‌هاي 

تولید کوچک به طرزی اثربخش فراهم ساخته‌اند.

مفهوم تدوین در امر فیلم‌سازی 

برای درک قدرت و چالش‌های ویدیوی دیجیتال، باید ابتدا به عناصر ویدیو و ریشه‌های آن در فناوری‌های 
آنالوگ قرن گذشته باز گردیم. 

فیلم و ویدیو از مجموعه‌ تصاویر ثابتی تشکیل شده‌اند که به سرعت نمایش داده می‌شوند. ما به دو دلیل این 
تصاویر ثابت را به شکل حرکات مداوم مي‌بينيم. نخست اینکه هر تصویر یک لحظه از حرکت را ثبت و تغییرات 
در موقعیت اشیای متحرک را ضبط می‌کند. یک تصویر، پاهای اسب درحال دویدن را در ‌یک موقعیت نشان 
می‌دهد و تصویر بعدی موقعیت جدید آنها را در لحظه‌ای بعد ثبت می‌کند. عامل دوم ماندگاری دید است. 
تصویرهایی که در شبکیه تشکیل می‌شوند برای مدتی کوتاه پس از ناپدید شدن شیء باقی می‌مانند. اگر 
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تغيير  تصویرهای ثابت به اندازه کافی تند باشد، ماندگاری دید، زمان بين آنها را پر می‌کند و به درک جریانی 
پیوسته از حرکت می‌انجامد. 

آنالوگ هستند. فیلم تصاویر واحد را به‌عنوان مناطق پیوسته رنگ روی  فیلم و ویدیوی سنتی رسانه‌هایی 
به‌عنوان  را  تصاویر  آنالوگ  ویدیوی  می‌شود.  انداخته  پرده  روی  سپس  که  می‌کند  ضبط  شفاف  واسطه‌ای 
لوله‌های اشعه کاتد  تولید تصاویری روی  برای  ولتاژها  این  الکتریکی ضبط می‌کند. سپس  ولتاژهای متغیر 
)CRTs( یا پرده به کار گرفته می‌شوند. ترک‌های صدا برای فیلم و ویدیو‌های سنتی نیز از تكن‌كيهای آنالوگ 

بهره می‌گیرند. 
فرمت‌های دیجیتال به سرعت جايگزين ویدیو آنالوگ مي‌شوند، اما بسیاری از نرم‌افزار‌های چندرسانه‌ای 
به  ميك‌نند.  استفاده  خود  محصولات  نمایش  برای  آنالوگ  تلویزیون‌های  از  یا  آنالوگ  منبع  مواد  از  یا 
این دلایل، درکی ابتدایی از استاندارد‌های قدیمی‌تر ویدیو همچنان با توسعه چندرسانه‌ای مرتبط باقی 

می‌مانند. 
دیجیتال  ویدیوي  اما  نیست.  ویدیو مشهود  و  فیلم  از  بیشتر  در هیچ جایی  این  و  است  دیجیتالی  آینده 
چالش‌های بسیار مهمی را پیش روی توليدكنندگان چندرسانه‌ای قرار داده است. مهم‌ترین چالش آن اندازه 
بزرگ فایل است. ویدیوي دیجیتال نيز از مجموعه‌ای از تصاویر واحد تشکیل شده است که به سرعت نمایش 
داده می‌شوند. هر تصویر از عناصر بسیار کوچک عکس یا همان پیکسل ساخته شده است. به هر پیکسل 
یک رنگ اختصاص داده می‌شود. برای بازتولید طیف رنگ لازم برای عکس واقعی به کدی 24 بیتی برای 
هر پیکسل نیاز است. مانیتور رایانه هایی با پایین‌ترین درجه وضوح، شبکه‌ای از 640 پیکسل عرض و 480 
پیکسل ارتفاع را نمایش می‌دهد. این شبکه به 200 و 307 پیکسل و حدود یک مگابایت داده دیجیتال 
برای هر صفحه، ترجمه می‌شود. ویدیویی با حرکت کامل به نمایش سی عدد از این صفحه‌ها در هر ثانیه 
نیاز دارد. رایانه برای ویدیوی فشرده‌سازی‌نشده دیجیتال، تقریباً باید 30 مگابایت داده‌ در هر ثانیه ذخیره و 
پردازش کند. این به مراتب فراتر از توانایی پردازش و ذخیره‌سازی ریزرایانه های ابتدایی است. بهبود شگرفی 
که در سخت‌افزار و تكن‌كيهای فشرده‌سازی روي داد، به‌شدت بر محدودیت‌های آغازین در نمایش تمام 
صفحه ویدیوی رایانه رومیزی فائق آمد. پخش‌کننده‌های DVD که دستگاه‌های افزوده‌ رایجی به رایانه های 
نیز  را  دیجیتال  ویدیو‌های  iPodها هستند،  و  PDAها  مانند  قابل‌حملی  دستگاه‌های کوچک  و  شخصی 
به‌طور رضایت‌بخشی نمایش می‌دهند. البته فایل‌های ویدیویی بزرگ هنوز چالشی عمده به شمار می‌روند، 
به‌ویژه اگر یک نرم‌افزار برای توزیع روی شبکه درنظر گرفته شده باشد. توليدكنندگان چندرسانه‌ای هنگامی 
که می‌خواهند ویدیوی دیجیتالی با کیفیتی را بهك ارگيرند، معمولاً باید در خواسته‌های خود تخفیف قائل 

شوند.

به 10  تقریباً   ،CD با کیفیت  استریو  اضافه می‌کند. صدای  ویدیویی  فایل‌های  اندازه  به  نیز  صدا 
مگابایت در هر ثانیه نیاز دارد.

نکته
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مراحل تدوین فیلم 

تدوین ویدیوی دیجیتال چهار کار عمده را شامل می‌شود: 
 دریافت ویدیو از منبعی خارجی 

 تنظیم سكانس‌های ویدیو‌یی جداگانه یا »کلیپ‌ها« 
 تقسیم و برش کلیپ‌ها

 اضافه کردن گذار‌ها و جلوه‌های ویژه
نرم‌افزار ویرایش ابزارهایی را برای انجام این کارها فراهم می‌کند. نرم‌افزارهای ویرایشگر پنجره‌هایی دارند که 
در آنها هریک از فعالیت‌ها انجام می‌گیرد. نام و ویژگی‌های خاص این پنجره‌ها از كي محصول به محصولی 

ديگر متفاوت هستند، اما تقریباً همه مدل‌ها پیش‌نمایش، کتابخانه‌ها و پنجره‌های ساخت را دربرمی‌گیرند.
یک پنجره پیش‌نمایش، ویدیوی منبع را پیش از دریافت کردن نشان می‌دهد و برای پیش‌نمایش پروژه فعلی، 
در هر زمانی در طول فرایند ویرایش نیز به کار می‌رود. کنترل‌گرهای VCR مانندی برای بازگشت به عقب، 
حركت سريع به جلو، توقف و پخش، تعبیه شده‌اند. کلیپ‌هایی که به رایانه انتقال می‌یابند در یک پنجره 
کتابخانه جای داده می‌شوند. پنجره کتابخانه نیز عناوین، گذار‌ها و جلوه‌هایی را نمایش می‌دهد که می‌توانند 
کلیپ‌های  ساخت  پنجره  می‌شوند.  ترکیب  و  ویرایش  ساخت،  پنجره  در  کلیپ‌ها  شوند.  افزوده  ویدیو  به 
استوري‌بورد  ارائه می‌دهد.  خط زمان2  به‌عنوان یک  یا  استوري‌بورد1  به صورت  یا  را  ویدیویی سرهم شده 
مروری کلی‌تر است که در آن هر کلیپی با یک فریم‌ ویدیویی واحد نشان داده می‌شود. استوري‌بورد ترتیب 
کلیپ‌‌ها و گذار‌های بين آنها را نشان می‌دهد. این امر بررسی سازمان‌دهی کلی عناصر پروژه را برای ویرایشگر 
آسان می‌سازد. خط زمان نمایش دقیق‌تر این پروژه است. خط‌های زمان‌ مدت زمان ویدیو را نشان می‌دهند 
و چندین ترک را شامل می‌شوند. ترک‌ها برای ذخیره‌سازی کلیپ‌‌های ویدیویی مختلف و صداهای ضبط‌شده 
یا برای نشان دادن فریم‌های  برای نمایش کل پروژه بزرگ‌نمایی  به کار می‌روند. خط‌های زمان را می‌توان 

ویدیویی واحد کوچک‌نمایی کرد. 

 گام اول 
دریافت/وارد کردن ویدیو: نخستین گام در فرایند تدوین، دریافت ویدیو از دوربین و تحویل آن به رایانه 
است. این عمل به‌عنوان دریافت ویدیو یا وارد کردن ویدیو، بسته به نرم‌افزار مورد استفاده، توصیف شده است. 
برخی از دوربین‌های ویدیویی دیجیتال فيلم‌ها را مستقيماً روی دیسک‌های DVD ضبط می‌کنند. در این 
موارد، درایو DVD رایانه را می‌توان برای انتقال ویدیو به کار برد. البته همان‌طور که پیش از این اشاره شد، 
 DV نوارهای  به‌خوبی  ویدیو  ویرایش  برای  فرمتی که  بهره می‌گیرند؛   MPEG2 از فشرده‌سازی  ‌DVDها 
نیست. به‌علاوه، ضبط DVD کد زمانی موجود در نوار DV را تولید نمی‌کند. بنا به این دلایل، دوربین‌های 
از طریق  رایانه  به  انتقال  ادامه می‌دهند.  برای ذخیره‌سازی ویدیوی دیجیتال  نوار  از  بهره‌گیری  به  بسیاری 
ثانیه  بر  مگابایت  اندازه 800  به  انتقال‌هایی  نرخ  از   FireWire انجام می‌پذیرد.   FireWire نام  به  اتصالی 

پشتیبانی می‌کند و آن را برای انتقال فایل‌های ویدیویی بزرگ بسیار مناسب می‌سازد. 
Storyboard ـ 1
Timeline ـ 2



فصل پانزدهم: مفاهیم و تعاریف تدوین

165

ویدیویی  دوربین‌های  بخشد.  بهبود  را  ویدیو  دریافت  کارآمدی  می‌تواند  که  است  تكنكيی  تشخیص صحنه 
دیجیتال علاوه بر کد زمان موجود در نوار DV، چندین قلم اطلاعات اضافه نیز همراه با صدا و تصویر ضبط 
می‌کنند. این اطلاعات معمولاً تاریخ و زمان هستند. نرم‌افزار ویرایش می‌تواند از تغییر در این اطلاعات برای 
شناسایی جلسات مختلف ضبط به‌عنوان صحنه‌هایی جداگانه بهره بگیرد. اینها را می‌توان به صورت جداگانه 
دریافت کرد. این امر، کار انتخاب بخش‌های ویرایش ضروري را آسان‌تر می‌سازد چرا که فیلم اولیه منبع، 
به جای ظاهر شدن به‌عنوان یک سكانس ویدیویی بلند، به بخش‌هایی قابل‌شناسایی‌ تقسيم می‌شود. تشخیص 
صحنه می‌تواند بر اساس تغییر در محتوای فایل‌های ویدیویی نیز صورت پذیرد. نرم‌افزار ویرایش، ویدیوی 
وارده را برای شناسایی تغییرات عمده در تصاویر بررسی می‌کند و هرگاه این تغییرات روي دهند نقاط شکست‌ 
صحنه را مشخص می‌سازد. به تشخیص صحنه مبتني بر محتوا کمتر از تشخیص صحنه مبتني بر کد داده‌ها 
می‌توان اعتماد کرد، هرچند که نرم‌افزار ویرایش به کاربران اجازه می‌دهد که پارامترهای مورد استفاده برای 
بهبود دقت در تشخیص صحنه را تغییر دهند. تكن‌كيهای مبتني بر محتوا به‌ویژه هنگامی مفید هستند ‌که 
کد داده‌ها در دسترس نباشند، همان‌طور که برای مثال، در ویدیویی که از فرمت آنالوگ تبدیل شده باشد، 

چنین است. 
باشند.  شده  انتخاب  مشخص  به‌طور  که  است  منبع  نوار  از  بخش‌هایی  آن  انتقال  فرایند  دسته‌ای  دریافت 
ویرایشگر ویدیو نوار را اسکن می‌کند، »نقاط ورود« را برای علامت‌گذاری شروع یک صحنه دلخواه و »نقاط 
خروج« را برای علامت‌گذاری پایان صحنه انتخاب می‌کند. به محض آنکه همه صحنه‌های موردنظر مشخص 
شدند، فرایند دریافت آغاز می‌شود. نرم‌افزار ویرایش نوار را به عقب برمی‌گرداند و انتقال صحنه‌های موردنظر 
به رایانه را آغاز می‌کند. سپس کلیپ‌های ویدیویی دریافت‌شده روی ‌هارد دیسک رایانه ذخیره می‌شوند. آنها 
درون پنجره کتابخانه قابل‌مشاهده و برای رفتن به مرحله بعدی ویرایش و تنظیم در استوري‌بورد یا خط زمان 

آماده هستند. 

گام دوم 
عملیات پایه‌ای ویرایش ویدیو: کلیپ‌های ویدیویی دریافت‌شده، ویدیوی منبع1 را نشان می‌دهند يعني 
همان ویدیوی خامی که برای خلق محصول نهایی به کار می‌رود. ویدیوی منبع، با کشیدن تصویر کلیپ به 
درون پنجره کتابخانه و نقطه موردنظر در پنجره ساخت، برای ویرایش انتخاب می‌شود. به محض آنکه درون 
پنجره ساخت قرار گرفت، کلیپ به بخشی از ویدیوی مادر تبدیل می‌شود. ویدیوی مادر2 دنباله‌ای از کلیپ‌ها 

به شکلی است که در محیط ویرایش توسعه یافته‌اند. 
مادر  ویدیوی  عمومی  از ساختار  را  آساني  فهم  و  کلی  به پنجره ساخت، درک  مربوط  استوري‌بورد‌ی  نمای 
آن  به  کلیپ‌ها  کدام  دهد:  تشخیص  را  مسائل  این  می‌تواند  به‌راحتی  ویرایشگر  نرم‌افزار  مي‌آورد.  وجود  به 
اضافه شده‌اند، ترتیب آنها چیست و چه گذار‌هایی اعمال شده‌اند. با کلیک کردن روی یک کلیپ‌ می‌توان 
آن را در پنجره‌ای پیش‌نمايش داد که قرار است در آن نمایش داده شود. خط زمان نمای دقیق‌تری فراهم 
می‌آورد. ویدیو می‌تواند در ترک‌های مختلف وارد شود. صدا نیز می‌تواند در ترک‌های جداگانه‌ای منظور شود. 

زمان‌بندی سكانس‌های صدا و تصویر و نیز گذار‌ها و جلوه‌های ویژه، می‌توانند در خط زمان تنظیم شوند. 
Source Video ـ 1
Master Video ـ 2
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خرد کردن1 فرایند تقسیم یک کلیپ به بخش‌های متعدد است. ویرایش هم‌زمان با فیلم‌برداری، دریافت انواع 
مختلفی از نماها را دربردارد. یک کلیپ معین می‌تواند یک نمای باز داشته باشد که برای آشنا کردن بیننده در 
اوایل ویدیو مطلوب باشد و نمای باز دیگری برای ساختن یک نمای پایانی اثرگذار. تقسيم‌بندي به این بخش‌ها 
اجازه می‌دهد در موقعیت‌هایی به کار روند که بیشترین اثرگذاری را داشته باشند. تقسيم‌بندي را می‌توان در 

خط زمان به انجام رساند، ولی گاهی پنجره کتابخانه نیز از آن پشتیبانی می‌کند. 
ویرایشگرهای ویدیویی برای به‌کارگیری منابع اولیه خود همواره به دنبال اثربخش‌ترین راه می‌گردند. این کار 
اغلب مستلزم حذف فریم‌هایی از کلیپ‌هاست. پیرایش2، از بين بردن فریم‌های ناخواسته از ابتدا ‌یا انتهای 
را شناسایی می‌کند.  پایان جدید  نقطه  و یک  نقطه شروع جدید  ویرایشگر یک  است.  ویدیویی  یک کلیپ 
سپس نرم‌افزار فریم‌هایی را حذف می‌کند که خارج از این محدوده قرار دارند. پیرایش می‌تواند در خط زمان 
به انجام برسد. برنامه‌های پیشرفته‌تر نیز پنجره‌ای جداگانه یا پنجره‌هایی را در اختیار می‌گذارند که در آنها 
فریم،  به  فریم  پیشروی  می‌شود:  داده  نمایش  پیرایش،  برای  موردنیاز  کنترل‌گرهای خاص  با  همراه  کلیپ 
کنترل‌گرهای پیش‌نمایش )پخش، توقف، عقب‌گرد( و دکمه‌ها یا كوليس‌های لغزنده برای علامت‌گذاری نقاط 

شروع و پایان. 
پیرایش فریم‌هایی را حذف می‌کند و در نتیجه طول کلی ویدیو را کوتاه می‌سازد. در برخی موارد، حفظ طول 
معینی از ویدیو اهمیت دارد. برای مثال، یک پیام بازرگانی ممکن است لازم باشد دقیقاً شصت ثانیه طول 
بکشد یا دنباله‌ای از تصاویر ممکن است برای تکمیل دکلمه‌ای طراحی شده باشد که دو دقیقه و ده ثانیه به 
طول می‌انجامد. یک رویکرد، کشیدن دستی کلیپ ویدیویی دیگری در این پروژه، برای جبران فریم‌های از 
دست رفته کلیپ پیرایش شده است. رویکرد دیگر به‌کارگیری پیرایش دو طرفه است که ویرایش غلتان هم 
نامیده می‌شود. در یک ویرایش غلتان پیرایش یک کلیپ به صورت خودکار کلیپ بعدی را طولانی‌تر می‌کند. 

این کار مدت زمان اصلی ویدیو را حفظ می‌کند. 
گذار‌ها3 جلوه‌هایی هستند که برای حرکت به درون کلیپ یا خارج شدن از آن به کار می‌روند. گذار‌ها معمولاً 
بين کلیپ‌‌ها اعمال می‌شوند، اما آنها را می‌توان در ابتدای نخستین کلیپ ویدیو یا در پایان آخرین کلیپ نیز 
به کار برد. درحالی که صدها گذار متنوع وجود دارند، دسته‌های عمده گذار عبارت‌اند از: برش‌ها، محو شدن‌ها، 

حل‌ شدن‌ها و پاک‌سازی‌ها. 
 برش4 جزو ساده‌ترین گذار‌ها است، چرا که به یک معنا، اصلًا گذار محسوب نمی‌شود. در برش، یک کلیپ 

پایان می‌گیرد و دیگری بدون دخالت هیچ جلوه‌ای آغاز می‌شود. 
 محو شدن‌ها5 گذار‌هایی بين یک تصویر و صفحه‌ای سیاه هستند. برخی اوقات یک ویدیو با محو بودن 
درون سیاهی و گذار به نخستین تصویر کلیپ آغاز می‌شود. کلیپ نهایی می‌تواند از آخرین تصویر به درون 
سیاهی محو شود. محو شدن‌ها بين کلیپ‌‌ها نیز به کار می‌روند؛ این جلوه، اغلب برای القای تغییری عمده‌ در 

صحنه صورت می‌گیرد. 

Splitting ـ 1
Trimming ـ 2
Transitions ـ 3
Cut ـ 4
Fades ـ 5
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 در حل‌ شدن1، آخرین تصویر کلیپ اول در نخستین تصویر کلیپ دوم حل می‌شود. حل شدن‌ها اغلب 
تغییر مکان ظریفی بين صحنه‌ها فراهم می‌آورند و تمایل دارند تا برای القای پیوستگی بين اعمال مرتبط، 

به کار گرفته شوند. 
پاک‌سازی2، یک تصویر را با تصویر دیگر، از طریق حرکت دادن هریک به شکلی خاص، جا به جا می‌کند. برای 
به دور صفحه‌نمایش می‌چرخاند.  ثابت است  انتهای آن در مرکز  را که یک  مثال پاک‌سازی شعاعی، خطی 

همین‌طور که خط صفحه‌نمایش را جارو می‌کند، تصویر نخست جایگزین تصویر دوم می‌شود.
ویرایشگرهای ویدیویی همچنین ابزارهای گوناگونی را برای پدید آوردن عنوان‌ها، قدردانی‌ها و سایر متن‌ها 
ارائه می‌دهند. بسیاری از ویرایشگرها علاوه بر کنترل معمول روی فونت، اندازه و رنگ، جلوه‌های ویژه متنی 
قدردانی‌هایی که  یا  تایپ می‌شوند  به نظر می‌رسد روی صفحه‌نمایش  عناوینی که  مانند  ارائه می‌دهند  نیز 
می‌چرخند. انعطاف‌پذیری ویرایش دیجیتال در دسترس بودن بسیاری از جلوه‌های ویژه دیگری را تضمین 
می‌کند که می‌توانند در هر قسمتی از ویدیو به کار روند. همه چیز، از مه و باران گرفته تا آثار زمین‌لرزه و گرد 

و غبار می‌توانند به‌راحتی در ویدیوي دیجیتال به کار برده شوند.

 گام سوم 
رندر3 فرایند ویرایش، ویدیوی مادری تولید می‌کند که تنها می‌توان آن را درون نرم‌افزار ویرایش به کار گرفت. 
در واقع، ویدیوی مادر مجموعه‌ای از شاخص‌ها و راهبردها برای انجام عملیات روی فیلم‌های اولیه منبع اصلی 
است. ویرایش، فیلم اولیه را تغییر نمی‌دهد و ویدیوی تازه‌ای نیز به وجود نمی‌آورد. این ترفند اطلاعات ویدیوی 

اصلی را حفظ می‌کند و سبب صرفه‌جویی در فضای فایل می‌شود.
برای این که ویدیوی مادر در نرم‌افزارهای دیگر بهك ار رود یا حتی به‌عنوان یک محصول مستقل عمل کند، 
باید به یک فایل ویدیویی جدید و مستقل تبدیل شود. این امر معمولاً مستلزم پدید آوردن محتوای دیجیتال 
تازه‌ای است، برای مثال، حل شدن‌ها به فریم‌های جدیدی نیاز دارند که عناصر دو یا چند تصویر مختلف را 
با هم ترکیب کنند همچنين جلوه‌های ویژه به تغییر دادن بسیاری از فریم‌ها نیاز خواهند داشت. رندر فرایند 
اعمال کردن اعمال ویرایشی است که ویدیوی مادر براي تولید فایل‌های ویدیویی مستقل و جدید مشخص 
کرده است. با توجه به طیف گسترده گزینه‌های ویرایشی موجود، رندر می‌تواند به عملیاتی بسیار زمان‌بر و پرُ 

پردازش تبدیل شود.
در طول فرایند رندر، توليدكننده گزینه‌های خروجی را نیز براساس کاربرد درنظر گرفته شده ویدیو مشخص 
می‌کند. ویدیو‌یی که برای توزیع به شکل DVD درنظر گرفته شده باشد، نسبت به ویدیوی مناسب برای 
وب به شکل متفاوتی رندر می‌شود. گزینه‌های رندر نرم‌افزار‌های دیجیتال عبارت‌اند از: روش فشرده‌سازی 
ویدیو، درجه وضوح یا اندازه صفحه‌نمایش، نرخ فریم، نرخ داده‌های ویدیویی و فرمت صوتی و نرخ داده‌های 

صوتی. 

Dissolve ـ 1
Wipe ـ 2
Rendering ـ 3
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مفهوم تداوم و زمان در تدوين 

زمان1  و صدا، یک کد  تصاویر  به هنگام ضبط  دیجیتال  ویدیویی  دوربین‌های  در  زمان  از کد  مراقبت  برای 
می‌نویسند. کد در قالب ساعت: دقیقه: ثانیه: فریم نوشته می‌شود. یک کد زمان 01:21:36:05 مکانی را در 
یک ساعت، بیست و یک دقیقه، سی و شش ثانیه و فریم پنج نشان می‌دهد. این کد را می‌توان در هریک از 
فریم‌های ویدیو مشاهده کرد و آن را به‌عنوان آدرس به کار برُد. کد زمان، پیدا کردن سريع قسمت‌های خاص 
كي ویدیو را ممکن می‌سازد. نرم‌افزار ویرایش برای انجام تقسيم‌بندي، پیرایش‌ها، گذار‌ها و جلوه‌های دیگر از 

کد زمان استفاده ميك‌ند. 
کاربرانِ دوربین‌هایی که با نوار فیلم کار می‌کنند باید کارهای احتیاطی لازم را برای حفاظت از کد زمانی 
دقیق انجام دهند. این دوربین‌ها درصورتی کد زمانی پیوسته و یکتا را برای کل طول نوار ضبط می‌کنند 
قبلی  نقطه ضبط  از  نوار  اگر  این حال  با  کنند.  قبلی شروع  نقطه ضبط‌شده  از  را  که جلسه جدید ضبط 
جلوتر برود این کد زمانی منقطع )قطع( خواهد شد و به‌محض این‌که دوربین، دوباره ضبط را از سربگیرد 
اتفاق می‌افتد که دوربین به‌منظور مشاهده بخش  امر زمانی  این  از کد شروع خواهد شد.  دنباله جدیدی 
ضبط‌شده قبلی به VCR تغییر حالت دهد و سپس قبل از این‌که ضبط دوباره شروع شود از آخرین فریم 
زمانی ضبط‌شده جلوتر برود. از آنجا ‌که هیچ کد زمانی روی نوار وجود ندارد )تعریف نشده است( دوربین 
مختلف  فریم‌های  ترتیب،  به ‌این  می‌کند.  شروع  نو  از  را  کد  و  داده  تشخیص  جدید  نوار  به‌عنوان  را  آن 
»آدرس« یا کد زمانی یکسانی را به‌اشتراک خواهند گذاشت. برای دوری از دردسر‌ها و اطلاعات متناقضی 
که دوربین درنتیجه عملکرد خود هنگام فهرست‌بندی و تدوین فیلم پدید می‌آورد کد زمانی نباید به‌هیچ 
عنوان منقطع شود. دوربین‌ها غالباً به ابزار کنترل »End Search« به‌منظور مکان‌یابی خودکار نقطه پایانی 

ضبط مجهز هستند.

ويژگي تدوين خطي، معايب تدوين خطي 

فرض کنید درحال مشاهده مسابقه فوتبال به صورت زنده از تلویزیون هستید، در پایین تصویر هر از گاهی 
می‌گیرند  انجام  تصاویر  روی  رایانه ای  سیستم  توسط  پیام‌ها  این  می‌شود،  دیده  پیام‌هایی  و  بازیکنان  نام 
نرم‌افزار و سخت‌افزار موردنظر  از قبل در  این نوشتار و گرافیک‌ها  آن هم به صورت لحظه‌ای و زنده، یعنی 
تنظیم می‌شوند و در زمان فوتبال فقط جای نام بازیکنان و عدد‌های مربوطه ویرایش و با یک کلیک پایین 

صفحه‌نمایش داده می‌شوند. به این نوع تدوین، تدوین خطی2 یا LE می‌گوییم.

Time Code ـ 1
Linear Editing ـ 2
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تدوین خطی فیلم نیازمند دستگاه‌های خاص و همچنین اتصالات سخت‌افزاری است.
در یک مراسم یا همایش، سه دوربین داریم، هر سه باید به یک سیستم توسط کابل یا بی‌سیم متصل شوند، 
این اتصال باید توسط یک سخت‌افزار مخصوص انجام شود. تصویر هر سه دوربین باید هم‌زمان وارد نرم‌افزاری 

که با سخت‌افزار هماهنگ است شوند.
اپراتور )شخص ویرایشگر ویدیو( با توجه به نیاز در زمان مشخص می‌تواند تصویر یک دوربین را به‌عنوان اصلی 
درنظر بگیرد. نوشتارها و حالت‌های گرافیکی را که از قبل آماده کرده است فراخوانی و همان لحظه روی تصویر 

به نمایش بگذارد و می‌تواند تصویر در تصویر و یا ترانزیشن نیز اجرا کند.
تا اینجا هر دوربین را که خواست انتخاب و همه جلوه‌ها و نوشتارها را نیز اعمال کرد، حاصل چه می‌شود و 
کجا می‌رود؟ در این زمان از همان سیستمی که ویرایش‌های لحظه‌ای درونش انجام می‌شود یک خروجی 
تصویر به تجهیزات صدا و سیما یا پخش همگانی و یا دستگاهی که قابلیت رکورد داشته باشد متصل می‌شود 

و هر آن چیزی که اپراتور می‌بیند روی آن دستگاه ذخیره خواهد شد.
بیشتر مصرف تدوین خطی برای نمایش برنامه‌های زنده کاربرد دارد. هر کاری که انجام دهیم امکان بازگشت 
یا تصحیح ندارد چون زنده درحال پخش شدن و مشاهده از سوی بسیاری مخاطب است، پس اپراتور تدوین 
خطی باید مسلط باشد چون امکان مرور فیلم وجود ندارد و همه تصاویر همان لحظه از مقابل دیدگان ما گذر 

خواهند کرد.
از معایب این نوع تدوین می‌توان به لحظه‌ای بودن نوع ویرایش اشاره کرد، ویرایشی که امکان بازگشت نخواهد 

داشت. ضمناً این روش تدوین بسیار سخت است و نیاز به کاربری آموزش‌دیده و خبره دارد.

 ـ١٥ شکل 1
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ويژگي تدوين غيرخطي، مزايای تدوين غيرخطي 

به زبان ساده، تدوین غیرخطی همان ویرایش ویدیو با سیستم و نرم‌افزارهای ویرایشگر ویدیو است.

که  داریم  بهتری  خیلی  شرایط  و  است  بازتر  خیلی  ما  دست  غیرخطی  تدوین  در  خطی،  تدوین  برخلاف 
عبارت‌اند از:

 در لحظه می‌توانیم اشتباهات را تصحیح کنیم، زیرا امکان دسترسی سریع به هر قسمت از فیلم وجود دارد.
 می‌توانیم هر نوع جلوه‌ای بگذاریم و آن را تغییر دهیم.

 می‌توانیم تمام پروژه را بارها مرور کنیم.
 این کار از اتلاف وقت جلوگیری می‌کند.

 فیلم‌ها از قبل رکورد شده‌اند )با موبایل یا دوربین(، سپس به سیستم منتقل می‌شوند.
 شما می‌توانید بارها و بارها اشتباه کنید، از اول شروع کنید، حذف و تولید مجدد کنید.

پرسش‌های تشریحی 

1 کد زمانی چیست و چرا در فیلم‌برداری ویدیو مهم است؟
٢ سه استاندارد پخش عمومی ویدیو‌های آنالوگ کدام اند؟

٣ ماندگاری دید چیست؟
٤ در نرم‌افزار تدوین ویدیو، پنجره پیش‌نمایش چه کاری انجام می‌دهد؟

٥ ویدیوی منبع چیست؟
٦ خرد کردن چیست؟

 ـ15 شکل 2
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پرسش‌های چهار گزینه‌ای 

1 در استوري بورد كي ويديو چه مواردي نمايش داده مي‌شود؟
الف(  فريم‌هاي موجود در ويديو

ب( مدت زمان ويديو و ترا‌كهاي موجود در آن
ج( فريم‌ها با درنظر گرفتن آثار جلوه‌ها و گذار‌هاي اعمال شده بر روي آنها

د( كي فريم از هر كليپ به اضافه ترتيب كليپ‌ها و گذار بين آنها

٢ كي فريم از هر كليپ به اضافه ترتيب كليپ‌ها و گذار بين آنها
الف( با قرار گرفتن سوژه در كي زاويه بسته، ابهامات و سؤالاتي براي بيننده ايجاد مي‌شود.

ب( سوژه صفحه نمايش را پر ميك‌ند و توجه بيننده روي جزئيات متمركز مي‌شود.
ج( تصوير از فاصله بسيار دوري گرفته مي‌شود تا محيط به طور كامل در ديد بيننده قرار گيرد.

د( سوژه در كي طرف صفحه نمايش قرار مي‌گيرد تا معناي خاصي را القا كند.

٣ ترانزيشن چيست؟
الف( تبديل ويديوي آنالوگ به ديجيتال
ب( تبديل ويديوي ديجيتال به آنالوگ

ج( جلوه‌هايي براي حركت به درون كي كليپ يا خارج شدن از آن
د( انتقال داده‌هاي ويديويي روي شبكه و تحويل آن به كاربر

٤ تمام اين گزينه‌ها عواملي هستند كه بر يكفيت خروجي كي ويدیوي رندر شده تأثير دارند، بجز:
ب( رسانه ذخيره‌سازي الف( نرخ داده ويدیويي	
د( اندازه صفحه نمايش ج( نرخ فريم ويدیويي	

٥ همه گزینه‌های زیر فرمت فایل ویدیوی دیجیتال محسوب می‌شوند، بجز:
CD-Video )ب 	S-Video )الف

DVD Video )د 	Quicktime )ج
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می رود:
  فرمت های تصویری را بشناسد.

  انواع استانداردهای تصویری را بشناسد.

  استانداردهای جدید جهانی را بشناسد.

  با مفهوم رزولوشن تصویر آشنا باشد.

  نسبت های ظاهری تصویر را بشناسد.

  با مفهوم کدک آشنا باشد.

روش  و  فریم  نرخ  وضوح صفحه نمایش،  درجه  دارد:  بستگی  اصلی  عامل  سه  به  دیجیتال  ویدیوی  کیفیت 
ارائه تصویر  فشرده سازی. درجه وضوح صفحه نمایش1، تعداد پیکسل های افقی و عمودی است که برای 
ویدیویی به کار می رود. درجه وضوح صفحه نمایش اندازه ای را که ویدیو برای کاربر ظاهر می شود، تعیین 
تعداد  فریم2  نرخ  ارتفاع.  پیکسل   480 و  عرض  پیکسل   720 با  پنجره ای  شکل  به  مثال،  برای  می کند، 
فریم های واحدی است که در هر ثانیه نمایش داده می شوند. روش فشرده سازی یا کدک3، الگوریتم خاص یا 
مجموعه ای از الگوریتم هایی است که برای فشرده سازی و سپس باز کردن ویدیو های دیجیتال به کار می رود. 
اندازه بزرگ صفحه های نمایش و نرخ فریم های بالاتر به پردازش و پهنای باند بیشتری نیاز دارند كه آن هم، 

اغلب فشرده سازی بیشتری را نيز طلب می کند.

 SECAM و PAL ،NTSC انواع استانداردهاي تصويري

 ،NTSC فرمت پخش تلویزیونی ویدیو در  ایالات متحده را تثبیت کرد. استاندارد NTSC ،1952 در سال
شامل مشخصه هایی برای نسبت ابعاد تصوير، درجه وضوح، سرعت اسکن، روش اسکن و تكنيك های پخش 

که برای خلق تصاویری در تلویزیون های آمریکا به کار گرفته شد. 
نسبت ابعاد تصوير4 رابطه بين عرض و ارتفاع تصاویر یا فریم های ثابت است که سکانسی از فیلم یا ویدیو 
را تشکیل می دهد. همچنین شکل صفحه نمایشی را تعیین می کند که برای نمایش دادن فیلم یا تلویزیون به 
کار خواهد رفت. نسبت ابعاد تصويری NTSC برای تلویزیون 4:3 است )برای هر چهار واحد عرض، سه واحد 
ارتفاع در نظر گرفته می شود(. صفحه نمایش تلویزیونی که 16 اینچ پهنا دارد، 12 اینچ ارتفاع خواهد داشت. 

تلویزیون های کوچ کتر و بزرگ تر همین نسبت را حفظ می کنند. 
درجه وضوح5 ویدیوی NTSC، تعداد خطوط به کار رفته برای خلق دوباره تصاویر روی صفحه نمایش است. 
Screen Resolution ـ١
Frame Rate ـ٢
Codec ـ٣
Aspect Ratio ـ4
Resolution ـ5
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NTSC درجه وضوح حداکثر 525 خط برای تولید هر فریم را تثبیت کرد. CRTها یا لوله های اشعه کاتدي، 
در بیشتر دستگاه های تلویزیون آنالوگ به کار می روند تا با بهره گیری از یک تفنگ الکترونی برای پاک کردن 
الگویی خاص، تصاوير  تابش در  به  آنها  از نقطه های رنگی متفاوت فسفری و واداشتن  خطوط تشکیل شده 
را به وجود آورند. NTSC سرعتی را که در آن صفحه نمایش اسکن می شود، در 60 هرتز یا شصت بار در 
ثانیه تثبیت کرد. این شیوه، از سرعت چرخه )60 سیکل در ثانیه( جریان متناوب برق در  ایالات متحده بهره 

می گیرد. 
روش اسکن کردن مورد استفاده در ویدیوی NTSC روش يك در ميان1 نام دارد. یک اسکن يك در ميان2 
اسکنی است که در آن خطوط متناوب تصویر در هر بار عبور کردن اسکن، تولید می شوند. تفنگ الکترونی 
ابتدا همه خطوط با شماره های فرد را پاک می کند و سپس در گذر دوم به پاک کردن خطوط با شماره های 
زوج می پردازد. هر بار عبور کردن، تصویری ناتمام به نام میدان3 را تولید می کند. دو میدان با سرعت زیادی 
تولید و با هم مخلوط می شوند تا تصویری کامل به نام فریم4 را به وجود آورند. اسکن کردن هر  یک از این دو 

میدان در  یک شصتم ثانیه، نرخ فریمی5 برابر با سی فریم در ثانیه )fps 30( را به وجود می آورد. 
استاندارد NTSC برای اسكن اضافي نیز طراحی شده است. اسكن اضافي6 به فرایند انتقال تصویر بزرگ تر از 
اندازه ای اطلاق می شود که روی صفحه نمایش تلویزیون ظاهر مي گردد. این فرایند از اینکه آیا تصویر منتقل 
شده صفحه نمایش تلویزیون را به طور کامل می پوشاند یا خیر، اطمینان حاصل می کند. در نتیجه، حداکثر 

درجه وضوح مشهود روی صفحه نمایش تلویزیون NTSC از 525 خط به 484 خط کاهش پیدا می کند. 

برای پخش تصاویر رنگی تلویزیونی، NTSC سیگنالی ترکیبی را به کار می گیرد. یک سیگنال رنگ ترکیبی7 
مخلوطی از دو سیگنال دیگر است که یکی از آنها نمایانگر درخشندگی و دیگری نمایانگر فام نمایی است. 
درخشندگی8 میزان روشنایی یا سفیدی در  یک تصویر است. فام نمایی9 نیز فام مربوط به رنگ است. خلق 
و انتقال رنگ ترکیبی ارزان است. این تكنيك این امکان را نیز فراهم ساخت که پس از آمدن تلویزیون های 
که  حالی  در  قدیمی تر،  دستگاه های  داد.  ادامه  سفید  و  سیاه  تلویزیون های  از  بهره گیری  به  بتوان  رنگی، 

اطلاعات درخشندگی را همچنان به کار می بردند، فام نمایی را نادیده مي گرفتند. 

Interlacing ـ1
Interlaced Scan ـ2
Field ـ3
Frame ـ4
Frame Rate ـ5
Overscanning ـ6
Composite Color ـ7
Luminance ـ8
Chrominance ـ9

نرخ فریم فعلی برای ویدیوی NTSC در واقع fps  97/ 29  است. این اختلاف جزئی با 30fps، زمانی پدید 
آمد که اطلاعات مربوط به رنگ به سیگنال سیاه و سفید اصلی افزوده شد.

نکته
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با  تلویزیون  صفحه  روی  ولی  می شود،  پخش  ترکیبی  سیگنالی  قالب  در   NTSC رنگی  تلویزیون  گرچه 
به کارگیری مدل رنگ متفاوتی نمایش داده می شود. نمایش در تلویزیون، مانند مانیتورهای رایانه، از مدل 
رنگ RGB )قرمز، سبز، آبی( بهره می گیرد. هر پیکسل تصویر، از ترکیب نسبت های مختلفی از نور قرمز، 
نشان داده می شود.  به طور جداگانه  رنگ مؤلفه2 است: هر مؤلفه رنگ   RGB آبی رنگ می گیرد.  یا  سبز 
RGB عملًا می تواند دامنه نامحدودی از رنگ های بسیار خالص را تولید کند. براي تولید رنگ RGB روی 
مؤلفه  به حالت  از سیگنال پخش شده  را  ترکیبی  اطلاعات رنگ  باید  ابتدا  تلویزیون  صفحه نمایش، دستگاه 
RGB تبدیل کند. البته سیگنال ترکیبی نمی تواند رنگ را با دقت مؤلفه رنگ ضبط کند. در نتیجه، رنگ 
NTSC که در تلویزیون نمایش داده می شود فاقد خلوص و دامنه رنگ RGB کامل به شکلی است که روی 

مانیتور رایانه به نمایش در می آید. 
اصلی  تولید  البته  کار می برند.  به  را   NTSC ترکیبی  رنگ  آمریکا  در  آنالوگ  ویدیو ی  انواع مختلف پخش 
ویدیو، به فرمت های دیگری انجام می شوند که بسیاری از آنها از رنگ مؤلفه بهره می گیرند. این مسئله به 
تهیه کنندگان اجازه می دهد تا تصاویر را با طیف رنگی فوق العاده و کیفیت فرمت RGB خلق و ویرایش کنند. 
در حالی که NTSC در بیشتر نقاط آمریکای شمالی به کار می رود، سایر استانداردهای ناسازگار تلویزیون های 
 PAL .SECAM4 و PAL3 :آنالوگ در دیگر نقاط جهان به کار گرفته می شوند. دو رقیب عمده عبارت اند از
در انگلستان و بسیاری نقاط اروپا به کار می رود، SECAM در تعدادی از کشورها از جمله فرانسه و روسیه 
كاربرد دارد. این استانداردها نيز يك در ميان هستند، اما سرعت اسکن )50 هرتز(، نرخ فریم )25fps( و 
درجات وضوح صفحه )625 خط( متفاوتی را به کار می گیرند. ویدیویی را که برای  یک فرمت خاص تولید 
بدان  این  برای فرمت دیگری در نظر گرفته شده است.  باشد، نمی توان در دستگاهی پخش کرد که  شده 
معنی است که نوارهای ویدیویی NTSC را نمی توان در اروپا پخش کرد و محصولات ویدیویی اروپایی را نیز 

نمی توان در  ایالات متحده بدون سیستم های VCR مخصوص اجرا کرد.

استانداردهاي جديد جهاني 

توسعه VCRها و دوربین های دستی و تلویزیونی در دهه 1980 نحوه دیگری از خلق و توزیع ویدیوی آنالوگ 
 8mm ،S-VHS ،VHS ها فرمت های نوار گوناگونی را به کار می گیرند که مهم ترین آنهاVCR .را عرضه کرد
و Hi8 هستند. بين این فرمت ها سازگاری محدودی وجود دارد: دستگاه های S-VHS، نوارهای VHS و 

دستگاه های Hi8، نوارهای 8mm را نيز پخش می کنند، اما ترکیب دیگری امکان پذیر نیست. 

خلوص و دامنه رنگ محدود NTSC منتقدان را بر آن داشت تا به شوخی بگویند که مخفف واقعی این 
واژه »هرگز نه همان رنگ1« است.

نکته

Never The Same Color ـ1
Component Color ـ2
Phase Alternate Line ـ3
Sequential Couleur Avec Memoir ـ4
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VHS: نخستین فرمتی که به طور گسترده اي پذیرفته شد VHS بود. فرمت VHS درجه وضوح نسبتاً پایین 
240 خط را دارد و صدای های فای را پشتیبانی مي کند اما از رنگ ترکیبی بهره می گیرد. در نتیجه، کیفیت 

ویدیوی VHS در مجموع از پخش  های تلویزیونی آنالوگ کمی پایین تر است. 
در  بود.   VHS بهبود یافته  نسخه  واقع  در  كه  کرد  معرفی  بازار  به  را  اي   S-VHS  1987 سال  در   JVC
S-VHS درجه وضوح به 400 خط افزایش پیدا کرد. کیفیت رنگ را نیز، با مجزا نگه داشتن سیگنال های 
درخشندگی و فام نمایی، به جای مخلوط کردن این دو نوع اطلاعات مانند رنگ ترکیبی، بهبود بخشید. این 
شاخه ای از رنگ مؤلفه به نام Y/C )برای درخشندگی/ فام نمایی( است. رنگ Y/C به »شبه ـ مؤلفه« نیز 
معروف است؛ چرا که دقت رنگ RGB را ندارد. البته بیانگر بهبود یافتگی چشم گیری در رنگ ترکیبی است. 

S-VHS بهبود یافته همان ویدیوی پخش NTSC است. 
8mm: فرمت 8mm نوار کوچ کتری بود که تولید دوربین های سب کوزن تر و جمع و جورتر را امکان پذیر 
 CD ساخت و از صفحه نمایش با درجه وضوح 230 خط پشتیبانی کرد، همچنين کیفیت صدایی نزدیک به

را ارائه داد. 
Hi8 :Hi8 درجه وضوح و رنگ 8mm را به روشی بهبود بخشید که مشابه با بهبوددهی S-VHS نسبت به 

VHS مشابه بود. درجه وضوح به 400 خط افزایش یافت و رنگ مؤلفه Y/C نیز به آن اضافه شد. 
S-VHS و Hi8 به عنوان رسانه های منبع امکانات مهمی برای تبدیل دیجیتال در اختیار گذاشتند؛ علت آن 
هم درجه وضوح و کیفیت رنگ برتر آنها بود. البته هیچ یک از این فرمت ها، توانايي مقابله ای مطلوب با کیفیت 
پخش ویدیوی گران قیمت مورد استفاده در تولیدات تلویزیونی را ندارند. این ویدیوها رنگ مؤلفه RGB کامل 

و درجه وضوح صفحه ای در حدود 1000 خط را ارائه می دهند. 

تعريف رزولوشن تصوير 

پردازش کمتر، حجم  به  باشد،  ویدیوی دیجیتال کمتر  یا درجه وضوح  صفحه نمایش یک  رزولوشن  هرچه 
انتقال آسان تری نیاز پیدا می کند. توليدكنندگان اغلب درجه وضوح صفحه نمایش  ذخیره سازی پایین تر و 
با توانایی های رسانه خروجی کاهش می دهند. به این کار، درجه وضوح خروجی ویدیو  را برای مطابقت 
اطلاق می شود. فرمت درجه وضوح خروجی با کیفیت DV )ویدیوی دیجیتال( 480×720 پیکسل است. این 
امر مستلزم آن است که رایانه اطلاعاتی در حدود 350,000 پیکسل با نرخ نزدیک به 30 بار در هر ثانیه 
را پردازش و منتقل کند. گزینه های تحویل کندتر مانند CD-ROM و پخش ویدیوی اینترنتی نمی توانند 
اطلاعات را با این نرخ انتقال دهند. کوچک کردن اندازه صفحه نمایش به 240×320 برای CD-ROM تعداد 
پیکسل ها را به کمتر از 80,000 عدد کاهش می دهد؛ در حالی که به کارگیری 180×240 برای ویدیوهای 

اینترنتی، پیکسل ها را تنها به کمی بیش از 43,000 عدد کاهش می دهد. 

مفهوم جنبه هاي مختلف نسبت ظاهري تصوير 16:9، 4:3 و مشابه آن 

DTV نسبت ابعاد تصوير جدیدی برای صفحه نمایش های تلویزیون ارائه می دهد. به جای فرمت 4:3 تلویزیون 
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آنالوگ، DTV نسبت ابعاد تصويری گسترده تر 16:9 را به کار می گیرد. این نسبت، به فرمت مورد استفاده در 
فیلم نزدی کتر است، در نتیجه ادغام فیلم، ویدیو و رایانه را رواج می دهد. در استاندارد NTSC، برای تبدیل 
فیلم به ویدیو تغییراتی لازم بود که یا صفحه نمایش تلویزیون را پرُ »full screen« و بخشی از تصاویر فیلم 
اصلی را قربانی می کرد یا به هنگام نمایش در تلویزیون »letter box«، نوارهایی افقی در بالا و پایین فیلم 

ایجاد می کرد. 

مفهوم كدك زماني 

فشرده سازی، کلید تحویل موفقیت آمیز ویدیوی دیجیتال است. همه فرمت های مربوط به تحویل ویدیوی 
از فشرده سازی را به کار می برند. توليدكنندگان چندرسانه ای، به ترفندهایی اساسی روی  دیجیتال، نوعی 
آورده اند که گزینه های مختلف فشرده سازی از آنها پشتیبانی می کنند. این ترفندها عبارت اند از: تكنيك های 

رمزگذاری درون فریمی، میان فریمی و نرخ بیت متغیر. 

کدک دستورعمل هایی را به رایانه می دهد که فایلی را فشرده سازی کند و سپس آن را دوباره باز کند تا 
نگارش اصلی فایل را نمایش دهد.

نکته

فشرده سازی درون فریمی1: فشرده سازی درون فریمی اطلاعات درون یک فریم ويديو را دوباره رمزگذاری 
می کند. راهبردهاي بدون اتلافي مانند RLE را می توان برای فشرده سازی درون فریمی به کار برُد. نتیجه، 

	Frame CompressionـIntra ـ١
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بیشتر  البته  می کند.  تولید  مجدداً  را  اولیه  فایل  اطلاعات  همه  که  می شود  کارآمدتری  و  کوچ کتر  فایل 
باز شدن فایل  اولیه، در حال  از اطلاعات  با اتلاف هستند، یعنی برخی  فشرده سازی های درون فریمی توأم 
از دست می روند. یکی از کدک های پرُطرفدار توأم با اتلاف JPEG است. فایل های JPEG در وب به طور 
انتقال روی وب  گسترده ای به کار می روند تا تصاویر ثابت واقعی را در اندازه های کوچ کتر موردنیاز برای 
رمزگذاری کنند. میزان فشرده سازی JPEG مقياس پذير1 است )فشرده سازی را می توان در سطوح مختلف، 
از کیفیت بالا به پایین انجام داد(. تصاویر با کیفیت پایین اندازه فایل بسیار کوچکی دارند و می توانند برای 
لینک  یا دکمه هایی مفید واقع شوند که به تصویر بزرگ تر و با کیفیت بالاتری ختم می شوند. نسخه ویدیویی 
M-JPEG 2 ،JPEG نامیده می شود. تصاویر واحد فشرده سازی و به عنوان سكانسی حرکتی به هم وصل 

می شوند که پس از آن می توانند با به کارگیری نرم افزار های ویدیوی دیجیتال ویرایش شوند. 
برخی از ترفند های فشرده سازی ویدیویی، مانند فرمت پرطرفدار DV، تنها فشرده سازی درون فریمی را به 
کار می برند. این ترفند اغلب برای ویدیوهایی که برای ویرایش در نظر گرفته شده اند، بهترین انتخاب به شمار 
می رود، زيرا تک تک فریم های ویدیو را حفظ می کند. ویرایشگر ویدیو سپس می تواند تک فریم ها را در صورت 

نیاز اصلاح کند یا ببرد. 
حذف  را  میانی  فریم های  از  برخی  میان فریمی،  فشرده سازی  مقابل،  در  میان فریمی3:  فشرده سازی 
متحرک( کدکی  تصویر  کارشناسان  )گروه   MPEG4 نگه می دارد.  را  فریم ها  بین  تغییرات  تنها  و  می کند 
می برد  بهره  درون فریمی  فشرده سازی  از  هم  که  است  ویدیویی طراحی شده  برای  به طور خاص  که  است 
میان فریمی  فشرده سازی  به کارگیری  با  می توان  را  ویدیویی  از سكانس های  بسیاری  میان فریمی.  از  هم  و 
نقل می کند،  را  ماجرایی  برنامه خبری که  ویدیوی یک  مثال،  برای  به طرز چشم گیری فشرده سازی کرد. 
مجموعه ای از فریم ها را شامل می شود که در آن حرکات بسیار کمی اتفاق می افتند. یک فریم ممکن است 
تنها در حالت لب اخبارگو با فریمی دیگر متفاوت باشد و فریم های دیگر می توانند فقط وقتی اخبارگو سر و 
شانه خود را حرکت می دهد کمی بیشتر تغییر کنند. MPEG بعضی از فریم ها را به عنوان تصاویری کاملًا 
متراکم شده ذخیره می سازد. به اینها میم فریم5 )مخفف »میان فریمی«( اطلاق می شود، چرا که با ترفند مورد 
استفاده در فشرده سازی میان فریمی فرقی ندارند. فریم های بعدی، تنها بخش هایی از تصویر را ضبط می کنند 
که بين میم فریم ها تغییر کرده باشند و بقیه تصویر را دور می ریزند. فریم های بعدی، پ فریم )فریم های 
پیش بینی گر( یا دال فریم )فریم های دو جهته( هستند. پ فریم ها تغییرات شدیدتر را ضبط می کنند. دال 
فریم ها، فریم هایی بين میم و پ هستند كه تغییرات کوچ کتر را ضبط می کنند. رمزگذاری MPEG از آنچه 
بتوان با فشرده سازی درون فریمی به خودی خود ساخت، فایل های بسیار کوچ کتری تولید می کند. وقتی که 
یک فایل MPEG رمزگشایی می شود )یعنی از حالت فشرده شده باز می شود(، پردازنده، فریم از قلم افتاده را 
با به کارگیری میم فریم تداعی می کند و این کار را هم زمان با ارجاع به باز تولید فریم های درونی و تغییرات 

ذخیره شده در قالب فریم های پیش بینی گر یا دو جهته انجام می دهد. 
فشرده سازی درون فریمی گزینه ای عالی برای توزیع ویدیوی دیجیتال است، زیرا فایل های ویدیویی اصلی را 
Scalable ـ1
Motion-JPEGـ2
	Inter-Frame Compression ـ3
Motion Picture Experts Group ـ4
frameـl ـ5
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به طور مناسبي فشرده سازی می کند. البته این تكنيك برای ضبط فیلم منبع ویدیویی که برای ویرایش در 
نظر گرفته شده باشد، بهترین گزینه نیست. فریم های از قلم افتاده باید براي ویرایش سكانس و حفظ هر چه 

کمتر اطلاعات اصلی، بازسازی شوند. 
رمزگذاری نرخ بیت متغیر: دو روش عمده در رمزگذاری داده های دیجیتالی وجود دارد. نخستین روش، 
رمزگذاری نرخ بیت ثابت  یا CBR را به کار می گیرد. CBR به همه قسمت های ویدیو و مستقل از محتوای 
آن، تعداد بیت یکسانی در هر ثانیه اختصاص می دهد. هر دو سكانس ویدیویی ساده و پیچیده، با بهره گیری از 
شماره های یکسانی برای بیت ها در هر ثانیه رمزگذاری می شوند. VBR یا رمزگذاری نرخ بیت متغیر، محتوای 
ویدیو را تحلیل كرده و در ادامه برای رمزگذاری صحنه های پیچیده بیت های بیشتر و برای صحنه های ساده تر 
بیت های کمتری اختصاص می دهد. در نتیجه، منابع رایانه ای را در جاهای لازم سرمایه گذاری می کند و به 
این ترتیب راه را برای تولید مجدد و با کیفیت تر صحنه های پیچیده باز می کند. VBR گزینه رندر رایجی در 

نرم افزارهای ویرایش ویدیو است. 

مفهوم كدك ها 

به طور   RealVideo و   M-JPEG  ،MPEG  آنها بين  در  دارند.  بسیار مختلفی وجود  ویدیویی  کدک های 
گسترده تری به کار می روند. MPEG چندین کدک مختلف از جمله MPEG-2 ،MPEG-1 و MPEG-4 را 
شامل می شود. MPEG-1، فرمتی است که به طور گسترده اي پشتیبانی مي شود و حجم ویدیوهای کوتاه تر 
را در قالب ویدیو CD ارائه می دهد که یکی از فرمت های دیسک نوری است. MPEG-2 ویدیویی با کیفیت 
عالی برای فرمت DVD با ظرفیت بیشتر و سرعت بالاتر تولید می کند. MPEG-2 همچنین برای انتقال 
ویدیو از طریق تلویزیون های دیجیتال به طور وسیعی به کار می رود. MPEG-4 برای تحویل ویدیو روی وب 
بهینه سازی شده است كه در آن با پهنای باند نسبتاً پایین تر، به سطوح بالاتری از فشرده سازی نیاز است. 
RealVideo از کدک های اختصاصي براي رمزگذاری ویدیوي جریانی1 برای وب استفاده ميك ند و به طور 
گسترده ای به عنوان یک plug-in در مرورگرها یافت می شود. البته همه ویدیوها را برای توزیع فوری در نظر 
نگرفته اند؛ توليدكنندگان چندرسانه ای اغلب بايد ویدیو را به شکلی مناسب برای تألیف یا آرشیو رندر کنند. 
در این موارد فرمتی که معمولاً انتخاب می شود DV است. DV، کدک دیگری، یعنی M-JPEG را به کار 

می بندد تا فایل هایي با فشرده سازی و با کیفیت عالی و بدون فشرده سازی میان فریمی را تولید کند. 

پرسش های تشریحی 

1 کدک چیست؟
٢ چرا سازگاری فايل برای توسعه چندرسانه ای اهمیت دارد؟
٣ فرمت فایل طبیعی چیست؟ برای این فرمت مثالی بیاورید.

Streaming Video ـ١
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٤ چرا نباید نام یک فایل ZipIt.exe را به ZipIt.jpg تغییر نام دهید؟
٥ چرا فشرده سازی RLE بدون اتلاف است؟

٦ رزولوشن چیست و براي ويدیوي ديجيتال، چه مفهومي دارد؟
٧ چرا توليدكنندگان اغلب بايد رزولوشن خروجی دیجیتال را تنظیم کنند؟ 

٨ سه ترفند اصلی برای فشرده سازی ویدیوی دیجیتال را نام برده و تعریف کنید. 
٩ یک مزیت و یک عیب فشرده سازی میان فریمی را نام ببرید. 

١٠ تمایز بين فشرده سازی ویدیوی MPEG2 و MPEG4 چیست؟ 
١١ نسبت ابعاد تصوير را تعریف کنید. مانیتور تلویزیون چه چیزی را نشان می دهد؟

پرسش های چهار گزینه ای 

1 كدك چيست؟
الف( نوعي از محصولات چند رسانه اي است.

ب( رمزگذار و رمزگشاي سخت افزاري براي داده هاي آنالوگ است.
ج( برنامه اي براي تريكب صدا، تصوير و متن است.

د( نرم افزاري براي تبديل يك فايل ديجيتال به نسخه فشرده تر و همين طور بازگرداندن آن است.

٢ محدوده رنگ های موجود در یک ویدیو چه نامیده می شود؟
د( درخشندگی ج( طیف رنگ	 ب( رنگ مؤلفه	 	RGB )الف

٣ رابطه بین عرض و ارتفاع تصاویر یا فریم های ثابت چه نامیده می شود؟
ب( سکانس	 		 الف( درجه وضوح

د( نسبت ابعاد تصویر 		 ج( فرمت

٤ میزان روشنایی یا سفیدی در یک تصویر چه نامیده می شود؟
ب( درخشندگی 		 الف( درجه وضوح

د( فام نمایی 		 ج( طیف  رنگ

٥ در مانیتورهای رایانه از چه مدل رنگی استفاده می شود؟
VCR )د 	SECAM )ج 	RGB )ب 	CMYK )الف

پروژه عملی 

یک کلیپ ویدیویی 45 تا 90 ثانیه ای روی aparat.com پیدا کنید. در مورد کیفیت ویدیو از این جوانب 
بحث کنید: انتخاب نما، کنترل روی دوربین و ویرایش. چگونه می توان این کلیپ را بهبود بخشید؟
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می رود:
  با محیط Premiere آشنا باشد.

  بتواند Premiere را نصب کند.

  با فضای کار Premiere آشنا باشد.

  پنجره Timeline  را بشناسد.

  نمایشگرهای Source  و Program را بشناسد.

  بتواند سکانس ها را ایجاد کند.

  بتواند ظاهر محیط کار را تغییر دهد.

بسیار  فیلم  ویرایش  عرصه  در  به ویژه   Adobe Premiere Pro CC مانند  غیرخطی  ویرایش  برنامه های 
متفاوت عمل می کنند؛ از این رو و با توجه به استفاده آسان از این ابزارها برای ویرایش فیلم، گزینه خوبی برای 
کار روی فیلم ها هستند. هر کسی که اشتراک Adobe Creative Cloud و سودای ویرایش فیلم را در سر 
داشته باشد، می تواند فیلمی ساخته و آن را به صورت جهانی در اختیار مخاطبان قرار دهد. البته قبلًا وضعیت 
این گونه نبود. کمی پیش از اینها، برای ساخت فیلم نیازمند انواع تجهیزات ویرایشی بودید که نمی شد از 
هیچ کدام چشم پوشی کرد. در دنیای آن روز Undo وجود نداشت. عملًا نگارش آن به گونه ای بود که باید 

آن را یک بار برای همیشه انجام بده نامید. 
تا جایی که به هزینه های ویرایش مربوط می شود، رویای ساخت فیلم در قرن گذشته قماری بود که  بازنده آن 
شما بودید. مگر این که آنقدر خوشبخت باشید که در این عرصه فعالیت داشته و به  پیشرفته ترین تجهیزات 
دسترسی داشته باشید، وگرنه نمی توانستید کارهای با کیفیتی انجام دهید. بنابراین بدون چمدانی پر از پول، 
اعمال اصلاحات نهایی در پروژه های فیلم امری کاملًا دور از تصور بود. حتی اگر از عهده خرید تجهیزات اولیه 
برمی آمدید، نابرابری سطح فیلم های خانگی و حرفه ای بسیار چشمگیر بود. نه تنها نمی توانستید فیلم هایی 

در سطح هالیوود تهیه کنید، بلکه نتیجه نهایی کیفیتی بی نهایت پایین نیز داشت. 
امروزه، تمام این محدودیت ها از میان برداشته شده و تنها چیزی که اهمیت دارد این است که فیلم ها را 
به خوبی تهیه و ویرایش کنید. برنامه های کاربردی غیرخطی مانند Premiere Pro CC راه خود را در این 
میان یافته و به کاربران متوسط نیز امکان دسترسی به ابزارهای ویرایشی سطح پیشرفته را می دهند. خالقان 
محتوای ویدیویی برای ساخت فیلم واقعی ـ بلند، کوتاه، واقعاً کوتاه )مانند آنچه  در TikTok می بینید( یا حد 

وسط اینهاـ به این ابزارها دسترسی دارند. 
 Premiere Pro CC این قدرت خلاق را در اختیار همگان قرار می دهد. حتی نوستراداموس هم نمی تواند 
با  بتوانند  پایین، تصور کند که  بالا و قدرت دسترسی  با جاه طلبی  برای کاربران معمولی،  را  چنین قدرتی 

منابعی محدود فیلم هایی بسازند که مخاطبانی در سرتاسر جهان داشته باشند.
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  Premiere نحوه نصب نرم افزار

 Adobe کنید.  کلیک  صفحه  بالای  گوشه سمت چپ  در  ذره بین  آیکن  روی  بروید.   soft98.ir سایت  به 
Premiere را تایپ کنید و کلید Enter را فشار دهید. در صفحه به پایین حرکت کنید و روی دکمه ادامه 
ورژن  دانلود،  لیست  از  و  پیمایش کرده  پایین  به  باز می شود،  در صفحه ای که جدید  کنید.  کلیک  مطلب 
موردنظر خود را طبق سیستم عامل رایانه خود انتخاب کنید و نرم افزار را دانلود کنید. برای نصب نرم افزار، به 

برگه آموزش نصب و فعال سازی مراجعه کنید و توضیحات لازم را بخوانید.

 Premiere Pro  فضای کار

رابط کاربر Premiere Pro در نگاه اول غافلگیرکننده به نظر می رسد، چون آنقدر گزینه های زیادی ارائه 
می دهد که تمرکز روی گزینه ای خاص مشکل به نظر می رسد. بله، حجم انتخاب ها بسیار زیاد است. اما باید 
فقط روی ضروریات تمرکز کنید. ابتدا توجه شما را به بالای صفحه نمایش جلب می کنیم که عنوان منو را در 

ابتدا مشاهده نمی کنید، همان طور که در شکل 1ـ17 نشان داده شده است.

از  مجموعه ای  را  آن  است  بهتر  می رساند.  را  مفهوم  و  معنا  اما  می رسد  نظر  به  پیچیده  اگرچه  کار  فضای 
مؤلفه های مجزایی در نظر بگیرید که به صورت یک کل واحد با هم عمل می کنند. پنل Project )در گوشه 
سمت چپ پایینی شکل 1ـ17( فایل های فیلم وارد شده و Timeline )در گوشۀ سمت راست پایینی شکل 
1ـ17(، کلیپ ویرایش شده را نشان می دهد. در قسمت بالا، پنل Source Monitor، محتویات کلیپ را نشان 

می دهد در حالی که پنل Program Monitor کلیپ ها را در Timeline به اجرا درمی آورد. 

شکل 1ـ17ـ فضای کار Premiere Pro برای ویرایش
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اگر Premiere Pro را ساختمانی اداری در نظر بگیرید، پنل Project فضای بزرگ دفتر کار است که چندین 
اتاق دارد. این پنل که در شکل 2ـ17 می بینید، دارایی های رسانه را در خود جای می دهد که عبارت اند از: 
کلیپ های فیلم، تصاویر ایستا، فایل های صوتی و نیز تمام سکانس هایی که شخصاً ایجاد کرده اید. این پنل 
شبیه به اتاقی است که باید قطعات مختلف را در آن سازمان دهی کنید و از نظر اندازه و نحوه نمایش کاملًا 

قابل سفارشی سازی است. 
ضمناً می توانید کنترل کنید اطلاعات پنل به چه شکلی در انتهای پالت نمایش داده شود. پالت به شما امکان 
می دهد محتوا را به صورت آیکن هایی در اندازه های مختلف نمایش داده یا هر یک از عناصر و وضعیت های 
اصلی آن را در فهرستی در نمای Freeform مشاهده کرده و کوچ کترین جزئیات را اصلاح کنید. عملکردها 

در گوشه سمت چپ پایینی پنل نمایش داده می شوند. 

در این فهرست تفاوت نما های مختلف را شرح داده ایم: 
 نمای List: زمانی که به صورت افقی پیمایش می کنید، در بخش Video and Audio Info آمار ضروری 
نمایش داده می شوند مانند نرخ فریم، مدت زمان پخش کلیپ و نقاط In و Out. در بخش Audio Info مدت 
زمان پخش، فشرده سازی و فرمت نمایش داده می شود. برای پیمایش این اطلاعات می توانید از لغزنده انتهای 

 Project شکل 2ـ17ـ پنل
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پنل استفاده کنید. هر زمان که مایل باشید به سادگی می توانید بین این دو نما جابه جا شوید. 
 نمای  Icon: نمونه تصویرهای کوچکی از محتویات کلیپ را نمایش داده و زمانی مفید واقع می شود که 

بخواهید به سرعت کلیپ موردنظر خود را در پوشه شلوغ و درهمی بیابید. 
 نمای Freeform : درست مانند نمای Icon به شما امکان می دهد بریده فیلم1 را سازمان دهی کنید اما 
جذابیت این نما بیشتر است. اگر از لحاظ بصری بهتر عمل می کنید، این نما برای شما عالی است زیرا نمونه 
تصویر ها به شما کمک می کنند به سادگی دارایی موردنیاز خود را بیابید. می توانید پیش نمایش نمونه تصاویر 
را مشاهده کرده، نقاط In و Out را تنظیم کرده و ترتیب کلیپ ها را مستقیماً در خود پنل Project تغییر 
دهید. این نما به شما امکان می دهد کلیپ ها را کشیده و جابه جا کنید. ترتیب آنها را تغییر داده یا به شیوه ای 
متفاوت از نماهای Icon یا List آنها را گروه بندی کنید. درست است این نما انعطاف پذیری بیشتری دارد، 

اما فضای بیشتری را اشغال می کند. 
پنل Project چند ویژگی جالب دیگر نیز دارد که به ویژه هنگام تولید ویدیو بسیار به کمک شما خواهند آمد. 
فیلد Search که در بالای پنل قرار گرفته است به شما امکان می دهد کلیپ های موردنظر خود را بیابید. 

این فیلد زمانی مفید واقع می شود که تعداد کلیپ هایی که با آنها کار می کنید زیاد باشد. 
 )bin( را مرتب کنید. برای این منظور باید پوشه Project به شما امکان می دهد پنل New Bin ویژگی
جدیدی را ایجاد کرده، آن را نامگذاری کرده و فایل های موردنظر خود را به آن بکشید. برای ساخت پوشۀ 
 File را انتخاب کنید یا می توانید از طریق منوی New Bin جدید باید داخل پنل کلیک راست کرده و گزینۀ

عمل کنید )فرمان File>New>Bin را انتخاب کنید(. 
تمام اقلام موجود در این پنل و پوشه های موجود در آن را می توانید در سکانس مورد استفاده قرار دهید. 

 Timeline مفهوم پنجره

Timeline در پایین و نمایشگرها در بالا، چیدمانی است که معمولاً مورد استفاده قرار می گیرد. اما اگر برعکس 
 Project را ببندند تا بتوانند به نمای بهتری از پنل Timeline باشد چه؟ حتی برخی از کاربران ترجیح می دهند
دست یابند. برخی دیگر دوست دارند Timeline را وسیع تر نمایش دهند تا بتوانند هم زمان چندین کانال صوتی 
و ویدیویی را مورد بررسی قرار دهند. شاید برخی افراد بخواهند Timeline فضای کمتری اشغال کند تا برای 
نمایشگر جای بیشتری باقی بماند. تمام اینها انتخاب هایی سلیقه ای است و Premiere Pro مانند بوفه سلف 

سرویسی عمل می کند که می توانید بشقاب خود را بر اساس علایق و سلیقه شخصی خود پر کنید. 
فرمان  باید  صورت  این  در  کنید.  استفاده  پیش فرض  کاری  فضاهای  از  یکی  از  دهید  ترجیح  است  ممکن 
 Premiere را انتخاب کنید. این بار نیز انتخاب کاملًا شخصی و سلیقه ای است و Window>Workspaces
بین طرح بندی های  می توانید  تمایل  در صورت  می دهد.  قرار  شما  اختیار  در  نامحدودی  انتخاب های   Pro

مختلف جابه جا شوید تا برای انجام وظایف موردنظر خود بتوانید اعمال خاصی را اجرا کنید.

Footage ـ١
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نکات زیر را مدنظر داشته باشید: 
 پنل Timeline ناحیه ای برای به نمایش گذاشتن دارایی های صوتی و تصویری است تا در نهایت به صورت 

سلسله مراتبی پخش شوند. 
 می توانید از ترک های صوتی و تصویری دیگری نیز برای افزودن جلوه ها، میکس  و طرح بندی استفاده کنید. 
 برای بریدن یا باز کردن کلیپ های صوتی و تصویری می توانید مستقیماً از خود پنل Timeline استفاده کنید. 

 با فعال یا غیرفعال کردن ترک ها می توانید روی کلیپ خاصی در سکانس تمرکز بیشتری داشته باشید. 

جادو در پنل Timeline رخ می دهد، جایی که می توانید کلیپ ها را کشیده، پویش کرده و مورد آزمایش 
مانند  را  پنل  این  یابید.  فیلم دست  برای ساخت  ترتیب صحیح موردنیاز خود  به  بتوانید  تا  قرار دهید 
جایگاهی در نظر بگیرید که اقلامی که باید در صفحه نمایش داده شوند در آن صف کشیده اند. هم زمان 
هم می توانید ترتیب کلیپ ها را تغییر دهید، هم می توانید آنها را برش داده و اصلاح کنید و هم می توانید 
آنها را باز کرده و اصلاح کنید. ضمناً در همین پنل است که می توانید ترک های صوتی و تصویری را فعال 
و غیرفعال کرده و بر پخش تأثیر بگذارید. حتی می توانید تنظیماتی را مستقیماً در خود Timeline در 
سطوح صدا اعمال کنید که در شکل 3ـ17 نیز نشان داده شده است. در حالی که Timeline به عنوان 
پنلی برای اجرای ویرایش ها عمل می کند، هر یک از ویرایش هایی که به صورت مجزا در Timeline انجام 

می شوند همان سکانس ها هستند. 

نکته

Timeline شکل 3ـ17ـ کلیپ های ویدیویی در
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 Program و Source معرفي نمایشگرهای

نمایشگرهای Source و Program را ابزارهای دوقلوی پویایی تصور کنید که به شما امکان می دهند ببینید 
چه کاری دارید انجام می دهید. آنها مانند دستگاه های تلویزیون دوقلو در فضای کار Premiere Pro عمل 
می کنند. در حالی که هر پنل وظیفه متفاوتی را انجام می دهد، در اصل هر دو یک عملکرد را دنبال می کنند. 
می توانید کلیپ ها را در Source Monitor در پنل Project مشاهده کرده و تصمیم بگیرید آیا می خواهید 
آنها را به Timeline بکشید یا خیر. سپس نقاط In و Out )که بخش هایی از کلیپ طولانی تری است که 
می خواهید مورد استفاده قرار دهید( را قبل از کشیدن کلیپ ها به Timeline تنظیم کنید. به محض این 
که کلیپ ها در Timeline قرار می گیرند، می توانید پخش آنها را در نمایشگر Program مشاهده کنید که 
محتوا به ترتیب خطی در آن پخش می شود. همان طور که در شکل 4ـ17 می بینید، این نمایشگرها در هر 

پنل شباهت هایی دارند. 

شکل 4ـ17ـ نمایشگرهای پنل Source و Program که کنار هم نمایش داده شده اند. 

برای استفاده از Source Monitor برای مشاهده پیش نمایش کلیپ ها، روی آیکن آنها یا در صورت 
تمایل روی نام فایل در پنل Project دابل کلیک کنید. زمانی که کلید فاصله را فشار می دهید، پخش یا 

توقف پخش در هر دو نمایشگر صورت می گیرد. 

نکته

در انتهای هر پنل دکمه هایی نمایش داده می شود که کنترل های سنتی پخش را به یاد شما می آورند، از 
جمله مثلثی که نوک آن رو به سمت راست است و نشان دهندۀ دکمۀ پخش است. اما این دکمه ها کاری 
بیشتر از پخش کلیپ را به عهده دارند. آنها به شما امکان می دهند ویدیو را Scrub کرده )با پخش سریع 
آن را مرور کنید(، آن را فریم به فریم مشاهده کرده و تنظیمات دقیق را اعمال کنید، مارکرها را اضافه کرده، 

نقاط درج را مشخص کرده یا نظایر این موارد را انجام دهید. 



190

ساخت سکانس 

کار اصلی از این جا شروع می شود. همان اقداماتی که انجام می دهید تا ویدیو، صدا و سایر دارایی ها را در 
Timeline سرهم کرده و فیلم خود را بسازید. اما تمام سکانس ها به صورت یکسان ایجاد نمی شوند، البته 
اگر واژه »ایجاد« برای این منظور مناسب باشد. هر سکانس به صورت خاص طراحی شده تا درجه وضوح و 
سرعت فریم مخصوص به خود داشته باشد. می توانید سکانس های مختلفی را درون یک پروژه واحد ایجاد 

کنید، اگرچه بهتر است برای ایجاد ویدیو با یک سکانس اصلی کار کنید. 
برای شروع کار، فرمان File>New>Sequence را انتخاب کنید تا پنجره New Sequence نمایش داده 
شود که در شکل 5ـ17 می بینید. قبل از این که خوشحال شده و روی OK کلیک کنید، بهتر است جزئیات 
را بیشتر بررسی کنید. سمت چپ پنل پر از تنظیماتی است که مرتبط با درجه وضوح و سرعت فریم هستند. 
داده  نمایش  پنل  راست  به آن در سمت  اطلاعات مربوط  انتخاب می کنید،  را  تنظیمات  از  زمانی که یکی 
می شود. انتخاب گزینه مناسب بستگی به نیازهای شما دارد. به احتمال زیاد شما از محتوای HD استفاده 
می کنید. در این صورت گزینه های زیادی در اختیار دارید، بنابراین ممکن است هنگام شروع پروژه بخواهید 
گزینه ای را انتخاب کنید که با رمزگشای مورد استفادۀ شما تطبیق داشته باشد. معمولٌا بهتر است گزینه ای 

را انتخاب کنید که با دوربین یا فرمت فیلم برداری، مثلًا HD یا 4K تطبیق داشته باشد. 
برای یافتن یکی از گزینه های رایج HD روی فلش سرپایین کنار DVCPROHD کلیک کرده و سپس روی 
فلش سرپایین کنار 1080i یا 1080p کلیک کنید تا دو گزینه برای هر کدام نمایش داده شود. در اصل، 
i50 و i60 نگارش های پیشرفته  به فرم HD هستند که به ترتیب برای PAL و NTSC )دو سیستم رنگ 
امریکا استفاده می شود( مورد استفاده قرار می گیرند.  NTSC در  اروپا و  PAL در  تلویزیون؛  برای  آنالوگ 
گزینۀ DVCPROHD 1080i60 را انتخاب کنید که درهم بافته است )اشاره دارد به خطوط درجه وضوح 
  U.S. که به صورت متناوب عوض می شوند تا بتوانیم عناصر را در صفحه نمایش تلویزیون ببینیم( و با استاندارد
استاندارد  اگر  National Television System Committee شناخته می شود.  نام  با  همخوانی دارد که 
کشور شما PAL است، باید گزینه DVCPROHD 1080i50 را انتخاب کنید. نامی برای سکانس انتخاب 

کرده و روی OK کلیک کنید. 
اگر  یا  می کنند  استفاده  کوکی  کاتر  از  که  نیستید  افرادی  دسته  آن  از  اگر  تنظیمات سفارشی:   اعمال 
نیازهای خاصی دارید، می توانید پا را از تنظیمات معمول فراتر گذاشته و تنظیمات مخصوص به خود را ایجاد 

کرده و حتی به نام خود نامگذاری کنید. این مراحل را دنبال کنید: 
1 فرمان File>New>Sequence را انتخاب کنید تا پنل Sequence نمایش داده شود. 

٢ یکی از گزینه های سمت چپ را انتخاب کنید. فرقی نمی کند کدام گزینه را انتخاب کنید، چون به هر 
حال قرار است آن را تغییر داده و ذخیره کنید. در این مثال، گزینۀ بالا را امتحان کنید. برای این منظور روی 

فلش های سرپایین کلیک کنید تا به مقدار 1080 برسید و آن گزینه را انتخاب کنید. 
٣ روی برگه Settings کلیک کنید. در بالای پنل Settings گزینه های مختلفی نمایش داده می شود. 
به بالاترین گزینه پیمایش کرده و همان طور که در شکل 5  ـ17 می بینید، گزینۀ Custom را انتخاب 

کنید. 
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٤ Timebase موردنظر خود را انتخاب کنید. این روشی فانتزی برای بیان سرعت فریم است و دومین منوی 
کشویی در برگۀ Settings است. این گزینه حیاتی است، زیرا همان جایی است که باید تصمیم بگیرید آیا 
ویدیوی فیلم نمای روانی با سرعت 29/97 فریم در ثانیه )fps( داشته باشد یا فیلمی سنتی با سرعت فریم 
سینمایی fps 24 باشد. به خاطر داشته باشید زمانی که شروع به ویرایش کنید دیگر نمی توانید این مقدار 

را تغییر دهید. 
ابعاد  با   HD زیاد فرمت  احتمال  به  تنظیم کنید.  را  فریم  اندازه   ،Settings برگه  Video در  ٥ در بخش 
1080×1920 است. اما اگر به هر دلیلی متفاوت است، همین اندازه را وارد کنید. سپس گزینه های زیر را 

انتخاب کنید که در شکل 6  ـ17 نیز نشان داده شده است. 
 Pixel Aspect Ratio : گزینه Square Pixels را انتخاب کنید. 

 Fields: مقدار No Fields را انتخاب کنید. 
 Display Format : همان مقداری را انتخاب کنید که برای گزینه Timebase انتخاب کرده اید. 

٦ برای تنظیمات بخش Audio از مقادیر پیش فرض استفاده کنید. 

New Sequence شکل 5ـ17ـ پنجره
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با  و  تنظیمات حیاتی هستند  )این  اعمال کنید   Video Preview تنظیمات  را در بخش  زیر  ٧ تغییرات 
اسیر نخواهید شد(.  آنها در دام پخش  از  استفاده 

 گزینۀ اول را انتخاب کنید، Frame Only MPEG ـ1
آن  اندازه  اگر  بنابراین  باشد،  داشته  تطابق  سکانس  فریم  اندازه  با  که  کنید  انتخاب  را  وضوحی  درجه   
1080×1920 باشد باید همین گزینه را انتخاب کنید )با خیال راحت تمام کادرها را تا پایین پیمایش کرده 

بیابید(.  را  و گزینه موردنظر خود 
٨ روی Save Preset کلیک کنید. کادر محاوره ای نمایش داده می شود. 

٩ نامی برای تنظیمات سفارشی خود انتخاب کنید. روی دکمه Save Preset کلیک کنید تا کادر محاوره ای 
باز شود و همان طور که در شکل 7ـ17 نشان داده شده است نامی برای آن انتخاب کنید. از این پس هر زمان 

که لازم باشد، می توانید این تنظیمات سفارشی را انتخاب کنید. روی OK کلیک کنید. 
 OK ١٠ آخرین مرحله به شما امکان می دهد نام سکانس را تغییر دهید. از نام موجود راضی هستید؟ روی

کلیک کنید. 

شکل 6 ـ17ـ تنظیمات ویدیو را در این بخش اعمال کنید

Save Sequence Preset شکل 7ـ17ـ کادر محاوره ای
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 Timeline تنظیم
Timeline در موقعیت پیش فرض خود، اطلاعات کافی را برای شروع کار در اختیار شما قرار می دهد. اما آیا 
این اطلاعات برای اعمال اصلاحات جزئی تر نیز کافی است؟ خیر. کلیپ ها حاوی تمام اطلاعاتی هستند که به 
Timeline کشیده شده اند. گاهی این کلی کها یا بیش از حد طولانی یا بیش از حد کوتاه هستند. اگر باید 
یک یا دو فریم اضافی را برش دهید، باید روی فریم زووم کنید )آن را بزرگ تر کنید( تا فضای کافی برای 
بریدن آن داشته باشید. این کار به ویژه در مورد ویدیوهای طولانی مفید واقع می شود که می خواهید تمام 

برداشت ها را در یک نمای واحد ببینید. چندین روش برای انجام این وظیفه وجود دارد. 
همان  دارد.  وجود  چپ  سمت  گوشه  در  لغزنده ای   ،Timeline انتهای  در  کنید:  استفاده  لغزنده  از   
را به سمت  لغزنده  اگر  انتهای آن به چشم می خورد.  لغزنده ای که دستگیره های دایره ای شکل در هر دو 
 Timeline ،بزرگ تر می شود. اگر دستگیره های لغزنده را به سمت بیرون بکشید Timeline ،داخل بکشید

می شود.  کوچ کتر 
 از منو استفاده کنید: روی آیکنی به شکل آچار که در سمت چپ Timeline قرار گرفته است کلیک 
کرده و در منویی که نمایش داده می شود گزینه Expand All Tracks را انتخاب کنید که در شکل 8 ـ17 

نیز نشان داده شده است. 

Expand All Tracks شکل 8ـ17ـ انتخاب گزینه
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 از کلیدهای صفحه کلید استفاده کنید: Timeline را انتخاب کرده و از کلید )+( برای بزرگ تر کردن 
و از کلید )-( برای کوچ کتر کردن آن استفاده کنید. 

 با پیمایش اندازه Timeline را تغییر دهید: اگر ماوسی دارید که چرخ دنده پیمایش دارد، می توانید 
 Command در ویندوز( یا کلید( Alt با استفاده از آن طول ترک را تغییر دهید. برای این منظور باید کلید

)در مکینتاش( را نگه داشته و به سمت بالا یا پایین پیمایش کنید. 

افزایش ارتفاع تر کهای صوتی و تصویری 

و  کلفت  خطوط  به  شبیه  کلیپ ها  این  هستند.  باریک  بسیار  تصویری  و  صوتی  ترک های  پیش فرض،  به صورت 
رنگارنگی هستند و نمونه تصویری آنها در ترک ویدیویی یا شکل موج های ویدیو نشان داده نمی شود. خوشبختانه 
Premiere Pro روشی برای بهبود نما ارائه می دهد. تا اینجا حتماً متوجه شده اید که Premiere Pro برنامه ای 
است که برای انجام هر وظیفه ای چندین راهکار ارائه می دهد و افزایش ارتفاع ترک نیز از این قاعده مستثنی نیست. 

برای تغییر ارتفاع کلیپ ترک صوتی یا تصویری به این شرح عمل کنید: 
 از لغزنده ها استفاده کنید: همان طور که در شکل 9ـ17 می بینید، این لغزنده ها که در انتها و سمت 
راست Timeline قرار گرفته اند به شما امکان می دهند روی Timeline بزرگ نمایی کرده و ارتفاع را تغییر 
دهید. اگر لغزنده را به سمت داخل بکشید، ارتفاع ترک ویدیویی افزایش می یابد و با کشیدن لغزنده به بیرون، 
اندازه آن به اندازه پیش فرض برگشته یا کوتاه تر خواهد شد. لغزنده ای که در گوشه ها قرار گرفته است نیز 
می تواند ارتفاع را تغییر دهد. با کشیدن آن به سمت پایین می توانید عمق ترک را بیشتر کرده و اگر به سمت 

بالا بکشید عمق ترک کاهش می یابد. 

از  استفاده  با  آنها  ارتفاع  افزایش  و  ترک ها  طول  افزایش  و   Timeline بزرگ نمایی  برای  لغزنده هایی  شکل9ـ17ـ 
فلش های سرپایین لغزنده  های مربوط به تغییر طول و ارتفاع 
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 از کلیدهای میانبر صفحه کلید برای تغییر اندازه ترک استفاده کنید: کلید Control )در ویندوز( 
یا Command )در مکینتاش( را نگه داشته و با استفاده از کلید )+( ارتفاع را افزایش و با استفاده از کلید 

)ـ( آن را کاهش دهید. 
 اندازه ترک صوتی و تصویری را به صورت هم زمان تغییر دهید: آیا می خواهید حتی یک ثانیه هم  
شده در زمان ویرایش صرفه جویی کنید؟ کلید Shift را نگه داشته و از کلیدهای )+( و )-( برای بزرگ تر کردن 

هر دو ترک صوتی و تصویری به صورت هم زمان استفاده کنید. 

نمایش پنل در کل صفحه نمایش 

 Project پنل  از  می توانید  مثال  برای  کنید.  فصل  پنل  یک  با  باید  فقط  که  می آید  پیش   شرایطی  گاهی 
برای افزودن داده یا از پنل Program Monitor برای مشاهده فیلم در کل صفحه نمایش استفاده کنید. 
فرمان  و  کرده  انتخاب  را  پنل  باید  فقط  و  است  ساد ه ای  کار  ممکن  اندازه  بزرگ ترین  در  پنل  از  استفاده 
Window>Maximize Frame را انتخاب کنید تا همان طور که در شکل 10ـ17 می بینید پنل بزرگ تر 
نمایش داده شود. حال با انتخاب فرمان Window>Restore Frame Size می توانید به مجموعه پنل های 
گروه بندی شده برگردید. ضمناً می توانید پنل را انتخاب کرده و از کلید accent استفاده کرده بین اندازه بزرگ 

پنل و پنل گروه بندی شده با سایر پنل ها منتقل شوید. 

شکل 10ـ17ـ با بزرگ تر کردن پنل Program Monitor می توانید ویرایش را در ابعاد کل صفحه نمایش اعمال کنید
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کار با کلیپ های تودرتو  

با ادغام چندین کلیپ، یک کلیپ واحد ایجاد می شود که به سادگی می توانید آن را حول Timeline جابه جا 
کنید. البته این دیگر فقط یک کلیپ واحد نیست، چون می توانید به هر یک از مؤلفه های آن نیز دسترسی 
داشته باشید. فرض کنید کلیپ ها را در صندوقچه یا هر محل دیگری به جز این جا قرار داده اید، به جای این 
که در پوشه پروژه قرار گیرند، در حال حاضر در Timeline هستند. حال در نظر بگیرید که سه کلیپ دارید 
که در هم ادغام شده اند و یکی از آنها نیاز به اصلاح رنگ دارد. به سادگی می توانید این مشکل را برطرف کنید. 

به این روش عمل کنید: 
1 روی کلیپ تودرتوشده دابل کلیک کنید. 

٢ زمانی که در Timeline باز شد، هر یک از کلیپ های مجزا را می بینید، هر تغییری را که لازم است، در 
هر یک از کلیپ های مجزا اعمال کنید. 

٣ روی کلیپ کلیک راست کرده و گزینه Next را انتخاب کنید. به این ترتیب دوباره یک کلیپ تودرتوشده 
واحد خواهید داشت. 

معرفي منوي اصلي نرم افزار 

حالا به معرفی منوی اصلی نرم افزار می پردازیم:
File  : در این منو می توانیم پروژه جدیدی ایجاد کنیم یا پروژه ای را که از قبل تغییر داده ایم اجرا کنیم و 
یا ذخیره سازی با پسوندهای مختلف داشته باشیم و یا اعمال import و export را انجام دهیم که در منوی 

export تنظیمات خیلی دقیقی بابت خروجی می توانیم دریافت کنیم.
Edit  : در این منو می توانیم هر تغییراتی را که می خواهیم در پنجره های مختلف اعمال کنیم. انجام این 

کار از طریق زیرمنوهای مختلف قابل انجام است. 
 source در این منو اگر کلیپی به پروژه اضافه کنیم می توانیم تغییراتی از بابت سرعت و تغییرات : Clip 

clip و یا subclip و تغییرات دیگری را اعمال کنیم. 
Sequence  : در این قسمت در پنجره ای که در نرم افزار زمان تغییرات اضافه می شود به جای اینکه در خود 

پنجره تغییرات اعمال کنیم در این منو اعمال می کنیم، البته فقط بابت پنجره سکانس.
Markers  : در این قسمت هر تغییراتی را که در پنجره های مختلف می دهیم اگر می خواهیم نشانه گذاری 
کنیم تا نفر بعدی اعمال کننده تغییرات متوجه شود چه تغییراتی در این لایه انجام شده و چه تغییراتی اعمال 
نشده از این قسمت می تواند متوجه شود و یا اینکه می خواهیم به کسی تغییراتی را که انجام داده ایم توضیح 

دهیم از این منو استفاده می کنیم.
Graphics  : در این منو می توانیم لایه های جدیدی از متن و یا عکس یا هر لایه ای که در زیرمنو آن 

اضافه کنیم. مشاهده می کنیم 
View : در این منو می توانیم play back ها را مشخص کنیم و حتی می توانیم تنظیمات play back را 

طوری انجام دهیم که با بهترین کیفیت پخش شود.
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Window  : در این منو که یکی از منوهای اصلی این نرم افزار است می توانیم تنظیمات خیلی کلی که 
کدام پنجره فعال باشد کدام نباشد و نمای کلی را مشخص کنیم.

Help  : همان گونه که از نام این منو مشخص است راهنمایی های لازم بابت خود نرم افزار و بهنگام رسانی 
آن در این منو مشاهده می شود و هم چنین بازخوردهایی در مورد این نرم افزار ارائه می گردد.

مفهوم تغيير ظاهري محيط كار 

زمانی که Premiere Pro را برای اولین بار باز می کنید، به شما خوش آمد می گوید. این فضای خودمانی که 
در شکل 11ـ17 می بینید، چند گزینه در اختیار شما قرار می دهد تا کار را برای شما ساده تر کند. می توانید 
پروژۀ جدیدی را ایجاد کنید، پروژه  ای قدیمی را باز کنید یا مستقیماً به سراغ پروژه ای بروید که قبل از این 
روی آن کار می کردید. ضمناً می توانید به دوره های آموزشی و برخی گزینه های سودمند دیگر نیز دسترسی 

داشته باشید. اگر از قبل پروژه ای را باز کرده باشید، این صفحه را نخواهید دید. 

Welcome شکل 11ـ17ـ صفحه نمایش

استفاده از فضاهای کاری پیش فرض  

یادآوری: در بالای پنجره برنامه، فهرستی از فضاهای کاری پیش فرض را می بینید که برای انجام وظایف مختلف 
طراحی شده اند. علاوه بر فضای کار پیش فرض Editing، می توانید از یکی از گزینه های پیش فرض استفاده 
 Windows>Workspaces کنید که مناسب وظیفه یا پروژۀ شما باشد. برای تغییر فضای کاری از فرمان
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استفاده کنید که در شکل 12ـ17 می بینید و نگاهی به گزینه های موجود بیندازید. همین گزینه ها را در بالای 
پنجره برنامه نیز خواهید یافت و فضای کار انتخاب شده جاری به رنگ آبی هایلایت شده است. 

Workspaces شکل 12ـ17ـ منوی کشویی

توضیح مختصری از هر یک از این فضاهای کاری را در ادامه خواهید دید: 
Assembly  : این فضای کاری برای شروع پروژه بسیار مفید است. این فضای کار، چیدمانی شهودی برای بازبینی 
و سازمان دهی کلیپ ها ارائه می دهد، به ویژه اگر اولین باری است که آنها را می بینید. در این فضا، سکانس های 
 مجزایی برای هر یک از صحنه ها، گفت و شنودها و یک بریده فیلم اضافی برای فیلم ایجاد می شود که با نام 
B-roll معروف است و در مراحل بعدی کار با پروژه می توانید از آن استفاده کنید. در اصل، صفحه نمایش 
از یک سمت با پنل Project پر شده است که می توانید تمام فایل ها را در آن مشاهده کرده و پوشه ها و 
یا   Source Monitor از پنل های  بالایی می توانید یکی  را سازمان دهی کنید. در سمت راست  سکانس ها 

Program Monitor را نمایش دهید و Timeline کوچکی در زیر آن به چشم می خورد. 
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در  انتقالات  و  نقل  که  است  محلی  است،  برنامه  پیش فرض  چیدمان  عملًا  که  گزینه  این   : Editing  
آن صورت گرفته و می توانید داستان خود را در آن نقل کنید. چیدمان آن به گونه ای است که پنل های 
Source و Program Monitor در بالا نمایش داده شده و پنل های Project و Timeline را در پایین 

می بینید. 
Color  : این فضای کاری است که به کمک آن می توانید مطمئن شوید بریده فیلم از لحاظ رنگ بندی 
بی عیب و نقص است. به جای این که مجبور باشید به صورت دستی جلوه ها و تنظیماتی را برای کنترل رنگ، 
میزان روشنایی، کنتراست، منحنی های RGB، درجۀ اشباع و جلوه های شیوه بندی شده بارگذاری کنید، این 
فضای کار تمام آنها را یکجا در دسترس شما قرار می دهد. ضمناً می توانید پنل قدرتمند Lumetri Color را 
بارگذاری کرده و از کنترل های تصحیح رنگ آن استفاده کنید )برای جزئیات بیشتر در مورد این پنل به فصل 
دهم مراجعه کنید(. فضای کار Color بسیار شبیه به فضای کار Editing است اما در این جا پنل ها در ابعاد 

کوچ کتری نمایش داده می شوند تا جلوه های تصحیح رنگ در سمت چپ نمایش داده شوند. 
Effects  : این فضای کار بسیار شبیه به فضای کار Color است، اما در پنل آن گزینه های بیشتری برای 
با  Essential Graphics وجود دارد که می توانید  نام  به  پنلی  اینجا  ارائه شده است. ضمناً  تصحیح رنگ 
استفاده از آن جلوه های متنی مانند گرافی کهای یک سوم پایینی، متن متحرک، انتساب شیوه های فیلم و 

غیره را اضافه کنید. 
Audio  : همان طور که از نامش پیداست، این فضای کار ابزارهایی برای تنظیم و بهبود کیفیت صدا ارائه 
می دهد. در این جا پنل Essential Sound و نیز پنل های Audio Clip و Audio Mixer را نیز خواهید 
یافت. حتی می توانید کلیپ های صوتی را بین برنامه های ویرایش صدای Adobe مانند Audition انتقال 

داده و کیفیت شیار ها را بهبود ببخشید. 
Learning  : این فضای کار کمی زائد به نظر می رسد زیرا بسیار شبیه به فضای کار Editing است، فقط 
برگه های انتقال به سایر پنل ها را ندارد. زمانی که برای اولین بار این فضای کار را فعال می کنید، محتوای 
آموزشی برای شما نمایش داده می شود. این محتویات به ویژه زمانی مفید واقع می شوند که بخواهید برای 
اولین بار با Premiere Pro کار کنید. اگر می خواهید برنامه را باز کرده و مروری بر آن داشته باشید، این پنل 

سودمند برای شما مفید واقع می شود. 
Graphics  : این فضای کار بسیار شبیه به پنل Effects است، اما پنجرۀ Adobe stock و قالب های 
Adobe graphic را اضافه تر دارد. اگرچه بیشتر آنها رایگان هستند، اما برای برخی دیگر باید هزینه پرداخت 
کنید. با استفاده از کادر های انتخاب  ارائه شده در این پنل می توانید هر یک از این دو گروه یا در صورت تمایل 

هر دو را نمایش دهید. 
Libraries  : این فضای کار مربوط به اشتراک گذاری است. این فضا به شما امکان می دهد به محتویات 
کتابخانه جاری، سایر کتابخانه ها و Adobe Stock دسترسی یافته و آنها را با سایرین به اشتراک بگذارید. با 
فعال کردن این فضای کار، پنل Libraries و Project موقتاً نمایش داده می شوند و می توانید محتویات را 

در برنامه وارد کرده یا در برنامه دیگری به اشتراک بگذارید. 
قرار  کار  این فضای  است. در   Assembly کار  به فضای  این فضای کار خیلی شبیه   :Metalogging 
نیست ویرایشی انجام دهید، اما گزینه های مفیدی برای سازمان دهی و برچسب گذاری محتویات ارائه شده 
است. این فضا به ویژه زمانی مفید واقع می شود که حجم زیادی از محتویات دارید و باید توضیحات دقیقی در 
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مورد هر کدام ارائه دهید تا هنگام ویرایش بتوانید به سادگی هر کدام را بیابید. زمانی که روی پروژه بزرگی 
کار می کنید، طول کلیپ، درجه وضوح، سرعت فریم و سایر اطلاعاتی که وارد کرده اید به سادگی در اختیار 
ارائه شده است، برای دسترسی   Overflow شماست. چون این فضای کار به صورت پیش فرض در منوی
به این فضای کار از طریق پنجره Program باید روی علامت پیکان در سمت راست کلیک کنید. هنوز هم 

می توانید از طریق منوی کشویی به آن دسترسی داشته باشید. 

تغییر ترتیب اجزای فضای کار

همیشه هم لازم نیست برای انتخاب فضاهای کار پیش فرض روی علامت پیکان منو کلیک کنید. در عوض 
 Window>Workspaces>Edit فرمان   ،Program پنجره  ترتیب  سفارشی سازی  برای  می توانید 
از  را  و گزینه موردنظر  پیکان کلیک کرده  یا می توانید روی علامت  انتخاب کنید.  را   Workspaces

منوی کشویی انتخاب کنید. 

نکته

 افزودن توضیح به کلیپ

اطلاعات  بهتر است  ویرایشی همکاری می کنید،  با گروه  ویرایش کنید، چه  را  فیلم خود  بخواهید  چه 
مربوط به هر پلان را ثبت کنید؛ این کار در Premiere Pro بسیار ساده است. در پنل Project اطلاعات 
مربوط به خصوصیات بریده فیلم )عبارت اند از: سرعت فریم، اطلاعات ویدیو و اطلاعات صدا( نمایش داده 
این  از پوشه های شلوغ و درهم و برهم بسیار مفید واقع می شوند.  انتخاب کلیپ ها  می شوند و هنگام 
اطلاعات فقط محدود به خصوصیات نیستند؛ می توانید توضیحات و جزئیات موردنظر خود را نیز اضافه 

کنید. فرقی نمی کند در کدام فضای کار باشید. 
ممکن است فکر کنید وارد کردن توضیحات مربوط به کلیپ کار وقت گیری است، اما در نهایت جبران 
نام کلیپ  تایپ کردن  با  از وارد کردن اطلاعات،  به ویژه در پنل پروژه های شلوغ بزرگ. پس  می شود، 

موردنظر خود در کادر جستجو، می توانید آن را به سادگی بیابید. 

نکته

طریقه وارد کردن توضیحات کلیپ به این شرح است. در نمای List، فهرست را پیمایش کرده و روی یکی از 
فیلدهای Log Notes ،Description ،Tape Name یا Scene کلیک کنید. فیلد قابل ویرایش می شود و 

همان طور که در شکل 13ـ17 می بینید، می توانید مستقیماً در آن تایپ کنید. 
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 سفارشی سازی و ذخیره سازی فضای کار
صرف نظر از گزینه ها و انتخاب هایی که Premiere Pro فراهم می کند، مطمئناً تغییراتی هر چند جزئی اعمال 
کرده اید. گزینه ای را انتخاب کنید که بیشتر از همه با نیازهای شما هماهنگ است و مانند طراح داخلی آن را 
به دلخواه خود تغییر دهید. ممکن است آدم خلاقی بوده و بخواهید خود دست اندرکار اعمال تغییرات باشید یا 

ممکن است فردی باشید که ترجیح دهید از تخصص دیگران استفاده کنید. به هر حال تصمیم با شماست.
 

 جابه جایی پنل ها 

شکل 13ـ17ـ اطلاعات کلیپ که در فیلد Clip Description Notes تایپ شده است

لغت »جابه جایی« حتی در شجاع ترین افراد نیز حس ترس را برمی انگیزد، مگر این که ربطی به تغییر 
محل زندگی نداشته باشد. اما در مورد فضای کار مسئله فرق می کند. جابه جایی پنل ها به شما کمک 
می کند تا ویرایش ها را راحت تر انجام دهید زیرا تمام پنل ها در جایی قرار می گیرند که به آنها نیاز دارید 
و اندازه آنها به طور دقیق مشخص می شودـ و تازه انجام تمام این کارها بسیار ساده است. تنها کاری که 
باید انجام دهید این است که روی نوار بالایی ـ همان جا که نام پنل نمایش داده می شودـ کلیک کرده 
و بکشید. مکان نمای ماوس را به پنل دیگری بکشید تا محل جاگذاری جدید مشخص شود. هر یک از 
بخش های مجزا که از چندین شکل تشکیل شده اند، مانند محلی عمل می کنند که می توانید پنل انتخابی 

را به آن بکشید. 

یادآوری

پنل  اگر  مثال  برای  شود.  ضمیمه  پنل  آن  به  می شود  باعث  دیگر  پنل  مرکز  به  انتخابی  پنل  کشیدن   
آیتم های فهرست پنل های موجود در آن گروه  از  بکشید، یکی   Source Monitor پنل  به  را   Program

دیده می شود.  پنل  بالای  در  که  لین کها  منوی  به  دارد  اشاره  این  می شود. 
 زمانی که پنلی را به کنار پنلی دیگر می کشید، نه در هم ترکیب می شوند نه اندازۀ پنل های دیگر تغییر 
می دهند. در عوض، فاصله  بین پنل های مجاور را پر می کنند. به خاطر داشته باشید که پنل های جدیدی که 
اضافه می شوند بر اندازه پنل های مجاوری که کنار آنها قرار می گیرند تأثیر می گذارند. اگر پنلی را به سمت 

بالا و نزدیک به نوار منو بکشید، آن پنل به نوار منو اضافه خواهد شد. 
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 اگر پنلی را به آخرین گوشه سمت چپ یا راست پنجره Premiere Pro بکشید، پنل تغییر شکل داده و 
کل آن نیمه از پنجره را خواهد پوشاند. 

 ذخیره سازی فضای کار 

روش انجام این کار به این صورت است: 
 برای ذخیره سازی فضای کار، فرمان Window>Workspaces>Save As a New Workspace را 

کنید.  انتخاب 
 Window>Workspaces>Save Changes to this فرمان  موجود،  کار  فضای  بهنگام رسانی  برای   

کنید.  انتخاب  را   Workspace
 Window>Workspaces>Reset to برای بازیابی تنظیمات پیش فرض فضای کار انتخابی باید از فرمان 

Saved Layout استفاده کنید. 

پرسش های تشریحی 

1 پنجره Timeline  چه کاری انجام می دهد؟
٢ پنجره Source به چه منظور استفاده می شود؟

٣ پنجره Program به چه منظور استفاده می شود؟
٤ تفاوت بین کلیپ های صوتی و کلیپ های فیلم چیست؟

٥ چگونه پروژه خود را در Adobe Premiere Pro ذخیره می کنید؟

پرسش های چهار گزینه ای 

1 دلیل ایجاد پوشه جدید در پنجره Project چیست؟
Timeline الف( برای تودرتو کردن

با سفارشی سازی فضای کار Premiere Pro، هم خلاقیت و هم کارآمدی خود را افزایش خواهید داد. 
اما اعمال سلیقه در مرتب سازی فضای کار، فقط نیمی از داستان است. اگر به فضای کار جدید خود واقعاً 
علاقه دارید، باید آن را با نام مخصوص به خود ذخیره کنید، وگرنه این تغییر در فضایی اعمال می شود 
که ویرایش کرده اید. اگر در میان فهرست فضاهای کار پیش فرض، Assembly و Metalogging را 
بیشتر دوست دارید، می توانید از نام هایی نظیر »Ed’s Editing« یا »Aubrey’s Audio« یا نام هایی 

از این قبیل استفاده کنید. 

نکته
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ب( برای ایجاد سکانس جدید
Timeline ج( برای خودکارسازی کلیپ ها در

Project د( برای سازمان دهی کلیپ ها در پنجره

٢ Adobe Premiere Pro روی کدام پلت فرم ها اجرا می شود؟
Scientific Linux 4/5 )ب 	Linux Kernel Version 2/6 با Linux )الف
Microsoft Windows )د 	Windows و Mac OS X )ج

٣ Adobe Premiere Pro یک برنامه نرم افزاری ویرایش ویدیوی مبتنی بر Timeline… حرفه ای است.
ب( چند وظیفه ای رایانه ای 		 الف( رایانش بی درنگ

د( نرم افزار رایانه ای 		 ج( سیستم عامل بی درنگ

٤ چگونه پروژه ای را در Adobe Premiere Pro ایجاد می کنیم؟
Timeline ب( با استفاده از 	New Project الف( با استفاده از کادر محاوره ای

Close Project د( با استفاده از کادر محاوره ای 	fade out ج( با استفاده از صفحه نمایش

٥ چگونه کلیپ های فیلم را در پروژه وارد می کنیم؟
الف( کلیک راست می کنیم و رسانه را وارد می کنیم.
ب( کلیک راست می کنیم و رسانه را صادر می کنیم.

ج( کلیک می کنیم و رسانه را صادر می کنیم.
د( کلیک می کنیم و رسانه را وارد می کنیم.
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می رود:
  بتواند ويديوي ديجيتال را ذخیره کند و انتقال دهد.

  بتواند با Adobe Bridge کار کند.

  بتواند ويديوي ديجيتال را از کارتخوان انتقال دهد.

  بتواند مستقیماً از کارت ویرایش را انجام دهد.

  بتواند کلیپ های مختلف را دانلود کند.

  بتواند رسانه ها را وارد کند.

  بتواند کلیپ های موسیقی و صدا را اضافه کند.

وارد کردن، اشاره به فرایند ضبط کلیپ ها و دارایی ها در Premiere Pro دارد که از طریق دوربین، کارت 
از  را  فایل ها  این  این است که  cloud و درایو سخت صورت می گیرد. هدف  رسانه، محل ذخیره سازی در 
مکان های مختلف گرفته و آنها را به محل ذخیره سازی محلی انتقال دهید تا همیشه قابل دسترس باشند. 
که  می کنید  کاری  فقط  عوض  در  دهید.  قرار  استفاده  مورد  را  واقعی  فایل های  نمی توانید  کردن  وارد  با 
Premiere Pro از وجود آنها مطلع شود. اجازه دهید روش های مختلف وارد کردن رسانه به پروژه را مورد 

دهیم.  قرار  بررسی 
گزینه های موجود عبارت اند از: 

Adobe Bridge : از Bridge می توانید برای یافتن فایل های ویدیو، صدا و عکس از کل سیستم و وارد 
کردن آنها به Premiere Pro استفاده کنید )برای جزئیات بیشتر در مورد Adobe Bridge به بخش بعدی 

مراجعه کنید(. 
Camcorder : بیشتر دوربین های فیلم برداری به شما امکان می دهند دوربین را از طریق کابل USB به 

رایانه متصل کرده و فایل ها را مستقیماً به Premiere Pro وارد کنید. 
Hard Drive : فایل های ذخیره شده را می توان از طریق درایو سخت یا از طریق درایو خارجی به پروژه 

وارد کرد. 
DVD : وارد کردن فایل ها از DVD بسیار ساده است. فقط باید آنها را در درایوهای دیگر بیابید. وارد کردن 
از DVD که به خودی خود پخش می شود کار ساده ای نیست، اما با استفاده از نرم افزار مناسب می توانید 

بخش های مختلف را به سادگی استخراج کنید. 
Recorded from Zoom : ضبط مصاحبه ها با استفاده از Zoom این روزها بسیار مرسوم شده و فایل ها 

به سادگی قابل وارد کردن هستند. 
Photos from cameras or devices : فقط باید دستگاه موردنظر را به رایانه متصل کرده، فایل را 

جستجو کرده و آن را به Premiere Pro وارد کنید. 
Downloaded from your smartphone : محتویات را از cloud دریافت کرده یا گوشی هوشمند 

خود را متصل کرده، محتویات را به درایو صادر کرده و سپس آنها را به Premiere Pro وارد کنید. 
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 DVD مجوزها و خطرات استفاده از

شاید در گذشته یک DVD خودـ پخش از ویدیوهای مربوط به گروه موسیقی مورد علاقۀ خود در دهۀ هشتاد 
تهیه کرده بودید و حالا می خواهید از بخشی از آن در فیلم خود استفاده کنید. از سوی دیگر اگر بخواهید 
بخشی از صحنۀ فیلم DVD خریداری شدۀ قبلی را استخراج کرده و مورد استفاده قرار دهید، اگر قرار باشد 
فیلم خود را برای عموم به نمایش در آورید، باید مجوزهای لازم را اخذ کنید. بدون اخذ مجوز، از قوانین 

کپی رایت تخطی کرده اید و فقط در صورت دریافت مجوز می توانید این کار را انجام دهید. 

  Adobe Bridge

اگر این برنامۀ کاربردی مدیریت دارایی های دیجیتال را در رایانه خود دارید، پس بهتر است از آن استفاده 
کنید. اگر آن را ندارید، بهتر است دانلودش کنید. Adobe Bridge که در شکل 1ـ18 می بینید، زمانی مفید 
واقع می شود که در جستجوی فایل های ویدیویی ذخیره شده در رایانه، درایوهای سخت خارجی یا هر وسیلۀ 
دیگری باشید که در آن لحظه به رایانه خود متصل کرده اید. با استفاده از Premiere Pro می توانید آدرس 

موردنظر را پیمایش کرده، کلیپ موردنظر خود را یافته و آن را در پوشۀ Project وارد کنید. 

شکل 1ـ18ـ Adobe Bridge برای بازبینی فایل ها، انتقال بین فایل ها و مدیریت دارایی دیجیتال طراحی شده است. 
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انتقال از کارت خوان 

بسته به نوع دوربین مورد استفاده، به احتمال زیاد روی کارت SD( Secure Digital( ضبط کرده اید. در 
مدل های قدیمی تر DSLR ها، از کارت CF( Compact Flash( استفاده می شد. بیشتر رایانه ها در حال 
حاضر به صورت پیش فرض قادر به خواندن فرمت SD هستند. اگر رایانه شما این قابلیت را ندارد یا اگر از 
کارت CF برای ضبط ویدیو استفاده کرده اید، همان طور که در شکل 2ـ18 می بینید، به سادگی می توانید از 

کارت خوان هایی که با قیمت ارزان در بازار موجود هستند استفاده کنید. 

Compact Flash شکل ٢ـ18ـ کارت خوان به همراه کارت

برای انتقال ویدیو، این مراحل را دنبال کنید: 
1 کارت رسانه دیجیتال را به رایانه متصل کنید. چه از کارت خوان تعبیه شده در رایانه استفاده می کنید چه 

از کارت خوان خارجی، کارت را وارد کنید. 
٢ مطمئن شوید کارت به درستی وارد شده است. به عبارت دیگر، دایرکتوری یا Finder را بررسی کنید یا 

فرمان File>Import را انتخاب کنید. 

به خاطر داشته باشید که ابتدا محتوا را در درایو سخت ذخیره کنید. درست است که می توانید مستقیماً 
از طریق کارت رسانه ویرایش کنید، اما بهتر است ابتدا کل محتویات را به کارتی در درایو سخت یا درایو 
خارجی انتقال دهید. به محض این که آن را وارد کردید، لازم نیست دیگر نگران باشید که پس از خارج 

کردن کارت دیگر محتویات قابل دسترس نخواهند بود. 

هشدار
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٣ روی کارت دابل کلیک کنید. چندین پوشه و فایل های دسته بندی شده در آنها را در داخل کارت می بینید. 
بهتر است  اما  نباشد،  آنها  به وارد کردن  نیازی  باشند که  نیز وجود داشته  اگرچه ممکن است دارایی هایی 
پوشۀ اصلی را به درایو محلی یا درایو خارجی متصل شده بکشید. به محض انتقال، می توانید کارت رسانه را 

از دستگاه خارج کنید. 
 Clip ٤ محتویات را وارد کنید. فرقی نمی کند چند پوشۀ تو درتو را وارد کرده باشید، در عوض باید پوشۀ
را بیابید. کلیپ یا گروهی از کلیپ های موردنیاز خود را بیابید. فایل های مربوطه در پنل Project نشان داده 

خواهند شد. 

ویرایش مستقیم از طریق کارت 

گاهی زمانی که نیاز به ویرایش سریع دارید یا می خواهید در زمان صرفه جویی کنید، می توانید از مرحلۀ 
وارد کردن مستقیم از کارت حافظه چشم پوشی کنید. در مقابل می توانید به سرعت ویرایش را انجام داده و 
در مورد وجود فضای کافی در درایو سخت رایانه نگران نباشید. اما این روش خطرات خود را دارد زیرا رسانه 
فقط در کارت وجود دارد و در صورتی که پاک شده یا اتصال آن قطع شود دیگر دسترسی به صورت آنلاین به 
آن امکان پذیر نخواهد بود. در صورت بروز چنین اتفاقی، همیشه می توانید کارت را دوباره وارد کرده و اتصال 

رسانه را بار دیگر برقرار کنید. 
برای انتقال ویدیو، این مراحل را دنبال کنید: 

1 کارت رسانۀ دیجیتال را به رایانه متصل کنید. چه از کارت خوان تعبیه شده در خود رایانه استفاده می کنید، 
چه از کارت خوان خارجی، کارت را وارد کنید. 

٢ مطمئن شوید کارت به درستی وارد شده است. به عبارت دیگر دایرکتوری یا Finder را بررسی کنید یا 
فرمان File>Import را انتخاب کنید. 

٣ کلیپ را وارد کنید. اگر کارت هنوز در کارت خوان قرار داردـ به عبارت دیگر، اگر کارت را خارج نکرده اید 
یا اتصال هنوز قطع نشده است ـ می توانید پوشۀ کلیپ را پیمایش کرده یا کل پوشه را انتخاب کرده یا آن 
را باز کرده و کلیپ های موردنظر خود را بیابید. کلیپ یا گروهی از کلیپ های موردنظر خود را انتخاب کنید. 

 ضبط محتویات نوار از دوربین فیلم برداری 

همۀ دوربین های فیلم برداری روی کارت رسانه ضبط نمی کنند یا گزینه ای برای ضبط ویدیو در درایو 
سخت داخلی ندارند آن را مانند کارتی در نظر بگیرید که قابل استفاده در خارج از دوربین است. بنابراین 
به تدریج که نسل جدید ویدیوی دیجیتال معرفی شد، نوارهای DV و HDV رو به انحطاط رفتند. در 
حالی که برنامه هایی که نوار ویدیو را به رسانۀ دیجیتال تبدیل می کنند فرایند کار را ساده تر کرده اند، 
به Premiere Pro وارد  هنوز هم می توانید محتویات را از دوربین فیلم برداری قدیمی خود مستقیماً 
کنید. ممکن است به مبدل نیاز داشته باشید. وقتی اتصال برقرار شد، می توانید محتویات نوار را به دیسک 

سخت خود وارد کنید. 

یادآوری
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)capture( و ضبط کردن )import( تفاوت وارد کردن
این دو اصطلاح به جای هم به کار می روند، اما درست مانند  هنگام وارد کردن محتویات در پروژه، معمولاً 
زمانی که برای قهوۀ خود شیر بادام یا خامه را انتخاب می کنید، وارد کردن و ثبت کردن محتویات در پروژه 
هر دو هم شبیه به هم هستند و هم متفاوت عمل می کنند. ثبت کردن اشاره به ایجاد رسانۀ جدید مانند 
فیلمی دارد که با استفاده از دوربین می گیرید، در حالی که وارد کردن اشاره به فایلی در درایو دارد که به 

پروژه وارد می کنید. 
می توانید این محتوا را مانند شکل 3ـ18 از طریق اتصال USB دوربین به Premiere Pro وارد کنید. پس 

از اتصال آن به رایانه، این مراحل را دنبال کنید: 

HDV شکل 3ـ18ـ اتصال به دوربین فیلم برداری

١ـ فرمان File>Capture را انتخاب کنید تا پنجرۀ Capture نمایش داده شود: 
در سمت راست پنجره ، بخش Clip Data را می بینید. این جا جایی است که تمام نام ها و توضیحات را وارد 

می کنید. 
٢ـ نام نوار و نام کلیپ را تایپ کنید: برای بیشتر انواع ضبط، نام نوار دیگر منسوخ شده است مگر این 
که محتوا را از نوار وارد کرده باشید. می توانید از هر نامی که مایلید استفاده کرده و نام کارت را نیز مشخص 
کنید. در فیلد بعدی، Clip Name، اطلاعات مهم دیگری را وارد می کنید که به ویژه برای سازمان دهی و 
جستجوی اطلاعات مفید واقع می شود. سپس نوبت به فراداده می رسد تا با داده هایی نظیر تاریخ یا محل هر 

یک از فیلم ها، بین کلیپ ها تمایز قائل شود. 
٣ـ محتوای ضبط شده را ذخیره کنید: در بالای پنل، روی Settings کلیک کنید تا بتوانید موقعیتی را 
انتخاب کنید که می خواهید محتوای ضبط  شده را در آن ذخیره کنید. روی Browse کلیک کرده و آدرس 

موردنظر خود را پیمایش کنید. 
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٤ـ آدرس را پیمایش کرده و بریده فیلم را ضبط کنید: دوباره روی برگۀ Logging کلیک کنید. در 
انتهای کادر محاوره ای، روی دکمۀ Play کلیک کنید. زمانی که قسمتی را یافتید که می خواهید ضبط کنید، 
روی دکمۀ Record کلیک کنید تا Premiere Pro شروع به ضبط بی درنگ محتویات کند. پس از این که 
بریده فیلم ضبط شد، روی دکمۀ Stop کلیک کنید. کادر محاوره ای Save Captured Video نمایش داده 
می شود. می توانید اطلاعات بیشتری را اضافه کنید و به محض این که از نتایج راضی بودید، می توانید روی 

دکمۀ OK کلیک کنید. کلیپ به پنل Project وارد شده و آماده ویرایش خواهد بود. 

دانلود کردن کلیپ ها 

یکی دیگر از روش های گردآوری محتوا برای فیلم، استفاده از کلیپ های اینترنتی است. البته، فقط به این 
دلیل که می توانید کلیپی را از اینترنت دانلود کنید، به این معنا نیست که اجازه دارید این کار را انجام دهید. 
در عوض باید محتوا را در سایت هایی بیابید که حق امتیاز انحصاری نداشته باشند، از طریق شخص ثالثی 
برای شما ارسال شده باشند یا شاید هم از رایانه دیگری آپلود شده باشند. شاید هم کلیپی از طریقی دیگر 
به دست شما رسیده باشد اما مجوز استفاده از آن را داشته باشید. تمام این ها روش های مفیدی هستند زیرا 
رایج ترین منابع  با  بهتر است  آنلاین وجود دارد. در حال حاضر  دانلود کلیپ های  برای  روش های متعددی 

دانلود آشنا شوید. 
 سایت های انتقال ویدیو: هزینۀ استفاده از این سایت ها از کاملًا رایگان تا پرداخت چند دلار در ماه 
متفاوت است. بسته به اندازۀ فایل ها، سایت هایی مانند Redtail ،WeTransfer و Dropbox راه حل های 
کارآمدی برای انتقال فایل های بزرگ از محلی به محل دیگر ارائه می دهند. اساساً باید لینک ارسالی توسط 

پست الکترونیکی را باز کنید تا فایل به پوشۀ Downloads شما منتقل شود. 
 از طریق پست الکترونیکی: هرچند برای حجم فایل های انتقالی با محدودیت زیادی روبه رو هستید 
پست  طریق  از  را  کوتاه  و  فشرده سازی شده  فیلم  کلیپ های  می توانید  اما  کمتر(،  یا  مگابایت   20 )معمولاً 

اما تا حدی مفید واقع می شود.  این بهترین گزینه نیست،  الکترونیکی ارسال و دریافت کنید. 
 سایت های فاقد حق امتیاز انحصاری: سایت هایی هستند که می توانید کلیپ های عمومی را برای فیلم 
خود دانلود کنید بدون این که نیاز به پرداخت هزینه داشته باشید یا بدون این که قوانین کپی رایت را زیر پا 

بگذارید. 
 محتوای توزیع شده: گاهی می توانید مجوزهای استفاده از محتویات دانلود و توزیع شده را به دست آورید. 
یا محتویات دیگری که مجوز  از کلیپ های فیلم  برای استفاده  الکترونیکی Kits (EPKs) که  مانند مجلۀ 

استفاده از آنها را داشته باشید مفید واقع می شود. 

وارد کردن رسانه 

 File>Import کار بسیار ساده ای است. یا می توانید فرمان Premiere Pro افزودن کلیپ ها و صدا به پروژۀ
 Command+1 را انتخاب کرده و فایل را پیمایش کنید یا می توانید از کلیدهای میانبر صفحه کلید )کلیدهای
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پنل  خالی  قسمت  روی  باید  فقط  یا  کنید.  استفاده  ویندوز(  در   Control +1 کلیدهای  یا  مکینتاش  در 
Project کلیک راست کنید تا منوی بازشویی که در شکل 4ـ18 می بینید باز شود. سپس گزینه Import را 

انتخاب کرده و فایل موردنظر خود را پیمایش کنید. 

افزودن کلیپ های موسیقی و صدا 

موسیقی و صدا نقش مهمی در موفقیت فیلم شما دارند. با استفاده از لایه ها می توانید صدا را بهبود بخشیده، 
جلوه ها را اضافه کرده، موسیقی متن را افزوده یا حتی از ADR )دیالوگ های جایگزین( استفاده کنید که 
از جمله موسیقی، جلوه های صوتی  ـ  اصوات  بیشتر  بنابراین  است.  فیلم سازی حرفه ای  در  بخشی ضروری 
از محتویات ضبط شده توسط دوربین اضافه می شوند، زیرا تصاویر  و صداهای جایگزین ـ به صورت مجزا 
متحرک بدون آنها جلب توجه نمی کنند. Premiere Pro از شیار های متعددی پشتیبانی می کند، بنابراین 

در صورت لزوم می توانید با لایه بندی از دارایی های صوتی مختلفی در فیلم خود استفاده کنید. 
شرایط  تحت  مجدد صدا  جایگزین، ضبط  دیالوگ های  از  منظور  )دیالوگ های جایگزین(:   ADR ضبط 

بازیگر اعمال شود.  افزایش یافته یا تغییراتی در صدای  کنترل شده است تا کیفیت صدا 

با انتخاب گزینه »Import« فایل واقعی وارد نمی شود، بلکه فقط نام فایل و مسیری وارد می شود که فایل 
رسانه در آن ذخیره شده است. 

یادآوری

Import شکل ٤ـ18ـ منوی
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یافتن موسیقی مناسب: گاهی شخصاً می توانید بهترین قطعۀ موسیقی موردنظر خود را انتخاب کنید و در 
برخی موارد به دلایلی باید از نظر فرد دیگری بهره بگیرید. اما این فقط قسمتی از ماجرا است. مهم ترین سؤالی 
که باید از خود بپرسید این است که آیا مجوز استفاده از موسیقی انتخابی خود را دارید یا خیر. گاهی موسیقی 
بی نظیری را انتخاب کرده اید اما عملًا قادر به استفاده از آن نخواهید بود، زیرا یا مجوزهای لازم را در اختیار 
ندارید یا کسب این مجوزها آن قدر هزینۀ بالایی دارد که عملًا امکان پذیر نیست. همیشه باید محدودیت های 

موجود را به طور کامل مورد بررسی قرار دهید.

پرسش های تشریحی 

1 نحوه کار Adobe Bridge را توضیح دهید.
٢ مراحل انتقال ویدیو از SD کارت به رایانه را بیان کنید.

٣ تفاوت وارد کردن )import( و ضبط کردن )capture( چیست؟
٤ رایج ترین منابع دانلود کلیپ ها را نام برده و توضیح دهید.

٥ وارد کردن رسانه به Premiere به چه صورت انجام می شود.

پرسش های چندگزینه ای 

1 چه هنگام دکمه های کنترلی در پایین پنجره Capture غیرفعال می شوند؟
الف( زمانی که Premiere هیچ دستگاه تصویرگیری را تشخیص نمی دهد.

ب( شما هیچ دکمه کنترلی را انتخاب نکرده اید.
ج( شروع به تصویرگیری نکرده اید.

د( دستگاه DV شما در حال برگشت است.

٢ کدام روش به کاربر اجازه می دهد تا camera Source Sequenceـ Create Multi را از منوی زمینه 
انتخاب کند؟

الف( Shift کلیک کردن روی کلیپ های منتخب
ب( Alt کلیک کردن روی کلیپ های منتخب

ج( کلیک راست کردن روی کلیپ های منتخب
د( Ctrl کلیک روی کلیپ های منتخب
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می رود:
  با مفاهیم جلوه و گذار آشنا باشد و كاربردهاي آنها را بداند.

  بتواند گذارهای پیش فرض را تنظیم و اعمال کند.

  بتواند گذارها را کنترل کند.

  بتواند از دستگیره های کلیپ استفاده کند.

  بتواند از تکنی کهای پیشرفته گذار استفاده کند.

  برای استفاده از گذارها برنامه ریزی کند.

  بتواند گذارها را تغییر دهد و حذف کند. 

  بتواند از پلاگین های گذار استفاده کند.

  بتواند گذارها را در پنل کنترل های Effects  تنظیم کند.

جلو ه های صوتی نقش مهمی در فیلم بازی کرده و حتی به فیلم روح 
می بخشند. شکستن شیشه، صدای رعد و برق، تاخت اسبان، صدای 
نفس کشیدن و صدای شیپورها فقط چند مورد از اصواتی است که 
می توانید به فیلم اضافه کرده و به آن جان ببخشید. وب سایت  های 
زیادی وجود دارند که جلوه های صوتی متداول، از صدای پا و هوهوی 
باد گرفته تا صدای سوت مانند حرکت سریع اجسام و صدای برخوردها 
و تصادفات را به رایگان در اختیار شما قرار می دهند. ضمناً با استفاده 
از پنل Essential Sound در Premiere Pro که در شکل 1ـ19 

می بینید نیز می توانید تغییراتی در این صداها اعمال کنید. 
از گذار ها برای حرکت از یک صحنه از یک پلان به صحنه ای دیگر 
استفاده می شود. Premiere Pro فهرستی از گذار ها را فراهم می کند 
که می توانید در سکانس اعمال کنید. گذار ممکن است از محوشدگی 
تا  می کند  کمک  شما  به  و  دربربگیرد  را  پیچیده  جلوه ای  تا  ساده 
جذابیت بصری بیشتری به فیلم خود اضافه کنید. اما این ها استثناها 
هستند نه قانون. بیشتر گذار ها همان کات های ساده هستند که در 
از  اگر می خواهید  بنابراین  ادغام می کنند.  را در هم  اصل دو کلیپ 
جلوه ای بیش از یک کات ساده استفاده کنید، هر از گاهی این کار را 

انجام دهید نه همیشه. 

 Essential Sound شکل 1ـ19ـ پنل
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قبل از اعمال گذار، بخش هایی از کلیپ را برش دهید چون برخی از بخش های اضافی فریم نمونه گیری 
می شوند. هر چه بخش های بیشتری را برش دهید، می توانید از فریم های بیشتری در گذار استفاده کنید. 
گاهی مقدار کمی برای برش وجود دارد یا اصلًا وجود ندارد، بنابراین باید مطمئن شوید فریم های کافی 

در اختیار دارید. 

هشدار

در فهرست زیر توضیح مختصری در مورد هر یک از پوشه های Transition ارائه می دهیم: 
3D Motion : این ها عبارت اند از: Cube Spin یا Flip Over که گذار های متحرک پیچیده ای را بین 

کلیپ ها ایجاد می کنند. 
Dissolve : این جا محلی است که بیشتر گذار های پرکاربرد و گونه های مختلف آنها در آن قرار گرفته اند. 
که  هستند  استفاده  قابل  فیلم  بریده  از  نوعی  با  مجازی  واقعیت  گذار های  این   :Immersive Video 
واقعیت مجازی  برای  فیلم  بریده  اگر  باشد.  فیلم برداری شده  در وضعیت مستطیلی سیصد و شصت درجه 

کنید.  استفاده  دیگری  روش  از  باید  باشد،  نشده  تصویربرداری 
Iris : این مجموعه منحصربه فرد از تکنی کهای ماسک کمک می کنند تا علیرغم نمایش صحنه، توجه 
مخاطب فقط به بخش خاصی از کلیپ جلب شود. چندین گزینه ارائه می شوند که از جملۀ آنها می توان به 

Iris Round اشاره کرد )شکل 2ـ19(. 
Page Peel : یک جفت از گذار ها که مانند آنچه در شکل 3ـ19 می بینید، عملکردی مانند ورق زدن کتاب 

را شبیه سازی می کنند. البته در نوع خود گذار خوبی است، اما بهتر است زیاد از آن استفاده نکنید. 

شکل 2ـ19ـ نمونه ای از گذار Iris Round در میانه کار
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Slide : گروهی از گذار ها را شامل می شود که عملکرد آنها از روی نامشان پیداست و کلیپ ها را به صورت 
اسلاید نمایش می دهند. گزینه های موجود عبارت اند از: Split ،Slide و Push )شکل 4ـ19 را ببینید(. 

شکل 3ـ19ـ نمونه ای از گذار Page Peel در میانه کار

شکل 4ـ19ـ نمونه ای از گذار Push در میانه کار
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به طور  به نظر می رسد یک پلان  به پلان دیگر می رود.  از پلانی  لغزنده  انیمیشنی  با  این گذار   :Wipe 
 Wipe کامل پاک می شود تا پلان بعدی نمایان شود. بیشتر از ده ها گزینه وجود دارد که عبارت اند از: همان
معمولی، صفحۀ شطرنجی، ساعت و در مزرعه. گذار های Wipe برای جلب توجه مخاطب بسیار خوب عمل 

می کنند، اما اگر بیش از حد مورد استفاده قرار گیرند جذابیت خود را از دست خواهند داد. 
Zoom : همان طور که قبلًا هم گفتیم، زمانی که از این گذار بین دو کلیپ استفاده می کنید، انتهای کلیپ 

اول و ابتدای کلیپ دوم بزرگ نمایی شده و سایر بخش های کلیپ ها به صورت نرمال پخش می شوند. 

تنظیم گذار های پیش فرض 

در حالی که Cross Dissolve گذار پیش  فرضی است )و دلیل خوبی برای آن وجود دارد(، درست مانند 
عملکرد  دنبال  به  شاید  اما  کنید.  استفاده  دیگری  چیز  هر  همراه  به  را  آن  می توانید  است.  وانیلی  بستنی 

بیابید.  پوشه ها  میان  در  را  آن  نمی خواهید  و  خاص تری هستید 
بنابراین اگر به دنبال تنظیمات خاص خود هستید، می توانید تنظیمات گذار را به این صورت تغییر دهید: 

1 فرمان Window>Effects را انتخاب کرده و پوشۀ Video Transition را باز کنید. 
٢ گذاری را انتخاب کنید که می خواهید از آن به عنوان پیش فرض جدید استفاده کنید. 

٣ روی گذار کلیک راست کرده و گزینۀ Set Selected As Default Transition را انتخاب کنید. 
٤ روی آن کلیک کنید تا از این به بعد به عنوان یکی از گذار های پیش فرض در اختیار شما قرار گیرد. 

اعمال گذار های پیش فرض  

را  پیش فرضی  گذار  می توانید  به سادگی 
انتخابی  کلیپ  دو  بین  ویرایش  نقطۀ  در 
است  این  روش  ساده ترین  کنید.  اعمال 
کرده  کلیک  کلیپ  دو  بین  کات  روی  که 
و کلیک راست کنید. به این ترتیب منویی 
5ـ19  شکل  در  که  می شود  داده  نمایش 
 Apply Transitions گزینه  می بینید. 
گذار   Premiere Pro تا  کنید  انتخاب  را 
cross dissolve را اضافه کند. مگر این که 
باشید.  داده  تغییر  را  پیش فرض  تنظیمات 

Transition شکل 5ـ19ـ کادر محاوره ای
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 Sequence>Apply Default Transitions ضمناً می توانید نشانگر پخش را بین کلیپ ها قرار داده و فرمان
To Selection را انتخاب کنید. 

کنترل گذار ها 

بیشتر گذار ها گزینه ای ارائه می دهند تا آنها را طولانی تر اعمال کنید و نیز به شما امکان می دهند کنترل 
کنید جلوۀ آنها در چه مقدار از کلیپ های مجاور نشان داده شود. با کشیدن لبه های گذار می توانید آن را در 
بخش های بیشتر یا کمتری از دو کلیپ تحت تأثیر اعمال کنید. اما برای این که گذار بی عیب و نقصی را در 
کلیپ اعمال کنید کارهای بیشتری نیز می توانید انجام دهید. برای مثال، می توانید مدت زمان آن را تغییر 
 Set Transition Duration تا کادر محاوره ای  دابل کلیک کنید  باید روی گذار  این منظور  برای  دهید. 
نمایش داده شود که در شکل 6ـ19 می بینید. مدت زمان موردنظر خود را تنظیم کرده و روی OK کلیک 

کنید. 

Set Transition Duration شکل 6ـ19ـ کادر محاوره ای

 گذار پیش فرض 
Cross dissolve به عنوان گذار پیش فرض عمل می کند و برای دسترسی به آن چندین روش وجود دارد. 
می توانید روی نقطۀ ویرایش کلیک راست کرده و گزینۀ Apply Default Transition را از منو انتخاب 
 Command-D را نگه داشته و کلیک کنید. می توانید از کلیدهای میانبر Control کنید. می توانید کلید
استفاده کنید. یا می توانید فرمان Sequence>Apply Default Transition را از منوی کشویی انتخاب 

کنید. برای تنظیم مدت زمان آن باید از فرمان Preferences>Timeline استفاده کنید. 
برای این که کنترل بیشتری روی گذار داشته باشید، می توانید آن را از طریق کادر Effect Controls تنظیم 

کنید. 
طریقۀ انجام کار به این شکل است: 

1 روی گذار کلیک کنید تا هایلایت شود. 
٢ به Effect Controls بروید. 
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٣ در صورت لزوم برای تنظیم مدت زمان گذار، روی فیلد Duration کلیک کرده و زمان متفاوتی را تایپ 
کنید. 

٤ تراز را با استفاده از منوی کشویی Alignment تنظیم کنید. این گزینه به صورت پیش فرض با مقدار 
Center تنظیم شده است، اما همان طور که در شکل 7ـ19 می بینید، می توانید آن را با یکی از مقادیر 

Start at Cut یا End at Cut تنظیم کنید. 

استفاده از دستگیره های کلیپ 

Effect Controls شکل 7ـ19ـ تغییر جلوه های گذار در پنل

برای این که گذار به خوبی عمل کند، نیاز به چند فریم اضافی قبل از نقطۀ In و بعد از نقطۀ Out دارید، 
چون بیشتر گذار ها فریم های قبل و بعد از کات را نمونه گیری می کنند. این فضای اضافی با نام دستگیرۀ 
کلیپ شناخته می شود. بنابراین، اگر بخواهید از dissolve بین دو کلیپ مجاور استفاده کنید، انتهای 
اولین کلیپ و ابتدای دومین کلیپ، هر کدام باید فریم های اضافی داشته باشند تا جلوه به درستی عمل 

کند. 

هشدار

فریم  قرار می دهید در آخرین  استفاده  آیا کلیپی که مورد  دریابید  به سادگی می توانید  اول  نگاه  در همان 
قرار گرفته یا خیر. همان طور که در شکل 8  ـ19 می بینید، مثلث کوچکی در گوشۀ سمت راست بالایی )در 

انتهای کلیپ( یا گوشۀ سمت چپ بالایی )در ابتدای کلیپ( نمایش داده می شود. 
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البته هر فریمی هم برای انجام این کار مناسب نیست. فریم ها باید با پلان هماهنگی داشته باشند. گاهی هنگام 
فیلم برداری یک صحنه، ممکن است از زاویه ، سوژه یا لوکیشن جدیدی استفاده کنید که قابل نمونه گیری 
باشد، اما این امر باعث می شود گذار جلوۀ زشتی پیدا کند. اگر در طول پخش با چنین مشکلی مواجه شدید، 
باید مدت زمان گذار را تغییر داده یا تراز آن را تصحیح کنید )رجوع کنید به بخش قبلی »کنترل گذار ها«(. 

تکنیک های پیشرفتۀ گذار 

ارائه می دهد که  نیز  تعدادی گذار دیگر   ،Wipe و   Dissolve بر گذار های مرسوم  Premiere Pro علاوه 
 .Light leaks و   Spherical blurs  ،Luma fades  ،Slides  ،Pushes  ،Zooms از:  عبارت اند 

برنامه ریزی برای استفاده از گذار ها  

شکل 8  ـ19ـ نشانۀ انتهای کلیپ

گذار تک وجهی 

 Timeline انتهای سکانس  زیرا فقط در  به حساب می آیند،  Fade-out گذار های ت کوجهی  و   Fade-in
گذار های  می شوند.  اعمال  کلیپ  دو  هر  در  یعنی  هستند،  وجهی  دو  گذار ها  بیشتر  البته  می شوند.  اعمال 
ت کوجهی به جای این که در دو لحظه ابتدایی و انتهایی اعمال شوند، زمانی مفید واقع می شوند که یک یا 

باشد.  چند دستگیرۀ کلیپ وجود داشته 

استفاده از گذار بین دو کلیپ تصادفی به آنها کمک می کند بهتر عمل کنند. فیلم برداری کلیپ ها با این 
نیت که قرار است از گذار خاصی در آنها استفاده شود نیز بسیار کم ککننده خواهد بود. چه از زوایای 
متضاد استفاده کنید چه از نمای بی نهایت کلوزآپ، زمانی که محتوا را از قبل برای ویرایش آماده کرده 

باشید، می توانید کنترل بیشتری روی آن داشته و از جذابیت بیشتری در فیلم خود بهره ببرید. 

نکته
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  Timeline وجه تمایز گذار ها در

با خطی مورب به دو قسمت تقسیم  Timeline دقت کنید که گذار ت کوجهی  برای تشخیص گذار ها در 
با خط موربی نشان داده  نیمه روشن است، در حالی که گذار دووجهی  تیره و یک  نیمه  می شود که یک 

برای جزئیات بیشتر به شکل 9ـ19 مراجعه کنید.  نیمه در آن تیره هستند.  می شود که هر دو 

اگر می خواهید از گذار ت کوجهی به عنوان Fade-in( Fade-out( استفاده کنید، به این شرح عمل کنید. 
١ـ در پنل Effects، روی پوشۀ Video Transition دابل کلیک کنید تا باز شود. 

٢ـ پوشۀ Dissolve را پیمایش کرده و آن را باز کنید. گزینه های زیادی در دسترس هستند )در مورد 
هر یک از آنها در قسمت های بعدی همین فصل بیشتر شرح خواهیم داد(، اما گزینۀ Dip to Black از 

همه بهتر عمل می کند. 
٣ـ گذار را به انتهای کلیپ در Timeline بکشید. 

نکته

تغییر و حذف گذار ها  

شکل 9ـ19ـ گذار دووجهی

گذار جدید را روی گذار قبلی بکشید تا جایگزین آن شود. برای حذف گذار، روی آن کلیک کرده و سپس 
کلید Delete را فشار دهید یا می توانید روی گذار کلیک راست کرده و گزینۀ Clear را از منوی کشویی 

انتخاب کنید. 

نکته
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کپی کردن و چسباندن گذار ها 

گاهی نوع و مدت زمان مناسب گذاری را می یابید که برای شما بهتر از بقیه عمل می کند. بنابراین به جای 
این که هر بار تمام مراحل کشیدن و تنظیم گذار موردنظر خود را تکرار کنید، می توانید آن را کپی کرده و 

بین دو کلیپ بچسبانید. 
روش انجام کار به این شرح است. 

1 ترانزیشن موردنظر خود را در Timeline انتخاب کنید تا هایلایت شود. 
٢ برای کپی کردن گذار می توانید از فرمان Edit>Copy استفاده کرده یا از کلیدهای میانبر Cmd+C )در 

مکینتاش( یا Ctrl+C )در ویندوز( کمک بگیرید. 
٣ گذار را در نقطۀ ویرایش موردنظر خود بچسبانید. برای این منظور یا باید فرمان Edit>Paste را انتخاب 

کنید یا از کلیدهای میانبر Cmd+V )در مکینتاش( یا Ctrl+V )در ویندوز( استفاده کنید. 

استفاده از پلاگین های گذار 

از  این ها مجزا  و  قرار می دهد  اختیار شما  را در مورد گذار ها در  زیادی  Premiere Pro گزینه های مفید 
آنهایی هستند که خودتان می توانید به صورت سفارشی بسازید )در مورد این موضوع حتی می توان یک کتاب 
تخصصی دیگر نوشت(. زمانی که در جستجوی گزینه های دیگری برای گذار بین صحنه ها هستید، گزینه های 

پلاگین زیادی هستند که می توانید با آنها کیفیت فیلم خود را بهبود ببخشید. 

 Effects تنظيم گذارها در پنل كنترل هاي

همان طور که قبلًا در سرتاسر کتاب هم گفتیم، پنل های Effect و Effect Controls مانند چیپس و سس 
Effects Control جمع  پنل  در  آن  انتخاب کنید. خصوصیات  اول  پنل  از  را   Effect همراه هم هستند. 

شده اند که می توانید آنها را تصحیح کنید.

پرسش های تشریحی 

1 وظیفه Effects چیست؟
٢ گذار ویدیویی پیش فرض در Adobe Premiere Pro چیست؟

٣ مدت زمان یک گذار در کجا تنظیم می شود؟
٤ گذاری وسط چین شده است. چنانچه آن را با ابزار منتخب به سمت راست بکشیم، چه اتفاقی می افتد؟

٥ کدام پنل ترجیحی شامل مدت زمان گذار ویدیویی و مدت زمان  گذار صوتی است؟
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پرسش های چهار گزینه ای 

1 همه گزینه های زیر نوعی گذار برای ویرایش ویدیو محسوب می شوند، بجز:
Trims )د 	Wipes )ج 	Cuts )ب 	Dissolves )الف

٢ چگونه یک گذار ویدیو را بین دو کلیپ فیلم در timeline اضافه می کنیم؟
الف( با استفاده از پنجره Effects و کلیک کردن و کشیدن گذار به کلیپ های فیلم

ب( با استفاده از پنجره Effects و کلیک کردن روی گذار
ج( با استفاده از پنجره Colour و کلیک کردن روی جلوه
د( با استفاده از پنجره صدا و جابه جا کردن محوکننده ها

٣ می خواهم برای انجام تغییر هموار بین کلیپ های ویدیویی، جلوه ای را قرار دهم. نوع جلوه ای که به دنبال 
آن هستم، در کدام پوشه جلوه قرار دارد؟

Video Transition )ب 	 	Audio Transition )الف
Video Effects )د 		 Audio Effects )ج

٤ تنظیمی در پنل Effect Controls است که به شما اجازه پخش عقب گرد گذار را می دهد.
Reverse )ب 		 Border With )الف

Edge Selector )د 	Source Monitor Panels )ج

٥ در Premiere Pro، نقطه ای که یک کلیپ تقسیم بندی می شود، چه نامیده می شود؟ این نقطه با یک 
خط عمودی بین دو کلیپ علامت زده می شود.

ب( محو شدن 		 Project الف( پنل
Timeline د( پنل 		 ج( خط برش



فریم های کلیدی



فصل 20
فریم های کلیدی
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می رود:
  با مفهوم فریم های کلیدی آشنا باشد.

  بتواند از فریم های کلیدی در عمل استفاده کند.

درست مانند مارکرها که بخش های مهم کلیپ را در Timeline علامت گذاری می کردند، فریم های کلیدی 
نیز اقدام مشابهی دارند. تفاوت آنها در این است که به جای این که فقط بخش های مهم را علامت گذاری کنند، 
می توانید اقداماتی را نیز انجام دهید. هر فریم کلیدی را مانند دستورعمل مجزایی در نظر بگیرید که با قرار 

گرفتن چند فریم کلیدی در کنار هم می توانید جلوه ای را ایجاد کنید. 
فریم های کلیدی نقاطی در زمان هستند که آنها را تنظیم می کنید تا در آن نقاط تغییرات خاصی را به وجود 
آورید. بنابراین برای متحرک کردن کلیپ ویدیویی یا عکس می توانید موقعیت و اندازۀ این نقاط را در محدودۀ 
زمانی در نظر گرفته شده تغییر دهید. فریم کلیدی نقطه ای از زمان را نشان می دهد که قرار است حرکت 

فریم از آن آغاز شود. 
زمانی که فریم کلیدی را اضافه می کنید، نقطه ای را در زمان علامت گذاری می کنید که می خواهید عملی 
در آن صورت گیرد. برای مثال ممکن است بخواهید اندازۀ تصویر را در طول زمان تغییر دهید. باید فریم 
کلیدی را در نقطه ای اضافه کنید که قرار است عمل آغاز شود، سپس نشانگر پخش را به محلی ببرید که 
قرار است عمل خاتمه یابد، تغییرات موردنظر را در کلیپ اعمال کرده و فریم کلیدی دیگری را در آن نقطه 

اضافه کنید. 
را  تصویر  و  کرده  اضافه  را  دیگری  کلیدی  فریم  می توانید  یابد،  ادامه  بیشتری  مدت  عمل  می خواهید  اگر 
اعمال  کلیپ  در  بیشتری  تغییرات  کنید، می توانید  اضافه  بیشتری  کلیدی  فریم های  کنید. هرچه  متحرک 
کنید. نکته آخر این که: هرچه فریم های کلیدی بیشتر از هم فاصله داشته باشند، مدت زمان بیشتری طول 

می کشد تا جلوه اجرا شود. 
برای افزودن فریم کلیدی به این روش عمل کنید: 

1 نشانگر پخش را در Timeline و در نقطه ای قرار دهید که می خواهید عمل آغاز شود. 
2 به پنل Effect Controls رفته و جلوه ای را پیمایش کنید که می خواهید فریم کلیدی برای آن اضافه 
کنید. برای شروع استفاده از فریم های کلیدی می توانید از دکمۀ Toggle Animation استفاده کنید. این 
دکمه آیکنی شبیه به کرونومتر دارد. زمانی که روی آن کلیک می کنید، کنترل Add Keyframes فعال 
می کنید،  اضافه  بیشتری  کلیدی  فریم های  که  به تدریج  می بینید،  1ـ20  در شکل  که  همان طور  می شود. 

می بینید که در سمت راست کنترل و با علامت هایی شبیه به لوزی نشان داده می شوند. 
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استفاده از فریم های کلیدی در عمل 

از فریم های کلیدی می توانید برای اعمال بیشتر تغییرات در کلیپ خود استفاده کنید. در ادامه با مثالی نشان 
می دهیم چگونه از فریم های کلیدی برای ایجاد حرکات در تصویری ثابت استفاده کنید. 

 )aka the ken Burns ایجاد حرکت در تصویری ثابت )جلوۀ 
پس از یافتن تصویری مناسب، آن را به Timeline بکشید. چون هدف ما این است که تصویر را به اطراف 
جابه جا کنیم، باید اندازۀ آن را در فریم افزایش دهید. قبل از اضافه کردن فریم های کلیدی، ابتدا تصمیم 

بگیرید قرار است چه برنامه ای را روی تصویر پیاده کنید. 
مثالی که در این جا مورد استفاده قرار داده ایم در نمای پانوراما )دید وسیع( گرفته شده است. چون نسبت 
ابعاد آن بسیار بزرگ تر از اندازۀ صفحه نمایش است، برای ایجاد حرکتی شبیه به جارو زدن در کل تصویر 

است.  مناسب 
برای ایجاد این جلوه به این روش عمل کنید: 

1 تصویر را به Timeline بکشید. 
٢ تصویر را در Timeline انتخاب کنید. 

٣ همان طور که در شکل 2ـ20 می بینید، روی تصویر در پنل Program Monitor دابل کلیک کنید. نقاط 
لنگر را به سمت پایین بکشید تا کل فریم را بپوشاند. سپس تصویر را به سمت چپ بکشید تا همان طور که 
در شکل 3ـ20 می بینید، لبۀ سمت راست آن نمایش داده شود. ضمناً می توانید از ابزار Scale نیز استفاده 

کنید که در فصل دوازدهم در مورد آن شرح داده ایم. 

 Add Keyframes دکمۀ ،Toggle Animation و دکمۀ Effect Controls شکل 1ـ20ـ پنل
و فریم های کلیدی )از چپ به راست با دایره ها مشخص شده اند(
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1 کلیپ را در Timeline انتخاب کنید. به پنل Effect Controls رفته، گزینۀ Motion را پیمایش کنید. 
نشانگر پخش را در Effect Controls در لوکیشنی قرار دهید که می خواهید جلوه از آن جا آغاز شود. نشانگر 

پخش شبیه به فریم کلیدی در Timeline عمل می کند. بهتر است از چند فریم جلوتر شروع کنید. 
2 روی دکمۀ Position Toggle Animation در بخش کنترل های Motion کلیک کنید که شبیه به 
کرونومتر است. نشانگر پخش را در Effect Controls به انتهای تصویر یا جایی بکشید که می خواهید جلوه 

خاتمه یابد. 

شکل 2ـ20ـ تصویر پانوراما )دید وسیع(

شکل 3ـ20ـ تصویر به سمت لبه کشیده شده است
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٣ روی تصویر در پنل Program Monitor دابل کلیک کرده و تصویر را به خارج از لبۀ سمت راست فریم 
یا همان طور که قبلًا گفتیم به جایی بکشید که می خواهید جلوه خاتمه یابد. 

٤ به ابتدای کلیپ در Timeline رفته و روی Play کلیک کنید تا ببینید آیا جلوۀ ایجاد شده مورد تأیید 
شما هست یا خیر. 

یک گام فراتر 
این روشی ساده اما مؤثر برای ایجاد حرکت در تصویر است. اما در صورت تمایل می توانید جلوه های دیگری 
را نیز اعمال کنید. برای مثال اگر می خواهید فقط بخشی از مرکز فریم را بزرگ نمایی کنید، به این روش 

عمل کنید. 
1 چون این تصویر یک عکس است، می توانید با کشیدن لبه ها به داخل یا بیرون، زمان اجرای جلوه را تغییر 

دهید. در این مثال می توانید آن را به بیرون بکشید تا پنج ثانیه بیشتر ادامه یابد. 
٢ نشانگر پخش را کمی بیرون از فریم ـ مثلًا دو ثانیه ـ کشیده و مقیاس را تغییر دهید تا تصویر بزرگ تر 

شود. به این ترتیب یک فریم کلیدی ایجاد می شود. 
٣ در صورت تمایل می توانید تعداد زیادی فریم کلیدی ایجاد کنید و از جلوه های دیگری نیز بهره بگیرید. در 

اصل هر جا که آیکن کرونومتر را دیدید، بدانید که می توانید عملی را با استفاده از فریم کلیدی اضافه کنید. 

پرسش های تشریحی 

1 در Ease Out کدام فریم کلیدی را باید تنظیم کنیم تا انیمیشن همواری داشته باشیم؟
٢ نحوه افزودن فریم کلیدی به Timeline چگونه است؟

٣ با مثالی نشان دهید چگونه از فریم های کلیدی برای ایجاد حرکات در تصویری ثابت استفاده می شود.
٤ برای بزرگ نمایی فقط بخشی از مرکز فریم به چه صورت عمل می شود.

پرسش های چندگزینه ای 

1 تنظیم فریم های کلیدی روی جلوه مبتنی بر کلیپ به شما اجازه چه کاری را می دهد؟
الف( نحوه اعمال جلوه در مقاطع مختلف زمانی را کنترل کنید.

ب( کلیپ را به کلیپ های جداگانه تقسیم کنید.
ج( نشانگرها را به کلیپ نسبت دهید.

د( امکان پیمایش آسان تر را در کلیپ فراهم کنید.

٢ میانبر بزرگ نمایی در Timeline چیست؟
د( \ ج( +	 	Alt+Z )ب 	Ctrl+Z )الف
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٣ کدام گزینه برای نشان دادن همه موارد در Timeline، بزرگ نمایی یا کوچ کنمایی را انجام می دهد؟
د( * ج( \	 	Shift+a )ب 	Ctrl+a )الف

٤ فریمی با تنظیماتی که تصویری فوری از نحوه نمایش کلیپ در زمان مشخصی ارائه می دهد، چه نامیده 
می شود؟

ب( فریم کلیدی الف( ویدیویی با قابلیت دانلود تدریجی	
د( فضای کاری 		 ج( اسلایدر شروع

٥ کدام گزینه زمان را در یک سکانس به صورت افقی اندازه می گیرد و آیکن هایی را برای نشانگرهای نقاط 
In و Out نمایش می دهد؟

	Fading )ب 		 Timecodes )الف
Time Ruler )د 		 Play Head (CTI) )ج
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می رود:
  با مفهوم عنوان و کاربردهای آن آشنا باشد.

  بتواند از ابزار Text  استفاده کند.

  بتواند با پنل Essential Graphics کار کند.

  با قالب ها آشنا باشد.

  بتواند با ویژگی Text to Speech کار کند.

  بتواند متن را متحرک کند و روی یک مسیر قرار دهد.

در گذشته، روزگار سینمای صامت، کارت های اسم و عنوان برای برقراری ارتباط با عملکرد نمایش داده شده در 
صفحه نمایش ضروری بودند. حتی زمانی که صدا از راه رسید و فیلم ها دیگر صامت نبودند، هنوز هم اطلاعات 
در صفحه نمایش با کلمات نشان داده می شدند مانند تیتراژ، گرافیک ها، عنوان بندی )عنوانی در انتهای فریم که 
نام فردی را نشان می دهد که درحال گفتگو است( و البته باز هم عناوین. بنابراین، زمانی که نوبت به ساخت 
فیلم می رسد، با افزودن کلمات می توانید جنبه های داستان سرایی را بهبود بخشیده و مخاطب را از همه چیز 
مطلع کنید از تنظیم صحنه گرفته تا دادن اطلاعاتی کلیدی در سرتاسر فیلم و البته تیتراژهای اول و آخر فیلم. 
Premiere Pro قابلیت گرافیکی فوق العاده ای را ارائه می دهد که با استفاده از آن می توانید از عنوان ها و 
موشن گرافیک برای جذابیت بیشتر ویرایش های خود استفاده کنید. هنوز هم قانع نشده اید؟ تماشای فیلمی 
بدون تیتراژ را امتحان کنید. بدون شک به این نتیجه می رسید انگار یک چیزی کم است. به همین ترتیب 
زمانی که با کاربرد متن در فیلم ها و نمایش های تلویزیونی آشنا شوید، دیگر بی صبرانه منتظر پایان فیلم و 

دیدن عنوان یا تیتراژ پایانی فیلم خواهید بود. 
بخش ها و مستندات جدید یکی دیگر از دلایلی هستند که چرا عنوان های روی صفحه نمایش ضروری هستند. 
بدون عنوان بندی چگونه می توانید بفهمید کدام بازیگر دارد با خودش حرف می زند؟ و بعد نوبت به لوکیشن ها 
و فریم های زمانی صحنه می رسد. بنابراین، اگر خوب فکر کنید، بدون این دارایی های ارزشمند نمی توانید 

ویرایش خود را تکمیل کنید. 

اگرچه کارت های اسم و عنوان یا هر کلمۀ دیگری روی صفحه نمایش که برای این منظور مورد 
استفاده قرار می گیرد، دیگر تنها راه برقراری ارتباط با مخاطب نیستند، اما هنوز هم سهم بزرگی 
در فیلم شما بازی می کنند. Premiere Pro با افزودن گرافیک های پیشرفته که می توانید آنها را 
کشیده و در Timeline رها کنید، روش انجام این کار را تغییر داده است. ظاهر این گرافیک ها 
After Effects ساخته شده اند و حالا یک گام جلوتر رفته و پنل  انگار در  به گونه ای است که 
و  گرافیک ها  از  گسترده ای  مجموعۀ  پنل،  این  در  است.  کرده  ارائه  را   Essential Graphics
ابزارهایی را خواهید یافت که به شما کمک می کنند از کلمات در صفحه نمایش استفاده کنید، آنها 
را به حرکت درآورید و پیام خود را سفارشی کنید تا جلوۀ پویاتری برای مخاطب داشته باشند. 

یادآوری



فصل بیست ویکم: مفهوم عنوان و کاربردهای آن

235

 Text استفاده از ابزار

امکان  شما  به   Type جدید  ابزار  است.  کرده  ساده تر  را  متن  افزودن   Premiere Pro نگارش  جدیدترین 
باید این  می دهد مستقیماً داخل پنل Program Monitor تایپ کرده و کلیپ متن را اضافه کنید. فقط 
ابزار را از جعبه ابزار انتخاب کرده، روی مانیتور کلیک کرده و شروع به تایپ کنید. سپس می توانید از ابزار 
 Essential برای جابه جا کردن متن استفاده کنید. در نهایت می توانید از ابزارهای موجود در پنل Selection

Graphics برای فرمت بندی متن خود استفاده کنید. 

 Essential Graphics پیمایش پنل

با   ،Premiere Pro در  ارائه شده  خاص  ویژگی های  بیشتر  مانند 
کنید.  را ساده تر  کار  روال  کاری خاص می توانید  بارگذاری یک فضای 
سوژه ای  بودید،  فیلم  تیتر  کردن  اضافه  آمادۀ  که  زمانی  بنابراین، 
داشتید که باید از عنوان بندی برای آن استفاده می کردید یا خواستید 
کار  فضای  از  است  بهتر  کنید،  استفاده  تیتراژ  برای  جالبی  سکانس  از 
فرمان  از  باید  منظور  این  برای  بگیرید.  بهره  منظور  این  برای  مناسب 
Window>Workspace>Captions and Graphics استفاده کنید. 
تمام ابزارهای موردنیاز برای قرار دادن کلمات در صفحه نمایش را در این 
 Essential بخش خواهید یافت که در سمت راست فضای کاری در پنل

Graphics قرار گرفته است. 

Essential Graphics شکل 1ـ21ـ پنل
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این پنل همان طور که از نامش پیداست هنگام کار با گرافیک ها و عنوان ها به کمک شما آمده و درعین حال 
حاوی قالب های از قبل بارگذاری شده، گرافیک ها و کتابخانۀ Adobe نیز هست. فضای کار Graphics و پنل 
Essential Graphics گردش کار قدرتمندی ارائه می دهند که به شما امکان می دهد تمام نیازهای خود را 

در زمینۀ استفاده از عنوان ها و گرافیک ها مرتفع سازید. 

آشنایی با قالب ها 

گرافیک  یافتن  برای  می بینید.  را   Edit و   Browse بخش  دو   Essential Graphics پنل  بالای  در 
موردنظر خود باید عنوان های بارگذاری شده در برنامه را پیمایش کرده یا آنها را شخصاً دانلود کنید. پس 
از انتخاب تیتر موردنظر و کشیدن آن به Timeline، زمان آن می رسد که آن را تکمیل کنید. برای این 
منظور باید از برگۀ بعدی یعنی Edit استفاده کنید. این برگه به شما امکان می دهد داده ای را وارد کنید 
که قرار است تیتر یا گرافیک را تکمیل کند. در پایان باید آنها را تراز کرده، تغییر شکل داده و فریم های 

کلیدی را اضافه کنید. 

یادآوری

به سادگی می توانید موشن گرافیک ها را مستقیماً در پنل Essential Graphics جستجو، پیمایش و مورد 
استفاده قرار دهید. این ویژگی نسبتاً جدید نوعی از گرافیک را در اختیار شما قرار می دهد که زمانی فقط در 
After Effects یافت می شد. با عملکردی نسبتاً ساده می توانید گرافیکی را سفارشی کرده و به فیلم خود 
روح ببخشید. این پنل به شما امکان می دهد تمام موشن گرافیک هایی را که به صورت محلی در رایانه ذخیره  
شده اند یا در Adobe Creative Cloud و Adobe Stock قابل دسترس هستند، مشاهده کنید. همان طور 
که از نام آن پیداست، موشن گرافیک به گرافیک هایی اطلاق می شود که حرکت را نشان می دهند و بسیار 

جذاب هستند. به تیتری فکر کنید که متحرک است.

 Text to Speech ویژگی

به یاد می آورم که  را   Office از فیلم  از پیش نمی برد. آن قسمت  به زبان آوردن کلمات کار زیادی  گاهی 
Michael Scott که به دلیل تخلفات مالی زندانی بود فریاد زد »من اعلام ورشکستگی می کنم« انگار کلمات 
 Premiere Pro واقعاً می توانند اتفاقات را به جریان بیندازند. متأسفانه در عمل این اتفاق نمی افتد. اما در
 Speech to این طور نیست، زیرا اگر تصمیم به تبدیل کلمات بیان شده در فیلم به متن بگیرید، ویژگی جدید

Text به طور خودکار می تواند دیالوگ ویدیو را به متن قابل ویرایش در رونوشت و عناوین تبدیل کند. 
عملکردهای این ویژگی به این شرح هستند: 

تهیۀ رونوشت برای ویدیو: پس از مرتب سازی ویدیو در Timeline، می توانید بخشی از آن یا کل بخش 
ویرایش شده را انتخاب کرده و تنها با چند کلیک به سرعت رونوشت تهیه کنید. 
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ایجاد عنوان بسته: پس از اعمال رونوشت، ویدیو می تواند سرعت دیالوگ را تطبیق دهد، درست مانند این 
که ویژگی Close-Captioning را در تلویزیون صفحه تخت خود فعال کنید. 

جمله  از  است  قابل استفاده  مختلف  زبان   13 با  حاضر  درحال  ویژگی  این  مختلف:  زبان  چندین  با  کار 
اسپانیایی، ایتالیایی، هندی و چینی و هر دو گویش آمریکایی و بریتانیایی زبان انگلیسی را شامل می شود. 

شیوه بندی عنوان ها: پس از ایجاد رونوشت، با اعمال شیوه و گزینه های خلاقانه می توانید کلمات را اصلاح 
کنید. بهتر است خودتان امتحان کنید. 

ایجاد رونوشت 

یکی از سخت ترین وظایف ساخت بخش خبری، مصاحبه، پست شبکه های اجتماعی یا هر بستۀ دیگری که 
نیاز به رونوشت دارد، این است که رونوشت آن را تهیه کنید. درحال حاضر Premiere Pro به کمک ویژگی 
از فضای کار  باید  این ویژگی  این کار را برای شما ساده کرده است. برای فعال کردن   Speech to Text

به هنگام شدۀ Captions and Graphics استفاده کنید، پس اول این فضای کار را انتخاب کنید. 
روش انجام کار به این شرح است: 

گزینۀ  روی  دهد.  نمایش  را  موردنیاز  ابزارهای   Text پنل  تا  کنید  انتخاب  را   Window>Text فرمان   ١
Transcript در سمت چپ پنل کلیک کنید که در شکل 2ـ21 می بینید. 

Text در پنل Click Transcript شکل 2ـ21ـ دکمۀ

٢ ویدیو یا بخشی از آن را که با نقاط In و Out علامت گذاری کرده اید در Timeline انتخاب کنید. 
این کادر  نمایش داده می شود که در شکل 3ـ21 می بینید. در   Create Transcript ٣ کادر محاوره ای 
محاوره ای اطلاعاتی مانند نام فایل و مدت زمان پخش نمایش داده شده و به شما امکان می دهد گزینه های 
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مختلفی را انتخاب کنید از جمله این که آیا می خواهید از انواع مختلف صدا رونوشت تهیه کنید یا فقط از یک 
ترک خاص. ضمناً با استفاده از این کادر محاوره ای می توانید صدای بین نقاط In و Out را ثبت کرده، زبان 

موردنظر خود را انتخاب کرده یا صداهای مختلف موجود در گفتگو را از هم تفکیک کنید. 
٤ پس از اعمال تنظیمات موردنظر خود روی OK کلیک کنید تا فرایند کار آغاز شود. 

٥ پس از پایان کار، رونوشت را در پنل می بینید. با کلیک روی دکمۀ سه نقطه ای که در سمت راست پنل 
می بینید و در شکل 4ـ21 نیز نشان داده شده است، می توانید چک کنندۀ املای صحیح کلمات را فعال کرده 

یا از گزینۀ Export برای صادر کردن به صورت فایل متن استفاده کنید. 

                     شکل 3ـ21ـ کادر محاوره ای Create Transcript                شکل 4ـ21ـ گزینه های مربوط به تهیۀ رونوشت

متحرك سازي متن و قرار دادن آن روي مسير دلخواه 

قبلًا هم گفتیم که می توانید از گزینه های ایستای موجود در پوشۀ قالب های آماده استفاده کرده، محتوای 
موردنظر را از Adobe Stock خریداری کرده یا پلاگینی را اضافه کنید که برای ایجاد تیتراژهای متحرک 

طراحی شده اند. 
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روش انجام کار به این شرح است: 
آن  دور  که  آیکنی  روی  و  کرده  کلیک   Edit برگۀ  روی   1
 New Layer دایره کشیده  شده است، کلیک کرده و گزینۀ

را انتخاب کنید. 
)شکل  کنید  انتخاب  را   Text گزینۀ  کشویی،  منوی  در   ٢
 Program Monitor 5ـ21(. فیلدی را می بینید که در پنل
نمایان می شود و زمانی که روی آن دابل کلیک کنید، بخشی 
قرمز  آن  رنگ  و  شده  هایلایت  صفحه نمایش  در  گرافیک  از 

می شود. 

روش دیگر این است که تیتراژ های متحرک را در حین کار در فضای Essential Graphics شخصاً 
از پایه ایجاد کنید. اگرچه این رویکرد نیازمند کار و تلاش زیادی است، اما دست کم خودتان می توانید 

تصمیم بگیرید چه اطلاعاتی را در آن بگنجانید. 

نکته

برگه  حول  که   New Layer آیکن  5ـ21ـ  شکل 
Edit دایره ای کشیده شده است.

٣ مستقیماً داخل فیلد تایپ کنید. می توانید از ترتیبی که قبلًا اعلام کردیم استفاده کرده یا طبق سلیقۀ خود 
عمل کنید. کل مجموعۀ تیتراژ را باید در این فیلد تایپ کنید، بنابراین همان طور که در شکل 6ـ21 نشان 

داده شده است، از کلید Enter برای ایجاد فاصله یا رفتن به سطر جدید استفاده کنید. 

شکل 6ـ21ـ ویرایش متن مستقیماً در فیلدی روی کلیپ انجام می گیرد.
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از تایپ سطر اول، به بخش متنی پنل رفته و همان طور که در شکل 7ـ21 می بینید روی آیکن  ٤ پس 
Center Align Text کلیک کنید. به این ترتیب مطمئن می شوید که تیتراژ در فیلد وسط چین خواهد شد. 

شکل 7ـ21ـ با کلیک روی دکمۀ Center Align Text می توانید متن را در فیلد وسط چین کنید.

٥ در بخش Align and Transform، روی دکمۀ Center on Screen کلیک کنید. به این ترتیب مطمئن 
خواهید شد که تیتراژ در مرکز صفحه نمایش تراز خواهد شد )شکل 8ـ21 را ببینید(. 

 Align and Transform بخش  در  موجود  کنترل های  از  استفاده  با  8ـ21ـ  شکل 
می توانید تیتراژ را در وسط صفحه نمایش قرار دهید. 

٦ سایر موارد را اضافه کنید. نوع فونت، اندازه و شیوه های موردنظر خود را در هر یک از سطرها اعمال کنید. 
 Responsive ٧ به محض این که تمام متن را اضافه کردید، روی بخشی خارج از فیلد کلیک کنید. به بخش
Design-Time در پنل رفته و روی کادر Roll کلیک کنید. پس از این که کادر انتخاب را در حالت تأیید 
قرار دادید، همان طور که در شکل 9ـ21 می بینید، گزینه های مربوط به زمان بندی ویرایش در اختیار شما 

قرار خواهند گرفت. 
٨ با توجه به شکل 10ـ21، تنظیمات موردنظر خود را در مدت زمان پخش اعمال کرده و با استفاده از نوار 

پیمایش آن را امتحان کنید. 
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در  این بخش، عنوانی را در امتداد یک مسیر ایجاد خواهیم کرد.
Title>New Title>Default still 1 را از نوار منو انتخاب کنید، کادر محاوره ای New Title نمایش داده 

می شود.
٢ در کادر متنی Name، نام Title along the Path را وارد کنید و روی دکمه OK کلیک کنید؛ پنجره 

Titler همراه با پنل های عنوان مختلف نمایش داده می شود.
٣ Path Type Tool را از پنل Title Tools پنجره Titler انتخاب کنید.

 Essential Sound در پنل Responsive Design-Time شکل 9ـ21ـ بخش
که کادر انتخاب Roll در آن در حالت تأیید قرار گرفته است. 

شکل 10ـ21ـ با استفاده از نوار پیمایش، تنظیمات موردنظر خود را اعمال کرده 
و نتیجۀ نهایی را مشاهده کنید. 



242

٤ مکان نما را روی صفحه نمایش در پنجره Titler ببرید؛ شکل مکان نما به قلم تغییر می کند )شکل 11ـ21(.

شکل 11ـ21ـ مکان نمای تغییریافته

٥ برای ایجاد یک نقطه درج برای متن، روی صفحه نمایش کلیک کنید.
٦ برای ایجاد نقطه دوم مسیر کلیک کنید و بکشید و به کلیک کردن تا زمانی ادامه دهید که شکل مناسب 

مسیری که عنوان روی آن ایجاد خواهد شد، به دست آید )شکل 12ـ21(.

شکل 12ـ21ـ مسیر ایجاد شده
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٧  Caslon Pro 68 را در پنل Title Styles انتخاب کنید. مجدداً، ابزار Path Type را انتخاب کرده و 
روی صفحه نمایش )در شروع مسیر( کلیک کنید. سپس، متن Title on a path را وارد کنید؛ متن نمایش 

داده می شود.
٨  اگر متن به درستی نشان داده نمی شود، می توانید مسیر آن را با بازآرایی نقاط لنگر مسیر تنظیم کنید 

)شکل 13ـ21(.

٩ متن عنوان را انتخاب کرده و شیوه Caslon Italic Bluesky 64 را از پنل Title Styles در پنجره 
انتخاب کنید. همچنین، نقاط لنگر را برای نمایش درست عنوان تنظیم کنید؛ عنوان همانند شکل   Title

14ـ21 نمایش داده می شود.

شکل 13ـ21ـ متن نمایش داده شده در امتداد مسیر

شکل 14ـ21ـ عنوان پس از تنظیم نقاط لنگر



244

١٠ روی دکمه Close در گوشه سمت راست بالای پنجره Titler کلیک کنید؛ پنجره Titler بسته شده و 
متن Title along the path در پنل Project نمایش داده می شود.

پرسش های تشریحی 

1 از کجا می توان متن جدیدی ایجاد کرد؟
٢ متن من در زیر تصویری قرار گرفته است؟ چطور می توانم آن را به بالای تصویر بیاورم؟

٣ چگونه می توان یک شکل سفارشی از متن ایجاد کرد؟
٤ چگونه می توان متن و تصویر را با هم گروه بندی کرد؟
٥ نحوه ایجاد عنوان در امتداد یک مسیر را توضیح دهید.

پرسش های چندگزینه ای  

1 کدام گزینه بیانگر متنی است که به صورت افقی روی بریده فیلم حرکت می کند؟
Swipe ب( گذار الف( عنوان غلتان	
د( عنوان خزشگر 	Slide ج( گذار

٢ قبل از وارد کردن متن، برای تنظیم اندازه و شکل کادر متنی، از کدام متد باید استفاده شود؟
ب( متن نقطه ای الف( متن مسیر	
د( متن پاراگراف ج( متن غلتان	

٣ عنوانی که در آن متن به صورت افقی روی بریده فیلم حرکت می کند، چه نامیده می شود؟
Opacity )ب 	Crawl )الف

Time Action Panel )د 	Time Ruler )ج
٤ عنوانی که دارای متن ثابت است چه نامیده می شود؟
ب( نمونه تصویری 	Still )الف

Title د( پنل ج( فایل پروژه	
٥ بخشی از Titlers در Premiere Pro است که می توانید شیوه های پیش فرض را اعمال کنید و عنوان های 

خاص خود را ایجاد و ذخیره کنید.
Title Tools ب( پنل 	Still )الف

Buffering )د 	Timeline ج( پنل
٦ عنوانی که در آن متن به صورت عمودی روی بریده فیلم حرکت می کند چه نامیده می شود؟

Roll )ب الف( سکانس	
د( نمایش زمان جاری ج( نشان دادن منابع واقعی	
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حرکت دادن یک کلیپ
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می رود:
  بتواند کلیپ ها را حرکت دهد.

  بتواند از کلیدها استفاده کند.

  بتواند کلیپ ها را وارونه پخش کند.

  بتواند از شیارهای صوتی استفاده کند.

  بتواند کلیپ ها را ترکیب کند.

  بتواند کلیپ ها را لایه بندی کند.

  بتواند ماتی را تنظیم کند.

  بتواند از وضعیت های Opacity  و Blend استفاده کند.

  بتواند توازن صحیح بین کلیپ ها برقرار کند.

  بتواند از جلوه Transform و لایه های تنظیمی استفاده کند.

  بتواند کلیپ ها را در یک مجموعه ادغام کند.

  با کانال های آلفا و ماسک گذاری آشنا باشد.

شاید فکر کنید اسکراب کردن کلیپ به معنای پاکسازی آن است، اما عملًا این تکنیک یعنی حرکت دادن 
نشانگر پخش به صورت دستی در طول کلیپ یا Timeline. این روشی مفید است تا بتوانید بخش موردنظر 
خود را به سرعت ارزیابی کرده و بیابید. این روش باعث تسریع این فرایند می شود، به ویژه اگر لازم نباشد کل 

کلیپ را مورد بازبینی قرار دهید. 
چندین روش برای بازبینی سریع وجود دارد که هر کدام مزیت های خاص خود را دارند. 

گرفتن نشانگر پخش و حرکت دادن آن در امتداد کلیپ یا Timeline به شما امکان می دهد با همان سرعتی 
که ماوس را حرکت می دهید در امتداد کلیپ حرکت کنید. 

استفاده از کلیدها 

کلیدهای K ،J و L به ترتیب حرکت رو به عقب، توقف حرکت و حرکت رو به جلو را مدیریت می کنند. هر بار 
که این کلیدها را فشار می دهید، سرعت دو برابر می شود. 

J: نشانگر پخش را رو به عقب حرکت می دهد. 
K: پخش را متوقف می کند. 

L: نشانگر پخش را رو به جلو حرکت می دهد. 
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استفاده از کلیدهای فلش جهت دار 

مواقعی که باید نشانگر پخش را در محل دقیقی قرار دهید، مثلًا زمانی که می خواهید بخشی از کلیپ را 
کات کنید، می توانید از کلیدهای فلش جهت دار در صفحه کلید استفاده کنید. هر بار که این کلیدها را فشار 

می دهید، نشانگر پخش یک فریم جلو می رود.

نحوه پخش وارونه كليپ ها 

می توانید حرکت صحنه را وارونه کرده و به این ترتیب جلوۀ واقعاً جالبی را ایجاد کنید. در بیشتر مواقع این 
جلوه بسیار جالب است و اگر هوشمندانه مورد استفاده قرار گیرد، می تواند هم روند داستان را به خوبی پیش 
برده و هم توجه مخاطب را جلب کند. تنها کاری که باید انجام دهید این است که روی کلیپ کلیک راست 
کرده و گزینۀ Speed/Duration را انتخاب کنید. زمانی که کادر محاوره ای نمایش داده شد، فقط باید کادر 

انتخاب Reverse Speed را درحالت تأیید قرار دهید. 
ضمناً می توانید سرعت ضبط اولیۀ محتوا را نیز تغییر داده، سرعت حرکت را بیشتر یا کمتر کنید. این جلوه 
در مورد حرکت خطی بهتر عمل می کند، مانند شیرجه در استخر که در شکل 1ـ22 نشان داده شده است 

یا حرکت در میان خیابانی شلوغ.

شکل 1ـ22ـ وارونه کردن حرکت شیرجه در استخر

كاربرد شيارهاي صوتي و انواع آن 

از  آنها  تمام  در  دارند؟  مشترکی  وجوه  زشت چه  بد،  و خوب،  ستارگان  پدرخوانده، جنگ  نظیر  فیلم هایی 
شیار های صوتی خاصی استفاده شده است که بیشتر افراد به محض شنیدن حتی چند نت از آنها به یاد آن 
فیلم ها می افتند. به احتمال زیاد شما هم می خواهید موسیقی پس زمینه ای را به فیلم خود اضافه کنید. ایدۀ 
خوبی است، اما اگر بخواهید فیلم خود را به صورت آنلاین یا برای عموم به نمایش درآورید، باید مطمئن شوید 
موسیقی پاکسازی شده است. موسیقی کپی رایت دارد، یعنی فقط سازندۀ آن است که حق قانونی و انحصاری 
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استفاده از آن را دارد. هر فرد دیگری که بخواهد از آن موسیقی استفاده کند باید ابتدا مجوزهای لازم را کسب 
کند و غالب اوقات باید هزینه ای را پرداخت کند و حدس بزنید چه اتفاقی می افتد؟ شاید مجبور شوید برای 
استفاده از آهنگ مورد علاقۀ خود در فیلم، درآمد یک سال خود را خرج کنید! در مورد موسیقی های متداول 
می توانید شانس خود را امتحان کرده و در میان سایت های متعددی که موسیقی رایگان ارائه می دهند، آهنگ 
مورد علاقۀ خود را یافته یا به کمک موتزارت درونی خود، شخصاً آهنگی را برای استفاده در پروژۀ خود بسازید. 
این یک حقیقت است: بی شک بدون صدا، ویدیو هیچ تأثیری نخواهد داشت. بیایید یک گام فراتر برویم. هرچه 
فیلم بهتر صداگذاری شده باشد، زیباتر دیده خواهد شد. آیا این ادعا نیاز به اثبات دارد؟ آیا در طول تعطیلات 
فیلم جان سخت را دیده اید، به ویژه با سیستم صوتی پیشرفته؟ یا هر فیلم اکشن دیگر، فیلم کنسرت یا فیلمی 

که به نوعی موسیقیایی باشد؟ پس درمی یابید که فیلم به خودی خود تجربه ای چندگانه است. 
هیچ تصادفی در کار نیست؛ برای دستیابی به این هدف باید تلاش کنید. ویرایش صدا به اندازۀ ترکیب بندی 
ویدیوی فیلم اهمیت دارد. بنابراین باید از کجا شروع کنیم؟ ابتدا باید صدای بکر و دست نخورده را در محل 
ضبط کرده و سپس در مرحلۀ پس از تولید آن را به دلخواه به عمل آورید. اگر این کار را با مهارت انجام دهید، 
همان صدا می تواند از کل پروژه یک تجربۀ عالی بسازد. شاید به این دلیل که چشم ها زمانی زیباتر می بینند 
که گوش ها از شنیدن صدای لذت بخش شاد باشند. شاید هم به این دلیل که صدا و حرکت مثل یین و یانگ 
بخش هایی جدانشدنی هستند. به هرحال دلیل هرچه باشد، Premiere Pro ابزارهای قدرتمندی برای ضبط، 

ویرایش و بهبود کیفیت صدای فیلم در اختیار شما قرار می دهد. 

درک نیاز به صدای مناسب 
صدای خوب می تواند هدف از محتوای فیلم را به شکل بهتری بیان کند. با شنیدن اصطلاح سینماتیک فقط 
صحنه های تجسمی صامت را به خاطر نمی آورید. بله، تمام حواس درگیر می شوند و چرا که نه؟ واژۀ سینما به 
هنر یا تکنیک ساخت تصاویر متحرک اطلاق می شود. اما به تدریج، دست کم از سال 1929 به بعد، مخاطب باید 
راجع به اتفاقات بشنود تا از آن چه دیده آگاه شود. ضبط و ویرایش صدا نقش بزرگی در این فرایند دارد. چقدر 
بزرگ؟ بیشتر فیلم ها و تولیدات تلویزیونی صدا را به صورت مجزا ضبط می کنند و نه تنها از صدای ضبط شده 
استفاده کرده بلکه در مرحلۀ پس از تولید آن را فراوری می کنند. حتی می توانید از موسیقی فاقد حق انحصاری 
استفاده کرده یا شاید به کمک برنامه های صوتی مانند GarageBand موسیقی اختصاصی برای خود درست 
کنید و بعد نوبت می رسد به موسیقی متن که آهنگساز قطعه ای از موسیقی را برای استفاده در همان پروژه آماده 

می کند. موسیقی متن خوب فقط باعث نمی شود فیلم خوش استیل شود، بلکه بخشی از DNA فیلم می شود. 

نکات مربوط به صدا 
داشت،  خوبی  صدای  که  نمی گویید  فقط  می آورید،  خاطر  به  دیده اید  که  را  فیلم هایی  بهترین  که  زمانی 
گران  این قدر  را  مدل  آخرین  دالبی  که سیستم صوتی  نیست  دلیل  به همین  آیا  بود.  عالی  می گویید صدا 
خریده اید؟ انکار نمی کنید که تجربۀ تماشای فیلم جان سخت که قبلًا هم ذکر کردیم یا فیلم موسیقیایی 
Sweeney Todd اگر در سیستم صدای پیشرفته پخش شود چقدر لذت بخش تر خواهد بود. گاهی صرفاً با 
شنیدن چند نت می توانید فیلم را تشخیص دهید. جنگ ستارگان، پلنگ صورتی و مهاجمان کشتی گمشده 
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دارای شناخته شده ترین موسیقی های متن هستند. 
اگرچه موسیقی متن مهم است، اما تنها سنجه برای تشخیص صدای خوب نیست. جنبۀ مهم دیگری که کمتر مورد 
توجه قرار می گیرد اما بدون اغراق تأثیر فراوانی دارد، صداهایی است که معمولاً زیاد مورد توجه قرار نمی دهید. 
گاهی صداهایی وجود دارند که خارج از سطوح نرمال هستند، واقعی نیستند یا سروصدایی آزاردهنده در پس زمینه 

هستند. چنانچه این مشکلات را برطرف نکنید، حتی اگر درحد زمزمه باشند کاملًا جلب توجه می کنند. 

تعریف صدای عالی
حتی زمانی که تمام اقدامات لازم را برای ضبط صدایی بی عیب و نقص انجام 
می دهید، هنوز هم در مرحلۀ پس از تولید راهی طولانی در پیش دارید و 
مسئولیت شما فقط با وارد کردن صداها به Premiere Pro خاتمه نمی یابد. 
آنقدر سطوح صدا متنوع هستند که انتخاب صدای بی عیب و نقص تاحدی 
ارائه  موسیقی  به  علاقه مند  فردی  که  تعریفی  مثال  برای  است.  سلیقه ای 
می دهد ممکن است به جنبه هایی اشاره داشته باشد که بیشتر افراد اهمیتی 
به آنها نمی دهند. در عوض بیشتر افراد معتقدند که MP3 صدای بهتری 
دارد. این نظرات سلیقه ای را رها کرده و بیایید در مورد تمام جنبه هایی 

صحبت کنیم که باعث می شود صدایی را بی عیب و نقص بشماریم.
نکات زیر را مدنظر داشته باشید: 

مراقب سطوح صدا باشید: هنگام ویرایش در Premiere Pro، حواستان 
به کنتورهای صدا باشد. با استفاده از آنها می توانید دریابید صدا در جایی 
در  است صدای گفتگوها همان طور که  بهتر  یا خیر.  باشد هست  باید  که 
این  از  بالاتر  اگر  باشد.  دسی بل  12ـ  محدودۀ  در  می بینید  2ـ22  شکل 
به عبارت دیگر چنان تحریف می شود که  از هم می پاشد.  باشد،  محدوده 
دیگر قابل ترمیم نخواهد بود. اگر پایین تر از این محدوده باشد نیز به اندازۀ 

کافی پویا نخواهد بود. 
صدای محیطی را تنظیم کنید: سطوح صدا در اغلب مواقع، برای صدای 
محیط و پس زمینه معمولاً صدای بم تری ایجاد می کند. بنابراین اگر صدای 
محیط را با صدای دیالوگ هم سطح کنید یا صدایی را که هنگام ضبط بسیار 
بلند ضبط شده است، پایین نیاورید، صدایی غیرطبیعی را ایجاد خواهد کرد. 

در عوض صدای محیط نباید از 18ـ دسی بل فراتر رود. 
مطمئن شوید سطوح صدا در هماهنگی مناسبی با هم باشند: صدای 
دیالوگ، اجرا و سروصدای محیطی هرکدام دارای محدوده های خاص خود 
هستند، اما زمانی که در کنار یکدیگر قرار می گیرند، باید طبیعی به نظر 
باشند. هیچ  با هم تطابق داشته  باید  برسند. به عبارت دیگر، سطوح صدا 

چیز بدتر از این نیست که یکی از صداها در مقایسه با سایر صداها بیش از حد بلند یا بیش از حد کوتاه باشد. 

شکل 2ـ22ـ سطوح صدای دیالوگ 
باید در محدودۀ 12ـ دسی بل باشد 
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تنظیم سطوح صدا 
به ندرت پیش می آید که سطوح صدای ضبط شده آن قدر بی عیب و نقص باشند که نیاز به هیچ گونه اصلاحی 

نداشته باشند. Premiere Pro روش های متعددی برای برطرف کردن اشکالات ارائه می دهد. 
به چندین روش می توانید سطوح صدا را تغییر دهید: 

است  می بینید، خطی  در شکل 3ـ22  که  همان طور  بروید:  rubber band در ترک صوتی  به بخش 
که در نیمۀ پایینی ترک صوتی می بینید. این ساده ترین روش تنظیم است و به سرعت می توانید مشکل را 
برطرف کنید. اعمال تنظیمات دقیق در هر یک از ترک ها همیشه هم کار ساده ای نیست و ممکن است بسیار 

خسته کننده باشد. 

شکل 3ـ22ـ rubber band در ترک صوتی

Audio Mixer: شبیه به نسخۀ مجازی بورد تخصصی میکس صدا در استودیو عمل 
کرده و کنترل های زیادی را برای تنظیم صدای کلی پروژه در اختیار شما قرار می دهد. 

برای جزئیات بیشتر در این زمینه به فصل سوم مراجعه کنید. 
Clip Mixer: این گزینه به شما امکان می دهد کلیپ را کنترل کنید، درست مانند 
زمانی که از ویژگی rubber band استفاده می کردید، اما در این جا دقت بیشتری را 

می توانید اعمال کنید. 
ابزار Pen: اگر می خواهید با ترک صوتی در Timeline کار کنید، این ابزار ارائه شده 
در جعبه ابزار که در شکل 4ـ22 دور آن خط کشیده شده است، به شما امکان می دهد 
فریم های کلیدی را در ترک صوتی اضافه کرده و به کمک آنها شکل صدا را تغییر داده 

آن را زیر یا بم کنید. 

شکل 4ـ22ـ ابزار Pen در جعبه ابزار
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میکس صدا 
اگر می خواهید صدای ویدیوی شما معقول و منطقی باشد، باید از میکس صدا کمک بگیرید. برای این منظور 
باید سطوح بلندی صدا را تنظیم کنید تا در شرایط مطلوب باشند و مطمئن شوید تمام کانال های صوتی 

دیگر با هم تطابق دارند. 

تنظیم سطوح صدا 
اول کارهای مهم. برای شروع کار باید صدا را در محدودۀ مناسب خود قرار دهید. همیشه کنتورهای صدا را 
نمایش داده و جلوی چشم خود داشته باشید. این تنها روشی است که می توانید دریابید آیا سطوح صدا خیلی 

بالا یا خیلی پایین هستند. 
اگر با سطوح بالا یا پایین برخورد کردید، برای رفع مشکل به این روش عمل کنید: 

مشکل را در Timeline برطرف کنید: ماوس را روی خطی که با نام rubber band شناخته می شود، قرار 
دهید. با کشیدن خط به سمت پایین شدت صدا کم و با کشیدن آن به سمت بالا شدت صدا زیاد می شود. 

از Audio Mixer استفاده کنید: به Audio Mixer رفته و سطوح صدا را براساس کل ترک تنظیم کنید. 
هر یک از کلیپ ها را به صورت مجزا تنظیم کنید: Clip Mixer به شما امکان می دهد مشکل را در ترک 

موردنظر خود برطرف کنید. برای جزئیات بیشتر در این زمینه به فصل سوم مراجعه کنید. 
هنگام تنظیم سطوح شدت صدا، نکات زیر را مدنظر قرار دهید. 

نگذارید سطوح صدا از حد نرمال فراتر روند: اگر سطح صدا بیش ازحد بالا باشد، صدا از هم می پاشد. 
یک صدای اضافی تق شنیده می شود. برای جلوگیری از این مشکل باید مطمئن شوید سطوح صدای تمام 

ترک ها در محدودۀ مناسب قرار گرفته است. 
از Gain استفاده کنید: روی کلیپ کلیک راست کرده و همان طور که در شکل 5 ـ22 می بینید گزینۀ 
Audio Gain را انتخاب کنید. مقدار عددی را تغییر دهید. به خاطر داشته باشید که شدت صدای اولیه در 
سطح 0/0 دسی بل است. اگر سطح صدا را به مقداری منفی تغییر دهید، شدت صدا کاهش و اگر آن را به 

مقداری مثبت تغییر دهید، شدت صدا افزایش می یابد. 
فریم های کلیدی را اضافه کنید: گاهی در یک کلیپ واحد نیز ممکن است شدت صدا متفاوت باشد، مثلًا 
صدای بخشی از کلیپ بسیار بلند و صدای بخشی دیگر بسیار کوتاه باشد. پس از تنظیم فریم های کلیدی، 

می توانید با کشیدن آنها شدت صدا را کاهش یا افزایش دهید. 

Audio Gain شکل 5ـ22ـ کادر محاوره ای
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 ساده سازی سطوح متفاوت صدا 
توازن صدا در برخی کلیپ ها نامعقول است، یعنی در بعضی قسمت ها بیش ازحد بلند و در برخی قسمت ها 
بیش ازحد کوتاه است. اگرچه تکنیک های زیادی برای حل این مشکل وجود دارد، شما را با روش ساده ای 

آشنا خواهیم ساخت. 
برای رفع اشکال سطوح متفاوت صدا در کلیپ به این روش عمل کنید: 

1 در پنل Effects، به بخش Audio Effects رفته، گزینۀ Hard Limiter را پیمایش کنید. همان طور که 
 ـ22 نشان داده شده، می توانید نام این ویژگی را در فیلد جستجو تایپ کنید.  در شکل  6  

٢ به بخش Effect Controls رفته و بخش Hard Limiter را پیمایش کنید که در شکل 7ـ22 نیز نشان 
داده شده است. روی دکمۀ Edit کلیک کنید. کادر Clip FX Editor نمایش داده می شود. 

داده شده، سطح  نشان  Maximum Amplitude همان طور که در شکل 8 ـ22  لغزندۀ  از  استفاده  با   ٣
dB 0/1 - را به 12ـ تغییر دهید. 

٤ به این ترتیب سطوح صدا در کلیپ هماهنگ می شوند. برای کپی و چسباندن خصوصیات در سایر کلیپ ها 
باید روی کلیپ های موردنظر خود در Timeline کلیک راست کرده، گزینۀ Paste Attributes را انتخاب 

کرده و دقت کنید کادر انتخاب Hard Limiter حتماً در حالت تأیید قرار گرفته باشد. 

شکل 6ـ22ـ در پنل Effects، گزینۀ Hard Limiter را جستجو کنید

شکل 7ـ22ـ روی دکمۀ Edit در پنل Effect Controls کلیک کنید
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 )Compositing Clips( نحوه تريكب كردن كليپ ها

اگر تا به حال بازی ویدیویی مانند Sim City را بازی کرده باشید، حتماً می دانید که برای ساختن شهر خود 
باید از روش خاصی پیروی کنید. ممکن است شهر خود را گسترش داده و حومۀ شهر را به آن اضافه کرده 
باشید، اما در خود شهر فضا محدود است و به ناچار باید ساخت وساز را رو به بالا ادامه دهید یعنی لایه به لایه 
رو به بالا بروید. در فیلم سازی می توانید کلیپ ها یا سایر دارایی ها را تک به تک اضافه کرده و تصویر قدرتمند 
واحدی را برای آماده سازی محتوا یا اصلاح آن ایجاد کنید. در این فصل می آموزید چگونه می توانید این نوع 
ساخت وساز »عمودی« را پیاده سازی کنید که در صنعت فیلم سازی با اصطلاح ترکیب بندی شناخته می شود. 
در این مرحله، می توانم ذهن شما را بخوانم. حتماً فکر می کنید »خب... اگر کلیپ های ویدیویی را روی هم قرار 
دهیم، فقط بالاترین کلیپ قابل مشاهده خواهد بود«. البته این امر تاحدی درست است، زیرا اندازۀ ابعاد کلیپ 
قابل تغییر بوده و می تواند چندین لایه را به صورت هم زمان نشان دهد. حالت تصویرـ درـ تصویر مثال خوبی 
است که در آن بخش کوچکی از ویدیو در صحنه نمایش داده می شود مانند تصویری که در پشت سر گزارشگر 
مورد استفاده قرار می گیرد یا حتی ممکن است ترکیب بندی مخصوص به خود را با چندین پلان ایجاد کنید، 
مانند افتتاحیۀ کمدی معروف The Brady Bunch در دهۀ هفتاد میلادی. شاید صفحه نمایش دو تکه ای که 
دو پلان در آن نمایش داده می شود، مفید واقع شود. این تکنیک در برخی فیلم ها مورد استفاده قرار می گیرد، 

به ویژه زمانی که گفتگوی تلفنی دو نفر را نمایش می دهند. اما در موقعیت های دیگری نیز کاربرد دارد. 
سپس نوبت به تکنیک ترکیب دو کلیپ با هم می رسد. با ترکیب ماتی کلیپ بالایی با کلیپ دیگری که روی 
آن قرار گرفته است، می توانید جلوه ای شبیه به long dissolve یا حتی جلوۀ منحصربه فرد دیگری ایجاد 
کنید. حتی می توانید محتویات لوکیشن دیگری را نیز با استفاده از صفحۀ سبز که حتی می تواند آبی نیز باشد 

شکل 8ـ22ـ در کادر Clip FX Editor، مقدار Maximum Amplitude را با 12dB- تنظیم کنید
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در پشت سوژه قرار دهید. به هرحال برنامۀ شما هرچه که باشد، در بخش های بعدی کمک می کنیم ویدیوی 
خود را به بیش از یک روش بسازید. 

آیا درس آناتومی بدن انسان در کلاس علوم را به خاطر می آورید که در آن کتاب هایی با صفحاتی از جنس 
استات بدن انسان را از خارج به داخل نشان می داد تا به اسکلت می رسیدیم؟ همین طور که ورق می زدیم، 
هریک از این صفحات شفاف بخش های بیشتری را به بخش های زیرین بدن اضافه می کردند، مانند گروه های 
مختلف عضلات، ارگان های داخلی بدن، سیستم اعصاب و سایر لایه ها. در ترکیب بندی نیز از همین مفهوم 
اندازه متفاوت  نظر  از  برخی  اضافه کردن عناصر مختلف هستیدـ  نیز شما درحال  این جا  استفاده می شود. 
هستند و برخی دیگر دارای ماتی متفاوتی هستندـ تا یک تصویر واحد پیچیده را ایجاد کنید. به عنوان مثالی 
آشنا در این زمینه می توانیم به گویندۀ اخبار اشاره کنیم که ویدیویی مربوط به لوکیشن دیگری در پشت سر 
وی درحال پخش است. البته قضیه به این جا ختم نمی شود. موقعیت های زیادی وجود دارند که با افزودن 
جلوۀ ویژۀ جذابی به عنصری بی روح، می توانید داستان سرایی را از لحاظ بصری تقویت کنید. پس به خاطر 
داشته باشید که عنوان ها، بخش های کلیدی اضافه شده با استفاده از پردۀ سبز و حالت تصویرـ درـ تصویر 

همگی نمونه هایی از ترکیب بندی هستند. 

لایه بندی کلیپ ها  

را  آنها  می توانید  که  دارند  وجود  مختلفی  ابعاد  در  مختلفی  خرده ریزهای  سرپایی،  خوراکی های  دنیای  در 
لایه به لایه روی هم بچینید. دست کم، تبلیغات تلویزیونی که این طور می گویند. در مورد کلیپ های فیلم نیز 
می توانید همین کار را انجام دهید. به جای این که کلیپ ها را در Timeline کنار هم قرار دهید، می توانید 
مانند آن چه در شکل 9ـ22 می بینید، آنها را در ترکی بالای کلیپ موجود بگذارید. رویکرد اصلی ترکیب بندی 

همین است. 

Timeline شکل 9ـ22ـ کلیپ های چیده شده روی هم در
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تكنيك هاي تريكب كردن و كاربرد آنها 

روش های زیادی برای شروع ساخت ترکیب وجود دارد: 
کشیدن: کلیپ ها را از پنل Project به ترک های موردنظر خود بکشید. 

چسباندن: پس از کپی کردن دارایی از محلی دیگر، می توانید آن را بچسبانید. فقط باید مطمئن شوید که 
مقصد صحیح برای ترک مشخص شده باشد. در غیر این صورت ممکن است ترک بازنویسی شود. 

هم پوشانی: نشانگر پخش را در نقطۀ موردنظر قرار داده و در پوشه کلیپ موردنظر خود را انتخاب کرده و 
آن را در پنل Program Monitor به بخش Overlay بکشید. به این ترتیب کلیپ انتخابی در اولین جای 

خالی بعد از ترک و در بالای ترک موجود در Timeline قرار خواهد گرفت. 

تنظیم ماتی برای نمایش محتوای زیرین 

 Premiere Pro درست مانند انیمیشن سلولی یا پارچۀ حریر، می توانید اشیای زیرین لایه ها را ببینید. در
این تکنیک با نام Blending )ترکیب( شناخته می شود. برخلاف کلیپ هایی که کنار هم قرار می گیرند تا 
به صورت خطی پخش شوند، می توانید کلیپ ها را به صورت لایه به لایه روی هم بچینید. در شرایط معمولی، 
فقط لایۀ بالایی قابل مشاهده است، مگر این که اندازۀ آن را تغییر دهید )در این مورد در قسمت های بعدی 
همین فصل بیشتر شرح خواهیم داد( یا از وضعیت Blend برای تغییر رنگ و تراکم کلیپ ها استفاده کنید یا 

میزان ماتی کلیپ بالایی را تغییر دهید تا بتوانید الگویی ایجاد کنید. 
لزوماً  آنها  یا درجۀ ماتی   Blend تغییر میزان ماتی: چیدن کلیپ ها روی هم و اعمال تغییر در وضعیت 
همیشه هم نتیجۀ خوبی به بار نمی آورد حتی در عنوان ها نیز ممکن است جالب نشود. در حقیقت ممکن 
است نتیجه ای کاملًا نابه جا حاصل شده یا کلًا از آن پشیمان شوید. البته مواقعی نیز هست که می توانید از 
این تکنیک به نفع خود بهره گرفته و تصویری ایده آل ایجاد کنید. شرایط متفاوت است و بسته به عواملی 

مانند محل قرارگیری اصلی سوژه در هر تصویر و رنگ و تراکم آن فرق می کند. 
موج،  مانند  خود  موردنظر  جلوۀ  ایجاد  و  بافت  برای  ساده  تصویری  از  و  کرده  احتیاط  است  بهتر  همیشه 

دورنمایی انتزاعی یا ابرها استفاده کنید. 
روش انجام کار به این شرح است: 

1 اگر کلیپ مبنا از قبل در Timeline وجود ندارد، آن را به Timeline بکشید. 
٢ کلیپی را بکشید که می خواهید آن را با ترک بالای کلیپ مبنا ترکیب کنید. 

٣ روی ترک کلیک کرده و به پنل Effect Controls بروید. بخش Opacity را بیابید که در شکل 10ـ22 
می بینید و تنظیمات آن را از 100 درصد )که کل کلیپ از روی آن معلوم است( به 25 درصد تغییر دهید. 

به این ترتیب هم کلیپ مبنا نمایش داده می شود و هم بافتی از کلیپ روی آن به کار می رود. 
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  Blend و Opacity استفاده از وضعیت های

فیلم خود  برای  به سادگی جلوه ای منحصربه فرد  Blend، می توانید  Opacity و  از وضعیت های  استفاده  با 
ایجاد کرده و حالتی سینمایی به صحنه ببخشید تا از لحاظ بصری جذابیت بیشتری داشته باشد. ضمناً به این 
روش می توانید بافت را در متن عنوان ها مورد استفاده قرار دهید. برای این منظور به دو کلیپ نیاز دارید: 
اولی که کلیپ مبنا است و در شکل 11ـ22 می بینید، صحنۀ کلی را نشان می دهد. ممکن است سوژۀ ویدیو 
باشد یا لوکیشن کلیدی صحنه. کلیپ دوم که در شکل 12ـ22 می بینید، روی آن قرار می گیرد. این یکی 
به عنوان لایۀ ترکیبی عمل کرده و می تواند انتزاعی تر باشد، مانند ابرها، موج، باران یا هر جلوۀ بصری دیگری 

که همان طور که در شکل 13ـ22 می بینید کل فریم را بپوشاند. 

Opacity شکل 10ـ22ـ منوی لغزندۀ

شکل 11ـ22ـ کلیپ مبنا
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برقراری توازن صحیح بین کلیپ ها  

هنگام ترکیب بندی کلیپ ها، باید دقت کنید دو کلیپ حتماً به خوبی با هم عمل کنند. چند نکته هست که 
باید مورد توجه قرار دهید: 

کلیپ باید برای ترکیب »مناسب« باشد: اگر قصد دارید با استفاده از لایۀ ترکیبی جلوه ای را روی کلیپ 

شکل 12ـ22ـ کلیپ ترکیبی

شکل 13ـ22ـ دو کلیپ روی هم قرار گرفته و از مقدار 50 درصد برای Opacity استفاده شده است
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مبنا ایجاد کنید، باید مطمئن شوید کلیپ فایل عناصر اضافی بوده و برای ترکیب مناسب باشد. 
کاربرد اصلاحی: می توانید برخی مشکلات کلیپ در زمینۀ تراکم یا کنتراست را حل کنید. برای این منظور 
 Option کمک بگیرید. فقط باید کلید Blend باید همان کلیپ را بار دیگر روی خودش قرار داده و از وضعیت
را نگه داشته و لایۀ دیگری از کلیپ را روی خودش بکشید. برای مثال اگر تصویری دارید که زیادی روشن 
است، همان طور که در شکل 14ـ22 می بینید، باید یک کپی از تصویر را روی خودش قرار داده و از وضعیت 

ترکیبی Multiply برای اصلاح تراکم تصویر استفاده کنید. نتیجه را در شکل 15ـ22 ببینید. 
افزودن بافت: برای ایجاد بافت یا جلوه ای فانتزی به تصویر باید الگوی ساده ای را روی کلیپ اولیه قرار داده 

و یکی از وضعیت های Blend را اعمال کنید. 
عنوان ها: ترکیب بندی روشی است که می توانید عنوان هایی جذاب تر و از لحاظ ظاهری درجه یک درست کنید. 

شکل 14ـ22ـ به دلیل نسبت واید نور، این صحنه که پل بروکلین را نشان می دهد بخش های پرنوری دارد

شکل 15ـ22ـ با استفاده از وضعیت ترکیبی Multiply می توانید تراکم تصویر را تصحیح کنید. 
مقدار Opacity با 75 درصد تنظیم شده تا توازن مطلوب برقرار شود
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  Blend آشنایی با وضعیت های

شاید باید یک فصل کامل را به وضعیت های Blend اختصاص دهیم و باز هم نتوانیم حق مطلب را ادا کنیم. 
اما چون فضای این کتاب محدود است و قرار است در این جا فقط به اصول کلی Premiere Pro بپردازیم، 

توضیح مختصری در مورد هریک از وضعیت های Blend ارائه می دهیم. 
وضعیت های Blend، محتوای دو لایه را مقایسه کرده و براساس مقادیر عددی پیکسل های تصویر هر لایه، 
جلوه ای را ایجاد می کنند. آنها برای انجام این کار، باید مقادیر پیکسلی بین آن لایه ها را تغییر داده و جلوۀ 
خاصی را ایجاد کنند. برای مثال، وضعیت Screen Blend دو لایه را مقایسه کرده و تصویر را روشن تر می کند 
و برای این منظور پیکسل های تیره تر را روشن می کند بدون این که بر پیکسل های روشن تر تأثیری داشته 
باشد. در شکل 16ـ22 می بینید هریک از وضعیت های Blend از چه روش هایی روی تصویر تأثیر می گذارند. 

شکل 16ـ22ـ وضعیت های ترکیبی Darken و Luminosity و تأثیری که روی دو کلیپ می گذارند
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وضعیت های Blend به پنج دسته تقسیم می شوند. اجازه دهید مروری بر عملکردی داشته باشیم که هر 
بخش بر فرایند ترکیب دارد. 

گروه اول: ترکیب های اصلی 
بخش اول گروه های ترکیبی مربوط به ترکیب هایی هستند که تراکم تصویر را نرمال می کنند. چقدر نرمال؟ 

آنقدر که اولین ترکیب نامش »normal« است. 
Normal: تنظیمات پیش فرض دارد و ترکیبی است که بر لایۀ زیرین تأثیری ندارد، مگر این که ماتی را 
کاهش داده باشید که در این صورت ترکیب با لایۀ بالایی صورت می گیرد. هرچه مقدار ماتی را بیشتر کاهش 

دهید، لایۀ زیرین آن بیشتر قابل مشاهده خواهد شد. 
Dissolve: برخی پیکسل های لایۀ منبع را شفاف می کند تا لایۀ زیرین از روی آن قابل مشاهده شود. بیشتر 

اوقات برای استفاده از این وضعیت باید مقدار ماتی را تنظیم کنید. 

گروه دوم: کاهشی 
نام کاهشی برای این گروه کاملًا برازنده است، زیرا گزینه هایی ارائه می دهند که تصویر نهایی را تیره تر کرده 
و تراکم آن را افزایش می دهند. تمام ترکیبات این گروه روی مقادیر سایۀ هر دو تصویر تأثیر می گذارند و 

معروف ترین آنها Multiply است. 
را در هر دو لایه حفظ می کند.  تیره ترین ها  و  مقایسه کرده  را  پیکسل های داخل تصویر  تمام   :Darken
به  از رنگ ترکیب  از رنگ ترکیب جایگزین می شوند درحالی که پیکسل های تیره تر  پیکسل های روشن تر 

همان شکل دست نخورده باقی می مانند. 
Multiply: یکی از مرسوم ترین گزینه ها برای افزودن تراکم به تصویر پرنور محسوب می شود. این وضعیت 
از فرمول های ریاضی برای تیره تر کردن تصویر استفاده کرده، دو لایه را مقایسه کرده و از معادله ای استفاده 
می کند که مقادیر خاکستری لایۀ انتخابی را در لایۀ زیرین ضرب کرده و سپس نتیجه را بر 255 تقسیم 

می کند. به عبارت دیگر، تصویر در نهایت تیره تر می شود. 
این وضعیت برای شما  باشد،   Multiply از وضعیت  Color Burn: اگر می خواهید نتیجۀ حاصله تیره تر 
مناسب تر است. این وضعیت نیز کنتراست و درجه اشباع رنگ را افزایش می دهد اما نقاط روشن  تصویر را 

نرم تر می کند. 
Linear Burn: تا این جا می بینید هر چه به انتهای فهرست گزینه ها نزدیک تر می شویم، شدت عملکرد 
گزینه بیشتر می شود. در مقایسه با Multiply و Color Burn، این وضعیت تصویر تیره تری ایجاد می کند، 
زیرا درجه روشنایی را کاهش داده و کنتراست رنگ های تیره تر را افزایش می دهد بدون این که تأثیری بر 

درجه اشباع کلی رنگ داشته باشد. 
Darker Color: هم به Darken شبیه است و هم تفاوت هایی دارد. این وضعیت اصلًا پیکسل ها را ترکیب 
نمی کند. در عوض دو لایه را مقایسه کرده و ـ همان طور که حتماً خودتان حدس می زنید ـ تیره تر را نگه 

می دارد. 
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گروه سوم: افزایش تراکم 
در حالی که گروه قبلی مربوط به افزایش تراکم و تنظیم کنتراست بود، این مجموعه از ترکیب ها راهکاری 
متضاد دارند و لایۀ نهایی را روشن تر می کنند. این گروه روی مقادیر روشن در تصویر کار می کنند. رایج ترین 

آنها Screen است. 
بیشتر گزینه های این مجموعه از ترکیب ها، رنگ ها را نیز تغییر می دهند. برای این منظور از نورهای تابیده شدۀ 

مختلف برای تغییر رنگ ها استفاده می کنند. 
اگر  را حفظ می کند.  نگارش های روشن تر  و  قرار داده  بررسی  را مورد  Lighten : لایه های مبنا و ترکیب 

پیکسل ها یکسان باشند، بدون تغییر می مانند. 
Screen : این روش پرطرفدار بیشتر از هر کار دیگری، این ایده را مجسم می کند که چندین تصویر را روی 
یکدیگر انداخته و در اصل مقادیر تیره تر را روشن می کند بدون این که تأثیری بر مقادیر روشن تر داشته باشد. 
این ویژگی به ویژه زمانی مفید واقع می شود که تصویری با نوردهی پایین داشته باشید. اگر تصویر را روی 

خودش کپی کنید، تصویر را به طور کلی روشن تر می کند بدون این که جزئیات از دست بروند. 
Color Dodge : گزینۀ دیگری که برای اصلاح رنگ بسیار خوب عمل می کند. این لایۀ ترکیبی، رنگ منبع 

را روشن تر کرده و کنتراست را کاهش می دهد. 
)Linear Dodge (Add : اگر قصد دارید جلوه های وضعیت های Screen و Color Dodge را در کنار هم 
استفاده کرده و از رنگ مایۀ روشن تر و با کنتراست پایین تر بهره بگیرید، بهتر است از این گزینه استفاده کنید. 
Lighter Color: این گزینه که شباهت زیادی به خواهر خود Lighten دارد، پیکسل های روشن تر را از 
مقادیر رنگ تصویر منبع و زیری آن دریافت می کند، اما ترکیب را در تمام کانال های رنگ اعمال نمی کند. 

گروه چهارم: ایجاد تصویری متفاوت 
تأثیر روی رنگ لایۀ ترکیب عمل  با   Blend این وضعیت های  Difference می رسد.  به دسته بندی  نوبت 
می کنند. برای این منظور از تفاوت های بین مقادیر رنگ منبع و رنگ زیرین بهره می گیرند. این وضعیت ها 
بسته به این که کدام گزینه را انتخاب کرده باشید روی کنتراست تأثیر گذاشته، رنگ های نهایی را روشن تر 
یا تیره تر می کنند. این گروه با مقادیر حد وسط در هر دو تصویر کار می کنند. رایج ترین گزینۀ این گروه، اول 

Overlay و بعد Soft Light است. 
Overlay: این وضعیت Blend یکی دیگر از گزینه های بامزه است که ترکیبی از وضعیت های Multiply و 
Screen بوده و قدرت نفوذ بیشتری به تصویر می بخشد. بخش های تیره، تیره تر و بخش های روشن، روشن تر 

می شوند. 
Soft Light: رنگ های کمتر از 50 درصد خاکستری روشن تر و رنگ های بیشتر از 50 درصد خاکستری 

تیره تر خواهند شد. این وضعیت به ویژه برای ترکیب بافت در تصاویر بسیار خوب عمل می کند. 
Hard Light: شبیه به Soft Light است، با این تفاوت که پیکسل های تیره تر از 50 درصد خاکستری را 
ضرب و روشن ترها را تقسیم می کند و در نهایت جلوه ای غیرواقعی ایجاد می کند که برای واقعی تر شدن آن 

تقریباً همیشه باید مقدار Opacity آن را تغییر دهید. 
Vivid Light: وضعیت ترکیبی قدرتمند دیگری که نیاز به کمی رقیق سازی دارد، چون رنگ های بالاتر از 
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50 درصد خاکستری را تیره تر کرده و کنتراست را افزایش می دهد. 
میزان  کنتراست  به جای  دارد،   Vivid Light به  شباهت هایی  که  ترکیب  وضعیت  این   :Linear Light
روشنایی را تنظیم می کند. برای درخشان تر شدن رنگ ها بسیار خوب عمل می کند اما نتیجۀ کار هنوز هم 

بیش از حد قوی است و نیاز به تنظیم Opacity دارد. 
دو  هر  مانند  این وضعیت  دارد.  کاربردهای محدودی  که   Blend از وضعیت های  دیگر  یکی   :Pin Light
وضعیت Lighten و Darken عمل می کند، به جز این که برای انتخاب پیکسل های بالا و پایین، براساس 
درجه روشنایی، پیکسل های ترکیبی تیره تر از 50 درصد خاکستری در هر دو لایه یا بدون تغییر گذاشتن 

رنگ مایه های روشن تر عمل می کند. 
Hard Mix: شاید این گزینه در مجموع یکی از منحصربه فردترین وضعیت های Blend باشد. برخلاف سایر 
وضعیت ها، این یکی روی تمام رنگ های هشت رنگ اصلی ـ قرمز، سبز، آبی، فیروزه ای، ارغوانی، زرد، سیاه و 
سفید ـ تأثیر گذاشته و منجر به ایجاد تصویری نقاشی گونه با ظاهری تقریباً متحرک می شود. اما جایی که این 
وضعیت ـ بی اغراق ـ واقعاً عالی عمل می کند، زمانی است که باید به کلیپ های ویدیویی مسطح با کنتراست 
 Hard Mix Blend پایین و رنگ هایی بی روح جان ببخشید. با فعال سازی لایه ها در ویدیو و اعمال وضعیت

می توانید جلوۀ بامزه ای را ایجاد کنید که در شکل 17ـ22 نیز نشان داده شده است. 

شکل 17ـ22ـ این تصویر بی مزه با کپی کردن لایه و افزودن ترکیب Hard Mix جانی دوباره گرفته است

 HSL گروه پنجم: دسته بندی
این گروه از وضعیت های Blend نتایجی مدرن تر و سورئال به بار می آورند:

Difference: همان طور که از نام آن پیداست، این یکی پیکسل های لایه های مبنا و ترکیب را از هم کم 
کرده و درجه روشنایی را افزایش می دهد. اگر پیکسل های هر لایه مقادیر یکسانی داشته باشند، زمانی که 
از هم کم می شوند نتیجه رنگ سیاه خواهد بود. این تکنیک زمانی مفید واقع می شود که بخواهید جلوه ای 
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وهم آور ایجاد کنید یا زمانی که بخواهید تفاوت بین صحنه های مشابه مشهود باشد. برای تأثیرات بیشتر بهتر 
است هنگام فیلم برداری از سه پایه استفاده کنید. 

Exclusion: این روش شبیه به Difference است، اما شدت تراکم آن کمتر است. Difference تفاوت ها 
را به رنگ سیاه نشان می دهد، اما این یکی فقط مربوط به رنگ های خاکستری است. 

Subtract: عملکرد این روش از روی نامش کاملًا مشخص است. این تکنیک مقادیر بین دو لایه را از هم 
کم کرده و در نهایت تصویر را تیره تر می کند. ترتیب قرار گرفتن لایه ها بسیار مهم است، بنابراین اگر ترتیب 
لایه ها را تغییر دهید با نتایج متفاوتی روبه رو خواهید شد. این گزینه تأثیری بر بخش های سیاه رنگ ندارد، 

اما بخش های سفید رنگ را تیره تر می کند. 
Divide: این گزینه نیز که نامش از روی یکی از محاسبات ریاضی گرفته شده دقیقاً برعکس Subtract عمل 
می کند. این روش برای اصلاح صحنه هایی مفید واقع می شود که حاوی مقادیر زیادی رنگ سفید هستند و 
برای عملکرد بهتر می توانید آن را با لایه ای solid با رنگی به غیر از سفید ترکیب کنید تا بر رنگ کلی تصویر 

تأثیر بگذارید. 
آخرین دسته بندی با فام رنگ، درجه اشباع، رنگ و درخشندگی کلیپ ویدیویی در ارتباط است. 

Hue: رنگ لایۀ بالایی و درخشندگی و درجه اشباع لایۀ زیرین را حفظ می کند. 
Saturation: درجه اشباع لایۀ بالایی و درخشندگی و رنگ لایۀ زیرین را حفظ می کند. 

Color: برای افزودن رنگ به تصاویر سیاه و سفید و تنظیم رنگ مایۀ تصاویر رنگی مناسب است. رنگ و درجه 
اشباع رنگ لایۀ بالایی و درخشندگی رنگ زیرین را مورد استفاده قرار می دهد. 

Luminosity: شبیه به وضعیت ترکیب Color بوده اما عملکرد آن برعکس است. درخشندگی رنگ منبع 
مورد استفاده قرار می گیرد. البته گاهی ممکن است تصویر به طور کامل ناپدید شود. 

 Blend آشنایی با مؤلفه های وضعیت های
بهتر است با اصطلاحات به کار رفته بیشتر آشنا شوید. 

منظور از رنگ منبع، رنگ لایه ای است که وضعیت Blend در آن اعمال شده است. 
رنگ زیرین در لایۀ ترک موجود در زیر لایۀ منبع در Timeline اعمال می شود. 

رنگ نهایی به خروجی ترکیب اعمال شده در ترکیب بندی اشاره دارد. البته می توانید نتایج حاصل از اعمال 
وضعیت های Blend را با تغییر مقدار Opacity آنها تحت تأثیر قرار دهید.

اعمال وضعیت Blend در لایۀ تنظیم  

از اهمیت   Premiere Pro از لایۀ تنظیم استفاده کنید. لایۀ تنظیم در  باید   Blend برای اصلاح وضعیت 
 Blend برخوردار است، زیرا این جا تصویر متحرک است و می توانید وضعیت Photoshop بیشتری نسبت به
 Opacity را در بخش Blend را در دسته ای از کلیپ ها اعمال کنید. فقط باید وضعیت Opacity یا تنظیمات
در برگۀ Effect Controls مربوط به لایۀ تنظیم تغییر دهید. عملکرد این تکنیک مانند این است که کلیپ 

را در ترک ویدیویی روی کلیپ موجود کپی کرده و سپس وضعیت Blend آن را تغییر داده باشید. 
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می توانید جلوه ای مانند جلوۀ اصلاح رنگ یا رنگ مایه را در لایۀ تنظیم اضافه کرده و سپس اندازۀ آن را تغییر 
دهید. این تکنیک به شما امکان می دهد فقط بخشی از صفحه نمایش را هایلایت کنید. 

جلوۀ Transform و لایه های تنظیم  

می توانید یکی از جلوه های تغییر شکل مانند Scale یا Rotate را در لایۀ تنظیم اعمال کرده و سپس آن را در 
دسته ای از کلیپ ها )یا تصاویر ثابت( متحرک کنید. این تکنیک به شما امکان می دهد به جلوه های متحرکی 
دست یابید که قبلًا باید از طریق ادغام کلیپ ها انجام می دادید. زمانی که سکانس را پخش می کنید، کلیپ 

دارای جلوۀ تغییر شکل خواهد بود که در محدودۀ دو یا چند کلیپ متحرک می شود. 

ادغام کلیپ ها در یک مجموعه  

یعنی چندین کلیپ مجزا را گرفته و آنها را به صورت یک کلیپ واحد تغییر شکل دهید. اگر همه چیز مرتب 
به نظر برسد، یعنی در ترک درست قرار گرفته اید. اما تنها نکته این نیست )البته این نکته هم مهم است(. 
دلیل دیگری نیز وجود دارد و آن مربوط به زمانی است که می خواهید سکانسی را ایجاد کرده و جلوه ای را 
در آن اعمال کنید. برای مثال ممکن است بخواهید بخشی از سکانس به صورت سیاه و سفید پخش شود، 
بهترین راه برای انجام این کار این است که تمام کلیپ ها را در هم ادغام کرده و تمام آنها را به صورت یک 

کلیپ واحد مورد استفاده قرار دهید. 
برای ادغام کلیپ ها به این روش عمل کنید: 

1 کلیپ هایی را که می خواهید در هم ادغام شوند، انتخاب کنید. 
بازشو نمایش داده شد، گزینۀ Next را  انتخابی کلیک راست کرده و زمانی که منوی  2 روی کلیپ های 

انتخاب کنید. 
3 در کادر محاوره ای نمایش داده شده، نامی را برای کلیپ های ادغامی تایپ کرده و همان طور که در شکل 

18ـ22 می بینید روی OK کلیک کنید. 

شکل 18ـ22ـ  نامگذاری کلیپ ادغام شده
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کار با کلیپ ادغام شده: با ادغام چندین کلیپ، یک کلیپ واحد ایجاد می شود که به سادگی می توانید آن 
را حول Timeline جابه جا کنید. البته این دیگر فقط یک کلیپ واحد نیست، چون می توانید به هریک از 
مؤلفه های آن نیز دسترسی داشته باشید. فرض کنید کلیپ ها را در پوشه یا هر محل دیگری به جز این جا قرار 
داده اید، به جای این که در پوشۀ پروژه قرار گیرند، درحال حاضر در Timeline هستند. حال در نظر بگیرید 
که سه کلیپ دارید که در هم ادغام شده اند و یکی از آنها نیاز به اصلاح رنگ دارد. به سادگی می توانید این 

مشکل را برطرف کنید. 
به این روش عمل کنید: 

1 روی کلیپ ادغام شده دابل کلیک کنید.
2 زمانی که در Timeline باز شد، هر یک از کلیپ های مجزا را می بینید. هر تغییری را که لازم است، در 

هر یک از کلیپ های مجزا اعمال کنید. 
3 روی کلیپ کلیک راست کرده و گزینۀ Next را انتخاب کنید. به این ترتیب دوباره یک کلیپ ادغام شدۀ 

واحد خواهید داشت. 

آشنایی با کانال های آلفا 

منظور از کانال آلفا، کانالی اضافی است که روی تصویر قرار گرفته و مانند نقشۀ شفافیت عمل کرده و به شما 
امکان می دهد برخی عناصر خاص را ویرایش کنید بدون این که بر سایر بخش های تصویر تأثیری بگذارید. 
این عملکرد بر اساس مناطق شفاف مبتنی بر رنگ صورت می گیرد که کار ترکیب بندی و ویرایش با استفاده 
از پردۀ سبز را راحت تر می سازد. برای درک بهتر این ویژگی، کلیپ های ویدیویی رنگی را در نظر بگیرید که 
حاوی سه کانال برای اطلاعات رنگ هستند: قرمز، سبز و آبی )RGB(. برای استفاده از کانال آلفا نیاز به کانال 
چهارمی دارید که حاوی اطلاعات مربوط به شفافیت است و به شما امکان می دهد کاری کنید برخی رنگ ها 
از پردۀ سبز در پس زمینۀ  این ترتیب می توانید همانند آن چه در شکل 19ـ22 می بینید  ناپدید شوند. به 

ترکیب بندی خود استفاده کنید. 

شکل 19ـ22ـ تصویری با پردۀ سبز در پس زمینه، مناطقی را نشان می دهد که باید حذف شوند
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برای ساخت کانال آلفا به این طریق عمل کنید: 
1 کلیپ را انتخاب کرده و بخش سبز رنگ را با انتخاب فرمان Keying>Ultra Key حذف کنید. 

2 با استفاده از ابزار Eyedropper که در شکل 20ـ22 می بینید، رنگ سبز را انتخاب کنید. به رنگ سیاه 
درمی آید. 

3 فرمان File>Export را انتخاب کنید. در پنل، فرمت را به QuickTime تغییر دهید. می توانید از گزینۀ 
پیش فرض Custom استفاده کنید. 

4 به سراغ کادرهای انتخاب Audio و Video بروید. اگر کانال آلفا فقط مربوط به گرافیک یا جلوه ها است، 
می توانید کادر انتخاب Audio را نیز در حالت تأیید قرار دهید. اما حتماً کادر انتخاب Video را در حالت 

تأیید قرار دهید. 
 ProRes یا Animation for 8-bit را با مقدار Video Codec پیمایش کنید. گزینۀ Video 5 به پایین برگۀ
4444 تنظیم کنید. هر دو از کانال آلفا پشتیبانی می کنند، بنابراین مطمئن شوید هنگام پیمایش حتماً یکی از 

کادرهای انتخاب را در حالت تأیید قرار داده باشید. 
 8-bpc+alpha را انتخاب کرده و در زیر آن، مطمئن شوید دکمۀ رادیویی Maximum Depth 6 گزینۀ

نیز در حالت انتخاب قرار داشته باشد. 
7 ویدیوی نتیجه را صادر کنید. پس از صدور ویدیوی حاوی کانال آلفا با استفاده از فرمان Export، آن  را 
به  را  فایل  قرار دهید. زمانی که  بررسی  تا مورد  Timeline بکشید  به  و  وارد کرده  پروژه  به پوشۀ  مجدداً 
Timeline وارد می کنید، همان طور که در شکل 21ـ22 می بینید، شفافیت با رنگ سفید نشان داده می شود. 

Eyedropper شکل 20ـ22ـ ابزار

شکل 21ـ22ـ کانال آلفای تصویر
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ایجاد ماسک در تصویر  

در  را  است، می توانید جلوه ها  آلفا  کانال  ایجاد  از  پیچیده تر  Premiere Pro که کمی  در  ماسک  ایجاد  با 
بخش های خاصی از ویدیو اعمال کنید. ماسک ها به شما امکان می دهند بخش هایی از کلیپ را انتخاب کنید 
که می خواهید آنها را مات کرده، کلًا پوشانده یا اصلاحاتی را در آنها اعمال کنید. برای مثال، با استفاده از 
 Ellipse ماسک می توانید صورت فرد یا نام محصولی را بپوشانید. می توانید از ابزارهای مختلفی مانند ابزار
یا Rectangle برای انتخاب بخش موردنظر خود استفاده کنید یا می توانید با استفاده از ابزار Pen محدودۀ 

انتخابی را به دلخواه ترسیم کنید. 
روش انجام کار به این صورت است: 

1 کلیپی را در Timeline انتخاب کنید که قرار است ماسک روی آن ایجاد کنید. 
٢ به پنل Effects رفته و جلوه ای را انتخاب کنید که می خواهید در کلیپ اعمال کنید. برای مثال می توانید 

فرمان Stylize>Posterize را انتخاب کنید. 
٣ جلوه را به کلیپ بکشید تا در آن اعمال شود. 

٤ به پنل Effect Controls رفته و با پیمایش بیشتر، کنترل های مربوط به جلوۀ Posterize را بیابید. 
٥ تصمیم بگیرید می خواهید از کدام یک از ابزارهای Rectangle ،Ellipse یا Pen استفاده کنید. 

 Program Monitor و به کمک نقاط لنگر، شکل بیضی را روی تصویر در پنل Ellipse ٦ با استفاده از ابزار
ترسیم کنید. شکل را می بینید و می بینید که جلوه فقط در محدودۀ ماسک ترسیم شده اعمال می شود. 

پرسش های تشریحی 

1 کدام حالت خودکارسازی Audio Mixer اجازه خودکارسازی را برای برگشت به حالت قبلی پس از انجام 
تنظیمات می دهد؟

٢ چگونه می توانید لبه های ماسک خود را با پس زمینه ترکیب کنید؟
٣ چگونه می توانید یک کمان بسازید؟

٤ آیا می توان یک ماسک را بر یک جلوه اعمال کرد؟
٥ بهترین روش برای این که اجازه دهید ماسک سوژه شما را دنبال کند، چیست؟

کانال آلفا را می توانید در برنامه های گرافیکی دیگر مثل Photoshop نیز ایجاد کنید.
توجه
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پرسش های چندگزینه ای 

1 سطح شفافیت در مقیاس 0 تا 100 درصد اگر روی 0 درصد تنظیم شود، در 100 درصد کلیپ 
شفافیتی ندارد. این ویژگی چه نامیده می شود؟

ب( فضای کار سفارشی 	Title Tools الف( پنل
Opacity )د 	Crawl )ج

٢ داده های شفافیت که هنگام تدوین رسانه ذخیره می شوند، در کجا قرار می گیرند؟
Effects ب( پنل 	Essential Graphics الف( پنل

د( ویرایش هم بندی ج( کانال آلفا	

٣ هنگامی که بخشی از بریده فیلم شما شفاف است، اطلاعات شفافیت در کجا ذخیره می شود؟
ب( کانال آلفا 	Source الف( نمایشگر
د( جلوه آلفا 	Opacity ج( جلوه

٤ کدام عبارت درباره ترجیحات Appearance درست است؟
الف( روشنایی پیش فرض، مکانی بین تیره تر و روشن تر است.

ب( می توانید نوار بالای پنجره ها را روی یک رنگ تأکیدی سفارشی تنظیم کنید.
ج( می توانید شدت Focus Indicator را تنظیم کنید تا به راحتی تشخیص دهید کدام پنجره فعال 

است.
د( می توانید رنگ متمایز را تغییر دهید.

٥ اگر بخواهید فقط تاریک ترین قسمت های یک تصویر را روشن کنید، کدام نوار لغزنده را باید در جلوه 
Lumetri تنظیم کنید؟

Contrast )ب 	Shadows )الف
Blacks )د 		  Midtones )ج

گرفتن خروجی و انواع فرمت های خروجی
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اهداف رفتاری  

پس از مطالعه این فصل از هنرجو انتظار می رود:
  بتواند از پروژه خروجی بگیرد.

  با پنل Export  آشنا باشد.

  با تنظیمات پیش ساخته آشنا باشد.

  انشعاب های )فرمت های( مختلف فایل های ویدیویی را بشناسد.

  با بخش Summary آشنا باشد.

  بتواند سرعت بیت را تنظیم کند.

  کادرهای انتخاب مناسب را بشناسد.

  تفاوت بین ظرف فایل و برنامۀ پخش فایل را بداند.

  نام خروجی را تنظیم کند.

از چندین روش  هنگام صدور محصول خود می توانید   Premiere Pro در  دیگر  موارد  تمام  مانند  درست 
بهره بگیرید. گزینه های زیادی برای صدور 
قابل دسترس هستند. چه بخواهید ویدیوی 
پست  خود   YouTube کانال  در  را  خود 
کنید، چه بخواهید آن را در صفحه نمایش 
بزرگی در جشن عروسی به نمایش بگذارید، 
 Timeline سفر ویدیوی شما برای صدور از
 File>Export>Media با انتخاب فرمان
آغاز می شود که در شکل 1ـ23 می بینید 
نمایش  به  را   Export محاوره ای  کادر  و 

در می آورد. 
و  شده  فرایند  این  وارد  دهید  اجازه 
برای  کنیم.  امتحان  را  موجود  گزینه های 
صدور فیلم خود به این روش عمل کنید: 

را   File>Export>Media فرمان   1
کلیدهای  از  می توانید  )یا  کنید  انتخاب 
 Ctrl+M در مکینتاش یا Cmd+M میانبر

در ویندوز استفاده کنید(. 

 Export شکل 1ـ23ـ دسترسی به پنل
Main از طریق منوی
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٢ فرمت موردنظر خود را انتخاب کنید. رایج ترین گزینه ها QuickTime و H.264 هستند. 
٣ تنظیمات پیش فرض موردنظر خود را انتخاب کنید. این ها مربوط به فرمت انتخابی شما هستند و بسته 
به نیازهای خود می توانید آنها را تنظیم کنید )اگر نمی دانید کدام گزینه را انتخاب کنید بهتر است به بخش 

»انتخاب فرمت« سری بزنید(. 
٤ )در صورت لزوم( نامی برای خروجی خود انتخاب کنید. برای این منظور باید روی لینک کلیک کرده و 

زمانی که کادر محاوره ای نمایش داده شد، نام فایل را در آن تغییر دهید. 
٥ دقت کنید حتماً کادرهای انتخاب Audio و Video در حالت تأیید قرار داشته باشند. در غیر این صورت 
فایل بعد از صدور دیگر این مؤلفه ها را نخواهد داشت. Premiere Pro به شما امکان می دهد صدا و تصویر را 
به صورت مجزا صادر کنید، بنابراین حتماً این دو کادر انتخاب را در حالت تأیید قرار دهید. این ویژگی زمانی 
مفید واقع می شود که بخواهید فقط از ویدیو برای نصب هنر استفاده کنید یا بخواهید از صدا به عنوان بخشی 

از ترک صوتی استفاده کنید. 
٦ روی Export کلیک کنید. 

بسته به عوامل مختلف از جمله سطح فشرده سازی، اندازۀ فریم، سرعت فریم، مدت زمان سکانس و قدرت 
پردازش رایانه، صدور چند دقیقه یا بیشتر طول می کشد. 

 Export آشنایی با پنل

قبل از صدور ویدیو از Timeline، باید تصمیم بگیرید چه نوع فیلم خود ـ پخشی قرار است ایجاد کنید. پس 
از نمایش پنل Export که در شکل 2ـ23 می بینید، از طریق منوهای کشویی، دکمه های رادیویی، لینک ها و 
برگه ها به گزینه های متعددی دسترسی خواهید داشت. بهتر است ببینیم هر کدام چه کاری انجام می دهند. 

Export شکل 2ـ23ـ نمایی از پنل
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انتخاب فرمت 
از سمت راست بالای کادر محاوره ای Export که شروع کنیم، اولین منوی کشویی به شما امکان می دهد 
از  منو منتخبی  این  انتخاب کنید. همان طور که در شکل 3ـ23 می بینید،  فیلم خود  برای  را  فایل  فرمت 
انواع فایل ها را هم برای فایل های ویدیویی و هم برای فایل های صوتی ارائه می دهد. از میان آنها می توانیم 
 Match Sequence انتخاب  کادر  باید  حتماً  کنیم.  اشاره   WAV و   QuickTime  ،H.264 فایل های  به 

Settings را در حالت تأیید قرار دهید. 

شکل 3ـ23ـ گزینه های زیادی در منوی کشویی Format ارائه می شوند

آیا نمی دانید کدام فرمت برای شما مناسب تر است؟ در فهرست زیر با کارایی برخی از رایج ترین فرمت ها آشنا 
شده و می بینید چرا باید یا نباید از آنها استفاده کنید. 

QuickTime: این فقط یک فرمت نیست، بلکه کل چهارچوب کار است، اما فعلًا این موضوع ربطی به بحث 
ما ندارد. فرمت فایل QuickTime فایل فشرده سازی نشده ای را در اختیار شما قرار می دهد که برای بایگانی 
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و نمایش سطح بالا ایده آل است اما برای استفادۀ آنلاین یا به اشتراک گذاری زیاد مفید نیست. 
H.264: فرمتی فشرده سازی شده که کیفیت را درحد مطلوبی حفظ کرده و برای به اشتراک گذاری ویدیوهای 

تکمیل شده و آپلود در شبکه های اجتماعی عالی است. 
WAV: در اصل فایل صوتی فیلم شما است. اما چرا به آن احتیاج دارید؟ دلایل زیادی وجود دارد، از جمله 

شفاف سازی نظرات، ایجاد پادکست صوتی یا آپلود به سایت رونوشت. 

آشنایی با تنظیمات پیش ساخته 

بسته به فرمتی که انتخاب کرده باشید، در منوی کشویی بعدی تنظیمات پیش ساخته ای مربوط به همان فرمت 
انتخابی نمایش داده خواهند شد. برای مثال، تنظیمات پیش ساخته H.264 عبارت اند از: انواع فشرده سازی، 
انتخاب گزینه  از  Vimeo. پس  یا   YouTube آپلود در  برای  اندازه فایل، درجه وضوح و حتی گزینه هایی 
H.264 از منوی Format گزینه های مختلف نشان داده شده در شکل 4ـ23 را خواهید دید که مرتبط با 

همان گزینه هستند. 

شکل 4ـ23ـ تعداد تنظیمات پیش ساختۀ مربوط به فرمت H.264 آنقدر زیاد است 
که برای دیدن تمام آنها باید فهرست را پیمایش کنید
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آشنایی با انشعاب های فایل های مرسوم ویدیویی 

 . Mp4 انشعاب  از  می دهید،  قرار  استفاده  مورد  صدور  برای  را   H.264 پیش ساختۀ  تنظیمات  که  زمانی 
ویدیوی  فرمت های  معروف ترین  از  یکی  فشرده سازی شده  فرمت  این  استفاده می شود.  فایل  نام  انتهای  در 
دیجیتال بوده و تقریباً در تمام دستگاه ها قابل پخش است. Mp4 در موارد مختلفی قابل استفاده است، از جمله 

 .Instagram و Twitter ،Facebook ،YouTube هنگام آپلود ویدیوها در
انشعاب معروف MOV )با انشعاب فایل .mov( برای فیلم های صادر شده به فرمت QuickTime از کیفیت 
 ProRes 422 بدون اتلاف فشرده سازی نشده تا انواع تنظیمات مختلف فشرده سازی را دربرمی گیرد. گزینۀ
 QuickTime برای پخش کنندۀ Apple توسط QuickTime در بیشتر پروژه ها قابل استفاده است. فرمت
خود ارائه شده است، اگرچه این فایل ها برای کاربردهای مختلف از جمله نمایش در تلویزیون به خوبی عمل 

می کنند. 

فرمت های فایل متداول 
را مرور می کنید؟ فرمت های  دارید دانش خود  یا فقط  فیلم آشنا شده اید  فایل  با فرمت های  تازگی  به  آیا 
توسط  که   H.264 فشرده سازی شدۀ  فرمت  هستند.  ویدیو  فرمت های  رایج ترین   QuickTime و   H.264
برقرار  تصویر  کیفیت  و  فایل  حجم  بین  مطلوبی  توازن  می شود،  پشتیبانی  بسیاری  پلت فرم های  و  ابزارها 
می کند. اگر قصد دارید فیلمی را در اینترنت آپلود کرده یا آن را با استفاده از یکی از برنامه های کاربردی 
انتقال فایل برای پخش بفرستید، باید از این فرمت استفاده کنید. البته ویرایش داستان دیگری دارد و برای 
آن باید از فرمتی فشرده سازی نشده استفاده کنید. QuickTime گزینۀ مناسبی است، به ویژه اگر قرار است 

بعدها با استفاده از برنامۀ تبدیل ویدیو، حجم و فرمت فایل خود را تغییر دهید. 
فرمت های فایل مرسوم دیگری نیز وجود دارند که عبارت اند از: 

 QuickTime همان نقشی را در ویندوز بازی می کند که Windows Media Viewer فرمت :WMV
در مکینتاش ایفا می کند. مایکروسافت آن را برای Windows Media Player طراحی کرده است. فایل 
WMV در YouTube به خوبی عمل می کند اما در سایر موارد باید برنامۀ پخش WMV را در اختیار داشته 

باشید. 
AVI: فرمت فایل Audio Video Interleave در بیشتر مرورگرهای وب در دستگاه های ویندوز، مکینتاش 
و لینوکس عمل می کند. AVI فرمت فایل دیگری است که توسط مایکروسافت ارائه شده که کیفیت بالا و 
بالطبع حجم فایل بالایی دارد. فرمت AVI توسط YouTube پشتیبانی شده و برای نمایش در تلویزیون 

به خوبی عمل می کند. 
Material Exchange Format :MXF ظرف فایل قدرتمند و باثباتی است که از برنامه های مختلف پخش 
پشتیبانی کرده و برای ویدیو و صدا ایده آل است. براساس استانداردهای SMPTE1، فرمت فایل ویدیویی 
MXF به طور کامل از کد زمانی و فراداده پشتیبانی کرده و به شما امکان می دهد از این دارایی ها در بیشتر 
این   MXF OP1a از نگارش   Premiere Pro تلویزیونی بهره بگیرید.  کاربردهای پیشرفته تر مانند پخش 
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فرمت استفاده می کند. 
برخی فرمت های دیگر به این شرح هستند: 

high- ویدیوی  خاص  که   Advanced Video Coding High-Definition فایل  فرمت   :AVCHD
definition و برای استفاده در دوربین های فیلم برداری HD طراحی شده است. این فرمت کیفیت بالایی را با 

حجم فایل معقول حفظ کرده و کمترین اتلاف را ایجاد می کند. 
MKV: فرمت Matroska Multimedia Container که اولین بار در روسیه ارائه شد، رایگان و متن باز 
بوده و تقریباً از تمام برنامه های پخش پشتیبانی می کند، اما محدودیت هایی دارد زیرا به جز برنامه های پخش 

رسانه متن باز مانند VLC یا Miro در بیشتر برنامه ها پشتیبانی نمی شود. 
MPEG-23 : فرمتی که در سال 2002 به وجود آمد و می توان از آن در ضبط فرمت DVD استفاده کرد. 

در این صورت این گزینه برای شماست. 

نگاهی به بخش Summary بیندازید 

از آن جا که اطلاعات حیاتی ترین منبع ما است، باید دادۀ بخش Output و Source فایلی را که می خواهید 
صادر کنید، مورد بررسی قرار دهید. با بررسی سریع بخش Summary که در شکل  5ـ23 می بینید، مطمئن 

خواهید شد که اطلاعات خروجی منطبق بر نیازهای شما هستند. 

 Export بخش پایینی پنل
پنل Export با شش برگه که در شکل 6  ـ23 نیز می بینید، محلی است تا تنظیمات پیشرفته را قبل از 
صدور در ویدیوی خود اعمال کنید. برگه های Captions ،Multiplexer ،Audio ،Video ،Effects و 
تنظیم  شما  انتخابی  پیش ساختۀ  گزینۀ  براساس  حاضر  درحال  اما  هستند،  قابل اصلاح  همگی   Publish

شده اند. 

Export پنل Summary در بخش Source و Output شکل 5ـ23ـ اطلاعات



276

تنظیمات سرعت بیت 

 .VBR 1-pass و VBR 2-pass ،CBR :در این بخش سه گزینه ارائه شده است
بالاترین  به  نیاز  که  است  مناسب  مواردی  برای  فقط  و  ایجاد می کند  را  فایل  بزرگ ترین حجم   CBR
کیفیت داشته باشید مانند ساخت فیلم. VBR 1-pass کوچک ترین حجم فایل را دارد. در بیشتر موارد، 
 Target Bitrate مفید واقع می شود. لغزندۀ پایین این بخش به شما کمک می کنند تا مقادیر VBR 2-pass
و Maximin Bitrate را تنظیم کنید. واحد اندازه گیری مگابیت بر ثانیه است و ویدیوی HD با فرمت 
H.264 )و با ابعاد 1080×1920 پیکسل( زمانی که در سیستم شما پخش می شود باید بین 3Mb/s و 
5Mb/s فشرده سازی شود. هنگام آپلود در شبکه های اجتماعی، بهتر است از مقدار 15Mb/s-10 استفاده 
کنید، زیرا تمام پلت فرم های شبکه های اجتماعی به صورت خودکار یک بار دیگر رسانه را فشرده سازی 
 15-20Mb/s بهتر است برای ذخیره سازی در سیستم خود از مقدار UHD 4 یاK می کنند. هنگام کار با

استفاده کنید. برای آپلود در شبکه های اجتماعی می توانید از مقدار 40Mb/s-35 استفاده کنید. 

تأیید کادرهای انتخاب مناسب  

کادرهای انتخاب زیادی در سرتاسر پنل Export می بینید. بهتر است آنها را از بالا تا پایین مرور کرده و 
ببینیم کدام را باید در حالت تأیید قرار دهیم. 

Match Sequence Settings: همان کاری را انجام می دهد که از نامش پیداست ـ تنظیمات مربوط به 
همان سکانس را تطبیق می دهد. 

شکل 6ـ23ـ برگه های مربوط به تنظیمات پیشرفته تر



فصل بیست وسوم: گرفتن خروجی و انواع فرمت های خروجی

277

Use Maximum Render Quality: برای سکانس های اکشن بسیار مفید است. اگر این کادر انتخاب را 
قبل از صدور در حالت تأیید قرار دهید، کیفیت حرکت کلیپ بهبود می یابد. البته، زمان رندر طولانی تر شده، 

حجم فایل افزایش یافته و نیاز به پردازنده ای قوی تر دارد. 
 Premiere یکی از تنظیمات صدور که مبتنی بر استفاده از فایل های پیش نمایشی است که :Use Previews
Pro برای پخش مورد استفاده قرار می دهد و کیفیت زیاد بالایی ندارند. زمان رندر بسیار کوتاه شده و بالطبع 
کیفیت نیز به میزان زیادی کاهش می یابد. این گزینه زمانی مفید واقع می شود که بخواهید از صدور با کیفیت 

پایین فقط برای بازبینی اصلاحات استفاده کنید. 
Import into Project: زمانی که این کادر انتخاب را در حالت تأیید قرار می دهید، نگارشی از فایل شما 
به پنل Project اضافه می شود. این گزینه زمانی مفید واقع می شود که قصد داشته باشید از فایل صادر شده 

به عنوان بخشی از یک ویرایش بزرگ تر استفاده کنید. 
Set Start Timecode: یک کارکرد مرجع دیگر. با قرار دادن این کادر انتخاب در حالت تأیید می توانید 
کد زمانی را به فایل صادر شده اضافه کنید تا مشخص شود دقیقاً در چه زمان هایی باید تغییرات اعمال شوند. 
Use Proxies: اگر می خواهید نگارش کم حجم تری از فایل خود را صادر کنید، این کادر انتخاب را در حالت 

تأیید قرار دهید. به ویژه برای ارسال فایل های بازبینی به دوستان و مشتریان مفید است. 
Render Alpha Channel Only: برای صدور کانال آلفا باید این کادر انتخاب را در حالت تأیید قرار 

دهید. 
اگرچه  می کند.  رندر  بیتی   32 رنگ  فرمت  با  را  ویدیویی  محتوای   :Render at Maximum Depth
برای  زیرا کیفیت مطلوبی  واقع می شود  مفید  این گزینه پشتیبانی می کنند، هنوز هم  از  فرمت های کمی 

جلوه ها و ترکیب بندی تولید می کند که در مقایسه با عمق بیت واقعی این فرمت مناسب است. 

تفاوت بین ظرف فایل و برنامۀ پخش فایل  

ایموجی و ایموتیکان در اصل یکی هستند، اما با هم تفاوت دارند. درحالی که ایموجی گرافیک مشخصی مانند 
صورتک خندان یا صورتکی درحال چشمک زدن است، ایموتیکان کاراکترهای تایپ شده ای است که همان 
نتیجه را به بار می آورد. دو نقطه + خط فاصله + پرانتز بسته را در پیام متنی تایپ کنید تا تبدیل به صورتک 
  : تبدیل به صورتک  ایموتیکان را به ایموجی تبدیل می کند. ( این  خندان شود. گوشی هوشمند بلافاصله 

خندان می شود.(  
همین ارتباط بین برنامۀ پخش و ظروف فایل برقرار است. منظور از کُدِک نرم افزاری است که فایل ویدیویی 
استفاده  برای پخش  آن  از  نهایی  پروژۀ  که  است  بسته ای  فایل  فشرده سازی می کند، درحالی که ظرف  را 
می کند. ظرف فایل را مانند کمد فایل درنظر بگیرید که اشیای مختلفی مانند اسناد، رسیدها و مجلات را در 
خود نگه می دارد. این رسانه ها نیز حاوی ویدیو، صدا، کد زمانی و فراداده هستند. در دنیای فرمت های فایل، 
MP4 که در انتهای فایل فیلم خود می بینید ظرف فایل است، در حالی که H.264 که از منوی کشویی 
انتخاب می کنید، برنامۀ پخش فایل را نشان می دهد. JPG ،MOV و MP3 مثال هایی از ظروف فایل هستند، 

درحالی که H.264 ،MPEG و DivX برنامه های پخش فایل را نشان می دهند. 
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منظور از برنامۀ پخش فایل چیست؟ 
برای تازه کارها، این اصطلاح واژه ای مرکب از دو ترکیب رمزگذار/ رمزگشا است. از لحاظ فنی، منظور از کُدِک 
برنامۀ کوچکی است که فایل ویدیو را پردازش می کند ـ که ممکن است خیلی بزرگ باشد ـ و دادۀ آن را 
 JPG رمزگشایی کرده و آن را برای ذخیره سازی و اشتراک گذاری فشرده سازی می کند. معروف ترین مثال
از:  است که حجم فایل های تصویر را هنگام ذخیره سازی بسیار کاهش می دهد. مثال های دیگر عبارت اند 

.DivX و H.264 ،MP3

تنظیم نام خروجی برای تحویل  

همان طور که قبلًا ذکر شد، با کلیک روی لینک Output Name در زیر منوی Preset در پنل Export کادر 
محاوره ای نشان داده شده در شکل 7ـ23 نمایش داده می شود که می توانید از آن برای تغییر نام فایل استفاده 
کنید. در این کادر محاوره ای می توانید به پوشه یا درایو موردنظر خود پیمایش کنید. اگر تا این  مرحله از کار 
ساخت یا ویرایش سکانس این کار را انجام نداده اید، بهتر است از نام هایی مناسب برای فایل های خود استفاده 

کنید تا به سازمان دهی و تمایز آنها کمک کند. 

شکل 7ـ23ـ نام مناسبی را در این کادر محاوره ای وارد کنید
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این پیشنهادها را مدنظر قرار دهید: 
نام های قراردادی: یکی از روش های مرسوم استفاده از کد تاریخ هشت رقمی است که یا قبل یا بعد از نام 

 .20211225-San Diego Scene فایل مورد استفاده قرار می گیرد، مثلًا
ایجاد تمایز از طریق اندازۀ حروف: هنگام صدور فایل اصلی از حروف بزرگ برای نام گذاری استفاده کنید. 

در مورد بستۀ کلیپ، کات های سایر ادیت ها و ادیت های مختلف از حروف کوچک استفاده کنید. 

پرسش های تشریحی 

1 رندر را توضیح دهید.
٢ رمزگذاری )encode( به چه معناست؟

٣ کدام گزینه به شما اجازه می دهد از فایل های رندر ایجادشده قبلی برای صدور استفاده کنید؟
اما  می کند،  ایجاد  یکسان  اندازه  با  را  کیفیت  توازن  بهترین  بیت،  میزان  رمزگذاری  گزینه  کدام   ٤

می کشد؟ طول  بیشتر  رمزگذاری 
٥ هنگام صدور، کدام فرمت فایل هیچ کانال صوتی را ایجاد نمی کند؟

پرسش های چندگزینه ای  

1 شما یک فایل صوتی MP3 را از فایل صوتی WAV اصلی ایجاد کرده اید. چرا بهتر است از فایل 
WAV در پروژه Premiere Pro خود استفاده کنید؟

الف( فایل صوتی MP3 نگارش فشرده شده ای از فایل اصلی است که احتمالاً کیفیت صدا را تحت تأثیر 
قرار می دهد.

ب( فایل WAV کوچک تر و کارآمدتر است.
ج( Premiere Pro از صدای MP3 پشتیبانی نمی کند.

د( فایل WAV نیازی به تطبیق ندارد.
٢ هنگام آماده کردن یک سکانس برای صدور به اینترنت، کدام سه تنظیم باید لحاظ گردد؟

الف( کدک، نرخ فریم و عرض و ارتفاع فریم
ب( نرخ فریم، میزان صدا و عرض و ارتفاع فریم

ج( کدک، نرخ فریم و میزان صدا
د( میزان صدا، عرض و ارتفاع فریم و کدک

٣ کدام انشعاب فایل توسط Windows Media File استفاده می شود؟
.pptx )د 	.wmv )ج 	.mov )ب 	.docx )الف

٤ محبوب ترین و پر استفاده ترین فرمت برای دستگاه های همراه چیست؟
AVI )د 	H.264 )ج 	QuickTime )ب 	FLV )الف

5 میانبر Save چیست؟
Shift+S )د 	Alt+S )ج 	Ctrl+S )ب 	S )الف



در  بنيادين  تحول  سند  اجراي  در  خود  خطير  نقش  ايفاي  جهت  آموزشي  برنامه ريزي  و  پژوهش  سازمان 
آموزش و پرورش و برنامه درسي ملي جمهوري اسلامي ايران، مشاركت هنرآموزان را به عنوان كي سياست 
اجرايي مهم دنبال ميك ند. به منظور تحقق اين امر مهم، اعتبارسنجي كتاب هاي درسي را در دستور كار خود 
اولين  با دريافت نظرات هنرآموزان درباره كتاب هاي نو نگاشت ، كتاب هاي درسي را در  تا  قرار داده است 
سال چاپ ، با كمترين اشكال به هنرجويان و هنرآموزان ارجمند تقديم نمايد. در اجراي مطلوب اين فرايند، 
همكاران گروه تحليل محتواي آموزشي و پرورشي استان ها و گروه هاي آموزشي نقش سازنده اي را بر عهده 
داشتند. ضمن ارج نهادن به تلاش تمامي اين همكاران، اسامي هنرآموزاني كه تلاش مضاعفي را در اين زمينه 
داشته و با ارائه نظرات خود سازمان را در بهبود محتواي اين كتاب ياري كرده اند به شرح زير اعلام مي شود.

اسامي دبيران و هنرآموزان شركت كننده در اعتبارسنجي كتاب تولید کننده چند رسانه اي سه بعدي ) جلد دوم( ـ 312270

استان محل خدمت نام و نام خانوادگي رديف 

تهران سحر اسماعيلي 1

شهرستان هاي تهرانزهرا كردي2

تهرانليلا سعيد  3

تهرانمريم شفيعي 4

خراسان رضويليلا داودي ثاني5

شهرستان هاي تهرانبيتا رهنماي زربيجاري6

تهرانمحمد هادی قومنجانی7

تهرانمریم شبانکاره8

شهرستان هاي تهرانفاطمه درفشی9

تهرانعباسعلي رضايي10

تهرانعباس احسان جو11
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